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Administrator Guide
 About this Guide

The manual defines the Aspect Quality system and how it operates. It includes descriptions and 
step-by-step instructions for implementing essential system functions. It also outlines the 
procedures required to operate the system and its associated modules.

For information about Training, Technical Support, commenting on the documentation, and a list 
of additional documentation see the appropriate product Release Notes document on the 
Alvaria documentation portal.

Audience
This manual is written for contact center system administrators who manage call center 
technology and resources, as well as those providing Quality Assurance and Training in the call 
center. An Administrator should have a basic familiarity with PC features and Microsoft Windows 
operation. This person should be familiar with using Microsoft Edge to navigate Web-based 
applications. Familiarity with common window elements such as pop-up windows, list boxes, 
scroll bars, and other web functionality is helpful.

Note: Aspect Customer Education programs supplement all information contained in this 
manual. Administrators, Supervisors, and Trainers should attend the Aspect Quality 
training provided by Aspect before applying the procedures described in this manual.
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Organization of this Guide
This guide consists of following chapters:

• Chapter 1, Aspect Quality Basics describes Aspect Quality and provides an overview of 
how it operates.

• Chapter 2, Navigate Aspect Quality describes how Aspect Quality is used in the different 
phases of the Quality life cycle.

• Chapter 3, System describes how to add LDAP server with SSL, activate/deactivate LDAP 
server in Aspect Quality. Also the Server and Site features. 

• Chapter 4, Search for an Interaction describes Aspect Quality users, roles, rights, and 
permissions that are defined in the User Definition facility.

• Chapter 5, Assigning Interactions describes how to view and assign an assigned 
interaction. 

• Chapter 6, Coaching describes how to assign coaching directly from Quality.

• Chapter 7, Evaluations uses the same scoring process as quality scoring to see how well 
individual Mentors’ scores align with the Master Calibrator scores, to identify issues in the 
scoring process.

• Chapter 8, Reporting in Workforce Engagement Management describes the available 
reports in Workforce Engagement Management - Aspect Quality.

• Chapter 9, Import describes about how to import metadata and recording files to Aspect 
Quality.

• Chapter 10, Aspect Quality Evaluation describes how to create, edit, and duplicate 
templates.

• Chapter 11, Recording describes how Aspect Quality uses rules that you define to 
determine whether the system should record a particular interaction.

• Chapter 12, Security describes major Security components that are the part of the Aspect 
Quality.
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1.  Aspect Quality Basics

This section describes the Aspect Quality™ function within Aspect Workforce Engagement 
Management feature, and provides an overview of how it operates.

1.1   What is Quality?
Aspect Quality™ is a tool that you use to record voice and window interactions based on 
customizable business rules. You can retrieve the recordings using advanced search criteria, 
play the recordings back, and score the recordings for quality and training purposes. Quality 
integrates with My Account, which you use to take advantage of the environmental definitions 
(such as agents, agent groups, or teams) to create advanced recording rules and search 
criteria.

1.1.1   System Benefits
Aspect Quality™ is an integral part of a contact center for managing customer satisfaction, 
agent morale, job satisfaction, and cost, the key concerns of every contact center manager.

1.1.2   Features
Aspect Quality™ features include:

• Integration with MyAccount for Rule Definition.

Customers

AgentsCosts

The balancing act:

Costs
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Aspect Quality integrates with MyAccount once you have provisioned Aspect Quality to 
recognize all agents and agent groups.

• Browser-based application.

Quality performs all functions with Microsoft Edge and Safari Firefox, so you have access 
to Quality from any desktop within a firewall.

• Record all types of calls.

Quality automatically records and stores all audio calls: ACD calls, agent-to-agent inbound 
direct, outbound direct, and outbound blended calls. You may need different or other 
hardware configurations to record calls between agents, in addition to calls between 
external calls and agents.

• Powerful search and access to saved interactions.

You can use Quality to perform simple search and retrieval functionality.

• Flexible Quality Scoring.

You can use Quality to create custom scoring templates to evaluate each recording. You 
can define multiple scoring templates to meet the varying needs of a contact center 
business unit. Templates can have multiple sections, each with separately calculated 
scores, and several question types exist as part of the template creation wizard, so you can 
tailor the Quality scoring templates to existing processes.

1.1.3   Best Practices
Some of the many Quality Monitoring Best Practices supported by Quality include:

• Creating an environment where customers highly value and respect agents.

With Quality, agents gain value as part of the big picture as they receive targeted feedback 
and participate directly in the quality improvement process.

• Enabling front line leadership that is dedicated to agent development.

Managers can use Quality to provide ongoing feedback and coaching to agents.

• Providing examples of excellent service to help agents learn.

Managers can select and review real examples by new and experienced agents alike.

• Providing immediate feedback.

Without Quality, providing immediate feedback is challenging. With Quality, supervisors can 
review and evaluate calls, and can notify agents of new information within minutes of an 
interaction taking place.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 7
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• Using Quality for agent development and motivation.

Agents can access feedback, scores, and recordings, so the agents involve themselves in 
the learning process: a true training vehicle. You can close skill gaps using Quality’s agent 
interface.

• Personalizing feedback.

Deliver the quality scores and feedback comments directly to the agent to give 
personalized feedback, even if you do not have time for frequent one-on-one meetings. 
The supervisor can direct specific feedback to an agent, since that agent views only the 
feedback.

• Using technology that is intuitive and easy to learn.

Quality is user-friendly. The web interface is intuitive and fits with the existing tools with 
which both agents and supervisors are typically familiar.

• Using metrics that tie to the performance you want.

You can use Quality to tailor quality metrics to specific needs. Each call can have its own 
scorecard with its own unique criteria, or you can grade all calls with a common set of 
metrics. You can weigh each question and section of the scorecard based on the 
importance that you assign to each question and section in the overall score. The result is a 
way to reinforce to an agent’s behaviors and skills that impact customer loyalty and 
satisfaction.

1.2   Lifecycle
The introduction chapter describes how to use Quality in the different phases of the Aspect 
Quality lifecycle.

Note: The content in this Lifecycle section denotes the entirety of the Quality feature, 
including forthcoming capabilities in future releases of Workforce Engagement 
Management.
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This section briefly describes each phase of the life cycle and the tasks that you perform 
appear with a reference to where the manual describes that task.

1.2.1   Phase 1 – Plan
A Quality Administrator must perform most of the data entry for the planning phase. Team 
Leads have significant input into how you should configure the system to ensure that it 
matches how you want to manage the call center.

Traditionally, the planning phase is where you define and prioritize the quality and logging 
initiatives. You identify the top priority issues facing the call center related to customer 
satisfaction, agent satisfaction, and costs (the balance impacting overall quality), and then you 
define the means to monitor and improve on those questions and issues. For call center 
monitoring, identifying the calls to review and score is a key step to focusing on the right issues 
and learning how to improve quickly. You enter the measurements in the scorecard templates 
that the system takes while reviewing each call. Team Leads have the right to review the calls 
for quality initiatives.

During the planning phase, the following Quality tasks occur. An asterisk (*) denotes any tasks 
that a Team Lead might perform.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 9
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1.2.1.1   Planning Tasks
• Provision users and data

• Create agent groups

• Define/edit scorecards*

• Create shared searches*

1.2.2   Phase 2 – Record and Capture
In this phase, everything you set up in the planning phase actually causes recordings to occur.

1.2.2.1   Record and Capture Tasks
• No tasks needed.

1.2.3   Phase 3 – Search, Review, Score
Once the system captures the recordings in Phase 2, the next phase can begin where you 
access, play back, and score recordings for quality and feedback purposes.

The Quality Search window is the launching pad for most work that takes place. From this 
page, you can build queries to obtain the specific recordings of interest. A variety of data about 
each recording is visible, including call history, hold times, Agent Groups, ANI/CLI and DNIS 
information. You can access the voice recording and the window recordings if you are using 
the Quality Full Picture option.

In this phase, you can give agents the rights to score themselves to contribute to quality 
improvement. An agent’s scores are visible to the Team Lead, and the Team Lead can 
compare and search for calls where the two scores are not in sync.

You can allow multiple Team Leads to score the same calls.

1.2.3.1   Search, Retrieve, Score Tasks
• Build queries and perform searches

• Find agent flagged interactions

• Review call history details

• Play back recorded voice

• Score interactions and set flags (team review, agent review, peer review)

• Email immediate feedback

• Download recordings
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 10
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• Assign Agent tasks

• Agent Self-Review

• Agent Self-Evaluation

1.2.4   Phase 4 – Report and Analyze
In this phase, you analyze the quality monitoring activity that has occurred over time for trends 
to spot areas where the agents have made improvements and where you need new quality 
initiatives.

You can run reports that focus on an individual agent’s performance over time on different 
criteria, for example, types of calls or specific questions on a scorecard. Reports can also 
compare agents on a team or can compare different Team Leads’ teams to see who is 
managing more effectively. Trends can help identify who consistently performs better on 
certain criteria to help identify ways that you can make further improvements across the entire 
center.

1.2.4.1   Report and Analyze Tasks
• Run Reports

• Review how an agent was scored against one or more interactions

• Review the average quality score of agents in a team for interactions

• View the average quality score of evaluated agents relative to the specified reporting 
frequency period

1.2.5   Phase 5 – Feedback and Education
During the feedback phase, typically agents can log into the Quality to automatically find 
interactions that they must review and then review the scores, comments, and recordings (if 
they exist).

You can prompt urgent reviews by emailing a link to the scorecard directly to the agent. When 
the agent clicks the link, the scorecard opens for immediate review of the comments.

1.2.5.1   Feedback and Education Tasks
• Email feedback

• Agent review, Team review, and Peer review flags

• Agent search and play back 

• Filter on own interactions that need review via setting Agent = self 

• Filter on team review interactions from last week (for training purposes)
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 11



Administrator Guide
• Agent self evaluation as two-way feedback mechanism

The remainder of this manual describes the specific steps of how to perform some of the key 
tasks for which an Administrator or Team Lead are responsible throughout the five major 
phases in the Aspect Quality life cycle.

1.3   User Personas
Workforce Engagement Management - Aspect Quality supports the following types of 
personas (user roles).

Administrators – This role has full unrestricted access to the entire Aspect Quality system. 
Generally, each Aspect Quality system only has a few Administrators. The administrator role 
focuses on creating users, rules, and scorecard templates. Administrators also run reports. 
You must create the Administrator manually in Aspect Quality. The Administrator has full 
access to 

• Play back recordings, view and edit reports, use Customer Measured Quality, and has 
Administrator privileges within the user interface.

• Create and configure new users along with setting rights and permissions for the following.

• New Administrator user

• Mentor

• Agent

• None

• Silent Monitor (Note: This option is obsolete and not available)

• IVR

The major functions an Administrator may perform include:

• Define and configure Mentor rights, including the right to create rules, create scorecard 
templates, and create and review reports.

• Define and configure Agents that allow Agents the right to review their calls and scorecards 
for self-evaluation. This includes turning on or off the right for an Agent to review their own 
recordings.

• Design and create scorecard templates.

• Define rules for recording to determine which calls the system should or should record.

• Configure permissions for Mentors, Teams, Agent Groups, scorecard templates, rules, and 
reports.

Mentors – this is the role that typically uses the Aspect Quality system to review calls and 
grade them using scorecard templates. You give Mentors access to recordings by assigning 
them to teams or Agent Groups. You can also grant Mentors rights to:

• View and Edit Reports

• Create Scorecard templates
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• Review or Score Recordings

• Define Rules

• Mark recordings for review by individual agents or teams

• Assign protection flags to save recordings for future use

For any specific rule or template, you can also give a Mentor the ability to view only or modify 
its contents.

Agents – the agent can log in to Aspect Quality to review interactions but cannot score other 
agent’s interactions. Typically, you give an agent access only to recordings that a Mentor has 
flagged for the agent’s attention. In addition, you can grant an agent the right to listen to his or 
her own calls before any Mentor reviews the calls, since sometimes the business process 
requires the agents to research what was said on previous calls. You can also grant access to 
an agent to view a self-evaluation to obtain feedback about his or her own performance.

While monitoring ACD activity, Aspect Quality™ discovers agents that it has not monitored 
previously, and the system adds the agent definition to the database to keep the agent’s 
identification in sync with the ACD definition for that agent. You can use information in the rules 
to allow the agent to log into Aspect Quality with the agent’s ACD logon ID.

In general, Agents can

• Listen to all of their calls before Mentor review.

• Perform self-evaluations, rating their own performance.

• Review other agents’ recordings when assigned by a Mentor.

None – Give the None user role to those agents who you want to record but not allow to log in 
to the Aspect Quality system. Therefore, None agents cannot review their own calls and score 
cards in Aspect Quality.

If you need agents with None user roles to review and score recordings, you must configure 
the agent user in the Aspect Quality system.

The database synchronization with the ACD, predictive dialer, or connector automatically 
enters Agents into Aspect Quality. However, you must configure these agents as None in the 
Aspect Quality system if you do not want them to access Aspect Quality.

IVR – The IVR role defines an IVR Port or Station. An Aspect Quality user with an IVR role 
represents an IVR port or station within the Aspect Quality system. It is mandatory to associate 
a valid position ID to an IVR port. You can modify any non-Aspect Quality user to act as an IVR 
port or station.

1.4   Access Rights
You assign all users, except for Administrators, access rights within Aspect Quality. These 
rights allow users to perform various functions. The system automatically grants 
Administrators nearly all available rights.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 13



Administrator Guide
The following table is a list of access rights that you can assign to users based on their 
selected user role.

1.5   Basic Configuration of WEM 
1. Install Quality builds and WEM builds.

2. Do the configuration in Quality Configuration Utility in Aspect Quality Server2.

a. Note: Refer Aspect Quality™ Server Installation Guide Chapter 4: Using the 
Configuration Utility.

3. Do the required configurations in Quality web config and WEM web config files.

Quality web config file

a. Update the “Require https” key to true or false based on you are accessing the web url 
with http or https.

Rights Job Roles

Administrator Mentor Agent/None None

Self Review X X

Self Evaluations X X

View Reports X X

Create Reports X X

Create Recording Rules X X

Create Evaluation Templates X X

Create Tasks X X

Download Recordings X X

Export Recordings X X

View Peer Review X X

Grant Peer Review X X

View All Evaluations X X

Edit All Evaluations X X

Assign Evaluations X X

Assign Interactions X X

Delete Interactions X X

Protect Interactions X X

Hide \ Show Interactions X X

View Calibration Events X X

Assign Calibration Events X X
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b. Set Enable antiforgery key to “true or false”. If you want to set it as true, then follow the 
steps in Aspect Quality™ WEM Installation Guide to configure antiforgery key.

WEM web config file 

a. Update the “Require https” key to true or false based on you are accessing the web url 
with http or https.

b. Set Enable antiforgery key to “true or false”. If you want to set it as true then follow the 
steps in Aspect Quality™ WEM Installation Guide to configure antiforgery key.

c. Set the “QMBaseURL” - http(s)://servername/qualitywebservice/api.

4. Launch WEM using below url.

http://<servername>/wfo 

5. Login as Administrator which you provided as an input during the installation.

6. Click on the main menu and Select System > Licensing link.

7. Upload a valid Quality license.
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8. Once license is uploaded successfully, sign out and sign in to WEM again.

a. Note: This is needed to ensure the WEM UI functions properly by considering the 
uploaded license.

9. Configure Sites and Servers.

a. Click on main menu and Navigate to Administration > System > Site link.

b. Click on the Edit button.
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c. Under Database tab, click on “+” (Add) button.

d. Enter the database details and click on OK button.
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Note: If you are configuring DR then you should enter the secondary replica details and set 
the Primary Replica accordingly. Refer: <<Provide the DR configuration guide.

e. Click on the OK button to save the site database details. 

f. Click on main menu and Navigate to Administration > System > Servers link.
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g. Click on “+” (Add) button. 

h. Enter the Server name and IP Address and Save the server. 

Note: Refer the Section Servers of WEM Admin guide if you want to know more about how to 
configure the Servers.
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10.Configure the System Processes.

a. Click on main menu and Navigate to Administration > System > “System Processes” 
link.
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b. Click on the “+” button.

c. Select “Process Type” as Web Server and Select the “Process Server” if you want 
Mentor to live monitor the agents using MDC if not this step can be ignored.

d. Select the Log Mode based on the requirement.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 21



Administrator Guide
e. Specify the web server root url (The WEM URL to accessed by MDC when the mentor 
wants to create an evaluation while live monitoring the agent) Root URL format: http(s):/
/<Servername>/wfo.
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f. Click on the OK button.

g. Click “+” button to add next process.

h. Select “Process Type” as Process Manager and Select the “Process Server”.
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i. Select the Log Mode.
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j. Click on the OK button.

k. Click on “+” button to add another process. 

l. Select “Process Type” as Interaction Monitor and Select the “Process Server” 
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m. Select the Log Mode 
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n. Click on the OK button to save the process.

11.Create Storage Group 

a. Click on main menu and Navigate to Administration > System > Storage Groups link.
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b. Click on “+” button to add the storage group.

c. Enter the recording files and evaluation attachment locations and save the storage 
group.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 28



Administrator Guide
Note: If you want to Enable Archiving, turn on the “Enable Archiving” toggle button and enter 
data in all the required fields.

12.Create Switch (Unified IP Regular CTIPS)

a. Create Unified IP Regular CTIPS by referring Aspect Quality™ Server Install Guide 
Appendix E.

b. Add the switch under Interaction Monitor process.

c. Exchange the certificates between Unified IP core, core redundant and Quality 
Servers.The root certificate of unified IP servers should be installed in Quality Server 
and the root certificate of Quality Server should be installed in the core and core 
redundant servers 

Note: The Quality server should have certificate with FQDN (Fully Qualified Domain 
Certificate) 

d. Add the Quality server in Unified IP core and core redundant host file.

e. Add Unified IP server details in Quality Server host file. 

f. Bind the Quality Server FQDN certificate to the Unified IP Call Back Port or 
Alternatively, you can use NetTCP communication with CTIPS by specifying the 
certificate thumbprint in InteractionMonitor.exe.config.

g. Start Quality Service.

h. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch. 
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i. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls.

j. Create SIP Recording Board.

k. Create Audio Ports using the recording board. 

l. Create Recording Rules for the switch.

m. Create Port Manager, File Mover processes. Add the audio ports created above under 
the Port Manager process and the Storage Groups created under the File Mover 
process. 

n. Stop and Start the Quality Service. 

Note: The Storage group assigned to switch when creating it should be added to the 
File Mover process. 

o. Check if the audio ports are Ready state by opening the System Monitor.

p. Login as the agent to “UAD” to record the calls.

13.Unified IP Enhanced CTIPS

a. Create Unified IP Enhanced CTIPS by referring Aspect Quality™ Server Install Guide 
Appendix E.

b. Add the switch under Interaction Monitor process.

c. Exchange the certificates between Unified IP core, core redundant and Quality Servers. 
The root certificate of unified IP servers should be installed in Quality Server and the 
root certificate of Quality Server should be installed in the core and core redundant 
servers.

Note: The Quality server should have certificate with FQDN (Fully Qualified Domain 
Certificate). 

d. Add the Quality server in Unified IP core and core redundant host file.

e. Add Unified IP server details in Quality Server host file. 

f. Bind the Quality Server FQDN certificate to the Unified IP Call Back or Alternatively, you 
can use NetTCP communication with CTIPS by specifying the certificate thumbprint in 
InteractionMonitor.exe.config.

g. Start Quality Service

h. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch. 

i. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls.

j. Create Recording Rules for the switch.

k. Create File Mover process. Add the Storage Groups created under the File Mover 
process.

l. Create File Receiver Process and add the Storage Groups where the recording files 
need to be moved.

m. Create Receiver Groups from WEM 
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n. Stop and Start the Quality Service.

Note: The Storage group assigned to switch when creating it should be added to the 
File Mover process.

o. Login as the agents to record the call.

14.Avaya

a. Create Avaya switch by referring Aspect Quality™ Server Install Guide Appendix C.

b. Add the switch under Interaction Monitor process.

c. Add Avaya server details in Quality Server host file.

d. Start Quality Service.

e. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch. 

f. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls.

g. Create Avaya DMCC Recording Board. 

h. Create DMCC Recording Ports.

i. Create Recording Rules for the switch.

j. Create Port Manager, File Mover, processes. Add the audio ports created above under 
the Port Manager process and the Storage Groups created under the File Mover 
process.

k. Stop and Start the Quality Service.

Note: The Storage group assigned to switch when creating it should be added to the File 
Mover process.

l. Login as the agents to record the call. 

15.Cisco UCCE 

a. Create Cisco UCCE switch by referring Aspect Quality™ Server Install Guide Appendix 
D.

b. Add the switch under Interaction Monitor process.

c. Add UCCE server details in Quality Server host file. 

d. Start Quality Service.

e. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch.

f. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls. 

g. Configure Cisco UCM to allow BIB recordings.

h. Create Cisco BIB Recording Board.

i. Create BIB Recording Ports. 

j. Create Recording Rules for the switch.
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k. Create Port Manager, File Mover processes. Add the audio ports created above under 
the Port Manager process and the Storage Groups created under the File Mover 
process.

l. Stop and Start the Quality Service. 

Note: The Storage group assigned to switch when creating it should be added to the 
File Mover process.

m. Login as the agents to record the call. 

16.Cisco UCCX 

a. Create Cisco UCCX switch by referring Aspect Quality™ Server Install Guide Appendix 
D.

b. Add the switch under Interaction Monitor process.

c. Add UCCX server details in Quality Server host file. 

d. Start Quality Service. 

e. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch.

f. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls.

g. Configure Cisco UCM to allow BIB recordings. 

h. Create Cisco BIB Recording Board.

i. Create BIB Recording Ports.

j. Create Recording Rules for the switch. 

k. Create Port Manager, File Mover processes. Add the audio ports created above under 
the Port Manager process and the Storage Groups created under the File Mover 
process.

l. Stop and Start the Quality Service.

Note: The Storage group assigned to switch when creating it should be added to the 
File Mover process.

m. Login as the agents to record the call.

17.Cisco UCM 

a. Install and configure Cisco TSP.

b. Create Cisco UCM switch by referring ServerInstall Guide Appendix D.Also do the 
configurations on UCM side to do BIB recording.

c. Add the switch under Interaction Monitor process.

d. Add UCM server details in Quality Server host file.

e. Start Quality Service.

f. Check the Interaction Monitor log for the connection establishment and data sync. Also 
verify if the users synchronized is appearing under Administrator > Security > Users 
page for the switch. 
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g. Once the data sync is done enable the users for “Audio and Screen Recording” to make 
the calls.

h. Create Cisco BIB Recording Board.

i. Create UCM_SIP Recording Ports. 

j. Create Recording Rules for the switch.

k. Create Port Manager, File Mover processes. Add the audio ports created above under 
the Port Manager process and the Storage Groups created under the File Mover 
process.

l. Stop and Start the Quality Service. 

Note: The Storage group assigned to switch when creating it should be added to the File 
Mover process. 

m. Login as the agents to record the call. 
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 33



Administrator Guide
2.  Navigate Aspect Quality

2.1   Access the Administration Area
To access the administration area follow the steps below:

1. Go to the menu.

2. Click Administration.

The full range of administrator’s access rights opens.
Note: The Quality modules listed may differ based on the license and security privileges.
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The following table describes the modules in the Administrator dashboard.

Feature Description

Import Import Jobs - It explains how to import metadata and recording files to Aspect 
Quality feature in Workforce Engagement Management such as creating 
import jobs, editing import jobs, activate and deactivate jobs, and so on.

Aspect Quality 
Evaluation

Evaluation Templates - Users score interactions for training purposes, and 
the scored interactions are called evaluations. Evaluation templates are a 
group of standardized questions that users answer to score interactions.

Workforce Configuration - Used for configuring Aspect Workforce server 
details to upload the agent scores.

Recording • Agent Groups - Agent Groups are the groups of agents defined with the 
common skill set.

• Audio Ports - Used for configuring various types of ports to meet the 
needs of the call center in terms of recording capacity and security. These 
are the components that actually record the phone calls and the window 
activity of the agents.

• Locations - Used for configuring storage locations to which the Unified IP 
software based recordings from specified telephony servers need to be 
stored.

• Receiver Groups - Use Receiver Groups to record on the Telephony 
Server and transmit the recording files for storage and retrieval in Aspect 
Quality. You must define at least one Receiver Group for each Unified IP 
switch with an Enhanced CTIPS integration.

• Recording Boards - Provides an interface for recording servers to 
communicate with the cards or software components of a switch. The 
recording board should be associated in audio ports to record the calls. 

• Recording Groups - Used for grouping of one or more Audio ports based 
on similar criteria (for example, the same switch or the same telephony 
card). An Administrator can create a Recording Group and give only 
certain Mentors permission rights to review the calls recorded on the 
ports in the group(s).

• Recording Rules - You can base the rules on a wide variety of criteria, so 
that you can create general rules that apply to the entire contact center or 
specific rules that apply only to a particular agent or customer.

• Skill Groups - Used for associating one or more Agent Groups that 
provides the user permission to view interaction details, view evaluation 
data, score interactions and playback media.

• Switches - Each Aspect Quality system integrates with one or more 
switches, which is used for the environmental definitions (for example: 
agents, agent groups and teams) within that integration. For each of 
these switches the configuration procedures need to be performed.

• Trunk Channels - When using IVR Recording, you may need to modify 
existing trunk entities within the Aspect Quality system.

• VOIP Tap Points - Used to setup a tap point to tap Session Initiation 
Protocol (SIP) or Cisco Skinny Call Control Protocol (SCCP) or Avaya 
H.323 phones registered with Avaya or Cisco system.
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Security • API Users - Used for configuring user accounts to access the API.
• Teams - Teams are users grouped together by, for example, schedule or 

location. You can create, edit, activate/deactivate teams in the Quality 
system.

• User Profiles - User profiles are a way for Administrators to assign rights 
and permissions to a group of users.

• Users - Users are the individual users on the Quality system.

System • LDAP Servers - Used for configuring the LDAP or Active Directory server 
details from which additional user details can be fetched for authorization 
in Aspect Quality.

• Licensing - When you initially log into Workforce Engagement 
Management - Quality, you need to set up the permissions to view the 
Quality features.

• Servers - Used for configuring the servers for hosting various Aspect 
Quality System Processes.

• Site - You can associate an agent with a site defined in Aspect Quality, so 
that the system can invoke the proper recording server when you want an 
agent’s call to be recorded.

• SMTP Server - Used for configuring the SMTP server details that sends 
emails for system alerts and enables user to email evaluations.

• Storage Groups - Use storage groups to define how long to store and 
where to store interactions and evaluation attachments.

• System Parameters - Allows system level configuration for certain 
features.

• System Processes - Used for configuring various processes that run 
within the Aspect Quality Server service.

Feature Description
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 37



Administrator Guide
3.  System

The chapter introduces the major components that are the part of the Aspect Quality™ 
system. As an Administrator, knowing the components helps you to be more productive while 
using the Aspect Quality system.

The components covered are listed below:

• LDAP Servers

• Servers

• Site

• SMTP Server

• Storage Groups

• System Parameters

• System Processes

3.1   LDAP Servers
Aspect Quality supports the Lightweight Directory Access Protocol (LDAP) and Active 
Directory (AD) functionality, which Administrators can use to assign policies, deploy software, 
and apply critical updates to an organization from a central point. You can also use this 
functionality to define overall user and group permissions and provide an integration to pull in 
user login ids, domains, and email addresses into Aspect Quality automatically. The 
integration can look up and populate the Active Directory or LDAP user name, domain, and 
email in the Aspect Quality web client. These capabilities allow screen capture and single sign-
on to Aspect Quality, based on Windows authentication with Microsoft Active Directory.

This section describes how to add LDAP server with SSL, activate/deactivate LDAP server in 
Aspect Quality. 

3.1.1   Add LDAP Server
Follow the steps below to add LDAP Server.

1. Go to the main menu.
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2. Click Administration > System > LDAP Servers.

3. The LDAP SERVERS window appears. Click on the  button.

4. The Add LDAP Server window appears as shown below.

Note: The fields marked (*) are mandatory fields.

5. Click on the Server Type drop-down and select Active Directory or LDAP as per your 
requirement.

6. Type server address on the Server Address field.
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7. To mention the port number, click on the up/down arrows or type the number of ports on 
Port Number field.

8. In the Base DN text box, type the distinguished name of the base object in the LDAP/AD 
server, where the search begins. Example: cn=users,dc=rd1,dc=atc,dc=Aspect,dc=com 
OR ou=People,dc=concerto,dc=com 

9. If you want Aspect EX Quality to connect to LDAP server over Secure Socket Layer, toggle 
on the SSL toggle button.
Note:

• Aspect EX Quality uses a secure connection to connect to the LDAP. The default 
port for the SSL is replace with 636 (389 for Non SSL). In the Server Address text 
box, you must type the LDAP/AD Server machine name, not the IP address, for 
Aspect EX Quality to communicate to LDAP/AD over the SSL.

• If you toggled on the SSL toggle button, check mark will be shown under the SSL 
column on the LDAP Server window.

10.In the Domain Name text box, type the domain name of the LDAP/AD server.

11. In the User Name text box, type the credentials used to bind with the LDAP/AD server. 
Example: Administrator.

12.In the Password text box, type the credentials used to bind with the LDAP/AD server. 
Example: xyz.

13.Choose you authentication type from the Authentication Type drop-down list such as 
Basic or NTLM. 

• Basic - Select this if you want to use Basic Authentication. This requires the user to 
supply a user name and password. Use this option only with Secure Sockets Layer 
(SSL), because the Web server obtains the user’s credentials unencrypted, ASP.NET 
applications can impersonate the caller and use their credentials to access network 
resources.

• NTLM - Select this if you want to use Windows Authentication. Integrated Windows 
authentication (formerly known as NTLM) means that the server negotiates with the 
client to determine the protocol to use.

Note: For NTLM authentication type when you leave the username and password 
fields blank in the LDAP configuration, the default network credentials 
configured for the Aspect Quality Service in the Interaction Monitor server is 
used to connect to LDAP/AD.

14.By default, the Sync User Email Address toggle button is turned on to pull the user’s 
email IDs, if available, into the LDAP/AD server. If you want to turn off the email syncing 
feature, toggle-off the toggle button.
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15.Click OK button to complete the process and the LDAP Server is added on the LDAP 
SERVERS window.

Note: The grid is sorted based on server address ascending order.

3.1.2   Activate and Deactivate LDAP Server
After adding a LDAP Server, you can activate and deactivate the LDAP Server. Refer to Add 
LDAP Server on page 3-38 section.

3.1.3   Activate LDAP Server
Follow the steps below to activate a LDAP Server.

Column Description

Server Address The address of the server.

Domain Name The domain name.

Port Number The port number of the server.

Base DN The distinguished name of the base object in the LDAP server.

User Name The username who added the LDAP server.

Authentication Type There are two types such as Basic and NTLM.

SSL The checkmark is shown if the SSL toggle button was toggled-on.

Sync Email The checkmark is shown if the Sync User Email Address toggle button 
was toggled-on.

Active The checkmark is shown if the LDAP server is active.
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1. After adding the LDAP Server, select the LDAP Server and click activate button.

2. After clicking on activate button, checkmark will be shown under the Active column. 

3.1.4   Deactivate LDAP Server
Follow the steps below to deactivate a LDAP Server.
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1. Select the activated LDAP Server and click on deactivate button.

2. After clicking on deactivate button, the Active column will be blank. 

3.1.5   Edit a LDAP Server
To edit a LDAP Server, perform the following steps.

1. Go to the main menu.
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2. Click Administration > System > LDAP Servers.

3. Select the LDAP Server and click on the Edit button. 
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4. The Edit LDAP Server window appears.

5. Edit the fields as per your requirement.

Note: Refer to Add LDAP Server on page 3-38 section, step 4 to 15.

6. Click the OK button to complete the process.

3.2   Servers
The Aspect Quality has one or more servers that operate on the network to run both the real-
time recording of calls and the web pages to search for and play back calls. For large systems, 
you must have more than one server to handle recording an extensive number of calls at one 
time. Generally, only Aspect Quality Administrators must identify the Aspect Quality servers.

This section describes about how to Navigate, Add, Edit and Delete Servers.

3.2.1   Navigation to the Servers
Follow the steps given below to navigate to the Servers page:

1. Go to the main menu.
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2. Click Administration > System > Servers.

3. The Servers page appears as given below:

4. The Menu buttons on the Servers page are described below:

Icons Description

Refresh Refreshes the users grid with latest user changes. Instead of 
the browser refresh button user can click on this menu button 
which will refresh only the grid data and not the page.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 46



Administrator Guide
5. The grid columns on the Servers page are described below:

3.2.2   Add Servers
To add Servers, perform the following steps:

1. Go to the main menu.

2. Click Administration > System > Servers.

3. The Servers page appears.

4. Click on the Add icon on the Servers page.

5. The Add Server dialog appears as given below:

Note: The fields marked (*) are mandatory fields.

6. Enter the host name of the Server in the Name field. 
Note: If you enable Secure Communication across the Aspect Quality system, the server 

name must be the Fully Qualified Domain name (FQDN). Otherwise, the name must 
be the non-qualified/NetBIOS server name.

Add Allows to add a new Server.

Edit Updates the details of the selected Server listed on the Servers 
page.

Delete Allows to delete the selected existing Server from the list.

Icons Description

Name The Name of the Server.

IP Address The Servers connected to the IP Address.

Process Types The Process assigned to run on the Server will be displayed.

Icons Description
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7. By default, DNS Resolution will be flagged off.

8. Enter the IP Address either manually or it can be searched by clicking the Search icon 
next to the Name field .

Note: When the Search icon is clicked, the IP address field populates with a list of IP 
addresses resolved with DNS, based on the name that you entered in the Name text 
box. If the server has been assigned multiple IP addresses, Aspect recommends 
that you select a specific IP address for Aspect Quality to use on the server, unless 
DNS resolution only resolves to the single, specific IP address that you want to use.

Note: When DNS Resolution is flagged on, the IP Address text box and the Search icon 
will be disabled automatically, as shown below:

9. Click the Save button to save the given Server to the grid, as shown below:
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3.2.3   Edit Servers
To edit Servers, perform the following steps:

1. Go to the main menu.

2. Click Administration > System > Servers.

3. The Servers page appears.

4. Select the available Server from the grid that needs to be edited and click the Edit icon .

5. The Edit window appears, as shown below:

6. Edit the fields as per your requirement.

Note: Refer to Add Servers on page 3-47, step 4 to 8.

7. Click the Save button to complete the process.

3.2.4   Delete Servers
To delete Servers, perform the following steps:

1. Go to the main menu.

2. Click Administration > System > Servers.
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3. The Servers page appears, as shown below:

4. Select the available Server from the grid that needs to be deleted and click the Delete  
icon.

5. The Warning dialog box appears to confirm the deletion of the selected Server, as shown 
below:

6. Click Yes to delete or No to cancel the deletion of the selected Server. 
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7. Yes option is selected and the listed Server is deleted from the grid, as shown below:

Note: The Delete option for the Servers will be disabled, when one or more process is 
associated with the Server.

3.3   Site
Only Aspect Quality Administrators can configure the site definition.

In Aspect Quality, Site allows the user to define the database details. This section describes 
about Edit and Delete a Site, also how to Add, Edit, Delete a database and set it as a Primary 
Replica with LDAP Sync.

3.3.1   Navigation to the Site
Follow the steps given below to navigate to the Site page:

1. Go to the main menu.
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2. Click Administration > System > Site.

3. The Site page appears as given below:

4. The Menu buttons on the Site page are described below:

Icons Description

Refresh Refreshes the users grid with latest user changes. Instead of 
the browser refresh button user can click on this menu button 
which will refresh only the grid data and not the page.

Edit Updates the details of the selected Site listed on the Site page.

LDAP/AD Sync Allows to sync the LDAP/AD details.
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5. The grid columns on the Site page are described below:

3.3.2   Edit a Site
To edit a Site, perform the following steps:

1. Go to the main menu.

2. Click Administration > System > Site.

3. The Site page appears.

4. Select the Site from the Name column that needs to be edited and click on Edit button. 

Icons Description

Name The name of the Site.

Servers The servers connected to the Site.

Primary Replica Sets the preferential Database as a primary replica.
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5. The Edit Site window appears to edit the fields as per your requirement.

On the Edit Site window, two tabs are available:

• General Tab

• Database Tab

6. Click the Save button to save the changes.

3.3.2.1   General Tab
• Name: This is the name of the Site that is selected already from the grid for the edit.
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• LDAP Servers: This is the list of the available Active LDAP servers that can be selected 
from the drop-down.

After editing the required fields, click the Save button.
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3.3.2.2   Database Tab
• Menu buttons on the Database tab are described below:

• The grid headers of the Database tab are explained briefly below:

Icons Description

Add Add the database connection string details to the Quality 
database which is configured in Quality Configuration Utility.

Edit  Updates the database connection string details for the 
selected database added to the grid. 

Delete  Deletes the database connection string details from the 
Quality.

Set Primary Replica Sets the selected Database, listed in the grid as primary.

All the CRUD (Create, Read, Update and Delete) operations 
will be done on the database which is set as Primary.

Column Description

Server Address This is the Server name of the Aspect Quality database server.

Database Name This is the name of the Aspect Quality database.

Archive Database 
Name

If the user wants to archive the data then this database name 
have to be configured.
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3.3.2.2.1   Add Database
The Add Database window appears by clicking the Add icon as shown below:

Note: The fields marked (*) are mandatory fields.

The Database Information fields are briefly given below:

1. Server Address: Server name of the Aspect Quality database server.

2. Name: Name of the Aspect Quality database.

3. Archive Name: Name of the database that will be available, when the system moves and 
stores the Archived media metadata.  
For example: QM_Archive. The Current/ Historical and Archive databases must reside on 
the same Microsoft SQL Server instance and use the same credentials for access. If you 
do not use archiving, you can leave this field empty.

Primary Replica This is the selected database that is listed in the grid as 
primary. This database has  icon in the Primary Replica 
column.

Note: 1. Delete and Set Primary Replica icons will be 
disabled for the replica that is set as Primary.
2. Only one database can be set as Primary Replica.

Column Description
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4. Port: TCP port number that Aspect Quality uses to communicate with the SQL Server. The 
default is 1433.

5. Authentication: Select the SQL Server option from the drop-down. Once you select the 
Authentication option, the User Name and Password fields are active.

Note: Aspect Quality supports Windows Authentication for SQL Server access. If you are 
using Windows Authentication to connect to the Aspect Quality database, you do 
not need to enter any User Name or Password at this window. When Aspect Quality 
attempts to access the Aspect Quality database, the Aspect Quality service uses the 
Windows account during Log On As setting to access the database.

6. User Name: SQL Server user name that you use to access the Aspect Quality database.

7. Password: Allows you to set the new password or use the existing password to access the 
Aspect Quality database. When you click on the password field available options list 
appear.

8. Click the OK button to Add the database or Cancel button to cancel the database. 

9. When the Cancel option is selected, the Warning message appears to confirm the 
cancellation. Select Yes to confirm cancellation or No to return to the previous screen, as 
shown below:

3.3.2.2.2   Edit Database
Select the existing database from the Database tab that needs to be edited. Click the Edit icon  
and the Edit Database window appears as shown below:
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1. Edit the fields as per your requirement.
Note: Refer to Add Database on page 3-57 section, step 1 to 8.

2. Click the OK button to complete the process.

3.3.2.2.3   Delete Database
Select the existing database from the Edit Site grid that needs to be deleted.

1. Click the Delete icon and the Warning window appears to delete database, as shown 
below:

2. Select Yes to delete the database and No to cancel the deletion.

Note: Delete button will be disabled for the database in the Edit Site grid that has been set as 
Primary Replica, as shown below:
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3.3.3   LDAP/AD Sync
To Sync a Site, perform the following steps:

1. Go to the main menu icon.

2. Click Administration > System > Site.

3. The Site page appears.
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4. Select the Site from the Name column that needs to be synced and click on LDAP/AD 
Sync button. 

5. The LDAP/AD Sync Success message window appears, as shown below:

6. Click the OK button to save the changes.

3.4   SMTP Server
This section describes how to view the existing SMTP Server and how to Add, Edit and Delete 
the SMTP Server in the system.

Note: Maximum one SMTP Server can be created for any system. So, if a different SMTP 
Server is required, user can either edit the existing SMTP Server or delete the same 
and then create a new SMTP Server.
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3.4.1   Navigation to SMTP Server
Follow the steps given below to navigate to the SMTP Server page:

1. Go to the main menu.

2. Click Administration > System > SMTP Server.
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3. The SMTP Server page appears, as given below:

4. The Menu buttons on the SMTP Server page are described below:

5. The grid columns on the SMTP Server page are described below:

Icons Description

Refresh Refreshes the SMTP server grid with latest SMTP server 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new SMTP server to the grid.

Edit Edits the SMTP server existing in the grid.

Delete Deletes the existing SMTP server listed in the grid.

Column Description

Server Name The name of the SMTP server.

System Email Address The system will send the e-mails using the specified System 
Email Address.

User Name The specified user name will be used to connect to the SMTP 
server.

Port The port number will be used by the SMTP server to send e-
mails.
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3.4.2   Create SMTP Server
To create a new SMTP Server, perform the following steps.

1. Go to the main menu.

2. Click Administration > System > SMTP Server.

3. The SMTP Server page appears.

4. Click on the Add button. The Add SMTP Server definition window appears.

Note: The fields marked (*) are mandatory fields.

5. Enter the name or IP Address of the mail server in the Server Name text box.

6. Enter the Email address or server address which the system will use to send the Emails in 
the System Email Address text box. The System Email Address is the From e-mail 
address from which the system seems to send the alerts, and must be a valid SMTP 
address on the external e-mail system.

7. Enter the name of the user in the User Name text box to optionally authenticate the SMTP 
server for sending e-mail.

8. Enter the password in the Password text box for the SMTP user name.

9. Enter the port number to connect to the Email server, either manually or using the arrow 
keys in the Port text box. By default, the port number will be displayed as 25. The Port 
number value can be entered ranging between 1 to 65535.

SSL The SMTP server’s SSL status is displayed by the checkmark 
icon, whether SSL was active or not.

Column Description
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10.The SSL toggle key is unflagged by default. To enable the STARTTLS SMTP extension for 
secure connections to the Email server, flag the SSL toggle key.

11.Click OK to create the SMTP Server.

By default, the new SMTP Server which is created will be listed in the grid. Now, the 

Add  button will be disabled and the Edit and Delete buttons will be enabled.

3.4.3   Edit SMTP Server
To edit a SMTP Server, perform the following steps.

1. Go to the main menu.

2. Click Administration > System > SMTP Server.

3. The SMTP Server page appears.

4. Select the available SMTP Server from the grid for editing and click the Edit icon.

5. The Edit SMTP Server window appears, as shown below.

6. Edit the field values as per your requirement.
Note: Refer to Create SMTP Server on page 3-64 section, step 4 to 11.

7. Click the OK button to complete the process.

3.4.4   Delete SMTP Server
To delete a SMTP Server, perform the following steps.

1. Go to the main menu.
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2. Click Administration > System > SMTP Server.

3. The SMTP Server page appears.

4. Select the available configured SMTP Server from the grid for deleting and click the Delete 
icon.

5. A warning message appears, if you want to delete or not, as shown below.

6. Select the Yes option to delete the listed SMTP Server.

3.5   Storage Groups
This section describes how to view the existing storage groups, and how to create, edit, 
activate, and deactivate the storage group in the system. 

3.5.1   What is a Storage Group?
A storage group defines how long to store and where to store interactions and evaluation 
attachments. 

The storage group can exist in one of the following storage conditions.

Storage Condition Description

Active • You can play and evaluate recordings.
• Frequently-accessed recordings are stored here.
• Example: Store an interaction or an evaluation for 90 days on the Media 

server.

Historical • You can play recordings.
• You can review previously-created evaluations for an interaction.
• Less-frequently accessed recordings that are stored here.
• Example: Store an interaction or an evaluation for 2 years on the Storage 

Area Network (SAN).

Archive • You can play recordings.
• You can review previously-created evaluations for an interaction. 
• Interaction records are moved from the Aspect Quality Primary database 

to the Archive database.
• Example: Store an interaction or an evaluation for 5 years on the Network 

Attached Storage (NAS).
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3.5.2   Storage Group List
This module describes how to view the storage groups that are available in the system.

1. Log in to Workforce Engagement Management as an Administrator.

2. From the main menu, click Administration > System > Storage Groups..

Elimination point • The place in time at which the system deletes interactions and database 
records. 

• Example: Delete interactions older than 5 years.

Storage Condition Description
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The Storage Groups page opens with a list of created storage groups displayed in the 
table.

The following table contains the description of buttons available on the Storage Groups 
page.

Button Description

Refresh the Storage Groups table

Create a new storage group

Edit an existing storage group
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The following table describes the columns in the Storage Group table.

The maximum number of storage groups records per page is 100. Use the Pagination 
buttons below the table to navigate to the Next Page, Last Page, Previous Page, or First 
Page.

3.5.3   Add a New Storage Group
To create a storage group in the system and add archiving details, perform the following steps.

1. On the Storage Groups page, click Add.

Make a storage group active (available for use)

Make a storage group inactive (not available for use)

Column Description

Name Name of the storage group

Description Description of the storage group

Active If the storage group is active (available for use), then a check mark 
displays in its row

Button Description
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The Add Storage Group window opens with the Current Tier tab active.

2. In the Name text box, type the name of the storage group. The maximum number of 
characters allowed is 50. The Storage Group name must be unique and is a required field.

Note: All required field are marked with a red asterisk (*).

3. In the Description text box, type a description for the storage group. The maximum 
number of characters allowed is 100. 

4. If you are using archiving in the system, select Enable Archiving.

With the archiving feature, the media files can exist in a different location during the 
lifecycle of the media.

By default, the Enable Archiving option is disabled, and Historical Tier and Archive Tier tabs 
are inactive.
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In the Current Tier, only the Recording files location and Evaluation Attachments location 
fields are available, until you select Enable Archiving. Then, the following fields display.

5. If you selected Enable Archiving, complete the following fields.

Field Description

Recording files location Enter a UNC Path where you want all recording/screen capture files 
for this storage group are to be stored while the interaction with which 
the files are associated resides within the Current tier.

Note: A maximum of 250 characters is allowed.

Evaluation attachments 
location

Enter a UNC Path where you want all scorecard attachment files for 
this storage group are to be stored while the interaction with which the 
files are associated resides within the Current tier.

Note: A maximum of 250 characters is allowed.

Pending disposition interaction 
time limit

Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days after which you want the system to delete the expired 
Pending media.

Note: This action does not apply to the Protected interaction/media.
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Move to Historical after Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days after which you want the interaction to qualify for 
Historical processing.

For example, if the interaction was recorded on 5 January 2017, and if 
the Move to Historical after field is configured as 10 (days), then the 
system moves the recording files to the Historical location after 15 
January 2017.

Note: The numeric value must be less than or equal to the Move to 
Archive after field on the Historical Tier tab.

Delete instead of moving to 
Historical - Audio Files

To delete the audio media files when processed for Historical tier 
transition, select Audio Files.

Note: This action does not apply to the Protected interaction/media.

Delete instead of moving to 
Historical - Screen Capture 
Files

To delete the video media files when processed for Historical tier 
transition, select Screen Capture.

Note: This action does not apply to the Protected interaction/media.

Delete instead of moving to 
Historical - Chat Transcript 
Files

To delete the chat transcript files when processed for Historical 
transition, select Chat Transcript Files.

Note: This action does not apply to the Protected interaction/media.

Delete instead of moving to 
Historical - Email Transcript 
Files

To delete the email transcript files when processed for Historical 
transition, select Email Transcript Files.

This will also delete any attachments, if present in the Email 
transcript.

Note: This action does not apply to the Protected interaction/media.

Protect for Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days after which you want the system to move the 
protected media from the Current storage locations to the Historical 
locations.

The numeric value must be less than or equal to the value entered in 
the Historical Tier tab’s Protect for field.

Field Description
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6. Select the Historical Tier tab.

7. If you want to use Historical archiving, use the following table to complete the fields.

Field Description

Recording files location Enter a UNC Path where you want all recording/screen capture files 
for this storage group to be stored while the interaction with which the 
files are associated resides within the Historical tier.

Note: A maximum of 250 characters is allowed.

Evaluation attachments 
location

Enter a UNC Path where you want all scorecard attachment files for 
this storage group to be stored while the interaction with which the 
files are associated resides within the Historical tier.

Note: A maximum of 250 characters is allowed.

Move to Archive after Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days after which you want the interaction to qualify for 
Archive processing.

For example, if the interaction was recorded on 5 January 2017, and if 
the Move to Archive after field is configured as 20 (days), then the 
system moves the recording files to the Historical location after 25 
January 2017.

Note: The numeric value must be less than or equal to the Move to 
Historical after in the Current Tier tab.

Delete instead of moving to 
Archive - Audio Files

To delete the audio media files when processed for Archive transition, 
select Audio Files.

Note: This action does not apply to the Protected interaction/media.
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8. Select the Archive Tier tab.

Delete instead of moving to 
Archive - Screen Capture Files

To delete the video media files when processed for Archive transition, 
select Screen Capture.

Note: This action does not apply to the Protected interaction/media.

Delete instead of moving to 
Archive - Chat Transcript Files

To delete the chat transcript files when processed for Archive 
transition, select Chat Transcript Files.

Note: This action does not apply to the Protected interaction/media.

Delete instead of moving to 
Archive - Email Transcript Files

To delete the email transcript files when processed for Archive 
transition, select Email Transcript Files.

Note: This action does not apply to the Protected interaction/media.

Protect for Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days after which you want the system to move the 
protected media from the Historical storage locations to the Archive 
locations.

Note: The numeric value in the Historical Tier tab must be greater 
than or equal to the value entered in the Current Tier tab’s 
Protect for field.

Field Description
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9. If you want to use Archiving, use the following table to complete the fields.

10.Click OK. The new storage group is created and displays in the Storage Groups page in the 
table.

3.5.4   Edit Storage Group
Use the edit feature to change storage group basic details, including details in the Current Tier, 
Historical Tier, and Archive Tier tabs.

Note: Only an Administrator has permission to edit a storage group.

1. From the Storage Group page, in the table, select the storage group that you want to edit. 
and click Edit.

Field Description

Recording files location Enter a UNC Path where you want all recording/screen capture 
files for this storage group to be stored while the interaction with 
which the files are associated resides within the Archive tier.

Note: A maximum of 250 characters is allowed.

Evaluation attachments 
location

Enter a UNC Path where you want all scorecard attachment files 
for this storage group to be stored while the interaction with which 
the files are associated resides within the Archive tier.

Note: A maximum of 250 characters is allowed.

Permanently delete Archived 
items

To delete both the Archived media files from the Archive storage 
location and from the associated metadata stored in the Archive 
database, select Permanently delete Archived items.

Note: This action does not apply to the Protected interaction/
media.

Delete after Enter or select a numeric value (Max 10000 and Min 0) for the 
number of days (from when the system created the media) that 
you want to delete the media and the metadata from the Archive 
storage location and from the Archive database.

Note: This action does not apply to the Protected interaction/
media.
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The Edit Storage Group window opens.

2. Change the fields on the window that you want to edit.

3. Click OK. The system saves your changes, closes the Edit Storage Group window, and 
displays in the Storage Groups page.

Note: For Aspect Quality Media Playback, you must modify the Media Storage Paths (Current 
Historical and Archive) configured ion the Storage Groups, by adding the Network 
Service, Users and Aspect Quality Service account to the Security Tab and granting 
Full permission to the Media Storage path. 
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Note: Enable the inheritable permissions on the Media Storage folder in the Advanced 
Security Settings for Playback. Verify that you have enabled inheritance and selected 
Replace all the child object permission entries with inheritable permission entries from 
this object checkbox. 

Note: The Media Storage Folder should not be named as Voicerec since the webserver has a 
voicerec Folder for caching the File that is played back. 
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3.5.5   Activate a Storage Group
To make a storage group in the Storage Group page active, perform the following steps.

Note: The Activate button is enabled only for an inactive storage group.

1. On the Storage Groups page, select the storage group that you want to activate from the 
table.
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2. Click Activate.

The system activates the Storage Group and refreshes the Storage Group page.

3.5.6   Deactivate a Storage Group
To make a storage group in the Storage Group page inactive, perform the following steps.

Note: The Deactivate button is enabled only for an active storage group.

1. On the Storage Groups page, select the Storage Group that you want to deactivate from 
the table.

2. Click Deactivate.

The system deactivates the Storage Group and refreshes the Storage Group page.

3.6   System Parameters
In Workforce Engagement Management, Performance and Quality consist of various System 
Parameters. This section describes how to use those System Parameters in Aspect Quality. 
The System Parameters features are below.

• Media File Download
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• Report Storage Path

• Insert Silence During Pause

• Default Player for Chat Interaction

• Disqualifying Rule Overrides Parent

• Use Ani & Dnis From CTI for UIP Switch

3.6.1   Media File Download
Media File Download feature allows the user to download the media files such as video and 
audio interactions, audio interactions, screen interactions in the Interaction window or Search 
Results page. Refer step 2 of Quick View of Audio Interaction and Quick View of Voice and 
Screen Interaction to view the Download button of the interaction. Follow the steps below to 
enable the Download button.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.

3. The SYSTEM PARAMETERS window appears. 
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• When Aspect Performance is integrated with Aspect Quality, go to the Quality tab, as 
shown below. The Media File Download Enabled row is selected under the Parameter 
Name column by default. 

• For standalone Aspect Quality, refer the below screenshot. 

Note: When media download is disabled for the user, “x” is mentioned under the 
Parameter Value column.

4. Click on the Edit button and the Edit System Parameter pop-up appears. 

5. Click on the drop-down list of Parameter Value field and select True as shown below. 

6. Click on the Save button to go back to the SYSTEM PARAMETERS window, as shown 
below.
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• When Aspect Performance is integrated with Aspect Quality .

• For standalone Aspect Quality, refer the below screenshot.

Note:
• As media download is enabled for the user, the checkmark is mentioned under the 

Parameter Value column.
• If you change the value for MediaFileDownloadEnabled key, then all the users 

must log out and log in to Workforce Engagement Management UI to effect the 
changes.

3.6.2   Report Storage Path
When the administrator generates any Scheduled Report or Ad Hoc Report, the report will 
store in a UNC path. To add or edit the storage path, the administrator will use Report Storage 
Path feature on the SYSTEM PARAMETERS window. Follow the steps below to add or edit 
the Report Storage Path.

1. Login to Workforce Engagement Management.
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2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.

3. The SYSTEM PARAMETERS window appears. Go to the Quality tab and select Report 
Storage Path row, as shown below.

4. Click on the Edit button and the Edit System Parameter pop-up appears.
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5. Type the storage path on the Parameter Value field. 

6. Click on the Save button to go back to the System Parameters window, as shown below.

3.6.3   Insert Silence During Pause
This feature allows administrators to specify how voice content suppression behaves when an 
interaction is paused.

Values:

True: Silence is always inserted during the pause period, regardless of whether the agent's 
screen is being recorded. This results in larger file sizes.

False (default): When the agent's screen is being recorded, silence is inserted into the 
voice recording to match the length of the video recording. If the agent's screen is not being 
recorded, no silence is inserted.

Follow the steps below to set the parameter value as True.

1. Login to Workforce Engagement Management.
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2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.

3. The SYSTEM PARAMETERS window appears. Select Insert Silence During Pause row, 
as shown below.

4. Click on the Edit  button and the Edit System Parameter pop-up appears.
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5. Click on the drop-down list of Parameter Value field and select True as shown below.

6. Click on the Save button to go back to the System Parameters window, as shown below.

3.6.4   Default Player for Chat Interaction
This feature allows to view a chat interaction in transcript player or screen.  
Example: If Chat interaction is recorded with Screen, in search page you can see both 
transcript and screen players in Quick view. In Interaction View/Evaluation page, if you want to 
see Screen choose 'Screen' as a option or choose 'Transcript' if you want to see 'Transcript' 
player. 

Follow the steps below to set the Parameter Value as Transcript or Screen.

Note: By default, the Parameter Value is Transcript.

1. Login to Workforce Engagement Management.
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2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.
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3. The SYSTEM PARAMETERS window appears. Select Default Player for Chat 
Interaction row, as shown below.

Note: This Key will be displayed for every UIP switch which provides the ability for the user to 
change the preference at the switch level. 

4. Click on the Edit button and the Edit System Parameter pop-up appears.

5. Click on the drop-down list of Parameter Value field and select the value as you wish, for 
example, if you want to change from Transcript to Screen then choose Screen as shown 
below.
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6. Click on the Save button to go back to the SYSTEM PARAMETERS window and the 
Parameter Value will be updated to the selected value, as shown below.

3.6.5   Disqualifying Rule Overrides Parent
This features prevents an interaction from recording even when its parent interaction is being 
recorded.

Example: When an ACD call from a customer is recorded (being the parent interaction), the 
agent puts the customer on hold to consult with another agent. The consult call can be 
prevented from being recorded by configuring an appropriate disqualify rule to match this 
interaction along with this parameter value set to true. 

Follow the steps below to set the Parameter Value as Transcript or Screen.

Note: By default, the Parameter Value is False.

1. Login to Workforce Engagement Management.
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2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.
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3. The SYSTEM PARAMETERS window appears. Select Disqualifying Rule Overrides 
Parent row, as shown below.

4. Click on the Edit  button and the Edit System Parameter pop-up appears.

5. Click on the drop-down list of Parameter Value field and select the value as you wish, for 
example, if you want to change to True then select True as shown below.
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Click on the Save button to go back to the SYSTEM PARAMETERS window and the 
Parameter Value will be updated to the selected value, as shown below:

As Disqualifying Rule Overrides Parent is set True for the user, the check mark is mentioned 
under the Parameter Value column.

3.6.6   Use Ani & Dnis From CTI for UIP Switch
This feature allows to populate ANI and DNIS values as received in CTI events from Unified IP 
switch.

Example: When an agent makes an oubound direct call and the CTI does not contain values 
for ANI & DNIS, the values will be set as the agent extension and the contact number of other 
party respectively, if the parameter value is false. For the same case the ANI & DNIS values 
will be empty, if the parameter value is true.

Follow the steps below to set the Parameter Value as Transcript or Screen.

Note: By default, the Parameter Value is True.

1. Login to Workforce Engagement Management.
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2. Go to Main Menu and click on Administration > System > System Parameters as shown 
below.
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3. The SYSTEM PARAMETERS window appears. Select Use Ani & Dnis From CTI for UIP 
Switch row, as shown below.

4. Click on the Edit button and the Edit System Parameter pop-up appears.

5. Click on the drop-down list of Parameter Value field and select the value as you wish, for 
example, if you want to change to False then select False as shown below.
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Click on the Save button to go back to the SYSTEM PARAMETERS window and the 
Parameter Value will be updated to the selected value, as shown below:

As Use Ani & Dnis From CTI for UIP Switch is set False for the user, the cross mark is 
mentioned under the Parameter Value column.

3.7   System Processes
This section describes about the System Processes. To Navigate, Add, Edit, Delete and Start 
Stop Processes is given below.

3.7.1   Navigation to System Processes
Follow the steps given below to navigate to the System Processes page:

1. Go to the main menu icon.
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2. Click Administration > System > System Processes.

3. The System Processes page appears as given below:
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4. The Menu buttons on the System Processes page are described 
below:

5. The grid columns on the System Processes page are described below:

3.7.2   Create System Processes
To add System Processes, perform the following steps:

1. Go to the main menu icon.

2. Click Administration > System > System Processes.

3. The System Processes page appears, click on the Add icon on the System Processes 
page.

Icons Description

Refresh Refreshes the System Processes grid with latest system 
processes changes. Instead of the browser refresh button user 
can click on this menu button which will refresh only the grid 
data and not the page.

Add Adds the new System Process to the grid.

Edit Edits the selected System Processes existing in the grid.

Delete Allows to delete the selected existing System Processes from 
the list.

Action Menu Action Menu contains Start, Stop, Terminate, Set to Active 
and Set as Stand-by.

Note: Set to Active and Set as Stand-by will be applicable 
only for the interaction monitor.

Column Description

Name The name of the system processes.

Server The name of the server.

Startup Startup is a method of how the Process gets started, when the 
Quality Service starts. Startup can be either Manual or 
Automatic.

Status Indicates status of the process as, No Communication, Started, 
Starting, Stopped, Stopping, or Unknown.

Redundancy Status Indicates whether process is active, stand-by, stopped, or 
unknown by means of specifying the same in the column. Also, 
it can be blank, without any specification.
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4. The Add System Process dialog appears as given below:

Note: The fields marked (*) are mandatory fields.

5. Following are the three drop-down fields on the Add System Process page:

• Process Type

• Process Server

• Startup Mode

These are given below in details.

6. Process Type: By default this field displays, “Select a process type..”. An option needs to 
be selected from the drop-down list. Based on the selection the associated Process 
Servers are displayed in the drop-down field.
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Once the Process Type and Process Server are selected, other fields appear to configure 
the Process. These configuration fields are given below, along with the Process Type.

Process Type Description Configuration

API Web 
Service

The API Web Service process is 
responsible for third party software 
integrated to Aspect Quality with Web 
API. This is an optional process.

Install the API Web Service on the 
Aspect Quality Web Server. Only install 
the API Web Service if one of the 
following conditions apply:
• Third-party software uses the API 

to start and stop recordings and 
update custom information on the 
recordings.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File 

API Web Service tab:

Communication section of the window has the below 
option:

Interaction Monitor Server*
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Archiver The Archiver process is responsible for 
archiving the recording files and is an 
optional process. 

The recommended server that is used 
to support the Archiver process is the 
Aspect Quality Media Server. You only 
install Archiver, if you want to archive 
old recordings, or if the monitoring 
mode is Quality Monitoring with 
Caching and you want to delete 
pending recordings.

One or more Archiver process can 
exist per Aspect Quality site. Whether 
or not to use multiple Archiver 
processes depends on whether you 
are implementing distributed recording 
storage, and if you are distributing 
current/historical and archive storage 
locations. Aspect Software 
recommends that you install Archiver 
processes on the Aspect Quality Media 
server, but it is not required, as the 
Archiver Process is optional.

General tab: 
Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Archiver tab: 
Processing Options section of the window has the 
below option:
• Historical Interval*: By default this field displays, 

“60” minutes. Enter the number of minutes to wait 
in between system processes of the Historical 
operation for the Historical qualifying interactions. 
This interval must be greater than or equal to 1. 
The system does not allow a value less than 1.

• Archive Interval*: By default this field displays, 
“60” minutes. Enter the number of minutes to wait 
in between system processes of the Archive 
operation for the Archive qualifying interactions. 
This interval must be greater than or equal to 1. 
The system does not allow a value less than 1.

• Storage Groups section:
Select the storage group(s) listed under the 
Available Items window that you want this 
Archiver to archive Interactions related to media 
records stored within the storage group and 
select the Add Item button to move it to the 
Selected Items window. Same way the storage 
group(s) listed under Selected Items can be 
moved to the Available Items window with the 
help of Remove Item button.

Note:
• Only a single Archiver process can service 

storage groups.
• The Archiver must have access to all storage 

locations defined within Storage Groups and the 
switches that also use the Storage Groups 
serviced by this Archiver instance use. This is 
necessary because it is possible for an interaction 
record to have files stored in multiple storage 
groups when using alternate storages, or when a 
scorecard attachment is added to a Task. An 
alternate option is to ensure that all Archiver 
processes have access to the storage locations 
defined in all Storage Groups in the site.

Process Type Description Configuration
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 100



Administrator Guide
Client Gateway The Client Gateway process provides 
connectivity between client desktops 
and Aspect Quality servers. The Client 
Gateway process is only used with 
Aspect Via environments. 

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Client Gateway tab:

Communication section of the window has the below 
option:

Interaction Monitor Server*

Exporter Exporter provides background 
transcoding services to export media 
from the Workforce Engagement 
Management user interface. You can 
configure the Exporter process on any 
Aspect Quality server, but Aspect 
recommends that you configure it on 
the Quality Web Service server.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Exporter tab:

Configuration section of the window has the below 
option:

Exporter Path: In the Export Path text box, enter 
the directory path of the location where you want 
to store the temporary export files.

Process Type Description Configuration
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File Mover The File Mover process is responsible 
for moving recordings from the Aspect 
Quality Recording servers that you 
define in the site to the Media Storage. 
It combines audio and video (screen 
capture) files into a viewable format.

Usually, you create one File Mover 
process for each site. This process 
runs on the Aspect Quality Media 
server.

If you create more than one File Mover 
process, each process must run on its 
own server. You cannot define multiple 
File Mover processes on one server.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

File Mover tab:

Communication section of the window has the below 
option:

Interaction Monitor Server*

File Transfer Configuration section of the window has 
the below option:

TCP Port*: In the TCP Port text box enter the 
default value 3881. File Mover listens for the 
connection on the TCP port, and you should 
never need to change the port number.
Storage Groups window:
Select the storage group(s) listed under the 
Available Items window for which you want this 
File Mover to accept files and select the Add Item 
button to move it to the Selected Items window. 
Same way the storage group(s) listed under 
Selected Items can be moved to the Available 
Items window with the help of Remove Item 
button.

Note: Any number of File Mover processes can 
service storage groups. If it is necessary to 
limit which File Movers are used to transfer 
files for a storage group from a particular file 
producing process (for example, Port 
Manager, IVR Import, Agent Desktop Client, 
and Mentor Desktop Client), you can 
accomplish this when you configure the file-
producing process itself.

Process Type Description Configuration
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File Receiver Use the File Receiver process to create 
an association between File Receiver 
process(es) and Unified IP telephony 
servers for a switch. Receiver Groups 
only apply to Unified IP switch 
definitions configured to use Enhanced 
CTIPS.

You can use Receiver Groups to record 
on the Telephony Server and transmit 
the recording files for storage and 
retrieval in Aspect Quality.

You must configure the File Receiver 
process and Receiver Groups for 
Aspect Enhanced CTIPS connector 
integrations. The Aspect Quality 
system allows multiple receivers for 
redundancy and efficient network 
configurations. Create at least one 
Aspect Quality File Receiver process 
for each Unified IP switch with 
Enhanced CTIPS integration.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

File Receiver tab:

File Receiver section of the window has the below 
options:

Media Transfer Port*: In the Media Transfer Port 
text box enter the default value 3890. You should 
never need to change the port number. This port 
must be open on the Aspect Quality server so that 
the Unified IP servers can reach the File Receiver 
system.

Preferred Media Storage section of the window has 
the below options:

• Click Add icon to Add preferred media 
storage.The Add Media Storage Preference 
window opens.

•  Click Edit icon.The Edit Media Storage 
Preference window opens.

• Click Delete icon.

After selecting the Switch to be deleted that is 
listed under the grid, click the Delete button.

Importer After the import job is created and 
When the schedule reaches for the job 
the import job will run.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Process Type Description Configuration
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Interaction 
Monitor

The Interaction Monitor process is the 
central process in an Aspect Quality 
system. All other Aspect Quality 
processes, including the Aspect Quality 
Desktop Client application, 
communicate with the Interaction 
Monitor. In addition, the Interaction 
Monitor handles all switch 
communication and data 
synchronization. 

You create only one Interaction Monitor 
process per Aspect Quality site and 
install the process on the Primary 
server. However, to implement 
redundancy, you can install an 
additional redundant Interaction 
Monitor process on a backup server. 

Although system allows to create n 
number of Interaction Monitor 
processes, but it’s recommendable to 
have only one or maximum two 
(Primary Interaction Monitor and 
Redundant Interaction Monitor) of 
these processes.

Note: Because this process is the 
central process, and all other 
Aspect Quality processes use 
this process, the Interaction 
Monitor process is a required 
process; you must configure it.

General tab: 
Process Logging section of the window has the below 
options:
• Log Mode: Once the system is running, you may 

want to go back and change the Log Mode to 
Normal.

• Log To File

Redundancy tab: 
Primary server redundancy allows an Interaction 
Monitor process to run simultaneously on two 
servers. Throughout normal execution, one 
Interaction Monitor process would be active while the 
other would be on stand-by. If the active Interaction 
Monitor fails and other Aspect Quality processes can 
no longer access it, the second Interaction Monitor 
would detect the failure, become active, and all of the 
Aspect Quality processes would then connect to that 
active Interaction Monitor. There is also a manual 
failover process, for example, for a planned outage.

Note: If you configure an all-in-one server (Primary, 
Media, Web, and redundant server all on the 
same server), you cannot establish 
redundancy. Aspect Software recommends 
that you configure more than one server if 
you are planning to configure a redundant 
server. 
Also, if a server configuration file is present 
on the Primary server, then that same server 
configuration file must exist on the 
Redundant server.

Alternate Process Configuration section of the 
window has the below options:
• Server*: From the Server drop-down list box, 

select the name of the server on which the 
redundant Aspect Quality process runs.

• Startup Mode: Select Automatic, or else the 
Interaction Monitor process does not run unless 
initiated from the web interface.

Alternate Process Logging section of the window has 
the below options:
• Log Mode
• Log To File

Process Type Description Configuration
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Redundancy Communication section of the window 
has the below options:
• Communication Port*: Enter the number of the 

TCP port that you want to communicate with the 
redundant Interaction Monitor processes.  
The Redundant TCP port number (default is 
4880), must be different than the Primary TCP 
port number.

• Startup Timeout*: Enter the amount of time, in 
seconds, that you want either of the redundant 
Interaction Monitor processes to wait to start up. 
This is the amount of time you want before 
communication establishes with the Interaction 
Monitor’s redundant peer, before the redundant 
process acknowledges a process failure and 
becomes the active Interaction Monitor process.

Note: The recommended values for the Startup 
Timeout and Disconnection Timeout for the 
Interaction Monitor redundancy parameters 
are both 30 seconds in duration.

• Disconnection Timeout*: Enter the amount of 
time, in seconds, either of the redundant 
Interaction Monitor processes wait to re-establish 
communications with its redundant peer after a 
disconnection, before assuming a process failure 
occurred and become the active Interaction 
Monitor process.

Note: After you define the redundant Interaction 
Monitor process, the process displays twice 
on the Processes window, and each process 
lists to which server it belongs. The process 
displays twice so that you can monitor both 
processes running on different servers. If you 
edit one of the Interaction Monitor process 
definitions, you modify the other process at 
the same time.

Interaction Monitor tab: 
Communication Configuration section of the window 
options are:
• TCP Port*: In the TCP Port text box enter the 

default value 3880. The Interaction Monitor 
listens for the connection on the TCP port, and 
you should never change the port number.

• Monitor Switches window:
Select the required switch(es) listed under the 
Available Items window and click the Add Item 
button to move it to the Selected Items window. 
Same way the switch(es) listed under Selected 
Items can be moved to the Available Items 
window with the help of Remove Item button.

Process Type Description Configuration
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IVR Import The IVR Import process is a process 
that you use specifically when 
integrating to Unified IP switch(es). It is 
responsible for importing call data and 
recording files for IVR calls which the 
Unified IP system has recorded. This 
allows IVR calls that the Unified IP 
system has recorded for the user to 
search, view, and play back from within 
the Aspect Quality System.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

IVR Import tab:

IVR Import Configuration section of the window has 
the below options:
• Import Switch*: From the drop-down list, select 

the Unified IP switch that exports M3 recordings.
• Import Directory*: Enter the full path of the 

Unified IP recording store that you use for IVR 
exports.

• VOXDirectory*: Enter the full path of the VOX 
files within the recording store.

• MatchField*: Enter the name of the XML field to 
filter IVR imports.

• Match Expression*: Enter a regular expression 
(a pattern syntax for matching string texts) to 
match the contents of the Match Field. The 
system only imports Unified IP recordings with 
matching values into Aspect Quality. Use the 
default match parameters unless otherwise 
instructed by Aspect Technical Support. The 
recommended defaults are: 
Match Field: Filename 
Match Expression: ^M3_Contact

Note: The configuration strings are case-sensitive.

If the system is not using distributed recording 
storages across three or more distinct geographic 
locations where the locations share the storage 
groups as alternate storages, then click Save. The 
Processes window opens with the IVR Import 
process in the list.

File Mover Selection Criteria section of the window 
has the below option:

File Mover: By default “Any available File Mover” 
option is selected. Select one of the criteria listed 
in the drop-down list box to limit which File Mover 
processes that the IVR Import process uses to 
transfer media files.

If the system is not utilizing distributed recording 
storages, or if the files produced by the IVR Import 
process are to be exclusively stored in the default 
Storage Group defined for the UIP switch, then click 
Save. The Processes window opens with the IVR 
Import process in the list.

Process Type Description Configuration
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Preferred Media Storage section of the window has 
the below options:
• Override Default Storage toggle key: This 

enables the Primary Storage Group and the 
Alternate Storage Group drop-down lists.

• Primary Storage Group: To override the default 
Storage Group assigned to the selected Unified 
IP switch, from the Primary Storage Group drop-
down list, select the storage group in which you 
want this IVR Import to primarily store recording 
files created for the selected Unified IP switch.

• Alternate Storage Group: To override the default 
Storage Group assigned to the selected Unified 
IP switch, from the Alternate Storage Group drop-
down list, select the storage group in which you 
want this Port Manager to alternately store 
recording files created for the selected Unified IP 
switch if the Primary Storage Group is 
unavailable. If you do not want to use an alternate 
storage group, keep the default value None.

Port Manager The Port Manager process is 
responsible for starting and stopping 
audio ports on the Recording Server, 
for hardware- and software-based 
recording, and for initiating one or more 
PREC processes. 

Create one Port Manager process for 
each Aspect Quality Recording server.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Port Manager tab:

Communication section of the window has the below 
option:

Interaction Monitor Server*

If the system is not using distributed recording 
storages across three or more distinct geographic 
locations where the location share the storage groups 
as alternate storages, then click Save. The 
Processes window opens with the Port Manager 
process in the list.

File Mover Selection Criteria section of the window 
has the below option:

File Mover: By default “Any available File Mover” 
option is selected. Select one of the criteria listed 
in the drop-down list box to limit which File Mover 
processes that the IVR Import process uses to 
transfer media files.

If the system is not utilizing distributed recording 
storages, then click Save. The Processes window 
opens with the Port Manager process in the list.

Process Type Description Configuration
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Preferred Media Storage section of the window has 
the below options:

• Click Add icon to Add preferred media 
storage.The Add Media Storage Preference 
window opens.

•  Click Edit icon.The Edit Media Storage 
Preference window opens.

• Click Delete icon.

After selecting the Switch to be deleted that is 
listed under the grid, click the Delete button.

Process 
Manager

The Process Manager process 
connects to all Aspect Quality servers 
using the Web application. The system 
reports the status of all processes 
configured on that server to the 
Process Manager. 

Configure one Process Manager 
process for each Aspect Quality server. 
Do not install this on the Database 
server.

Note: This is a required process; you 
must configure it.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Process Manager tab: 
Communication Configuration section of the window 
options are:
• TCP Port*: In the TCP Port text box enter the 

default value 3882. The Process Manager listens 
for the connection on the TCP port, and you 
should never change the port number.

Report 
Manager

The Report Manager Process is 
responsible for running on-demand and 
scheduled reports, and refreshing 
overseas report templates against the 
database. 

Configure one Report Manager 
process for each Aspect Quality site on 
the Aspect Quality Web Server.

Note: To run reports for Aspect 
Quality, you must configure this 
process; it is required.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File

Report Manager tab: 
Communication Configuration section of the window 
options are:
• TCP Port*: In the TCP Port text box enter the 

default value 3883. The Report Manager listens 
for the connection on the TCP port, and you 
should never change the port number.

VOIP Tap Use this process only for VOIP 
implementations. Install one VOIP Tap 
process on each Aspect Quality server 
that has an AudioCodes SmartWORKS 
HPX board configured. Voice Over IP 
Tap processes are available only for 
Cisco, and Unified IP configurations 
with Aspect Quality.

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File 

VOIP Tap tab:

Communication section of the window has the below 
option:

Interaction Monitor Server*

Process Type Description Configuration
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Note: The fields marked (*) are mandatory fields.

• Log Mode

Select from the options listed in the drop-down. The available options are Low, Normal, 
High, and Extreme.
Note: During initial Aspect Quality system testing, set the log mode to Extreme.

• Log To File

Log To File toggle key needs to be flagged, if you want the information logged to a file.

• Interaction Monitor Server*
By default this field displays, “Select a server..”. Select the Server name from the options 
available in the drop-down list, where the Interaction Monitor process runs.

• File Mover 

Web Server The Web Server process allows you to 
specify the sample root URL and Third 
Party Client server.

Configure one Web Server process for 
each Aspect Quality site on the Aspect 
Quality Web Server. 

General tab:

Process Logging section of the window has the below 
options:
• Log Mode
• Log To File 

Web Server tab:

Web Server Configuration section of the window has 
the below options:
• WEM URL*: Enter the URL that web clients use 

to browse to the Aspect Quality website.

Note: Use a valid WEM URL because the Aspect 
Quality system connects to this URL when 
the Mentor creates an evaluation from the 
Mentor Desktop Client using Live Monitor. 
WEM URL is mandatory for Web Server 
configuration.

• Third Party Client Server
Note: Leave the Third Party Client Server field 

blank.

Process Type Description Configuration
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The File Mover drop-down list box has the following options:

Note: Here Process1 can be IVR Import or Port Manager.

• Add Media Storage Preference

From the Switch* drop-down list, select the switch that you want to configure for this 
Process2. 
From the Primary Storage Group* drop-down list, select the storage group where you 
want this Process2 to primarily store the recording files that are created for the specified 
switch. 
From the Alternate Storage Group drop-down list, select the storage group that you want 
this Process2 to alternately store recording files that are created for the specified switch if 
the Primary Storage Group is unavailable. If you do not want an alternate storage group, 
then keep the default value of None. 
Click OK. The Add Media Storage Preference window closes and the Process Definition 
window is refreshed with the new media storage preference.

Note: Here Process2 can be File Receiver or Port Manager.

• Edit Media Storage Preference

Edit the Primary Storage Group* and Alternate Storage Group as required. 
Note: The Switch once created cannot be changed, so the Switch option will be disabled.

7. Process Server: By default this field displays, “No servers available..”. After the Process 
Type is selected, this field displays, “Select a server..”. The associated options available 
needs to be selected from the drop-down list.

Note: For VOIP TAP Process from the Process Server drop-down list box, select the name 
of the server where you configured the AudioCodes SmartWORKS HPX board.

8. Startup Mode: By default this field displays, the first option listed in the drop-down. The 
available options are:

• Automatic

• Manual

Option Description

Any available File 
Mover

Any File Mover that services one of the storage groups in 
which the media file can be stored.

File Mover must exist 
within same location as 
this process

The File Mover must be assigned to the same location as this 
Process1 or it must exist on the same server as this Process1.

File Mover must exist 
within same location as 
storage group

The File Mover must be assigned to the same location as one 
of the storage groups in which the media file can be stored.

File Mover must exist 
within same location as 
this process or storage 
group

The File Mover must be assigned to the same location as this 
Process1, it must exist on the same server as this Process1, or 
it must be assigned to the same location as one of the storage 
groups in which the media file can be stored.
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From the Startup Mode drop-down list box, select Automatic for the processes. If you select 
Manual, then after the Aspect Quality service starts, the process does not run unless initiated 
from the web interface.

Note: By default Startup Mode option is always selected as Automatic for API Web 
Service, Client Gateway, Process Manager, and Web Server Processes. So the 
Startup Mode option is disabled for these processes.

9. Click Save. The Process which is created will be listed in the grid.

Note: Process Manager is a mandatory process service and every server should have one 
Process Manager. So Process Manager has to be created, else you cannot stop the 
service.

3.7.3   Edit System Processes
To edit System Processes, perform the following steps.

1. Go to the main menu icon.

2. Click Administration > System > System Processes

3. The System Processes page appears.

4. Select the available System Processes from the grid that needs to be edited and click the 
Edit icon.
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5. The Edit Process window appears with General tab active as shown below:

Note: The Process Type cannot be updated for any System Processes that is already 
created and it will remain disabled for Edit Process option.

6. Edit the fields as per your requirement.
Note: Refer to Create System Processes on page 3-97 section, step 5 to 8.

7. Click the OK button to complete the process.

3.7.4   Delete System Processes
To delete System Processes, perform the following steps.

1. Go to the main menu icon.

2. Click Administration > System > System Processes

3. The System Processes page appears.

4. Select the available System Processes from the grid that needs to be deleted and click the 
Delete icon.
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5. The Warning dialog appears as shown below.

6. Select the Yes option to delete the process.

Note: The Interaction Monitor cannot be deleted directly for any System Processes, as it is 
internally used by API Web Services and Client Gateway. You should first delete the 
dependents, that is API Web Services and Client Gateway processes to further delete 
the Interaction Monitor process. Else a warning message appears as shown below.

3.7.5   Action Menu 
Action Menu  comprises of below options to set the Services to:

• Start: Start option will start the process.

• Stop: Stop option will stop the process.

• Terminate: Terminate option will terminate the process.

• Set to Active: Set to Active will set Interaction Monitor process to active.

• Set as Standby: Set as Stand-by will set Interaction Monitor process to stand-by.

Following points should be noted with respect to Action menu options:

• Web Server process is always running, as it runs on Internet Information Services (IIS), 
as selected in the grid, in the below image. No Action Menu operations can be 
performed on Web Server process.
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• Without starting the Services, all the options in the Action menu will be disabled and 
Status column is shown as Unknown in the grid by default, as shown below.

3.7.5.1   Setting Services to Startup Type
1. Login to Aspect Quality Primary Server.
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2. From the task bar on the desktop, click the Server Manager icon. The Server Manager 
window opens.

3. In the right corner of the Server Manager window, select Tools > Services. The Services 
window opens.

4. Sort by the Name column from A-Z, if required.

5. In the right pane, select Quality Management Server.

6. Click Start to start the services.

Note: Process Manager must be created to start the Quality Service, otherwise it cannot 
be switched to running state.

7. Once the Service is started, the Status changes in the System Processes grid to Started, 
only for Automatic Startup Mode. 

For Manual Startup Mode the status will be Stopped.
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You have just started the Primary server service.

Note: Notice the API Web Service and Client Gateway shows Status as Unknown, as 
these services will be used by third party.

Other processes which shows as Unknown status, it means the Aspect Quality 
services are not running, it cannot be stated whether those services were Started, 
Stopped or Terminated.
The Archiver process, it shows the status as Stopped, because Startup mode is 
Manual. To start this service, select the Archiver process from the grid and go to 
Action Menu. The Start option will be enabled to start the service, as shown below.
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8. Those services which are in the Started status, will have the Stop and Terminate options 
enabled in the Action Menu. Either you can Stop or Terminate the process, then the Status 
column will be updated to Stopped in both the scenarios. 

Note: Stop is a graceful stop with allowing the background tasks to be completed successfully 
and then stop the process. Terminate is when all the current ongoing tasks in the 
process memory are stopped forcefully immediately.

Note: In case of Interaction Monitor process, if the status in the Redundancy Status column is 
Active then the Set as Stand-by option in Action Menu will be enabled. If it is already in 
the Stand-by status in the Redundancy Status column, then Set to Active option will be 
enabled and you can set the Interaction Monitor to Active status.
Set to Active and Set as Stand-by are only functional for Interaction Monitor process.

9. When the Aspect Quality Service is stopped, WEM goes to unauthorized state. Any Action 
Menu operations that are performed during that time, will show an error message, as given 
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below. Then this needs IIS to be reset for the application pool reset. Once IIS is reset, the 
WEM services will be available again.

10.When you finish starting the service, close the Service window.
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4.  Search for an Interaction

Use the Aspect Quality Interaction Search feature to build queries to search for particular 
recordings for playback and review. The results display in the Search Results window.

Note: As you navigate through the Interaction window, the system remembers the last search 
criteria that you entered and loads it, only for the lifetime of the browser session. Refer 
the Interaction Menu section.

You can use interactions using one or multiple criteria.

From the Quality Search Results window, you can build queries to find recordings of interest. 
Data about each recording is visible, including call history, hold times, Agent Groups, ANI and 
DNIS information.

4.1   Performing a Search
In the Quality Search Results window, you can build queries to search for specific voice 
recording. You can use single or multiple criterias for media searches. 
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1. Go to main Menu > Employee Experience> Interaction > Search. The Search window 
opens.

2. Perform the below steps as given:

• Configure Search Results Grid

• Select a Date Option

• Select a Status

• Select a Channel

• Select Criteria

• Add Criteria
Note: If you are on either the Search Evaluations window, or the Search Results window, 

and you want to change criteria in the current search, select Search > Edit Search.

Note: If you want to perform a new search, select Search > New Search.

3. Click Search. 
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4.1.1   Configure Search Results Grid
In Aspect Quality, the user can select the Search Results grid view such as All or Scored or 
Non-Scored based on the requirements. 

4.1.1.1   All View
In All view, the user will see the interactions which do not have an accessible evaluation and 
accessible evaluation grouped under the interaction. Select All to view scored and non-scored 
interactions in the Search Results grid. After selecting the required criteria from Select a Date 
Option, Select a Channel, Select a Status and Select Criteria fields, the SEARCH RESULTS: 
ALL will be appeared as shown below.

Note: The interactions which have accessible evaluations are recognized by the  button 
on the first column. 

4.1.1.2   Scored View
In Scored view, the user will see the accessible evaluations which are grouped under the 
interaction. Select Scored to view only the scored interactions in the Search Results grid.
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After selecting the required criteria from Select a Date Option, Select a Channel, Select a 
Status and Select Criteria fields, the SEARCH RESULTS: SCORED will be appeared as 
shown below. 

Click the Expand button, as highlighted in below image to view the results for the scored 
evaluation.

The following table describes the column names on the expanded grid.

Column Name Description

Quality Score The evaluation score in percentage.
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4.1.1.3   Non-Scored View
In Non-Scored view, the user will see the interactions which do not have an accessible 
evaluation. Select Non-Scored to view only the non-scored interactions in the Search Results 
grid.

Point Score The evaluation score in “Total Points earned/Total Points Possible”.  
Eg: 5/10 (earned 5 points out of 10 possible points).

Pass/Fail The evaluation score in Pass/Fail format.

Status The status of an evaluation.

Template Name Name of an evaluation template.

Created By The creator of the evaluation.

Created Date Time The date and time when the evaluation is created.

To Review The reviewer (such as Agent, Team, Peer) who is assigned to review the 
evaluation.

Assigned Evaluation Evaluations which are assigned to you by other users will be available in 
this search criteria. 

Reviewed By Recorded 
Agent

The review status of the evaluation which is assigned to the recorded 
agent. 

Do Not Show in Report When the evaluation is used for the training purpose, a checkmark 
appears in this column.

Coaching When the coaching is required for the evaluation, a checkmark appears in 
this column.

Evaluation ID The ID of the Evaluation, which is stored in the database.

Column Name Description
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After selecting the required criteria from Select a Date Option, Select a Channel, Select a 
Status and Select Criteria fields, the SEARCH RESULTS: NON-SCORED will be appeared as 
shown below.

4.1.2   Select a Date Option
In the Edit Search pane, a Date Options drop-down list is available.

From this drop-down list box, select a date range. The following is a list of options in the drop-
down list box. Notice that as the date option is selected from the drop-down list box, the date 
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range automatically populates in the From and To fields. You cannot change the From and To 
fields unless you select the Custom Date Range option from the drop-down list box.

Date Option Description

Today Performs a search for the interactions only for today’s date.

Week to date Performs a search for the interactions only for the current week, including 
today. The week begins on Sunday at 12:00 AM and ends on Saturday at 
11:59 PM. For example, on 24 August 2014, if you perform a search and 
select the Week to date option, the results returned are interactions that 
occurred between 18 August 2014 12:00 AM and 24 August 2014 11:59 
PM.

Month to date Performs a search for the interactions only for the current month, including 
today. The month begins on the first day of the month and ends on the last 
day of the month, or Today. For example, on 24 August 2014, if you perform 
a search and select the Month to date option, the results returned are 
interactions that occurred between 1 August 2014 12:00 AM and 24 August 
2014 11:59 PM.

Year to date Performs a search for the interactions only for the current year, including 
today. The year begins on January 1, and ends on December 31, or Today. 
For example, on 24 August 2014, if you perform a search and select the 
Year to date option, the results returned are interactions that occurred 
between 1 January 2014 12:00 AM and 24 August 2014 11:59 PM.

Yesterday Performs a search for the interactions for the day before Today. For 
example, on 24 August 2014, if you search using the Yesterday date 
option, the results returned are interactions that occurred between 23 
August 2014 at 12:00 AM and 23 August 2014 11:59 PM.

Previous Week Performs a search for interactions for the week prior to the current week. 
The week begins on Sunday at 12:00 AM and ends Saturday at 11:59 PM.

30 Days to Date Performs a search for interactions for the last 30 days, including Today’s 
date.

Previous Month Performs a search for interactions for the month prior to the current month. 
The month begins on the first day of the month and ends on the last day of 
the month.

90 Days to Date Performs a search for interactions for the last 90 days, including Today’s 
date.

Previous 3 Months Performs a search for interactions for three months prior to the current 
month. A month begins on the first day of the month and ends on the last 
day of the month. For example, in August, if you perform a search and 
select the Previous 3 Months date option, the results returned are 
interactions that occurred in the months of May, June, and July.

180 Days to Date Performs a search for interactions for the last 180 days, including Today’s 
date.

Previous 6 Months Performs a search for interactions for six months prior to the current month. 
A month begins on the first day of the month and ends on the last day of the 
month. For example, in August, if you perform a search and select the 
Previous 6 Months date option, the results returned are interactions that 
occurred in the months of February, March, April, May, June, and July.
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4.1.3   Select a Status
From the Status drop-down list box, filter interactions based on the Status of the interaction by 
selecting any combination of the Current or Pending check boxes.

Select at least one Status to perform a search. Each option is described in the following table.

12 Months to Date Performs a search for interactions for twelve months prior to the current 
date, including Today’s date. For example, on 25 August 2014, if you 
perform a search and select the 12 Months to Date date option, the results 
returned are interactions that occurred between 1 September 2013 12:00 
AM and 25 August 2014 11:59 PM.

Previous Year Performs a search for interactions for the previous year. For example, on 
25 August 2014, if you perform a search and select the Previous Year date 
option, the results returned are interactions that occurred between 1 
January 2013 at 12:00 AM and 31 December 2013 at 11:59 AM.

Custom Date Range When you select this option, the From and To fields become active. If you 
select the Date/Time icon, you can select the date range that you want to 
use, or you can type the date and time directly into the text box.

Date Option Description

Status Option Description

Current The system either records calls in the Current state by using a business rule, or 
because the system is in Logging mode. Calls are also Current if the system is in 
Quality Monitoring with Caching mode and an agent or a Team Lead has specified 
to save the call beyond the pending period.

This is the default for Workforce Engagement Management - Aspect Quality; 
you must select it.

Historical The actual recording file is available for direct playback. You can still view any 
interactions and identify the file name. The Quality Administrator can specify the 
Historical directory.

Archived The actual recording file is available for direct playback. You can still view any 
interactions and identify the file name. The Quality Administrator can specify the 
Archive directory.
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4.1.4   Select a Channel
Every interaction that occurs between an agent and a customer happens by a channel. The 
channel is the medium used to complete the interaction; for example, a channel could be a 
phone call, a video call, or a text.

Note: Channels are only enabled for selection if you have an appropriate license installed.

From the Channel drop-down list box, select one or more check boxes by which you want to 
search. Each option is described in the following table.

Pending 
Disposition

Recordings are pending if they did not match a business rule and no agent or 
Team Lead has indicated the system should save the recordings beyond the 
pending period. All calls that are still pending after the pending period has elapsed 
have both the recording and the database record deleted. Calls can only be in the 
pending state if the system is in the Quality Monitoring with Caching mode for 
recording. In this mode, the system records all calls and places the calls in the 
Pending state if they do not match a business rule.

This call is waiting for a Team Lead to review a recording to determine if the 
system should keep or discard the recording. A Team Lead reviews and marks the 
recording for deletion, or makes the recording Active.

Status Option Description

Channel Definition

Voice Only Interactions that have only an audio/voice recording

Screen Only Interactions that have only a screen recording

Voice and Screen Interactions that have both voice and screen recording

Email Interactions that have only email interaction
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4.1.5   Select Criteria
Click on Add Criteria button, the Add Criteria window opens.

Chat Interactions that have only chat interaction

Task A placeholder for non-recording interactions that occurs internally. For 
example, a Task could be a placeholder for a performance evaluation for an 
agent.

Unknown Any interaction from which the system cannot determine the port state.

Channel Definition
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4.1.5.1   Search Types and Criteria
The following table contains the search types of criteria which will be added under the Criteria 
Summary.

Note: Evaluation Details and Evaluation Review are available if the user has selected the All 
or Scored button in the Search dialog. When the user has selected Evaluation Details 
or Evaluation Review search type and toggled to Non-Scored button then click on 
Search, a validation message will be displayed under the Criteria Summary section as 
shown below.

Interaction Search Aspect Quality Evaluation

• Advanced
• Custom Information
• Interaction Details
• Interaction Handling
• Interaction Statistics
• Recording Information

• Advanced
• Custom Information
• Evaluation Details
• Evaluation Review
• Interaction Details
• Interaction Handling
• Interaction Statistics
• Recording Information
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The Interaction Search criteria Search Type menu.

The Aspect Quality Evaluation criteria Search Type menu.

Depending on which search type you select, the criteria that displays is specific to that type.

4.1.5.1.1   Advanced
The Advanced criteria pertain to the criterias which are listed below.

Criteria - Select: Description - Options displayed

Audio Recording Ended 
Early

When a call recording is stopped in Aspect Quality (integrated with regular 
CTIPS switch) before the call ends in Unified IP.

From the Equals drop-down list box, select
• Yes
• No

Click on (+) to add the criteria under the Search List section.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 131



Administrator Guide
Audio Recording 
Expected

When Aspect Quality records audio, and the audio file status is available, 
deleted, failed during recording, failed during transfer or stored in separate 
storage disks.

From the Equals drop-down list box, select
• Yes (based on the above status)
• No (Not recorded)

Click on (+) to add the criteria under the Search List section.

Audio Recording 
Missing

When Audio Recording is expected and the audio filename is not updated 
in Aspect Quality database, the audio recording is considered as missing.

From the Equals drop-down list box, select
• Yes 
• No 

Click on (+) to add the criteria under the Search List section. 

Audio Recording Silent When voice content is not available in the recording. 

From the Equals drop-down list box, select
• Yes
• No

Click on (+) to add the criteria under the Search List section.

Audio Recording 
Started Late

When audio recording is started in Aspect Quality (integrated with regular 
CTIPS switch) after the actual start of the call in Unified IP.

From the Equals drop-down list box, select
• Yes
• No

Click on (+) to add the criteria under the Search List section.

Host ID It represents the Call ID of the switch.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the Host Id by which you want to search.

Interaction ID Aspect Quality creates a unique interaction ID for each interaction.

From the Show items with value that is drop-down list box, select
• Equals

Then, in the Entry text box, type the Interaction Id by which you want to 
search.

Note: An Interaction Id is represented as a GUID (Globally Unique 
Identifier).

Criteria - Select: Description - Options displayed
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Partial Audio Recording When a recording started late or ended early than expected, those 
recordings are retrieved using this search criteria.

From the Equals drop-down list box, select
• Yes
• No

Click on (+) to add the criteria under the Search List section.

Phone Foul When the Phone Foul happened during the conversation, those 
interactions are retrieved using this search criteria.

From the Equals drop-down list box, select
• Yes 
• No 

Click on (+) to add the criteria under the Search List section.

Screen Recording 
Expected

When Aspect Quality records screen, and the screen file status is available, 
deleted, failed during recording, failed during transfer or stored in separate 
storage disks.

From the Equals drop-down list box, select
• Yes
• No

Click on (+) to add the criteria under the Search List section.

Transcript File Name There is a Chat Transcript file. 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the transcript file number by which you 
want to search.

Screen Recording 
Missing

When Screen Recording is expected and the screen filename is not 
updated in Aspect Quality database, the screen recording is considered as 
missing.

From the Equals drop-down list box, select
• Yes 
• No 

Click on (+) to add the criteria under the Search List section.

Criteria - Select: Description - Options displayed
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Message ID From the Show items with value that is drop-down list box, select
• Equals
• Greater than
• Greater than or equals
• Less than
• Less than or equals
• Not equals

Then, in the Entry text box, use the arrow buttons or type the number by 
which you want to search.

Thread ID From the Show items with value that is drop-down list box, select
• Equals
• Greater than
• Greater than or equals
• Less than
• Less than or equals
• Not equals

Then, in the Entry text box, use the arrow buttons or type the number by 
which you want to search.

Universal Call ID From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the Universal Caller ID by which you want 
to search.

Universal Media ID Unique ID represents the call sequence number.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the Universal Media ID by which you want 
to search.

Evaluation ID Aspect Quality creates a unique evaluation ID for each evaluation.

From the Show items with value that is drop-down list box, select
• Equals

Then, in the Entry text box, type the Evaluation Id by which you want to 
search.

An Evaluation Id is represented as a GUID (Globally Unique Identifier).

Criteria - Select: Description - Options displayed
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4.1.5.1.2   Custom Information
Custom Information are variable criteria made available to Aspect Quality through CTI. These 
criteria pertain to interaction metadata from the associated switch. The criteria that the custom 
information list displays is based on the customer CTI metadata.

Criteria - Select: Description - Options displayed

<Custom Information>*

*Variable metadata from CTI. 
Examples include:
• D5 (UCCE 11.5 HPX)
• DNIS (Default Import 

Switch - Inactive)

Note: The associated switch 
is mentioned with the 
Criteria. Not only, it is a 
drop-down list, its a 
combo box, where you 
can also type the 
Criteria and the 
matching items will also 
appear at the top.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the custom information by which you 
want to search.
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4.1.5.1.3   Evaluation Details
The Evaluation Details are criteria that pertain to the template name, whether the evaluation 
passed or failed, the number of percentage or point score, or the evaluation status. 

Criteria - Select: Description - Options displayed

Assigned Evaluations Evaluations which are assigned to you by other users will be available in 
this search criteria. 

Note: Evaluations are assigned from Workforce Engagement 
Management UI.

Select Shared with me from Equals drop-down, then click on (+) button.

Created By Search text box.
• You can search without entering any filter value. A table displays a list 

of users depending on the logged in user. 
• You can also search by typing the partial or complete Lastname or 

Firstname or UserName of the evaluation creator.
• You can select only one user at a time.

For more information on Search text box, see The Evaluation Details are 
criteria that pertain to the template name, whether the evaluation passed or 
failed, the number of percentage or point score, or the evaluation status..

Created Date Time In the From and To fields, specify a date range.

By default, the From date is set 30 days prior to the current date and the 
current date is set as the To date.

Pass/Fail The Equals drop-down list box displays the options
• N/A
• Pass
• Fail
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Note: Only one user can be selected and added to the search list from the table.

The following table shows a list of users depending on the logged in user.

Percentage Score From the Show items with value that is drop-down list box, select
• Equals N/A
• Equals
• Greater than
• Greater than or equals
• Less than
• Less than or equals
• Not equals

Then, in the Entry text box, type the percentage by which you want to 
search.

Point Score From the Show items with value that is drop-down list box, select
• Equals N/A
• Equals
• Greater than
• Greater than or equals
• Less than
• equals
• Not equals

Then, in the Entry text box, type the point score by which you want to 
search.

Status The Equals drop-down list box displays the options Draft or Complete.

Template Name The Equals drop-down list box displays a list of accessible scorecard 
template names from which you can select.

Note: By default, only Active templates will be displayed. Refer to 
Edit My Preferences on page 4-239, if you would like to see 
the Inactive templates along with the Active templates in the 
search criteria.

Do Not Show in Report When the evaluation is used for training purpose, a check mark will be 
mentioned in this column.

The Equals drop-down list box displays the options
• Marked
• Non Marked

Users List of Users

Administrator All the active and inactive users available in the system.

Criteria - Select: Description - Options displayed
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Click Search to open a window with the following columns. 

4.1.5.1.4   Evaluation Review
The Evaluation Review is criteria that pertains to whether the agent or peer is required to 
review the evaluation.

Mentor • Logged in user.
• All the active and inactive users for which the logged in user has Team 

permission in the user profile.
• Users who have shared the evaluations with the logged in user.

Note: Evaluations can be shared through Agent, Team, and Peer Review.

Agent • Logged in user.
• Users who have shared the evaluations with the logged in user.

Note: Evaluations can be shared through Agent, Team, and Peer Review.

Column Name Description

User Name The user name configured in the Aspect Quality User Definition 
window.

First Name The first name configured in the Aspect Quality User Definition 
window.

Last Name The last name configured in the Aspect Quality User Definition 
window.

Switch Name The switch name for which the user is configured.

Role The role of the user configured in the Aspect Quality User Definition 
window (Agent or Mentor).

Status User Status (Active or Inactive).

Email Address The email address configured for the user.

Criteria - Select: Description - Options displayed

Agent The Equals drop-down list box displays the options Marked or Not Marked.
• Marked: Returns those interactions in which at least one of the 

evaluations is marked for Agent review.
• Not Marked: Returns those interactions in which none of the 

evaluations are marked for Agent review.

Peer The Equals drop-down list box displays the options Marked or Not Marked.
• Marked: Returns those interactions in which at least one of the 

evaluations is marked for Peer review.
• Not Marked: Returns those interactions in which none of the 

evaluations are marked for Peer review.

Users List of Users
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4.1.5.1.5   Interaction Details
The Interaction Details are criteria that pertain to the agent’s extension number, the switch on 
which the interaction was recorded, or the type of call.

Note: A chat initiated by a customer is stored as an interaction in Aspect Quality. Only when 
the Agent replies to the customer’s chat, is the interaction displayed for the users in the 
Workforce Engagement Management UI. Then, the Agent interaction contains the chat 
conversation of both the Agent and the customer.

Reviewed By Recorded 
Agent

Retrieves the recorded interaction based on whether the agent has or has 
not reviewed the agent's own evaluation.

From the Equals drop-down list box, select
• Yes 
• No 

Click on (+) to add the criteria under the Search List section.

Team The Equals drop-down list box displays the options Marked or Not Marked.
• Marked: Returns those interactions in which at least one of the 

evaluations is marked for Team review.
• Not Marked: Returns those interactions in which none of the 

evaluations are marked for Team review.

Criteria - Select: Description - Options displayed

ANI (Automatic Number 
Identification)

ANI represents the calling phone number. 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Assigned Interactions Recordings assigned to you by a peer will be available in Assigned 
Interactions. Select Shared with me from Equals drop-down, then click on 
(+) button.

Criteria - Select: Description - Options displayed
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Customer Email 
Address

This criteria uses to find the interactions based on the registered email 
address of the customer.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the registered email ID by which you want 
to search.

Customer Name This criteria uses to find the interactions based on the registered name of 
the customer.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the registered name by which you want to 
search.

Hidden Hidden feature is only available when the user has Hide/Show Interactions 
right flagged in the user profile.

From the Equals drop-down list box, select
• Yes - Interactions which are reserved for Hide/Show Interaction
• No - Interactions which are not reserved for Hide/Show Interaction.

Click the (+) button to add the criteria under the Search List section.

DNIS (Dialed Number 
Identification Service)

DNIS represents the number that the caller dialed.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Criteria - Select: Description - Options displayed
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Device Position Unique ID used to identify a device or phone. 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Direction Call direction for the agent. 

The Equals drop-down list box displays the list of interaction types.
• None
• Inbound
• Outbound

Extension Extension number of the device. 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Message Count The total number of messages.

From the Show items with value that is drop-down list box, select
• Equals
• Greater than
• Greater than or equals
• Less than
• Less than or equals
• Not equals

Then, in the Entry text box, type the number by which you want to search.

Note: The number must be within the range of 1 to 10000.

Protected Prevents interaction from being deleted. 

From the Equals drop-down list box, select
• Yes

Switch From the Equals drop-down list box, select the switch which you want to 
search. Click on (+) to add the criteria under the Search List section.

Criteria - Select: Description - Options displayed
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4.1.5.1.6   Interaction Handling

Task Name It is a non-recording evaluation. From the Show items with value that is 
drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Type Contains all of the interaction types. 

The Equals drop-down list box displays the list of interaction types.
• ACD Call
• Campaign Outbound Email
• Chat
• IVR Call
• Inbound Direct Call
• Inbound Email
• Manual Outbound Email
• Outbound Dialer Call
• Outbound Direct Call
• Task
• Unknown

Email Subject This criteria uses to find the interactions based on the registered name of 
the customer.

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the email subject by which you want to 
search.

Criteria - Select: Description - Options displayed

Agent Search text box.
• You can search without entering any filter value. A grid displays a list of 

all active users associated with the active switch.
• You can also search by typing the partial or the complete User name.

Note: This option is only available for Mentors and Administrators. 

Criteria - Select: Description - Options displayed
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Agent Group Search text box.
• You can search without entering any filter value. A table displays a list 

of all active agent groups with their associated switch.
• You can also search by typing the partial or the complete Agent Group 

name.

Note: This option is only available for Mentors and Administrators.

Application Search text box.
• You can search without entering any filter value. A table displays a list 

of all active agent groups with their associated switch.
• You can also search by typing the partial or the complete Agent Group 

name.

Note: This option is only available for Mentors and Administrators.

Initial Agent Group • You can search without entering any filter value. A table displays a list 
of all active agent groups with their associated switch.

• You can also search by typing the partial or the complete Agent Group 
name.

Note: This option is only available for Mentors and Administrators.

Initial Skill Group Search text box.
• You can search without entering any filter value. A table displays a list 

of all active skill groups with their associated switch.
• You can also search by typing the partial or the complete Skill Group 

name.

Precision Queue Search text box.
• You can search without entering any filter value. A table displays a list 

of all active precision queue with their associated Cisco UCCE switch.
• You can also search by typing the partial or the complete Precision 

Queue name.

Skill Group A group of agent groups called as Skill Group.

Search text box.
• You can search without entering any filter value. A table displays a list 

of all active skill groups with their associated switch.
• You can also search by typing the partial or the complete Skill Group 

name.

Team Search text box.
• You can search without entering any filter value. A table displays a list 

of all active teams with their associated switch.
• You can also search by typing the partial or the complete Team name.

Criteria - Select: Description - Options displayed
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Example: When you select the Agent criteria and click Search in the Search field, the 
window that opens displays the following columns. You can resize any of the columns in the 
grid.

Note: By default, only Active users will be displayed. Refer to Edit My Preferences on page 4-
239, if you would like to see the Inactive users along with the Active users in the search 
criteria. 
It is also applicable for the Agent Group, Application, and Team criteria.

Column Name Description

User Name The user name configured in the Aspect Quality User Definition window.

First Name The first name of the user configured in the Aspect Quality User Definition 
window.

Last Name The last name of the user configured in the Aspect Quality User Definition 
window.

Switch Name The switch name for which the user is configured.

Role The role of the user configured in the Aspect Quality User Definition 
window (Agent or Mentor).

Status The status (Inactive or Active) of the user.

Email Address The email address configured for the user.
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4.1.5.1.7   Interaction Statistics
The Interaction Statistics contain criteria that pertains to the time duration of the interaction.

Criteria - Select: Description - Options displayed

Duration From the Show items with value that is drop-down list box, select
• Equals
• Greater Than
• Greater Than or Equals
• Less Than
• Less Than or Equals
• Not Equals

Then, in the Entry text box, type the time (format: 00:00:00) by which you 
want to search.

Hold Count The total number of times a call put on hold.

From the Show items with value that is drop-down list box, select
• Equals
• Greater Than
• Greater Than or Equals
• Less Than
• Less Than or Equals
• Not Equals

Then, in the Entry text box, type the time (format: 00:00:00) by which you 
want to search.

Maximum Hold Time When a call put on hold and the hold time is maximum. 

From the Show items with value that is drop-down list box, select
• Equals
• Greater Than
• Greater Than or Equals
• Less Than
• Less Than or Equals
• Not Equals

Then, in the Entry text box, type the time (format: 00:00:00) by which you 
want to search.
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Total Hold Time When an agent places the call on hold multiple times, the sum of all hold 
duration is the Total Hold Time.

From the Show items with value that is drop-down list box, select
• Equals
• Greater Than
• Greater Than or Equals
• Less Than
• Less Than or Equals
• Not Equals

Then, in the Entry text box, type the time (format: 00:00:00) by which you 
want to search.

Criteria - Select: Description - Options displayed
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4.1.5.1.8   Recording Information

Criteria - Select: Description - Options displayed

Audio Port The port through which Aspect Quality recorded the audio.

Type the port number in the Contains text box by which you want to 
search.

Audio Port Description From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the port number by which you want to 
search.

Imported An interaction imported to the Aspect Quality.

From the Equals drop-down list box, select
• Yes

Matched Rule The rules that allow the interaction to be recorded.

From the Equals drop-down list, select the rule based on the requirement.

Recording Group Group of audio recording ports named as Recording Group.

Search text box.
• You can search without entering any filter value. A grid displays a list of 

all active users associated with the active switch.
• You can also search by typing the partial or the complete User name.

This option is only available for Mentors and Administrators.

Recording Reason From the Contains drop-down list box, select any one or multiple options 
based on the requirement
• Agent Requested
• API Requested
• Logging
• Mentor Requested
• Parent Monitored
• Recording Rule matched

Terminal Number From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the terminal number by which you want to 
search.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 147



Administrator Guide
4.1.5.2   Add Criteria
To add criteria to a search, perform the following steps.

1. On the Search window, click Add Criteria. 

The Add Criteria window opens.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 148



Administrator Guide
2. From the drop-down list box, select a Search Type.

3. From the drop-down list box, select Criteria.

4. Depending on the search type and criteria that you selected, based on the tables in Search 
Types and Criteria, select the remaining criteria and enter the remaining values.

5. Click Add criteria to list.

The criteria displays in the Search List.

Note: To remove the search criteria from the Search List, click X.
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6. Click OK. The Add Criteria window closes, the Search window becomes active, and the 
criteria that you selected displays in the Criteria Summary list.

7. To continue adding criteria, click Add Criteria and repeat the steps in this procedure.
Note: If you add different criteria, the search performs a logical AND operation. If you add 

the same criteria with different values, the search performs a logical OR operation.

8. When finished adding all criteria, click OK. The Search Results displays with the results of 
the search in the list.

9. Click Search. The Search Results window opens.
Note: For information about the search results, see Using the Search Results Window.

4.2   Using the Search Results Window
Once you have obtained the results from the search, you may want to arrange the information 
so that it is most useful to you. (To search for an interaction, see Performing a Search on page 
4-120.) This includes understanding how to use the tools on the window, such as:

• Pagination

• Group Search Results

• Resize Columns

• Use the Search Results Menu
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4.2.1   Pagination
By default, the system displays the interactions that you answered within a selected time 
period (refer Select a Date Option), based on the selected view such as All, Scored and Non-
Scored (refer Configure Search Results Grid), and lists the most recent 1000 interactions. 
Each page displays 100 interactions at a time and if you want to view the next 100 interactions 
within the 1000 interactions, click the pagination controls at the bottom-left of the window as 
shown below.

To view the next 1000 interactions, click the pagination controls at the bottom-right of the 
window.  
Example: The administrator is searching with a date range from 1st Jan 2019 to 31st 
December 2019 and there are a total of 12397 records available in the database. To view the 
next 1000 records or the last 1000 records, click on the pagination controls as shown below.

Note: In this scenario, if you click on the  button, the last 397 records will appear. The 
pagination will be shown like “12001 to 12397 of 12397 records” at the bottom-right of 
the window.
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4.2.2   Group Search Results
You can group data by column when you drag-and-drop the column from the table header to 
the top of the table where it says Drag a column header and drop it here to group by that 
column.

For example:
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You can also group by multiple columns by dragging the next column into the same header.

To edit the grouping, click the X of the column that you want to remove from the group.

4.2.3   Resize Columns
If you cannot see the complete content of a column, you can resize the column so that you can 
see the complete content.

• To resize the column, hover the mouse on the right border of the column that you want to 
resize so that the mouse displays a double-sided arrow, then click-and-drag the column 
border.

• To automatically adjust the size of the column to the width which displays all of its content, 
double-click the right border of the column that you want to resize.

4.2.4   Use the Search Results Menu
Once you view a set of search results in Search or Search Evaluations window, you have 
access to a drop-down menu from the triple-bar icon next to each column name. You can use 
this menu to customize what columns display and how the data displays (grouped or not 
grouped, sorted ascending or descending). The Search Results or Search Evaluations 
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windows retain the changes that you make to the window, and persists when you close the 
browser, or open a new instance of the browser.

4.2.4.1   Sort Columns
By default, the system sorts the search results on the start date time of the interaction in 
descending order, so that all related interactions display on the first page.

You can sort any of the columns that display in the search results, although only a default list of 
columns display.

To sort any column, click the triple-bar icon next to the column name, and the column menu 
opens. You can click Sort Ascending or Sort Descending, depending on how you want to 
sort your column.
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4.2.4.2   Add or Remove Column Names
You can remove or add the columns that you want to view by clicking the triple-bar icon next to 
any column name and selecting Columns.

The Columns menu displays the name of each column. Select or deselect the check boxes 
next to the column name that you want to view or remove.

Note: For descriptions on each column name, see Column Names on page 4-181.

4.2.4.3   Filter Criteria
From the Search Results or Scorecard Interactions pane, you can narrow the search of the 
database by changing the criteria of a particular column. For more information on obtaining 
search results, see Chapter 4, Search for an Interaction.

To change the criteria of a column, perform the following steps.
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1. Click the triple-bar icon next to the column name of the criteria that you want to change.

2. Select Filter. Depending on which column you selected, a menu displays with the criteria 
that you can change.

For example, if you want to change the criteria for the Channel, Direction, Agent, 
Extension, ANI, DNIS, or Status columns, the Filter drop-down list displays the following.

If you want to change the criteria for the Date/Time column, the Filter drop-down list 
displays the following.
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If you want to change the criteria for the Duration column, the Filter drop-down list displays 
the following.

3. Change the Filter criteria.
Note: If you want to start with a blank Filter drop-down list box, click Clear.

4. Click Filter. The Search Results automatically update.

4.2.4.4   Reset Layout
Select Reset Layout to restore the table layout to the factory defaults.
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4.2.4.5   Clear All Filters
Select Clear All Filters to delete all the filters that you added to this search.

A default of 100 results per page displays. Use the following buttons to move between the 
pages.

Button Icon Description

First Page

Previous Page

Next Page
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Once you have located the Agent on which you want to search, you can either double-click the 
row of the agent, or you can select the row and click OK. The Agent displays in the Search List 
on the Add Criteria pane.

Note: You can add more than one Agent to the Search List.

4.2.5   Edit or Delete Criteria
Follow the steps below to edit or delete the criteria in the Criteria Summary.

1. In the Criteria Summary list, in the criteria that you want to edit or delete, click Action > 
Edit or Action > Delete.

Clicking Action > Delete automatically deletes the criteria from the Criteria Summary list.

Last Page

Button Icon Description
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Clicking Action > Edit displays the Edit Criteria window, with the Search Type, Criteria, and 
other fields pertaining to that criteria display in the Search List.

2. Modify the fields you want to change.

3. Click OK. The new criteria displays in the Criteria Summary pane.

OR

To cancel the update, click Cancel.
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4.2.6   Interaction Window
When you select an interaction to review, or you create a playlist of interactions, the Interaction 
window opens. Any previously-selected interaction in the Search window displays in the left 
pane below the Media Player in a table. The first interaction in the list is selected by default.

Note: The View Transcript Player will be hidden in the Interaction View Detail Page, if the 
selected chat interaction mediafilestatus is marked as deleted. Check below 
screenshot for reference.
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4.2.6.1   Media Player Pop-out
This feature allows you to view a Voice and Screen Interaction in another window. It helps you 
to view the interaction in another window and do other tasks simultaneously. Click on the Pop-
out button, as shown below.

Note:

• The Pop-out option is only available for Voice and Screen Interactions.

• If you click on the Pop-out button while the video is in progress, the video will be paused 
at the same duration on the pop-out window.

• You can resize the Pop-out window based on your requirement. Hence if you resize 
down the Pop-out window to a certain size, the media player controls will overlap on 
each other.

• The Pop-out window which you closed earlier and in future when you click on the Pop-
out button, the pop-out window size and position will be retained the same on the parent 
window.

• When you want to move away from the page or select another interaction in the playlist 
or related interactions grid, a warning message will be displayed to notify you that the 
pop-out window needs to be closed.

• The settings for media player controls such as volume, playback speed, duration, and 
so on, will be carried over to the next active media player.

• In a multi-monitor environment, the pop-out window can be moved to a different monitor 
from the parent window.

• When an annotation is created with pop-up media player open, clicking on play button in 
the corresponding annotation does not start playback. This is expected behavior as the 
browsers restrict auto play due to security until a manual action is done in the pop-up 
window.
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• When an annotation is created with pop-up media player open, clicking on play button in 
the corresponding annotation does not start playback. This is expected behavior as the 
browsers restrict auto play due to security until a manual action is done in the pop-up 
media player.

The interaction will be opened in another window. Click on Pop-in button to resume playing on 
the Interaction window. 

Note: When you click on the Pop-in button, the pop-out window will close, and the video will 
be paused on the Interaction window.

4.3   Viewing Search Results
To viewing the search results, refer Pagination.

4.3.1   Create a Playlist
You can select more than one interaction, as a group, to listen to recordings. Selecting more 
than one interaction means that you are creating your own playlist.

In the following example, the procedure creates a playlist from the Interaction window.

To create a playlist, perform the following steps.

1. Begin by Performing a Search for the interactions to which you want to listen or view.
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2. In the Search Results pane, in the left column, select the check boxes of the interactions 
that you want to open in the playlist.

Note: You can select up to ten interactions for a playlist.

3. Click on Create Playlist button.

4. Depending on the type of interaction that you want to view, select the following option.

• Quick View of Audio Interaction in the Media Player

4.3.2   Quick View of Audio Interaction
If the user wants to listen to the recording or download the recording, follow the steps below to 
listen an audio interaction or download the audio interaction.
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1. Select the audio interaction and click on the Play Voice Only button as shown below.

Note: After selecting the audio interaction, only the Play Voice Only button will be 
enabled as the interaction is audio interaction.

2. Click on Play button to listen the audio or click on Download button to download the media 
file as shown below.
Note: The user must have access to download the media if not, the Download button will 

be disabled

3. Click on OK button to close the dialog.

4.3.3   Quick View of Voice and Screen Interaction
If the user wants to listen to the recording or download the recording, follow the steps below to 
listen a voice and screen interaction or download the audio interaction.
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1. Select the voice and screen interaction as shown below.

Note:
• After selecting the interaction, the Play Voice Only and Play Voice and Screen 

button will be enabled as the interaction is voice and screen interaction.
• When Voice and Screen interaction is expected but the Voice or audio is missing 

( - This icon is available under the Channel column for the interaction) then only 
the Play Voice and Screen button will be enabled and the Play Voice Only button 
will be disabled.

• When Voice and Screen interaction is expected but the Screen is missing ( - 
This icon is available under the Channel column for the interaction) then only the 
Play Voice Only button will be enabled and the Play Voice and Screen button will 
be disabled.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 166



Administrator Guide
2. Click on the Play Voice Only button to listen only audio as shown in step 2, Quick View of 
Audio Interaction or click on the Play Voice and Screen button. The Play Voice and 
Screen window appears as shown below.

3. Click on Play button to view/listen and view the interaction

4. Click on Download button to download the media file. The Download window appears as 
shown below.

Note: The user must have access to download the media if not, the Download button will 
be disabled

Note:
• Toggle-on the Combined Voice and Screen button to download the screen file with 

audio.
• Toggle-on the Voice button to download only audio file.
• Toggle-on the Screen button to download only screen file.
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5. Click on OK button to complete the download.

4.3.3.1   Quick View of Chat Interaction
If the user wants to view or download the chat interaction, follow the steps below.
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1. Select the chat interaction and click on the View Transcript button as shown below.

Note: 1. After selecting the chat interaction, only the View Transcript button will be 
enabled.

2. The View Transcript button will be disabled, as shown below, if the selected chat 
interaction mediafilestatus is marked as deleted.
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2. The View Transcript window appears as shown below.

3. Click on the Download button to download the interaction.

Note: The user must have access to download the Chat interaction if not, the Download 
button will be disabled.

4. Click OK button to close the View Transcript window.

4.3.4   View Interaction Details
Follow the steps below to view the metadata such as Interaction Details, Interaction Handling, 
Interaction Statistics, Recording information, Archiving Information and Custom Information for 
an interaction.

1. Select the interaction and click on View Interaction Details button as shown below.
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2. The View Interaction Details window appears as shown below. Scroll down to view the 
details such as Interaction Details, Interaction Handling, Interaction Statistics, Recording 
information, Archiving Information and Custom Information.

3. Click OK button to close the View Interaction Details window.

4.3.5   Custom Info Column to Display
Follow the steps below to view one Custom Info column or multiple Custom Info columns in the 
Search Results grid.
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1. Click on the  button to add one or multiple custom info columns. The list of Custom 
Info Key and Switch are displayed, as shown below.

2. Click on the check box to select the Custom Info Key and the adjacent Switch, as shown 
below. Click OK to add the custom info column in the search grid. 
Example: Disposition Code is taken as an example.

Note: Select multiple check boxes to add multiple custom info columns in the Search 
Results grid. If you want to multi-select, then drag or use CTRL button in your 
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keyboard and click (You can click anywhere in the row) on the rows that you want to 
choose.

3. The Custom Info column is added to the search grid, as shown below.

4.3.6   Interaction Menu
The Interaction Menu consists of multiple features such as Show or Hide Interaction, Assigned 
Interactions, Export Media, Collapse All, Save as my default view, Delete which help you to do 
various activities with interactions on the Search Results grid. 

Note: Interaction Menu will always appear regardless of any user profile right/permission for 
the user.

4.3.6.1   Show or Hide Interaction
This feature is only accessible when the user has Hide/Show interaction right/permission for 
the user profile.

4.3.6.1.1   Hide Interaction
The user wants to hide an interaction from others, if the recording interaction consists of data 
which you do not want others to see. Follow the steps bellow to hide an interaction from 
others.
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1. Click on the check box for the interaction which needs to be hidden, as shown below. 

Note: Select multiple check boxes to hide multiple interactions.

2. Click on the  button and select Hide Interactions to hide the interaction, as shown 
below. 
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3. The interaction is marked hidden under the Hidden column, as shown below.

Note: When multiple interactions are selected and the selected interactions consist of both 
hidden and shown interactions then only the shown interactions will be hidden.

4.3.6.1.2   Show Interaction
The user wants to show an interaction to others. Follow the steps bellow to show the 
interaction.
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1. Click on the check box for the interaction which needs to be shown, as shown below. 

Note:
• The interaction is marked hidden under the Hidden column
• Select multiple check boxes to “show” multiple hidden interactions.

2. Click on the  button and select Show Interactions.
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3. The interaction is blank under the Hidden column, as shown below.

Note: When multiple interactions are selected and the selected interactions consist of both 
hidden and shown interactions then only the hidden interactions will be shown. 

4.3.7   Collapse All
When nested grids are expanded on the SEARCH RESULTS window (either in SEARCH 
RESULTS: ALL or SEARCH RESULTS: SCORED), Collapse All option allows you to 
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collapse all of the expanded nested grids. Refer Configure Search Results Grid and the below 
screenshot of the expanded nested grids.

Note: Collapse All option is disabled in SEARCH RESULTS: NON-SCORED window.

1. To collapse all of the expanded nested grids, click on  button and select Collapse All. 
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2. The expanded nested grids are collapsed as shown below. 

4.3.8   Delete Interactions
This feature allows you to delete one or multiple interactions at a time.

Note: By default, the administrator has access to delete one or multiple interactions.
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1. To delete multiple interactions, click on the check boxes for the interactions which need to 
delete, as shown below.

2. Click on  button and select Delete as shown below.

Note: Related evaluations for the selected interactions will also be deleted.

3. Click YES to delete the interaction and related evaluations or click NO to return. 
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4.3.9   Save as Default View
In earlier version of Alvaria Quality, when user customizes the grid to sorting, adding filters, 
grouping, these will be stored in the browser cache and if the user uses a different machine to 
login to Workforce Engagement Management, they will not see the customized grid.If they 
have customized the grid and they want to save that as a default grid view, then click on  
button and select Save as my default view to save the customization in the database. When 
the user uses a different machine to login to Workforce Engagement Management, they will be 
able to see the same grid layout what they saved earlier. If you save, the system will save all 
the custom information columns selected.

4.3.10   Column Names
When the Interactions window opens, if the list of interactions exceeds the visible area, you 
can use the scroll bars to navigate to the appropriate interaction. You can use common table 
functionality such as grouping, filtering, sorting, and column resizing in this area.

The following table describes the column names in the search results.

Note: *Coaching, Score, and To Review only display in the Search Evaluations pane, not in 
the Search Results pane. 
 
To add a column to the search results, see Add or Remove Column Names on page 4-
155.

Column Name Description

Direction The direction of the interaction, which can be None, Inbound, or Outbound.

Date Time The start date and time of the interaction.

Duration The length of time of the interaction.

Agent The agent who handled the interaction.
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Extension The extension of the agent who handled the interaction.

Coaching If coaching is required for the evaluation, then check mark is shown on the 
column. Otherwise, the column is blank.

Quality Score The evaluation score in percentage.

Point Score The evaluation score in "Total Points earned/Total Points Possible".  
Eg: 5/10 (earned 5 points out of 10 possible points).

Pass/Fail The evaluation score in Pass/Fail format.

To Review Agent, Team or Peer will be shown.

Evaluation Status The status of an evaluation.

Evaluation Template 
Name

Name of an evaluation template.

Evaluation Created By The creator of the evaluation.

Assigned Evaluation Evaluations which are assigned to you by other users will be available in 
this search criteria. 

Evaluation Created 
Date Time

The date and time when the evaluation is created.

Reviewed By Recorded 
Agent

The review status of the evaluation which is assigned to the recorded 
agent. 

Customer Name The name of the customer associated with a chat interaction.

Note: Customer Name criteria only displays when you have a Chat 
license.

Message Count The total number of Chat interactions.

Customer Email 
Address

The Email address of the customer associated with a chat interaction.

Note: Customer Email Address criteria only displays when you have a 
Chat license.

ANI If available from the switch, the caller ID or ANI.

DNIS If available from the switch, the DNIS or DID (called number indicator).

Hold Count The total number of Holds that occurred during the interaction.

Host ID The identifier of the entity as known by the ACD or PBX.

Matched Rule A recording rule that the system matched at the time of recording. The 
system returns from a search only calls that matched the recording rule 
when you enabled it.

Maximum Hold Time The maximum duration of the hold in the interaction. If there is more than 
one hold, the system identifies the maximum duration of the hold out of all 
of the holds in the interaction.

Interaction ID The ID of the interaction which is stored in the database.

Total Hold Time The Total Hold Time duration in a call.

Agent Group The Agent Group which is stored in the database.

Column Name Description
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Initial Agent Group Specify the initial Agent Group to which the system announced the 
interaction.

Skill Group The name of a Skill Group which is stored in the database.

Initial Skill Group Specify the initial Skill Group to which the system announced the 
interaction.

Protected Displays if the Protected flag is marked in any one of the interactions of the 
interaction.

Device Position The unique ID for the device or phone.

Status The status of the interaction such as Complete or Draft.

Audio Port The audio port of the interaction which is stored in the database.

Audio Port Description The audio port is similar to the given input.

Recording Group The recording group which is stored in the database.

Imported If the interaction is imported then Yes is mentioned on the column.

Universal Call ID The ID which is stored in the database.

Universal Media ID The ID which is stored in the database.

Task Name The Task Name which is stored in the database.

Teams The team which is stored in the database.

Switch The switch on which the agent or agent group resides.

Application Search text box.
• You can search without entering any filter value. A table displays a list 

of all active agent groups with their associated switch.
• You can also search by typing the partial or the complete Agent Group 

name.

Terminal Number The terminal number of the agent who accepted the interaction.

Recording Reason The reason for the recording such as Agent Requested, API Requested, 
and so on.

Audio Recording 
Expected

If audio recording is expected, then the check mark is shown on the 
column. Otherwise, the column is blank.

Screen Recording 
Expected

If screen recording is expected, then the check mark is shown on the 
column. Otherwise, the column is blank.

Audio Recording 
Started Late

If audio recording is started late than the actual call start, then check mark 
is shown on the column. Otherwise, the column is blank.

Audio Recording Ended 
Early

If audio recording is ended earlier than the actual call end, then check mark 
is shown on the column. Otherwise, the column is blank.

Audio Recording Silent If the audio recording does not have audio content, then check mark is 
shown on the column. Otherwise, the column is blank.

Assigned Interactions Recordings assigned to you by a peer.

Column Name Description
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Audio Recording 
Missing

If audio recording is expected and the audio file name is not updated, then 
check mark is shown on the column. Otherwise, the column is blank.

Screen Recording 
Missing

If screen recording is expected and the video file name is not updated, then 
check mark is shown on the column. Otherwise, the column is blank.

Hidden This column indicates this interaction is reserved for Hide/Show 
Interactions, if the user has Hide/Show Interactions right for his/her profile.

Partial Audio Recording If audio recording is either started late or ended early or both, then check 
mark is shown on the column. Otherwise, the column is blank.

Channel The medium used to complete an interaction, such as Voice Only, Screen 
Only, Voice and Screen, Chat, Task, or Unknown.

Transcript File Name There is a Chat Transcript file. The Transcript File Name will be mentioned 
in a specific way for Chat. Example:
• Chat - chat/2020/09/02/09/ab48a17e-7015-4571-9e6a-

7d6597cae5e3.json

Phone Foul When the Phone Foul happened during the conversation, those 
interactions are retrieved using this search criteria.

From the Equals drop-down list box, select
• Yes 
• No 

Click on (+) to add the criteria under the Search List section.

Evaluation ID Aspect Quality creates a unique evaluation ID for each evaluation.

From the Show items with value that is drop-down list box, select
• Equals

Then, in the Entry text box, type the Evaluation Id by which you want to 
search.

An Evaluation Id is represented as a GUID (Globally Unique Identifier).

Precision Queue System announced interaction for specialized routing.

Note: This column displays the value to find the interactions based on the 
Precision Queue that was used for routing the call to the agent in 
Cisco UCCE. 

The Precision Queue column is hidden by default, this can 
be included into the grid, if required.

Email Subject The subject of the email interaction.

Thread ID The identification number for the email thread.

Message ID The identification number for the email thread.

Column Name Description
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4.3.10.1   Media
The following table describes the Media icons in the search results.

4.3.10.2   Status
The following table describes the Status icons in the search results.

Media Icon Name Icon Description

Audio Indicates that the recording is audio only.

Media Icon Name Icon Description

Current The system either records calls in the Current state by 
using a business rule, or because the system is in Logging 
mode. Calls are also Current if the system is in Quality 
Monitoring with Caching mode and an agent or a Team 
Lead has specified to save the call beyond the pending 
period.

An agent can score recordings that the system sets as 
Current, but a Team Lead must flag a recording before an 
agent can score it.

Historical The actual recording file is available for direct playback. 
You can still view any interactions and identify the file 
name. The Quality Administrator can specify the Historical 
directory.

Archived The actual recording file is available for direct playback. 
You can still view any interactions and identify the file 
name. The Quality Administrator can specify the Archive 
directory.
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4.3.10.3   Channels
The following table describes the Channel icons in the search results.

Pending Disposition Recordings are pending if they did not match a business 
rule and no agent or Team Lead has indicated the system 
should save the recordings beyond the pending period. All 
calls that are still pending after the pending period has 
elapsed have both the recording and the database record 
deleted. Calls can only be in the pending state if the 
system is in the Quality Monitoring with Caching mode for 
recording. In this mode, the system records all calls and 
places the calls in the Pending state if they do not match a 
business rule.

This call is waiting for a Team Lead to review a recording to 
determine if the system should keep or discard the 
recording. A Team Lead reviews and marks the recording 
for deletion, or makes the recording Active.

Note: This is for future release.

Channel Icon Name Icon Description

Voice Only Interactions that have only an audio/voice recording

Voice and Screen Interactions that have voice and screen recording both

Missing Voice or audio 
in Voice and Screen 
interaction

Voice and screen interactions that have only the screen 
recording, but the voice or audio is missing

Missing Screen in Voice 
and Screen interaction

Voice and screen interactions that have only the voice or 
audio recording, but the screen is missing

Media Icon Name Icon Description
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4.3.11   Related Interactions
In the Search results, if you have an interaction that has related interactions, those related 
interactions are linked to the main interaction in the Playlist. You can view the related 
interactions in the row of the appropriate interaction by clicking on the triangle icon.

Note:

• If there is no related interaction for all the interactions then Expand All button will be 
hidden.

• If there is no related interaction for all of the interactions in the playlist then Triangle will 
be hidden.

Chat Interactions that have the chat transcript between the 
customer and agent

Task Interactions that have only a task

Unknown Any interaction from which the system cannot determine 
the port state.

Channel Icon Name Icon Description
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The related interactions display in a table that drops down over the Interaction window.

The same functionality features such as grouping, filtering, sorting, and column resizing apply 
to this related interactions table.

4.4   Interaction Results Tabs
The interaction pane contains information about the current, selected interaction. The tab 
available is the Details Tab.
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4.4.1   Details Tab
The Details tab displays the information related to the interaction that you have open.

The Details tab provides the following information.

• Interaction Details

• Interaction Handling

• Interaction Statistics

• Archiving Information
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4.4.1.1   Interaction Details

4.4.1.2   Search the Interaction
This section describes how to search the interaction based on Task Name. To search follow 
the steps below.

1. Login to the system.

2. Go to Navigation menu > Employee Experience> click on Search Evaluations under 
Evaluation. The Search window appears. 

Criteria Description

ANI The caller ID.

Assigned Interactions Recordings shared with you.

DNIS The Direct Inbound Dialer (called number indicator).

Device Position Unique ID for a device.

Direction Inbound call or outbound call or none.

Extension The agent’s extension number.

Protected Displays if the Protected flag is marked in any one of the interactions of the 
interaction.

Switch The switch on which the agent or agent group resides.

Task Name Non-recording evaluation
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3. Click on New Search as shown below. 

4. Click on Add (+) button under Criteria Summary. The below window appears.

5. Click on the Search Type drop-down list and select Interaction Details.

6. Select the Criteria as Task Name.

7. Enter the mandatory fields (*) based on the requirement and click on Add button. 
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8. The selected search type with Task Name will display under Search List.

9. Click on OK button. The below window appears.
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10.Click on OK then Search to view the search in Search Evaluations window as shown 
below. 
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4.4.1.3   Interaction Handling

4.4.1.4   Interaction Statistics

Criteria Description

Agent The final agent from which the agent took the interaction. Agent is the 
agent from which the agent intercepted the interaction; it may not 
necessarily be the agent to which the system initially announced the 
interaction (for example, it may have escalated to other agents).

Agent Group The agent is associated with the Agent Group.

Application Search text box.
• You can search without entering any filter value. A table displays a list 

of all active agent groups with their associated switch.

You can also search by typing the partial or the complete Agent Group 
name.

Initial Agent Group Specify the Initial Agent Group to which the system announced the 
interaction. Initial Agent Group is the Agent Group to which the system 
initially announced the interaction. It may not necessarily be the Agent 
Group from which the agent took the interaction.

Initial Skill Group Specify the initial Skill Group to which the system announced the 
interaction.

Precision Queue This criteria is used to find the interactions based on the Precision Queue 
that was used for routing the call to the agent in Cisco UCCE. 

You can search without entering any filter value. A table displays a list of all 
active precision queue with their associated switch.

You can also search by typing the partial or the complete Precision Queue 
name. 

Skill Group A group of agent groups called as Skill Group.

Team The agent is a member of the team.

Criteria Description

Duration The length of time of the interaction.

Hold Count The total number of Holds that occurred during the interaction.

Maximum Hold Time The maximum duration of the hold in the interaction. If there is more than 
one hold, the system identifies the maximum duration of the hold out of all 
of the holds in the interaction.

Total Hold Time The total duration of the Hold time in the interaction. For example, there are 
2 Holds and each Hold had a duration of 10 seconds, then the Total Hold 
Time is 20 seconds.
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4.4.1.5   Archiving Information

4.4.2   Evaluation Tab
The Evaluation tab provides a snapshot of the evaluation for that interaction.

Note: If the loaded interaction does not have an accessible evaluation, then the Evaluation 
tab is inactive.

From this tab, you can also email or print the evaluation.

Criteria Description

Status Displays the current status of the interaction. Possible values are Active, 
Pending Disposition, Historical, Archive, or Burnt to Media.

Protected Displays if the Protected flag is marked in any one of the interactions of the 
interaction.
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4.4.3   Annotations Tab
If there are comments about the interaction, you can listen to them using the Annotations tab.

Note: If the loaded interaction does not have any accessible evaluation, the Annotations tab 
is inactive. It is also inactive if the loaded interaction type is a Task.

To view a comment in the Annotations tab, from the media player, click the Comments marker 
of the comment that you want to view.

4.4.4   Attachments Tab
If there attachments with an interaction, you can view or save the attachments.

Note: If the loaded interaction does not have an accessible scorecard, then the Attachments 
tab is inactive.

You can see that there are attachments to view even if you are not on the Attachments tab. 
The number on the tab next to the word Attachments denotes the number of attachments in 
the Attachments tab.

If Attachments exist, the list displays with the following information.

Columns Description

Attachment The file name of the attachment.

Description A description of the attachment.

Added By The name of the person who added the attachment to the interaction.

Date Added The date and time that the person added the attachment to the 
interaction. The format of the date and time is based on the browser 
locale.
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4.5   Saving Searches
You can save searches and access saved searches on both the Interaction Search and the 
Search Evaluations windows. However, the saved searches are unique to each screen; 
therefore, for example, if you created a search and saved it in Search Evaluation Search, that 
saved search does not display in Interaction Search.

In the Search window, you can save and share a search query with date options, channels, 
and criteria. Using saved searches removes the need to recreate common search queries 
each time the search window opens.

The Search tab contains all the search controls that you use to build and save a search query.

The New Search option on the Search tab is always active; select New Search to clear the 
current search from the screen, revert the fields to their default state, and begin a new search.

Note: To create a search, see Performing a Search on page 4-120.

View or Save Attachment Click the icon to Delete, Download, or Edit the description of the 
attachment.

Note: If you are not the owner of the evaluation, but other users 
provide you with access to the evaluation, then the Download 
icon displays instead of the cog wheel icon.

Columns Description
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You can only access the Saved Searches tab, or the Saved Searches option on the Search 
tab, when you have one or more saved searches. The tab title contains a number that 
indicates the number of saved searches available.

Note: When you save a search with a selected view such as All, Scored or Non-Scored and 
want to share or edit the Saved Search, the system will display the Saved Search 
based on the selected view.

The Save window appears as shown below.

1. In the Name text box, type a name for the search. Ex: Demo_Search.

Note: The saved search Name must be unique to the your saved search list; you can type 
up to 50 characters.

2. To share the saved search with user profiles, click on Select button and select the User 
Profile such as Agent or Mentor.
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3. Click on Show the search criteria check box to enable the button groups such as All, 
Scored and Non-Scored for the selected User Profile. 

Example: When the administrator will share this saved search, button groups will be 
enabled for the users (assignee) associated with selected User Profile. Hence, when the 
assignee will go to the shared saved search, the button groups will be enabled. 
Note: If the Show the search criteria check box is unchecked, the button groups will be 

disabled for the selected User Profile. Hence, when the assignee will go to the 
shared saved search, the button groups will be disabled.

4. Click OK. The Save window closes and the Search window is active.

When you save a Private search, the Saved Searches option in the Search tab is selected 
along with the My Searches drop-down list box. The newly added saved search becomes 
the selected saved search drop down item.
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4.5.1   Saved Search Types
Saved searches are defined as:

4.5.2   Save a Search as Private
This section describes how to save a search based on task name. Follow the steps below to 
save a search.

1. Login to the system.

Saved Search Type Definition

My Searches When I create a search and save it without sharing with others then the 
search will appear in the My Searches category. While saving the search if I 
have customized the grid like sorting, adding filters, grouping, resizing the 
column width, adding/removing columns etc and whenever I open this 
search, I will be able to see the same grid layout as when I saved this search 
last time.

Shared Searches created by the user which have been shared with one or more user 
profiles.

Shared with me • Searches created by another user and shared with the user profile of the 
user. For these saved searches, most of the on-screen search query 
controls are disabled and read-only. The only exception is the date option 
whereby permission to modify the date range is assigned during the 
saving of a shared search. 

• When the Assigner of the search, customizes the Search Results grid like 
sorting, adding filters, grouping, resizing the column width, adding/
removing columns etc, then saves the search and shares it with me. 
When I (assignee) open the search, I (assignee) will be able to see 
exactly how the Assigner had customized the grid. If assignee likes the 
grid layout he can also save the grid layout as his default grid layout.
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2. Go to Navigation menu > Quality > click on Search under Interaction.  

The Search window appears.

3. Click on New Search as shown below.
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4. Go to Date Options drop-down list, select the Custom Date Range and choose the date 
based on the requirement. Refer the below window. 

5. Click on Add button under Criteria Summary. The Add Criteria window appears as shown 
below. 

6. Click on the Search Type drop-down list and select Interaction Details.
Note: To select other Search Types, see Search Types and Criteria on page 4-130.

7. Select the Criteria as Task Name.

8. Select the Show items with value that is as Contains.
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9. Click on the Entry field and type Task. Refer the window as shown below.

10.Click on Add button which is available next to the Entry field. The following window 
appears as shown below. 
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11.Click on OK button. The Search window appears with the search criteria under the Criteria 
Summary section. Refer the Search window as shown below. 

12.Click on Search button. The Search results window appears as shown below. 

Note: The Task Name column is added to the grid as highlighted on the above 
screenshot.

13.Click on the Search button from the top-left corner and select Edit Search as shown 
below. 

The Search window appears with the search criteria.
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14.From the Save menu, click Save.

The Save menu has the following options:

Note: Evaluation Details and Evaluation Review are available if the user has selected All or 
Scored button in the Search dialog. When the user has selected Evaluation Details or 
Evaluation Review search type and toggled to Non-Scored button then click on Save 
or Save As, a validation message will be displayed under the Criteria Summary 
section as shown below.

Save Options Description

Save • For a New Search, the new search query is saved
• For a Saved Searches, the saved search is updated.

Save As To save a Saved Search as a new saved search, select the Save As option.

Note: Neither Save menu options are available if the active saved search is a Shared with 
me saved search, because as a Shared-with-me user, you do not have ownership of 
that saved search.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 205



Administrator Guide
The Save window appears as shown below.

15.In the Name text box, type a name for the search. Example: Demo_Search.
Note: The saved search Name must be unique to the your saved search list; you can type 

up to 50 characters.

Since this is a Private saved search, do not select anything in the Shared with User Profiles 
section of the window.

16.Click on Show the search criteria check box to enable the button groups such as All, 
Scored and Non-Scored for the selected User Profile.  
Ex: When the administrator will share this saved search, button groups will be enabled for 
the users associated with selected User Profile. Hence, when the assignee will go to the 
shared saved search, the button groups will be enabled. 
Note: If the Show the search criteria check box is unchecked, the button groups will be 

disabled for the selected User Profile. 
Ex: When the administrator will share this saved search, button groups will be 
disabled for the users associated with selected User Profiles. Hence, when the 
assignee will go to the shared saved search, the button groups will be disabled. 

17.Click OK. The Save window closes and the Search window is active.
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When you save a Private search, the Saved Searches option in the Search tab is selected 
along with the My Searches drop-down list box. The newly added saved search becomes 
the selected saved search drop down item.

4.5.3   View Saved Searches
To view a saved search, perform the following steps.
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1. On the Search window, select the Saved Searches tab. The list of saved searches display 
in the table.

Note: The Saved Search tab is active only if you have access to one or more saved 
searches.

The Shared column icons are defined in the following table.

Note: You can display the Shared With and Shared By values in separate columns, which 
are both hidden by default, by right-clicking the table and selecting Shared With 
and Shared By. When the columns display, you can use the columns to filter and 

Shared Type Icon Description

My Searches None Private searches created by the user and not shared with any user 
profile.

Shared Searches created by you that you have shared with one or more user 
profiles.

Note: When you mouse over the icon, the tool tip displays the user 
profile with whom you shared the search. You can also see 
this information in the Shared By column.

Shared with me Searches created by another user and shared with you. For these 
saved searches, most of the on-screen search query controls are 
disabled and read-only. The only exception is the date option, if the 
owner of the saved search gives you permission to modify the date 
range.

Note: When you mouse over the icon, the tool tip displays the name 
of the user who shared the search with you. You can also see 
this information in the Shared By column.
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group data by clicking on the triple-bar icon next to the column title by which you 
want to filter or group the data.

2. In the table list, select a saved search. The Search tab opens with the saved search criteria 
in the window.

3. When you are finished viewing the saved search, click Cancel.

OR

To edit, delete, or run a saved search, or to make a saved search a default search, see 
Administer a Saved Search on page 4-211.
Note:

• When you save a search with a selected view such as All, Scored or Non-Scored 
and want to share or edit the Saved Search, the system will display the Saved 
Search based on the selected view.

• You can also toggle the view in the Search dialog, regardless of you or someone has 
created and shared with you.

• For more information on a saved search that an owner shared with you, see View a 
Shared-with-me Search.
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4.5.3.1   View a Shared-with-me Search
The following screen shot is an example of a search shared by its owner, who selected a 
user to view the saved search criteria and to modify the date range options.

The following screen shot is an example of a search shared by its owner, who selected a 
user to view the saved search criteria, but did not give the user permission to modify the 
date range options.
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Note:
• When you save a search with a selected view such as All, Scored or Non-Scored 

and want to share or edit the Saved Search, the system will display the Saved 
Search based on the selected view.

• You can also toggle the view in the Search dialog, regardless of you or someone has 
created and shared with you.

• When a saved search was created in Search Evaluation (known as Scored 
Interaction), then all the saved search will appear on the Search page with the All 
view selected by default.

• If Show the search criteria check box is checked while saving the search (refer the 
below screenshot) then the button groups such as All, Scored and Non-Scored will 
be enabled. Hence, when the assignee will go to the shared saved search, the 
button groups will be enabled. 

• If the Show the search criteria check box is unchecked while saving the search, the 
button groups will be disabled. Hence, when the assignee will go to the shared 
saved search, the button groups will be disabled. 

4.5.4   Administer a Saved Search
Once you have saved a search, you can edit it, delete it, or set/unset it as the default search. 
To administer any one of these actions, perform the following steps. 

Note: You can only administer searches that you own; you cannot modify searches that 
another user shared with you, other than to set the search as your default search.

1. From the Search window, select the Saved Searches tab. The list of saved searches 
displays in the table.

2. From the list of saved searches, select a saved search that you own and want to modify. 
The Search window opens with the data for that saved search.
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The following table describes the icons that are active, once you select a saved search.

3. Adjust the search criteria as needed (for more information on the criteria, see Performing a 
Search).

Icon Icon Name Description

Edit If you are the owner of the saved search, click this icon to edit the search. 
The Search tab opens, and the saved search criteria of the search that 
you selected, displays.

Set/Unset as 
Default

You can set a saved search to be the default saved search. Therefore, 
when you first launch the Search window of the current session, the 
default search displays with all search data pertaining to the search 
query; in this instance, the Search window does not display.

Note: A star icon in the Name column indicates the current assigned 
default saved search.

Subsequent launching of the Search window during your session does 
not automatically load the default search; instead, the Search window 
with the last search query criteria opens.

You can have only one default Interaction search and one default Search 
Evaluations. The default search is not restricted to saved searches that 
you own; you can set any saved search displayed in the grid as the 
default saved search, including those searches that another user shared 
with you.

Delete You can delete the saved search if you are the owner of the selected 
saved search. When you click Delete, a warning window opens, so that 
you can confirm that you want to delete the saved search.

Note: Deleting a shared search removes the search from any 
previously-associated user profiles.
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4. When you are finished making changes, click the Save icon and select Save. The Save 
window opens and the saved search name is inactive; you cannot change it.

5. Click OK. The saved search is updated with the modifications.

6. To run the search query after changing it, on the Saved Searches tab, from the list, select 
the saved search and click Search.
Note: The Search button is active when you select a search in the list.

OR

Double-click the row of the saved search that you want to run.

The Current Search name and Search Type display above the Search Results table.

4.6   Protecting Interactions
Protecting an interaction means that you keep the interaction available for playback after the 
historical or archive processes run. For example, you may want to protect an interaction, that 
has recorded a challenging customer call that you want to play back at a later time for training 
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purposes. You can protect an interaction in Workforce Engagement Management by flagging 
the interaction.

4.6.1   Who Can Protect an Interaction?
• An Administrator user.

• A user who has permission to the interaction, but does not have the right to unprotect the 
interaction, can view the protect flag details created by other users.

• If the user does not have permission to the interaction, the Protect section for the 
interaction does not display to that user.

• If the user is an Administrator and the user has permission to the interaction, the Protect 
this interaction option is enabled, and the user can toggle the option to the On state to 
protect an interaction.
Note: In this case, if the user does not have permission to the interaction, the Protect this 

interaction option is inactive.

4.6.2   Protect an Interaction
To protect an interaction, perform the following steps.

1. Perform a search (see Performing a Search on page 4-120) for the interaction that you 
want to protect.
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2. Create a Playlist. The Media Player opens with the interaction that you want to protect in 
the Interaction window.

3. Select the Protect this interaction option. When selected, the option is green.
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4.6.3   Unprotect an Interaction
Only an Administrator or the interaction owner who protected the interaction can unprotect an 
interaction. If you want to unprotect an interaction, perform the following steps.

1. Perform a search (see Performing a Search on page 4-120) for the interaction that you 
want to unprotect.

2. Create a Playlist. The Media Player opens with the interaction that you want to unprotect in 
the Interaction window.

3. Select the Protect this interaction option. A warning message displays.

4. Clicks Yes. The system unprotects the interaction, and the option displays the Off state.

4.7   Export Media
The ability to export media and or metadata is permitted if a user has the Export To Media user 
profile permission selected. When selected, the following Export features are available:

• An Export Media button is visible in both the Interaction and Search Evaluations Search 
Results windows. This button launches the Export window, where users can save the 
selected interactions as an export job.

• The Select/Deselect check box on the Interaction and Search Evaluations search table is 
available for users to select or deselect multiple interactions at once, and is located in the 
top left cell of the Search Results table.

• A View Export Jobs navigation menu allows users to administer export jobs (that they have 
privilege to access).

4.7.1   Create an Export Job
An export job can contain different interaction channel types, and selected options are 
applicable against all selected interactions. Therefore, based on business requirements, you 
may want to export interactions based on their channel type using multiple export jobs. For 
example, you can export Voice channels versus Screen channels into two separate export 
jobs.

You must select at least one interaction to create an export job. The Export Media button is 
active when you select one or more interactions. Depending on user permissions, an 
administrator can select and export up to 1000 interactions, whereas all other users are limited 
to 300 interactions.
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To create an export job, perform the following steps.

1. Log in to Workforce Engagement Management as an Administrator.

2. Search for an interaction (see Performing a Search on page 4-120).

3. Select an interaction (or interactions) by clicking the check box(es) next to the interaction(s) 
that you want to export.
Note: You can select all of the interactions on the page if you click the Select All check 

box at the top of the check box column.

Navigating between pages retains the selected interactions of the active page.

4. Click on the  button and select Export Media from the list.
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The Export window opens.

Note: In this example procedure, Voice and Screen (combined) interactions is selected in 
the Search Results table.  

5. On the Job Name text box, type a name up to 100 characters.
Note: All fields marked with a red asterisk (*) are required.
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6. Click on the drop-down of Time Zone field and select the time zone based on your 
requirement, as shown below.

7. If you want to export the metadata for the selected interactions, select the Metadata option.

OR

If you do not want to export the metadata for the selected interactions, do not select the 
Metadata option.

8. If you want to export the media for the selected interactions, in the Media section of the 
window, you can select any combination of options as described in the following table.

Option Description

Voice Select this option to export Voice interactions.

Screen Select this option to export Screen interactions.
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9. To submit the export job for processing, select OK. 

Note: Until this point in the procedure, you can click Cancel to cancel the export job. A 
Warning window opens to verify that you do want to cancel the export job.

The export job is assigned a Pending status.

The Success window opens, indicating that the export job is being processed. In addition, a 
link to the View Export Jobs page is included, which, when you click it, launches a new 
browser tab of the Export Jobs window.

If an error occurred while saving the export job, an appropriate error window opens.

Voice and Screen Combined 
Interactions

If the interaction you want to export contains a media file with both Voice and 
Screen recorded together, then you can select one of the following options.
• Voice and Screen as one file - select this option to export the interaction 

as one file
• Voice - select this option to export only the Voice portion of the interaction 

in a file separate from the Screen portion.
• Screen - select this option to export only the Screen portion of the 

interaction in a file separate from the Voice portion.

Non Voice Channels Select this option to export Chat and Email interactions.

Email Attachment - Select the option for exporting Email attachments. 

Option Description
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10.The Export Jobs window appears with the Time Zone details. 

4.7.2   Export a Job for Search Evaluations
When exporting a job for Search Evaluations (an evaluation), you can export associated 
evaluation metadata.

To create an export job for Search Evaluations, perform the following steps.

1. Log in to Workforce Engagement Management as an Administrator.

2. Search for an evaluation (see Performing a Search on page 4-120).

3. Select an interaction (or interactions) by clicking the check boxes next to the interactions 
that you want to export.
Note: You can select all of the interactions on the page if you click the Select All check 

box at the top of the check box column.

Navigating between pages retains the selected interactions of the active page.
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If you select more than 10 interactions, the Playlist button becomes inactive because a 
Playlist can only contain 10 interactions; a tool tip displays to remind you. However, if a 
user does not have the Export To Media permission, but selects more than 10 interactions, 
a warning window opens, since for this user, creating a Playlist is the only actionable option 
from the table.

4. Click on Export Media  from the list.

The Export window opens.

5. In the Job Name text box, type a name up to 100 characters.

Note: The fields marked (*) are mandatory fields.
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6. Click on the drop-down of Time Zone field and select the time zone based on your 
requirement, as shown below.

7. If you want to export metadata, select the Metadata option.

8. If you want to export the evaluations for the selected interaction(s), select the Evaluations 
option.

9. If you want to export the media for the selected interaction(s), in the Media section of the 
window, you can select any combination of options as described in the following table.

Option Description

Voice Select this option to export Voice interactions.

Screen Select this option to export Screen interactions.

Voice and Screen 
Combined Interactions

If the interaction you want to export contains a media file with both Voice and Screen 
recorded together, then you can select one of the following options.
• Voice and Screen as one file - select this option to export the interaction as one file
• Voice - select this option to export only the Voice portion of the interaction in a file 

separate from the Screen portion.
• Screen - select this option to export only the Screen portion of the interaction in a 

file separate from the Voice portion.
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10.To submit the export job for processing, select OK. 

Note: Until this point in the procedure, you can click Cancel to cancel the export job. A 
Warning window opens to verify that you do want to cancel the export job.

The export job is assigned a Pending status.

The Success window opens, indicating that the export job is being processed. In addition, a 
link to the View Export Jobs page is included, which, when you click it, launches a new 
browser tab of the View Export Jobs window.

If an error occurred while saving the export job, an appropriate error window opens.

Non Voice Channels Select this option to export Chat and Email interactions.

Email Attachment - Select the option for exporting Email attachments. 

Option Description
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11.On the Success window, click OK. The Export Jobs window opens.
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12.Go to your local folder where the export job is saved and select the folder as shown below.

13.Extract All the .zip folder as shown below and open the spreadsheet.
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14.On the Metadata tab, the Start Time and End Time columns reflect the time according to 
the selected time zone, and scroll right to find the Start Time (In UTC) and End Time (In 
UTC) column of the export job as shown below. 

Note: By default, the Start Time (In UTC) and End Time (In UTC) columns are hidden on 
the exported spreadsheet.

15.On the TimezoneOffset tab, type the hours manually to change the Start and End Time as 
shown below. 

Note: The time will be changed based on the Start Time (In UTC) and End Time (In 
UTC).
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16.The time on the Start Time and End Time columns are changed, as shown below.

4.8   View Export Jobs
You can access the View Export Jobs by login to Workforce Engagement Management, and 
select Quality. Now, click the menu. Select Employee Experience > Utilities > View Export 
Jobs. 
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When you click View Export Jobs, the exporter loads all active exported jobs that you can 
access in a table.

The Export Jobs window does not contain a filter window and when the page is launched it 
automatically loads the active export jobs based on your permissions. Manually deleted or 
expired jobs are not displayed.

The following table describes the columns on the Export Jobs window.

Column Description

Job Name The job name entered when saving the export job. 

Note: Job names are not unique.

DateTime Requested This is the saved date time of the export job.

Voice and Screen The Voice and Screen icons are enabled when the respective interaction is 
selected

Non Voice The Email and Chat icons are enabled when the respective interaction is 
selected.

Metadata A check mark icon to indicate that Export metadata was selected when 
saving the export job.

Evaluation A check mark icon to indicate that Export metadata and evaluation data 
where available option was selected when saving the export job; only 
selectable from the Search Evaluations Export window.

Requested By The name of the user who saved the export job.

Job ID  
(Hidden column)

The unique identifier of the export job.

Time Zone The time zone of the exported job.

Status A job can have one of four possible states. Refer to the next table for further 
information.
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The following table describes the export job states.

The export job grid supports single row selection. With each selected row, where applicable, 
you can execute the following actions.

Status Description

Pending. The export job has been received and is currently being processed.

Failed. An error has occurred processing all interactions in the export job. A detailed 
description of the failed interactions is accessible in the Details window, or you can 
contact your administrator to troubleshoot this issue.

Done. The export process has completed successfully. The export job is available for 
download.

Done with Failures. The export process has completed but some items have failed to 
export. A detailed description of the failed interactions is accessible in the Details 
window, or you can contact your administrator to troubleshoot this issue.

The export job is available for download and contains the successfully exported items.

Note: This state is not applicable to table items in the View Job Details window.

Status Description

Refresh. When you select this action, the export grid is refreshed to reflect the latest 
export job items. 

This action is always enabled.
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4.8.1   Export Details
To view the interaction details of an exported job, select (highlight) the job row item that you 
want to view and click View Details. The View Job Details window opens.

View Details. When you select this action, a window opens with a detailed view of 
each interaction in the selected export job. 

This action is always enabled.

Download. When you select this action, the selected export job downloads as a single 
compressed (Zip) file. 

This action is only available to export jobs with a status of Done and Done with 
Failures.

Delete. When you select this action, you can confirm if you want to delete the selected 
export job.

This action is always enabled.

Status Description
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Each interaction or scorecard in the exported job is an individual row item. The same states 
display in each detail row.

The following table describes the columns on the View Job Details window.

4.8.2   View Failure Details
If one of more details are in either a Failed or an Unknown state, the Information button at the 
top of the View Job Details window is enabled.

Columns Description

Channel The channel associated with the interaction. This is represented by the 
corresponding channel icon used in the (Scored) Interaction search screen. If the 
interaction channel is a Voice and Screen channel, up to 3 icons may be 
displayed in this column. This would represent each of the separated channel 
options selected when the export job was saved (for example, combined option, 
voice only option, screen only option).

DateTime The interaction date and time.

Agent The agent associated with the interaction.

Extension The extension associated with the interaction.

ANI The Automatic Number Identification (ANI) associated with the interaction.

DNIS The Dialled Number Identification Service (DNIS) associated with the interaction.

UMID The Universal Media ID (UMID) associated with the interaction.

This column is only available on Aspect Cloud™ deployments.

ScorecardID 
(hidden column)

The unique identifier of the Search Evaluation.

InteractionID 
(hidden column)

The unique identifier of the interaction. If this is a scored interaction, the same 
Interaction ID may exist across other details rows to indicate related scored 
interactions.

Status A job interaction can have one of four possible states. Refer to the states table in 
View Export Jobs on page 4-228.

Note: The Done with Failures state is not applicable to the View Job Details 
window.
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To view the information about the failed export job, click Information. The View Failure Details 
window opens.

The View Failure Details window outlines the error associated with each export detail row.

The following table describes the columns in the View Failure Details window.

Column Description

Interaction ID The unique identifier of the interaction. If this is a scored interaction, the same 
Interaction ID may exists across other rows to indicate related Search 
Evaluations.

Details This column outlines the export error that occurred against the interaction.
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4.8.3   Delete an Export Job
To delete an export job, in the Export Jobs window, select (highlight) a job row and click 
Delete. A Warning window opens. The following screen shot is an example of that Warning 
window.

On the Warning window, if you select No, the window closes and no action occurs. If you 
select Yes, the system flags the export job to be deleted and it no longer displays in the export 
job list. When you delete an export, it remains accessible for reporting purposes.

4.8.4   Download an Export Job
To download an export job, in the Export Jobs window, select (highlight) a job row and click 
Download.

Depending on your browser type, a Save as window opens, on which you can select the 
location to which the download is saved; otherwise the export job is saved to the browser’s 
Download directory.

4.8.5   Export Audit Activity Details
Export actions such as Add, Delete, Download are logged against export jobs when an action 
is carried out. These audits can be reviewed in the Audit Activity Details report.

The following is an example of an Audit Activity Detail report.
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4.9   Deleting Multiple Evaluations
This section describes the procedure to delete multiple evaluations in the Search Evaluations 
window. This feature helps the Administrator to delete one or more evaluations from the 
Search Evaluations window instead of navigating to the Evaluation window to delete a specific 
evaluation.

• If the Administrator or owner of the evaluations wants to view the details of the evaluation 
and delete a specific evaluation, select the Delete menu in the Evaluation window to delete 
the specific evaluation.

• If the Administrator wants to delete the evaluations in bulk, then define the criteria in the 
Search Evaluations window. In the Search Evaluations table, select the evaluations that 
you want to delete and click Delete.

4.9.1   Delete Evaluations in Search Evaluations Window
1. Log in to Workforce Engagement Management as an Administrator.

Note: Only the Administrator can see the Delete button in the Search Evaluations window. 

2. On the Dashboard, click Quality.

3. Under Aspect Quality Evaluation, click on Search Evaluations. After selecting the required 
criteria from Select a Date Option, Select a Channel, Select a Status and Select Criteria 
fields, the Search Evaluations window opens.

4. Define the search criteria.
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5. The user can identify the details of the evaluation from the following columns in the Search 
Evaluations table:

• Evaluation Template Name 

• Evaluation Created By

• Score

• Evaluation Status 

6. Select one or more interactions that you want to delete. 

Once the evaluations are selected in the table, the Delete button gets enabled. 

7. Click Delete. A warning message opens.
Note:

• If one or more selected interactions are Non-Protected, the following warning message 
opens. 
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• If one or more selected interactions are Protected, the following warning message 
opens.

8. To delete the evaluations, click Yes.
Note:

• If the selected interaction has only one evaluation and you delete it, the interaction is no 
longer displayed in the Search Evaluations window. You can find the interaction on the 
Search Results window.

• If the selected interaction has two evaluations and you delete one, the interaction is 
displayed in the Search Evaluations window for the existing evaluation.

• If any evaluation has Assign Coaching, then the system removes the evaluation 
reference link in the coaching that is assigned. (To check the reference, refer to step 12 
under Assign Coaching.)

9. Once you delete the evaluation, the Success window opens.

Note: The window is not refreshed automatically. Click Edit Search and search again to 
refresh the search results.

10.Click OK to close the Success window.

4.10  My Preferences
My Preferences window allows you to show inactive details of User, Agent Group, Evaluation 
Template, Application and Team in Report definition and search criteria based on the 
preference of the logged-in user. The window also shows details of Playback In Stereo, which 
means audio should be played back in stereo when it is set to Yes. 

Below is the table for all the Preferences:
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Note: When you turn on the preference, the settings apply only to you and not across the 
system.

Follow the steps below to go to My Preferences window.

1. Login to Workforce Engagement Management.

Name of the Preferences Description

Display Inactive Users in Search 
Criteria

By default, inactive Users will not be displayed in Search 
Criteria and if you wish to view them, you have to turn on the 
preference.

Display Inactive Teams in 
Search Criteria

By default, inactive Teams will not be displayed in Search 
Criteria and if you wish to view them, you have to turn on the 
preference.

Display Inactive Evaluation 
Templates in Search Criteria

By default, inactive Evaluation Templates will not be displayed 
in Search Criteria and if you wish to view them, you have to 
turn on the preference.

Display Inactive Applications in 
Search Criteria

By default, inactive Applications will not be displayed in 
Search Criteria and if you wish to view them, you have to turn 
on the preference.

Display Inactive Agent Groups in 
Search Criteria

By default, inactive Agent Groups will not be displayed in 
Search Criteria and if you wish to view them, you have to turn 
on the preference.

Display Inactive Users in 
Reports

By default, inactive Users will not be displayed in Reports and 
if you wish to view them, you have to turn on the preference.

Display Inactive Teams in 
Reports

By default, inactive Teams will not be displayed in Reports and 
if you wish to view them, you have to turn on the preference.

Display Inactive Evaluation 
Templates in Reports

By default, inactive Evaluation Templates will not be displayed 
in Reports and if you wish to view them, you have to turn on 
the preference.

Display Inactive Applications in 
Reports

By default, inactive Applications will not be displayed in 
Reports and if you wish to view them, you have to turn on the 
preference.

Display Inactive Agent Groups in 
Reports

By default, inactive Agent Groups will not be displayed in 
Reports and if you wish to view them, you have to turn on the 
preference.

Playback In Stereo By default, playback of Audio recording or Audio with Screen 
recordings will be played back in Stereo (if it is recorded as 
Stereo, else will be played back as Mono), which is depicted 
by a check-mark in the value column. If you wish to play back 
in Mono, then you can edit the preference and select “No” 
from the Edit Preference to playback as Mono (the value 
column will be blank).
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 238



Administrator Guide
2. Go to Main Menu and click on Utilities - My Preferences.

3. The MY PREFERENCES window appears.

4.10.1   Edit My Preferences
When you want to edit the value of My Preferences, follow the steps below.
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1. Select the preference row and click on the Edit  button. 

2. The Edit Preference pop-up appears. Click on the drop-down list of Value field and 
select Yes as shown below. 
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 240



Administrator Guide
3. Click on the Save button to go back to the My Preferences window and the check mark is 
shown under the Value column, as shown below.

Note: If you change the value for any preference, then all the users must log out and log 
in to Workforce Engagement Management UI to effect the changes.
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5.  Assigning Interactions

From Search Results page, a user who has the “Assign Interaction” right can assign one or 
more interactions to other users and specify an expiry date. So that the user to whom the 
interactions were assigned, now will be able to see/score the interaction. For example, when 
one of the agents in a mentor's team, who has handled the call very well and if the mentor wants 
to share the interaction with other mentors, about how the agent has done. The mentor can use 
this feature to assign interaction to other mentors. Also, when a mentor goes on vacation and if 
the mentor wants other mentors to score his/her team's interactions then he/she can share the 
selected interactions with other users as well. Refer Performing a Search for the list of 
interactions and follow the steps below to assign an interaction. 

1. Select the interaction which you want to assign.

2. Click on Interaction Menu > Assign interactions as shown below.
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3. The Assign Interactions window appears as shown below. 

Note: The fields marked (*) are mandatory fields.
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4. Click on the Select button to choose the user whom you want to assign the interaction. The 
Select Users window appears as shown below. 

The buttons on the Select Users window are described in the following table.

Button Name Description

Search Click to search for the matched user and to open the Users table.

Note: Only active users are displayed.

Add Click to open the Users table, where you can add users to the list.

Note: Only active users are displayed.

Clear Selected Remove the selected users from the list.

Clear All Remove all users from the list.
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5. Click on Add button and select the user from the list as shown below.

Note:
• To select multiple users, click Ctrl and the left click on the mouse on the user rows 

from the list.
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• From the triple-bar icon which is next to the column name, the user can narrow or filter 
the columns by changing the criteria of a particular column. The column details are 
given in the below table. 

For example, if the user wants to change the criteria for the Switch Name column, the 
Filter drop-down list displays as shown below.

6. Click OK button. The User list table closes, the Select Users window is active, and the 
user(s) you selected displays in the lower half of the window.

Column Name Description

User Name Displays user name of the user

First Name Displays first name of the user

Last Name Displays last name of the user

Switch Name • Switch name to which the user is associated.
• If the Switch is not active, then “(Inactive)” will be displayed with the Switch 

Name
• If the user is not associated with any switch, then “None” will be displayed

Role Displays Role of the user from the below list
• None
• Agent
• Mentor
• Administrator

Status Displays the status of the user

Email Address • Displays Email address of the user
• If email address does not exist, then blank will be displayed

User Profile • Displays Profile name for which the user is associated.
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7. Click OK. The Select Users window closes and the Assign Interactions window is active as 
shown below.

8. Type name (which will be used as a reference to understand what is the purpose of the 
assignment, so that it will be helpful if user wants to modify when the user has multiple 
assignments) on the Name field and select the date from the View Until field as shown 
below. By selecting the date and time, the user is able to view or listen the assigned 
interaction until the selected date and time.

9. Toggle-on the Notify User button as shown below and type any custom information which 
user wants to share with the assigning users and if user don’t want customized message 
then user can leave the default message as mentioned in the screen for the selected user(s). 
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10.Click on OK button to assign the interaction for the selected user. The assigned user will 
receive the information which you have written on the Message field through an email.

5.1   Manage Assigned Interactions and 
Evaluations

Once an interaction is assigned to the user (Refer to Assigning Interactions). The user who 
assigned the interaction and whom the interactions are assigned will be able to view the details 
about the interaction, in the Assigned Interactions and Evaluations window. To view the 
Assigned Interactions and Evaluations window, follow the steps below.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Employee Experience > Interactions > Assigned 
Interactions & Evaluations as shown below.
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3. The Assigned Interactions and Evaluations window appears as shown below.  

The buttons on the Interactions Assigned By Me tab are described in the following table. 

The available columns under the Interactions Assigned By Me tab are given below.
• Name - The name of the assignment which the user entered while creating the 

assignment
• Assigned On - The date when the interaction is assigned to the users
• Expires On - The assignment is going to expire on the date and time mentioned in the 

column. The user is able to view the interaction until that date and time
• Assigned By - The user who assigned the interaction. This column is available only 

to the Administrator. 
• Status - The status of the evaluation such as Draft or Complete.

Button Name Description

Refresh Refreshes the grid with latest changes. Instead of user click on the browser 
refresh button, user can click on this which will refresh only the grid data and 
not the page

Edit Opens the Assigned Interaction for user to edit. 

Delete To Delete an Assigned Interaction.
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5.1.1   View Interactions Assigned To Me
Click on Interactions Assigned To Me tab to view the interactions which are assigned to you as 
shown below.

The buttons on the Interactions Assigned To Me tab are described in the following table.

The available columns under the Interactions Assigned To Me tab are given below.
• Name - The name of the assignment which the user entered while creating the 

assignment
• Assigned On - The date when the interaction is assigned to the users
• Expires On - The assignment is going to expire on the date and time mentioned in the 

column. The user is able to view the interaction until that date and time
• Assigned By - The user who assigned the interaction. This column is available only 

to the Administrator. 
• Status - The status of the assignment either Active or Expired.

To view the details of interactions that are assigned as part of the assignment such as Channel, 
Direction, Type, Date Time, and so on, click on the Expand  button. The expanded view is 
shown below.

Button Name Description

Refresh Refreshes the grid with latest changes. Instead of user click on the browser 
refresh button, user can click on this which will refresh only the grid data and 
not the page

Create 
Playlist

Select one or more interactions as a group, to listen to recordings. 
Refer the Step 2 of Create a Playlist section.
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5.1.2   View Evaluations Shared With Me
Go to Evaluations Shared With Me to view the evaluations which are shared with you as 
shown below. 

The buttons on the Evaluations Shared With Me tab are described in the following table.

Note: Evaluations which are shared with you only through the "Share with specific users" will 
display here.

The available columns under the Evaluations Shared With Me tab are given below.
• Quality Score - The evaluation score in percentage
• Point Score - The evaluation score in “Total Points earned/Total Points Possible”
• Pass/Fail - The evaluation score in Pass/Fail format.
• Status - The status of the evaluation such as Draft or Complete.
• Template Name - Name of the evaluation template.
• Created By - The creator of the evaluation template.
• Created Date Time - The date and time when the evaluation template was created.
• To Review - The reviewer (such as Agent, Team, Peer) who is assigned to review the 

evaluation.
• Reviewed By Recorded Agent - The review status of the evaluation which is 

assigned to the recorded agent, a check mark will be mentioned in this column.
• Do Not Show In Report - When the evaluation is used for training purpose, a check 

mark will be mentioned in this column.
• Coaching - When coaching is required for the evaluation, a check mark will be 

mentioned in this column.

Button Name Description

Refresh Refreshes the grid with latest changes. Instead of user click on the browser 
refresh button, user can click on this which will refresh only the grid data and 
not the page

Create 
Playlist

Select one or more interactions as a group, to listen to recordings. 
Refer the Step 2 of Create a Playlist section.
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5.2   Edit an Assigned Interactions and 
Evaluations
Use the edit feature to change an assigned interaction assignment and save the assigned 
interaction assignment.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Employee Experience> Interactions > Assigned 
Interactions & Evaluations as shown below.

3. Select an assigned interaction assignment which you want to edit and click on the Edit 
button under the Interactions Assigned By Me tab as shown below. 
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4. The Edit Assigned Interactions dialog appears as shown below. 

The Edit Assigned Interactions dialog contains two tabs General and Interactions.
• General tab - From General tab, the administrator will be able to add or remove 

users, edit the name of the selected Assigned Interactions assignment, “View Until” 
date and time, “Notify User” will send notification to the selected users through an 
email. Refer to step 3 to 10 of Assigning Interactions section. 

• Interactions tab - From Interactions tab, the administrator or owner of the assigned 
interaction will be able to delete interactions which are already assigned to the 
assigned user. If administrator or owner of the assigned interaction deletes 
interactions from the Interactions tab, the selected users (in General tab) will not be 
able to view those deleted interactions. Follow the steps from Step 5 to 7, to delete 
one or multiple interactions from the Interactions tab. 
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5. Click on the check boxes of the interactions which administrator or owner of the assigned 
interaction wants to delete for the selected users, as shown below.

Note:
• Total 100 interactions will be displayed on each page.
• The Interactions tab contains the following columns.

Column Name Description

Channel The medium used to complete an interaction, such as Voice Only, Screen 
Only, Voice and Screen, Chat, Task, or Unknown.

Direction The direction of the interaction, which can be None, Inbound, or Outbound.

Type Type of the interaction, such as Outbound Direct Call, Inbound Direct Call, 
Task, ACD Call.

Date Time The start date and time of the interaction.

Duration The length of time of the interaction.

Agent The agent who handled the interaction.

Extension The extension of the agent who handled the interaction.

ANI If available from the switch, the caller ID or ANI.
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6. Click on the Delete button to delete the selected interactions and Interaction tab is shown 
below.

7. Click OK button on the Edit Assigned Interaction dialog. System will save the edited 
Assigned Interactions and display in the grid.
Note: User cannot add interactions to an existing assignment and if the user wants to do 

that the user has to create a new assignment.

5.3   Delete an Assigned Interaction
The user who created or administrator will be able to delete an assigned interaction which is 
listed on the Assigned Interactions window. Refer Manage Assigned Interactions and 
Evaluations to view the Assigned Interactions window. Follow the steps below to delete an 
assigned interaction.

1. Select the assigned interaction which administrator or owner of the assigned interaction 
wants to delete.

DNIS If available from the switch, the DNIS or DID (called number indicator).

Status The status of the interaction such as Current.

Column Name Description
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2. Click on the Delete button as shown below.

3. Select Yes to delete the assigned interaction from the grid. 

4. The refreshed Assigned Interactions window appears as shown below.
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6.  Coaching

Coaching is a feature from the Aspect Performance component of Workforce Engagement 
Management that an Administrator or Supervisor uses to improve agents performance by 
providing feedback to the agent, for example, in a computer-based training, and giving the 
agent a specific time frame in which to complete the training. 

From the Aspect Quality component, you can be reviewing an interaction (an evaluation or a 
recording), and without logging off Aspect Quality to launch Aspect Performance, you can 
create a contextual link to Performance and assign coaching directly from Quality.

6.1   Assign Coaching
To assign coaching to a new evaluation, perform the following steps.

Note: To assign coaching to an existing evaluation, see Assign Coaching to an Existing 
Evaluation on page 6-260.

1. Search for an interaction. (See the Chapter 4, Search for an Interaction.)

2. Open the interaction by double-clicking it. The Interaction window opens.

3. In the right pane, click Add Evaluation.
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The Add Evaluation window opens.

4. From the drop-down list box, select a Template.

5. Click OK. The Add Evaluation window closes and the Interaction window is active.

6. In the right pane, select the Evaluation menu.

7. From the drop-down list box, select Assign Coaching.

Note: If the Assign Coaching option is inactive, then you do not have permission to assign 
coaching. To assign coaching, you must 

• Have a Aspect Performance system configured for Workforce Engagement 
Management.

• Have a Aspect Quality Evaluation license and an Performance Coaching license.
• Be logged into Quality as a user who is also configured in Aspect Performance.
• Have the Quality agent of the interaction for whom you are creating the coaching 

mapped to Aspect Performance
• Be logged into Quality as a user who is authorized to access coaching assignments 

in Aspect Performance
• Be logged into Quality as a user who is authorized to create a coaching assignment 

in Aspect Performance
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The Create Coaching Assignment window opens.

Note: You must complete all fields marked with a red asterisk.

8. In the Agents list box, the check box next to the agent that you want to coach is selected by 
default.

9. From the KPI Filter drop-down list box, you can select from a predefined set of Key 
Performance Indicators (KPIs) that the coaching action addresses.
Note: For more information about KPIs, see the Alvaria Performance™ System 

Administrator Guide.

10.From the Action list box, you can select from a predefined list the option of the type of 
training that you want the agent to complete.

11. In the Due Date field, using the Calendar, select the date by which you want the agent to 
complete the action.

12.In the Reference Link text box, type the URL to the external source that provides the 
coaching for the agent.

Note: For more information on the Reference Link option, see the AlvariaPerformance 
Supervisor Guide.

13.In the Comment text box, you can type any other information that you think might be helpful 
to the agent.

14.Click Save. The Create Coaching Assignment window closes and the Interaction window is 
active.

15.In the right pane, select the Evaluation menu.

16.To save the coaching assignment, select Save as Draft.
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OR

If you have finished assigning the coaching, select Submit. This also saves the coaching 
assignment.

The Success window opens.

If an error occurred while saving either the coaching assignment, the evaluation 
attachments, or the evaluation comments, the following Warning window opens.

17.On the Success window, click OK.

6.1.1   Assign Coaching to an Existing Evaluation
To assign coaching to an existing evaluation, perform the following steps.

1. Search for an interaction. (See the Chapter 4, Search for an Interaction.)
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2. Open the interaction by double-clicking it. The Interaction window opens.

3. In the right pane, select the Evaluation menu.

4. From the drop-down list box, select Assign Coaching.

Note: If the Assign Coaching option is inactive, then you do not have permission to assign 
coaching. To assign coaching, you must 

• Have a Aspect Performance system configured for Workforce Engagement 
Management.

• Have a Aspect Quality Evaluation license and an Performance Coaching license.
• Be logged into Quality as a user who is also configured in Aspect Performance.
• Have the Quality agent of the interaction for whom you are creating the coaching 

mapped to Aspect Performance
• Be logged into Quality as a user who is authorized to access coaching assignments 

in Aspect Performance
• Be logged into Quality as a user who is authorized to create a coaching assignment 

in Aspect Performance
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The Create Coaching Assignment window opens.

Note: You must complete all fields marked with a red asterisk.

5. In the Agents list box, the check box next to the agent that you want to coach is selected by 
default.

6. From the KPI Filter drop-down list box, you can select from a predefined set of Key 
Performance Indicators (KPIs) that the coaching action addresses.
Note: For more information about KPIs, see the Alvaria Performance System 

Administrator Guide.

7. From the Action list box, you can select from a predefined list the option of the type of 
training that you want the agent to complete.

8. In the Due Date field, using the Calendar, select the date by which you want the agent to 
complete the action.

9. In the Reference Link text box, type the URL to the external source that provides the 
coaching for the agent.

Note: For more information on the Reference Link option, see the Alvaria Performance 
Supervisor Guide.

10.In the Comment text box, you can type any other information that you think might be helpful 
to the agent.
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11.Click Save. The coaching assignment is created and the scorecard is automatically saved 
with the coaching reference. The Success window opens.

12.On the Success window, click OK.

6.1.2   View Coaching Assignments
To view the coaching action in Workforce Engagement Management, on the Workforce 
Engagement Management dashboard, perform the following steps.

1. Click Performance.

2. Select Application > Coaching Assignments. The Coaching Assignments window 
opens.

3. Select the Team Actions. The following screen shot is an example of a coaching action.

Note: For more information about the coaching action in Aspect Performance, see 
Chapter 4: Handling and Managing Coaching in the Alvaria Performance Supervisor 
Guide.

6.2   View Coaching
Coaching is a feature from the Aspect Performance component of Workforce Engagement 
Management that an Administrator or Supervisor uses to improve agents performance by 
providing feedback to the agent, for example, in a computer-based training, and giving the 
agent a specific time frame in which to complete the training.
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From the Quality component, you can review an interaction (an evaluation or a recording), and 
without logging off Quality to launch Performance, you can also view a coaching assignment 
directly from Aspect Quality.

Similarly, from the Performance component, it is possible to launch the associated Aspect 
Quality scorecard if the Open Evaluation contextual link is accessible in the View Coaching 
window. The link is only accessible if you created the coaching assignment from Aspect Quality 
version 18.1 or later.

To view coaching, you must

• Have a Aspect Performance system configured for Workforce Engagement Management.

• Have a Aspect Quality Evaluation license and a Performance Coaching license.

• Be logged into Quality as a user who is also configured in Aspect Performance.

• Have the Quality agent of the interaction mapped to Aspect Performance

• Be logged into Quality as a user who is authorized to view the coaching assignment in 
Aspect Performance

6.2.1   View Coaching on the Search Results Window
1. Perform a search (see Performing a Search on page 4-120).

2. On the SEARCH RESULTS: ALL/SCORED window, select the interaction which has 
evaluations associated with the coaching assignment. By default, the first evaluation is 
selected in the nested grid. User can select the specific evaluation in the nested grid to view 
the specific coaching assignment.

Note: View Coaching is based on the row selection of the nested grid on the Search Results 
page and not check box selection based.
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3. click on the  button and select View Coaching to view the assigned coaching.

Note: If the View Coaching option is disable, then

• You do not have access to Aspect Performance, OR
• There is no coaching assigned to that interaction or selected evaluation, OR
• The coaching assignment was created prior to version 18.

Note: A corresponding Error message opens if you do not have permission to view the 
coaching assignment.

• The Quality agent of the interaction is not mapped to Aspect Performance
• The logged in Quality user is not authorized to view the coaching assignment in 

Aspect Performance
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The Assignment Details window opens with the Details tab active. View coaching 
assignment will open the assigned coaching in read-only mode and not allow to perform any 
coaching actions.

4. To view the Coaching Action and the Trigger, select the Additional Information tab.
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5. To view the status of the coaching assignment’s comments, select the Comments tab.

6. To view the chronological history of the coaching assignment, select the History tab.

7. Click OK to close the Assignment Details dialog.

6.2.2   View Coaching on the Search Evaluations Window
1. Search for a scored interaction. (See the Chapter 4, Search for an Interaction.) 

2. On the Search Evaluations window, select an interaction that has a coaching assigned to it.
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3. Click View Coaching.

Note: If the View Coaching option is inactive, then
• You do not have access to Aspect Performance, OR
• There is no coaching assigned to that interaction, OR
• The coaching assignment was created prior to version 18.

Note: A corresponding Error message opens if you do not have permission to view the 
coaching assignment.

• The Quality agent of the interaction is not mapped to Aspect Performance
• The logged in Quality user is not authorized to view the coaching assignment in 

Aspect Performance
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The Assignment Details window opens with the Details tab active.

4. To view the Coaching Action and the Trigger, select the Additional Information tab.

5. To view the status of the coaching assignment’s comments, select the Comments tab.
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6. To view the chronological history of the coaching assignment, select the History tab.

7. When finished viewing the coaching assignment, close the Assignment Details window by 
clicking OK.

6.2.3   View Coaching on the Evaluation or Interaction 
Windows

1. Search for an interaction. (See the Chapter 4, Search for an Interaction.) 

2. Open the interaction that has coaching assigned by double-clicking it. The Interaction 
window opens.

3. In the right pane, select the Evaluation menu.
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4. From the drop-down list box, select View Coaching. 

Note: If the View Coaching option is not available, then you do not have permission to 
view coaching.  
 
If the View Coaching option is inactive, then

• The logged in Quality user does not have access to Aspect Performance, OR
• There is no coaching assigned to that interaction, OR
• The coaching assignment was created prior to version 18, OR
• The Quality agent of the interaction is not mapped to Aspect Performance, OR
• The logged in Quality user is not authorized to view the coaching assignment in 

Aspect Performance

The Assignment Details window opens with the Details tab active.
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5. To view the Coaching Action and the Trigger, select the Additional Information tab.

6. To view the status of the coaching assignment’s comments, select the Comments tab.

7. To view the chronological history of the coaching assignment, select the History tab.

8. When finished viewing the coaching assignment, close the Assignment Details window by 
clicking OK.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 272



Administrator Guide
7.  Evaluations

This section describes about:

• Calibration

• Non-Recording Evaluations

• Email an Evaluation

• Delete an Evaluation

7.1   Calibration
While quality scoring focuses on the Agent score, calibration scoring focuses on how well 
individual Mentors’ scores align with the Master Calibrator scores, to identify issues in the 
scoring process. Aspect Quality has quality scoring, and calibration scoring uses the same 
process as quality scoring (for more information about quality scoring, see Chapter 10, Aspect 
Quality Evaluation).

Note: Any user who is a participant in a calibration event can calibrate scores.

A Mentor, called the Calibration Master, requests other users (called the Calibration Users) to 
review and score an interaction using a specified scorecard template. After a specified number 
of days, the Calibration Master compares his response to the other Mentors responses, and 
identifies any issues in the scoring process.

To perform a scorecard calibration, the steps are as follows.

1. In Aspect Quality, create or modify user profiles with the Assign Calibration Event and/or 
the View Calibration Event rights (see Best Practices for Calibration User Profiles).

2. In Aspect Via Workforce Engagement Management, Tag an Interaction for Calibration.

3. Create a Calibration Event.

4. Calibrate a Calibration Event.

5. View Calibration Event Results.

7.1.1   Best Practices for Calibration User Profiles
Use Aspect Quality to have multiple Mentors grade the same interaction, calibrating 
measurements so that users grade all resources fairly and objectively. Use the Calibration 
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option to view all mentor responses on a scorecard in the same window for comparison on a 
question-by-question and section-by-section basis.

To use the calibration feature, Aspect recommends to set up a user profile and then assign this 
user profile the rights needed for the role of assigning calibration calls. Name the user profile 
Calibration Master, and then select the Assign Calibration Event and the View Calibration 
Event check box.

7.1.2   Tag an Interaction for Calibration
If you want an interaction or interactions to be scored and calibrated, you must first tag the 
interaction or interactions. If you have the View Calibration Event and the Assign Calibration 
Event rights, you can tag an interaction for calibration. In Aspect Quality, this means you must 
be logged in as an Administrator, Mentor and Agent to tag an interaction.

Note: If you have only the View Calibration Event right, then you can see a tag created by 
other users, but you cannot edit or remove a tag. 
 
If you have neither View Calibration Event nor Assign Calibration Event rights, then you 
cannot see or create a tag for an interaction. The Action tab displays a message that 
says No actions available.

To tag an interaction for calibration, perform the following steps.

1. From the Quality dashboard, under Interaction, click Search.

2. Search for an Interaction.
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3. Select one or more interactions.

4. Create a Playlist. The Interaction window opens with the Media Player or Chat transcript 
window active.

5. In the right pane, select the Actions tab.

6. On the Actions tab, in the Name text box, type a name for the tag.

7. Click the Tag for Calibration toggle button. The interaction is tagged when the toggle 
button is green.

Note: Once you tag the interaction for calibration, you cannot edit the tag name unless you 
deselect the Tag for Calibration toggle button. 
 
You can only create one tag per interaction. 
 
If a user has tagged an interaction on which you want to create a different tag, 
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 275



Administrator Guide
contact the user who created the tag, ask the user to remove the tag, and then you 
can tag the interaction with a different name. Therefore, only an Administrator or the 
owner of a tag can remove a calibration tag for an interaction.  
 
However, if you remove a calibration tag, the calibration events created using the 
removed tag continue to display the calibration name and there is no impact to the 
calibration event. In addition, you cannot remove a calibration tag from an 
interaction that is assigned to at least one calibration event that has not yet expired.

7.1.3   Create a Calibration Event
If you are a user who has the View Calibration Event right in your user profile, and you have 
the Aspect Quality Evaluation license, then in the Quality dashboard you see the Calibration 
link.

Note: If you are a participant with View Calibration Event right, you can view the calibration 
events assigned to you.

1. Click the Calibration link. The Calibration Events window opens.
Note: If you have the Assign Calibration Event right, then the Add button is enabled.

2. Click Add.
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The Create Calibration Event window opens. In the right pane is a list of interactions that 
you tagged for calibration.

Note: To return to the Calibration Events window, click Back.

Note: All required fields marked with a red asterisk (*).

3. In the left pane, in the Title text box, type a name for the calibration event. This is a multi-
line text box that accepts a maximum of 250 characters, including alphabetical, numeric, 
and special characters.

4. From the Evaluation Template drop-down list box, select the template to assign to the 
event.
Note:

• Only the Evaluation Templates to which you (the logged-in user) have permission, 
will be displayed in the drop-down list box.

• Evaluation Templates created in Workforce Engagement Management will be 
displayed in the drop-down list box.

• Evaluation Templates saved as Draft will not be displayed in the drop-down list box.

5. In the Due Date text box, using the Calendar icon, select the due date and time of the 
calibration event (the date and time when the calibration event expires). 
Note: The due date must always be at least 24 hours greater than the current date and 

time that you are creating the calibration event.
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6. In the Select Participants section, click Select. The Select Users window opens.
Note: The Select button is active only after you select a template from the Evaluation 

Template drop-down list box.

7. To select users to participate in the calibration event, you must add them to the Select 
Users list box by clicking Select User. The Select User pop-up window opens with a list of 
users who have the View Calibration Event right, and who have permission to the template 
that you selected.

8. From the list of names, select the user(s) who you want to participate in the calibration 
event. The user name(s) appear(s) in the list box of the Select Users window.

Note:
• At the bottom of the Select Users window, Selected (X) displays, where X equals the 

number of participants that you selected.
• If an user is assigned to an inactive switch, then switch name with (Inactive) suffix 

will be displayed.

9. Click OK. The Select Users window closes, and the Create Calibration Event window is 
active.

10.By default, the Show results on completion check box is checked. 

Note: The participants will not be able to see the results until all the participants complete 
the calibration.

11. If you want all calibration event participants to receive e-mail notifying them of the required 
action, select the Notify Participants check box.
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12.In the right pane is a list of interactions that you tagged for calibration. Select the check box 
next to the interaction(s) that you want to assign to the calibration event.
Note: One hundred interactions display per page.

The following table describes the columns in the interaction pane. By default, the data is 
sorted by the Date Tagged column in descending order.

The following table describes column names that are hidden by default.

Column Name Description

Name Name of the calibration tag provided for the interaction.

Channel Displays the channel type (for example, Chat).

Direction The direction of the interaction (for example, Inbound or Outbound)

Date Time The date and time of the interaction.

Type Type of the interaction, such as Outbound Direct Call, Inbound Direct 
Call,Task, ACD Call.

Agent The Taken Agent on the interaction.

ANI The ANI of the interaction.

DNIS The DNIS of the interaction.

Date Tagged Displays the date and time that the tag was created for the interaction.

Times Used Specifies the total number of times that any user has used the interaction for 
a calibration event.

Tagged By The LastName, FirstName of the user who created the calibration tag.

Column Name Description

Duration The length of time of the interaction.

Extension The extension of the agent who handled the interaction.

Status Displays the status of the interaction (for example, Current/Historical or 
Archived).

Hold Count The total number of Holds that occurred during the interaction.

Host ID The identifier of the entity as known by the ACD or PBX.

Maximum Hold Time The maximum duration of the hold in the interaction. If there is more than one 
hold, the system identifies the maximum duration of the hold out of all of the 
holds in the interaction.

Interaction ID The ID of the interaction which is stored in the database.

Device Position If available from the switch, the Position ID of the agent on which premises 
the agent is located.

Note: The Device Position column is hidden by default.

Universal Call ID A unique Avaya ID.

Universal Media ID A unique Aspect Via ID that references a customer interaction, regardless of 
channel type.
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Note: If you want to play back the media interaction or read the Chat transcript before 
assigning an interaction for the calibration event, select the interaction by clicking 
anywhere on the row and then click Play.

Note: OR, you can double-click the row to play the interaction. 
 
The Play button is not enabled for a Task interaction. 
 
The Media Player launches. You can only play back one interaction at a time. When 
you are finished playing back the interaction, click OK. The Media Player closes and 
the Create Calibration Event window is active.

13.Save the calibration event by clicking Save.

Note: If you do not complete the mandatory fields, a window corresponding to the 
incomplete field opens.

Terminal Number The terminal number of the agent who accepted the interaction.

Recording Reason The reason for the recording. Possible values include Agent Requested, 
Team Lead Requested, and API Requested.

Task Name The Task Name which is stored in the database.

Total Hold Time The total duration of the Hold time in the interaction. For example, there are 
two Holds and each Hold had a duration of 10 seconds, then the Total Hold 
Time is 20 seconds.

Column Name Description
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The Calibration Events window opens with the event that you just created in the list.

Note: By default, the Calibration Events table is sorted by Date Created in descending 
order. 
 
One hundred records display per page.

The following table describes the columns on the Calibration Events window.

Column Name Description

Title The name of the calibration event.

Evaluation Template The template name assigned to the calibration event.

Created By The LastName, FirstName of the owner of the calibration event.

Date Created The date and time when the owner created the calibration event.

Note: The date and time are based on the time zone of the client machine 
where the owner created the event. The format is based on the 
locale.

Due Date The date and time when the calibration event expires.

Note: The date and time are based on the time zone of the client machine 
where the owner created the event. The format is based on the 
locale.

Interactions The total number of interactions assigned for the calibration event.
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7.1.3.1   Edit a Calibration Event
Only an Administrator or the owner of the calibration event can edit the calibration event. To 
edit a calibration event, perform the following steps.

1. On the Dashboard, click Quality.

2. Under Aspect Quality Evaluation, click Calibration. The Calibration Events window opens.

3. Select the calibration even that you want to edit and click Edit.

My Progress Displays the progress made by the participant when evaluating the 
interaction associated with the calibration event.
• If the progress is less than 100%, the progress bar is blue.
• If the progress is 100%, the progress bar is green.
• If the calibration event has expired, the progress bar is red.

Note: If you hover your mouse over the My Progress column, the tool tip 
displays the Overall Completion percentage.

Overall Completion Displays how many users have completed the scoring for the calibration 
event, in percentage. For example, if 1 out of 2 participants have completed 
the scoring, the Overall Completion displays 50%.

Status Indicates the status of the calibration event with icons. The following list 
describes the values for this column.
• Not Started - When the calibration event is created and no participants 

have scored any of the interactions.
• In Progress - When any one of the participants submit scores for any 

ones of the interactions in the calibration event.
• Completed - When all participants have finished scoring all interactions 

under the calibration event.
• Expired - When a calibration event completion date has passed.

Column Name Description
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The Edit Calibration Event window opens.

4. You can edit the following fields.

• Due Date

Note: If you extend the due date for a calibration event that has expired, the Status of 
the event is updated to Not Started or In Progress or Completed, accordingly.

• Select Participants

• Show results on completion
Note: If you uncheck the check box, the participants will be able to view the results 

before all the participants complete the calibration.

• Notify Participants

5. Click Save.

7.1.3.2   Delete a Calibration Event
Only an Administrator or the owner of the calibration event can delete the calibration event. 
You can only delete calibration events that have expired.

To delete a calibration event, perform the following steps.

1. On the Dashboard, click Quality.

2. Under Aspect Quality Evaluation, click Calibration. The Calibration Events window opens.
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3. Select the row of the calibration event that you want to edit.

4. Click Delete.

The following Warning window opens.

5. To delete the calibration event, click Yes. The calibration event is removed from the 
Calibration Events window.

7.1.3.3   Duplicate a Calibration Event
If you want to copy a calibration event, you must have access to the calibration event and the 
Assign Calibration Event right.

To duplicate a calibration event, perform the following steps.

1. On the Dashboard, click Quality.

2. Under Employee Experience > Evaluations > Calibration. The Calibration Events 
window opens.

3. Select the row of the calibration event that you want to copy.

4. From the menu icon, select Duplicate.
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The Create Calibration Event window opens.

5. In the Title text box, type a name for the copied calibration event.

6. The copied Evaluation Template displays, but you can select a different template from the 
drop-down list box.
Note: If you change the Evaluation Template, and the selected participants in the copied 

calibration event do not have permission to the template that you selected, the 
Selected number changes.

7. In the Due Date text box, click the Calendar icon and select a date that is 24 hours greater 
than the current date and time of the client machine.

8. If you want to change the participants on the calibration event, click Select and add or 
remove the participants as appropriate.

9. Check or uncheck the Show results on completion check box as per the requirement. 

10.Based on the copied calibration event, you may want to select or deselect the Notify 
Participants check box.

If the aggregate user is logged in to Workforce Engagement Management and is 
duplicating the calibration event, the Created By name displays.

The Interaction(s) is (are) copied and enabled. You can assign the same interaction(s) for 
the calibration event, or you can assign a different set of interaction(s) for the new event.

11.After making the necessary changes, click Save. The new calibration event displays in the 
Calibration Events list.
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7.1.4   Calibration Event Email
When a user creates a calibration event and selects participants to score interactions to be 
calibrated, the user can choose to notify participants by email. Once the user saves the 
calibration event, an email is distributed to the participants.

Note: If the creator of the calibration event or any of the participants selected to score the 
interaction does not have an e-mail address configured, then a message displays, 
asking you to configure that e-mail address. However, e-mail is not sent only if the 
creator does not have an e-mail address configured in their Aspect Quality user 
account.

As an e-mail recipient, click the link in the e-mail, which takes you to the Calibration Events 
window where you can evaluate the interaction that is assigned to the calibration event. To 
score an interaction to be calibrated, see Calibrate a Calibration Event.

7.1.5   Calibrate a Calibration Event
Once a user has created a calibration event, the following steps must occur.

• The selected participants receive an e-mail with a link to the calibration event (see 
Calibration Event Email).

• The participants score the interactions. To score interactions that are tagged for calibration, 
see Score a Calibration Event.

• Finally, the creator of the calibration event views the progress of the interaction scores and 
when the calibration event is complete, the creator can interpret the results.

7.1.5.1   Score a Calibration Event
You may have received an e-mail asking you to score a calibration event (see Calibration 
Event Email). If so, click the link in the e-mail and the Calibration Events window opens.

1. On the Calibration Events window, from the list of calibration events, select row of the 
calibration event that you want to score.
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2. From the menu icon, select Calibrate.

The Calibration window opens with the Evaluation tab active, with the first interaction 
selected in the playlist table, and the media player loads with that first interaction for 
playback.

Note: If the interaction is a Chat, the Transcript player opens. In the following example, the 
interaction is an audio and screen recording.

Note: To return to the Calibration Events window, click Back. If you opened the Calibration 
window by clicking on the link from the calibration email, the Back button does not 
display.

Above the Evaluation tab are fields that are described in the following table.

Column Name Description

Title The name of the calibration event.

Agent The name of the Taken Agent for the selected interaction.

Date Time The date and time of the selected interaction.

Evaluation Template The name of the template that the creator of the calibration event selected for 
the participant to use to score the interaction to be calibrated.
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3. Listen to and/or watch the recording and using that information, in the Evaluation tab, 
respond to the questions in the Answer column.

Note: The Status of the respective interaction is on the right; in the example above, the 
interaction status is Draft.

When you click Information, an Information box opens.

The following table describes the details in the Information box.

Field/Column Name Description

Evaluation Template The name of the evaluation template used in the calibration event.

Created By The logged in user. The username appears in the Lastname Firstname 
format.

Created On The date and time when the calibration evaluation is created.

Note: The date and time appear only when the calibration evaluation is 
saved. This field displays N/A if the calibration evaluation is not 
saved even once.
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4. If there is more than one interaction in the playlist, double-click the next interaction and 
respond to the questions in the Evaluation tab. 

Note: To complete the calibration event, you must score all interactions in the calibration 
event.

5. Once you have finished scoring the interactions for the calibration event, you must submit it 
for calibration by clicking the Evaluation menu and selecting Submit.

Note: If you have not finished scoring the calibration and want to complete it at a later 
time, you can select Evaluation>Save as Draft. Until the evaluation is submitted, 
the Calibration Results window does not include the evaluation in the Score or 
Standard Deviation. 
 
The Evaluation menu items are enabled or disabled based on the calibration event 
status. The following table describes the conditions.

Note: When the interaction is scored, the status is Draft. 
When the calibration event is submitted, the status is Complete with Actual Score.

Last Modified On The date and time when the calibration evaluation was last modified.

Note:
• This field appears only after the calibration evaluation is saved. If the 

calibration evaluation is not saved even once, this field will not appear.
• This field displays the date and time when the calibration evaluation is 

modified at least once, else it displays N/A.

Menu Item Description

Print Evaluation Enabled only when the evaluation is submitted.

Cancel Enabled when evaluation is in Create/Edit mode.

Edit Evaluation Enabled when evaluation is saved and opened in Read-Only mode.

Save as Draft Enabled in Create/Edit mode only when the evaluation has not been 
submitted; disabled when the evaluation is submitted.

Submit Enabled in Create/Edit mode.

Field/Column Name Description
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7.1.5.2   Calibration Event Progress and Status
On the Calibration Events window, in the table, you can view the progress (including an overall 
completion percentage) and status of the calibration events assigned to you, or that you 
created.

The My Progress column displays the progress made by the participant when evaluating the 
interaction associated with the calibration event.

• If the progress is less than 100%, the progress bar is blue.

• If the progress is 100%, the progress bar is green.

• If the calibration event has expired, the progress bar is red.

Note: If you hover your mouse over the My Progress column, the tool tip displays the overall 
complete percentage, which is also visible in the Overall Completion column.

The Status column displays the status of the calibration event with icons. The following list 
describes the values for this column.

• Not Started - When the calibration event is created and no participants have scored any of 
the interactions.

• In Progress - When any one of the participants submit scores for any ones of the 
interactions in the calibration event.

• Completed - When all participants have finished scoring all interactions under the 
calibration event.

• Expired - When a calibration event completion date has passed.
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7.1.6   View Calibration Event Results
To view a calibration event result, you must be either the owner of or a participant in the event; 
you can view results regardless of the status of the event.

You can view calibration event results by performing the following steps.

1. On the Calibration Events window, select an event.

2. Click the menu button, and select View Results. 

The Calibration Results window opens with the Summary tab active.

Note: To return to the Calibration Events window, click Back.
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3. Go to the By Question tab and the questions related to the calibration event are listed as 
shown below.

4. To view the dependent questions and the reviewer, click on the drill-down. 
Example: 

a. Here, Q1 has a dependent question and it has Yes/No option, so click on the drill-down 
button as shown below. 
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The options related to the question appears and click on the drill-down button to view 
the reviewer as shown below.

b. The Q2 does not have any dependent question, so click on the drill-down button to view 
the reviewer details as shown below.

c. For any free form questions, the reviewer responds to the question and the response 
will be shown on the grid as shown below.

Note: When multiple reviewers are provided any responses, then the responses will be 
shown in multiple rows.
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7.1.6.1   Calibration Events Summary Tab
The following table describes the fields above the Summary tab.

The following table describes the columns on the Summary tab, which displays for 
interactions that are assigned to the selected calibration event, along with the scores 
completed by each user.

Field Description

Calibration Event The name of the selected calibration event.

Evaluation Template The name of the evaluation template assigned to the selected calibration 
event.

Number of Interactions The total number of interactions assigned to the selected calibration event.

Number of Participants The total number of users assigned to score the selected calibration event.

Overall Average Score The average score of all the participants for all the interactions scored. The 
formula used is 

[Total Point Score of each User/Total Max Possible Score of each User]*100

For example, User1 scored Interaction1 as 50 and Interaction2 as 100; 
User2 scored Interaction1 as 75 and Interaction2 as 50. The overall average 
score is [(50+100+75+75+50)/(100+100+100+100)]*100 = 68.75%.

Overall Standard 
Deviation

The formula used to calculate the overall standard deviation is:

For example, User1 score is 100 and User2’s score is 0, then 100,0 is used 
for the Standard Deviation formula, and the result is 70.71 (rounded to the 
nearest 100th decimal point).

Column Name Description

Interaction Interactions that are tagged for calibration.

Channel Displays the channel icon (for example, Voice, Voice and Screen, Screen 
Only, Chat, or Task).

Calibration Participants The user name of each participant displays in a separate column. Each user 
column contains the calibration score for the respective interactions.
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7.1.6.1.1   Play an Interaction from the Summary Tab
If you want to play an interaction while viewing calibration results on the Summary tab, select 
the interaction and click Play. The Media Player opens and loads the selected interaction.

Note: You cannot click Play when the interaction is a Task.

To close the Media Player and return to the Summary tab, click Close.

Average Score The average of evaluated score by user for the respective interaction. All 
scores display in percentage.

Note: If the template scoring type is Total Points or Pass/Fail, then scores 
convert to percentage, and display here. 
 
The interactions overall score displays here.

For example, User1’s score is 100 and Interaction2 as 100; User2’s score is 
0, then the average score is [(100+0)/(100+100)]*100 = 50%.

# of Evaluations 
Completed

The number of evaluations scored and completed for the respective 
interaction.

Note: If the scored evaluation is in Draft mode, it does not count as a 
completed evaluation.

Standard Deviation The standard deviation formula is

For example, User1 score is 100 and User2’s score is 0, then 100,0 is used 
for the Standard Deviation formula, and the result is 70.71 (rounded to the 
nearest 100th decimal point).

Column Name Description
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7.1.6.2   Calibration Events By Question
Click the By Question tab.

The following table describes the main header columns on the By Question tab.

Column Name Description

Section The name of the section.

Average Score The average of the section. All scores display in percentage.

Note: If the template scoring type is Total Points or Pass/Fail, then scores 
convert to percentage, and display here.

[Total Point Score of Section/Total Max Possible Score of Section]*100

For example, User1’s score for Section1 is 100 and Section2 is 0, then the 
average score is [(100+0)/(100+100)]*100 = 50%.

Standard Deviation The standard deviation formula is

For example, User1 score is 100 and User2’s score is 0, then 100,0 is used 
for the Standard Deviation formula, and the result is 70.71 (rounded to the 
nearest 100th decimal point).
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The following table describes the Question sub-section columns on the By Question tab.

The following table describes the columns in the sub-section under Question.

If an option contains dependent questions, then another table displays under the Option sub-
section. The following table describes the columns in the table.

Column Name Description

Question The question itself.

Number of Responses The number of responses to the question, including any N/A response.

Average Score Average score of the section, displayed as a percentage, including if the 
question is a Point Score or a Pass/Fail question. The formula used is 

[Total Point Score of each User/Total Max Possible Score of each User]*100

For example, User1’s score for Question1 is 100 and Questtion2 is 0, then 
the average score is [(100+0)/(100+100)]*100 = 50%.

Standard Deviation The standard deviation formula is

For example, User1 scored Question1 as 100 and Question2 as 0, then 
100,0 is used for the Standard Deviation formula, and the result is 70.71 
(rounded to the nearest 100th decimal point).

Column Name Description

Option The type of option (for example, Pass/Fail) for the question.

Number of Responses The number of time that the option is selected by a user.

Response % The percentage of the responses for the option, based on the users assigned 
to that calibration event. The formula used for this percentage is

[Number of Responses for that option/Total number of responses for that 
question]*100

Column Name Description

Dependent Question The name of the dependent question.

Number of Responses The number of responses to the question.

Average Score Average score of the section, displayed as a percentage, including if the 
question is a Point Score or a Pass/Fail question. The formula used is 

[Total Point Score of Question for each User/Total Max Possible Score of 
Question for each User]*100

For example, User1’s score for Question1 is 100 and Questtion2 is 0, then 
the average score is [(100+0)/(100+100)]*100 = 50%.
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7.1.6.3   Export Results Data to Excel
If you want to export the content of the Summary tab or the By Question tab to Excel, then on 
the tab from which you want to export the data, click Export to Excel.

The following screen shot is an example of the data in an Excel spreadsheet.

7.1.7   Delete a Calibration Event
This section describes how to delete a calibration event in Workforce Engagement 
Management.

1. Log in to Workforce Engagement Management as an Administrator.

2. From the Dashboard, click Employee Experience.

Standard Deviation The standard deviation formula is

For example, User1 scored Question1 as 100 and Question2 as 0, then 
100,0 is used for the Standard Deviation formula, and the result is 70.71 
(rounded to the nearest 100th decimal point).

Column Name Description
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3. Under Evaluations, click the Calibration link.

The Calibration Events window opens.
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4. In the list, select the calibration event that you want to delete. Select the delete button as 
highlighted in the below image.

5. The Warning Message appears to confirm the deletion.

6. Select Yes to delete the Calibration event.

7. You can also delete the Calibration evaluation from the Calibration Menu, as given below.
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a. From the Calibration menu, select the Calibrate option.

The Calibration window opens with the Evaluation tab active in the right pane.

Note: You can only delete a calibration evaluation if the calibration event is not expired. 
 
The Delete option is enabled once the user completes the calibration evaluation for 
the calibration event; otherwise the Delete option is disabled. 
 
Clicking Delete only deletes the calibration evaluation for the logged-in user.

b. From the Evaluation menu, click Delete.
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A Warning window opens.

• If the calibration event has, for example, two interactions, and user scored both 
interactions, then the My Progress window displays 100%. However, when a user 
deletes one evaluation that the user scored, then the My Progress window displays 
50%.

• If the Status is Expired, the user cannot delete the calibration evaluation.

• If the Status is In Progress, the Status continues to display In Progress

• If the calibration event has, for example, two (2) interactions, the user scored both 
interactions, the event is assigned for two (2) users, then when the second user has 
completed both evaluations, the Overall Completion displays 50% - 1 of 2 Participants.

• On the View Result window, the system generates the results (Averaged Results) by 
excluding the deleted evaluation.

7.2   Non-Recording Evaluations
Non-recording evaluation are evaluations that are not associated with a media file. For 
example, if you want to evaluate back office work, then you can create and use a non-
recording evaluation.

The Administrator role can create a non-recording evaluation. You can assign Mentors and 
Agents the ability to create a non-recording evaluation by assigning the Create a Task right to 
the Mentor’s or Agent’s user profile.

Some examples of when a user creates a non-recording evaluation are: 

• Back-office employee work that does not have an associated recording in Quality.

• Third-party recordings where recorded files can reside in another system, and Mentors or 
Administrators use Quality for quality scoring purposes only.

• General coaching, agent feedback forms, and periodic rolled-up scorecards (for example, 
monthly, quarterly, or annual scorecards) where the evaluation corresponds to many 
contacts (not tied to a single interaction).

• The system may or may not record the non-recording evaluation that the Agent performs 
as it occurs, but the Mentor or Administrator still can score the Agent’s task.

This section describes how to create and edit non-recording evaluations.
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7.2.1   Task Management
This feature allows the user to define the custom information which is required to manage 
during the creation of Non Recording Evaluation (Task) in WEM.

Note: Either a Admin or Mentor who has the Task Management right turned on in their user 
profile, can manage the Task Management.

Follow the below mentioned steps to create task management.

1. Login to WEM.

2. Navigate to main menu > Administrator > QM Evaluation > Task Management link
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Toolbar Buttons

3. Click on “+” (Add) button to add existing or new custom information key to the task 
management.

4. By default, “Use Existing Key” radio button will be selected. With this option the user can 
add the existing custom information key to the task management.

5. Click on the Search button to see all the active custom information existing in the system.

Note: Existing custom information can be searched by providing the starting text of the 
custom information in the search text box.

Button Name Functionality

Refresh Refreshes the task management grid with the latest data

Add Allows to add new or existing custom information key to the task 
management

Edit The Edit button will be enabled only for the newly added keys. For 
existing custom information keys, the edit button will be disabled

Activate Activates the selected row

Decactivate Deactivates the selected row
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6. Select the custom information and click on OK button.
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7. Click on the OK button.

8. The existing custom information key gets added to the task management as shown in the 
below screenshot.

If you want to add a new custom information that does not exist in the system, follow the steps 
below.

1. Click the Add button.

2. Select “New Manual Key” radio button. Text box will be enabled.

3. Enter the custom information key name and click on OK button
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 306



Administrator Guide
4. The new custom information key gets added to the task management.

Task Management grid will display as explained below;

Note: Maximum of 10 active line items can be created using existing or new custom 
information keys. Clicking on Add button after adding 10 active task managements will 
show information message.

Column Name Description

Custom Information Name Name of the custom information key

Created By The user who added the task management

Created Date The date and time when the Custom Information is associated for 
Task created

Manual • This column specifies if the custom information key is an existing 
one or it is added newly.

• Tick mark indicates newly added custom information key

• Blank value indicates it is an existing custom information key

Active This column indicates if the task management is active or inactive
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5. The custom information key name newly added can be updated by the user by clicking on 
“Edit” button. The custom information which is added by selecting the “Existing Key” will not 
be allowed to Edit.

6. The user can Activate/Deactivate the line items by clicking on Activate/Deactivate buttons.

7.2.1.1   Create Non Recording Evaluation and associate 
custom information key

1. Click on main menu > Employee Experience > Evaluations > Non Recording evaluation link

2. Create Task dialog will be displayed with the active custom information keys added to the 
task management.
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3. Manager or Agent can create Non Recording Evaluation by entering the custom 
information value required for the custom information key to assign to an task.
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4. Enter the task name, select the user to create task (taken agent), enter the custom 
information value in the required custom information field and Click on OK button.

5. Click on Add evaluation button and select a template, select a valid answer for the template 
question and submit the evaluation.

6. Task gets created and the custom information key values entered will be displayed under 
“Details” tab.
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Note: User can search for the Non Recording evaluation (Task) by adding the custom 
information search criteria.
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7.2.2   Create a Non-Recording Evaluation
This section describes how to create a non-recording evaluation in Workforce Engagement 
Management

1. Login to Workforce Engagement Management.

2. Click Quality.

3. Select Employee Experience > Evaluations > Non-Recording Evaluation.
Note:

• The Non-Recording Evaluation link only displays if the logged-in user has the 
Evaluation license.

• The user must have rights to create a task in the User Profile. Refer to Navigate Aspect 
Quality

The Create Task dialog appears.

4. Enter the Task Name. The Task Name is an optional field.
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5. Go to right-hand side of the Agent’s field and click on the Search button to get list of 
agents. Click on Yes to get the entire list of agents and click on No to search agents based 
on User Name, First Name, and Last Name.

Note: If the Agent is not selected, the logged-in user is considered as Agent.

6. The user is able to search agents based on the following fields

Role Description

Administrator All the users associated with teams should be displayed.

Mentor Based on team permission, associated user should be displayed. 

Agent Only the logged in user will be displayed always.
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7. Select the user from the search grid as shown above.  
Example:- 2127 is selected from the search grid, is taken agent.
Note: If an user is assigned to an inactive switch, then switch name with (Inactive) suffix 

will be displayed.
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8. Click on OK button. The Evaluation window appears and the Start Time is mentioned at 
the right-hand corner of the Evaluation window. 
Note: First time when the task is clicked called Start Time.

9. Click on Edit button to edit Task Name and Agent.

10.Edit the Task Name and Agent and click on OK button.

11.Click on Add template button as shown below.
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The Add Evaluation window opens.

12.From the Template drop-down list box, select a template that you want to use to evaluate 
the work.

Note: By default, the list of templates are sorted based on the Names in the ascending order.

13.Click OK. The Add Evaluation window closes and the Evaluation window is active with the 
Evaluation tab open and updated with evaluation details. Also, the Evaluation drop-down 
list box displays the evaluated User Name and Template Name.
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14.Select the options for the questions and Submit the evaluation.

15.Save the evaluation as a draft, or submit it.

• To save the evaluation for further modification, from the Evaluation menu, select Save 
as Draft.

Once the system finishes saving the evaluation, the Success window opens.

Click OK. The Success window closes, the Evaluation window is active and displays in 
Edit mode, so that you can continue to modify the evaluation.

OR
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• If you are finished evaluating the work, from the Evaluation menu, select Submit. Once 
the system finishes submitting the evaluation, the Success window opens.
Click OK. The Success window closes, the Evaluation window is active and displays in 
Read Only mode.

16.Go to Details > Interaction Details to view the Task Name field as shown below.

Note:
• When the user click on Non-Recording Evaluation, the last successfully saved task 

details will pop-up automatically. 
• The Task Name and the selected Agent will be the same until the user logout.

7.2.3   Email an Evaluation
Administrators or the owner of an evaluation can prompt urgent reviews by emailing a link to 
the evaluation directly to the agent who needs to review the evaluation. When the recipient 
clicks the link in the email, the evaluation opens for immediate review of the comments.

Note: To email an evaluation, the following requirements must be met:
• The Email Evaluation option is active and available only if the mail server is correctly 

configured (see the Alvaria Quality Server Installation Guide to configure the SMTP 
Mail Server in the Interaction Monitor process).

• The Email Evaluation option is active if you configure the mail ID for the logged-in 
user (see the Alvaria Quality Server Installation Guide to configure the logged-in 
user on the User Definition window).

• The option is active when the Interaction window loads with an accessible 
evaluation.

• If you create the evaluation but have not saved it to the database, the Email 
Evaluation option is inactive.

To email an evaluation, perform the following steps.
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1. Search for an interaction (see the Search for an Interaction on page 4-120).

2. From the Search Results window, double-click the interaction that you want to email for 
review. The interaction loads in the window.

3. From the Evaluation menu, select Email Evaluation.
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The Email Evaluation window opens with the interaction’s agent’s email address in the To 
field.
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4. Click Select. The Select Email Addresses window opens.

5. To include more addressees in the Email, in the Search Items text box, type the first name, 
last name, or Email ID of the person you want to add. 

6. Click Search.
Note: If you click Search without entering anything in the Search Items text box, a Warning 

message opens, stating, Your Search may return a large number of items. Do you 
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want to proceed? If you click Yes, e-mail Names and addresses display in the list 
box.

The table contains the following columns.

Column Name Description

Name Display the user’s name in the format Lastname, Firstname.

Email Displays the corresponding Email ID of the user in that row.
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The table displays 100 records per page. Use the pagination buttons below the table to 
move to the next page, previous page, first page, or last page.
Note: By clicking the triple bar next to the specific column name, you can sort (ascending 

or descending), add, remove, or filter the columns; you can also clear all filters.

The following table describes the accessible Email IDs for the logged-in user.

Note: Inactive user details do not display in the table.

Logged In User Search Results

Agent System retrieves the details of the mentors associated with the agent’s team 
and whose Email IDs are configured in the system.

If the user is not associated with any team, then the system does not return 
any email IDs.

Mentor System retrieves the details of all the members of the mentor’s team, and all 
the mentors in the system whose Email IDs are configured in the system.

Administrator System retrieves the details of the all the users whose Email IDs are 
configured in the system.
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The following table describes the buttons below the Search Items field.

Note: At the bottom of the window, next to the word Selected, the system displays the total 
number of e-mail addresses that you added to the detail list box. For example, in the 

Button Icon Button Name Description

Add Adds the first matching Email address if the 
user typed in a search phrase in the search 
text box, or if the system selects the first 
accessible Email ID.

Add All Adds all the Email addresses based on the 
search text specified. If you do not specify 
any text, then the system adds all the 
accessible Email IDs.

Clear Selected Removes the selected Email address. This 
button is enabled only if the detail list text 
box has at least one email address.

Clear All Removes all the Email address in the list. 
This button is enabled only if the detail list 
text box has at least one Email address. 
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following screen shot, the user added five (5) e-mail addresses. Therefore, the label 
displays Selected (5). This number persists in the Email Evaluation window.

7. To add a user’s email address to the email, select the row and click OK.
Note: Alternatively, you can double-click the row to add the user’s email address. 

 
Click Cancel to close the Select Email Addresses window without adding the Email 
addresses to the email.
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The Select Email Addresses window closes and the selected Email Evaluation window 
opens with the Selected button displaying the number of email addresses that you 
selected.

Note: If you are entering the e-mail recipients manually (that is, if you do not select the 
Include All check box as described below, in step 8), then the total number of emails 
between the To and the Cc fields cannot equal more than 100.
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8. To add all accessible e-mail IDs (“all emails” is a number of emails that your organization 
determines), select the Include All check box. The Selected field displays Selected (All).

Note: Once you select the Include All check box, the Select button is inactive.

9. Click Send. The system sends the e-mail to all the e-mail addresses that you added to the 
Cc list.

7.2.4   Delete an Evaluation
This section describes how to delete evaluation in Workforce Engagement Management.

1. Log in to Workforce Engagement Management as an Administrator.

2. On the Dashboard, click Employee Experience.
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3. Under Evaluation, click the Search Evaluations.

Note: The Search Evaluations link is displayed only if the logged-in user has the 
Evaluation license.

After selecting the required criteria from Select a Date Option, Select a Channel, Select a 
Status and Select Criteria fields, the Search Evaluations window opens.
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4. Double-click on the evaluation that you want to delete. The evaluation opens.

5. In the right pane, select the Evaluation tab.

6. On the Evaluation tab, click the Evaluation menu.

The Delete option on the Evaluation menu is enabled when the logged-in user is one of the 
following:

• An Administrator

• A Mentor and the owner of the evaluation
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• An Agent and the owner of the evaluation
Note: If the logged-in user is not the owner of the evaluation, then the Evaluation menu 

tool tip displays the message, You don’t have access to delete this evaluation.

7. From the Evaluation menu, click Delete. A Warning window opens.

If the interaction is not protected, the Warning window displays, Are you sure you want to 
delete this evaluation?

If the interaction is protected, the Warning window displays, This interaction is protected. 
Are you sure you want to delete this evaluation?

8. To delete the Evaluation, click Yes. The system deletes the evaluation and the associated 
annotations and attachments.

Note: If there is more than one evaluation for the same interaction, the Interaction window 
loads the next available evaluation details. 
 
If any evaluation has Assign Coaching, then the system remove the evaluation 
reference link (if it exists) in the Coaching that is assigned.
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8.  Reporting in Workforce Engagement 
Management

This chapter describes how to save a report, view a report, run a report and the available 
reports in Aspect Quality™ with Workforce Engagement Management. 

• Accessing Reports on page 8-333

• Save a Report on page 8-334

• Edit a Report on page 8-375

• View a Report on page 8-380

8.1   About Aspect Quality™ Reports
Using Quality, you can view quality data for individuals and evaluation templates. Information 
displays in tabular-style reports between which you can navigate the data.

You can generate the following reports in Quality.

• Save a Report on page 8-334

Note: You can access Quality reports if you are a user with Administrator or Mentor privileges 
(the user must have Create Report right in his user profile to add a new report) in 
Workforce Engagement Management. For a Mentor to report on agents, the Mentor 
must have permissions to those specific teams and agents. 
 
The Evaluation Detail report and the Quality Score Trend report only display data for 
interaction records. If the system Archiver process automatically deletes interaction 
data, or if a user manually deletes it, then the data is no longer available for reports. 
As you navigate through the Workforce Engagement Management application, the 
system remembers the last report search criteria that you entered and loads it, only for 
the lifetime of the browser session.

Note: The above applies only to the Evaluation Detail Report and Audit Activity Detail 
Report. Now, the Quality Score Trend report is able to save the report in the 
database.
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8.2   Accessing Reports
You can navigate to any of the Reports by performing the following steps:

1. Log in to Workforce Engagement Management as an Administrator or a Mentor.

2. Go to Navigation bar and click Employee Experience and then click Reports.

3. To complete the filter criteria for the report which you want to access, click on Scheduled 
Reports or Ad Hoc Reports. 

• Scheduled Reports - When the user wants to generate a report or view an existing 
Scheduled Report on a scheduled time such as One Time, Daily, Weekly and Monthly, 
then select Scheduled Reports. The Aspect Quality system generates the report based 
as per the scheduled time.  
Example: The user wants to check daily report. So, if the user enable schedule and set 
the Date Type as Daily, the Aspect Quality system generates the reports on daily basis. 

• Ad Hoc Reports - When the user wants to generate a report manually, then select Ad 
Hoc reports.

• Scheduled Reports and Ad Hoc Reports contain the Quality Score Trend report type. 

4. The Reports window appears which consists the Scheduled Reports and Ad Hoc Reports 
tabs. The tab is highlighted based on the selected reports type such as Scheduled Reports 
or Ad Hoc Reports. The Reports grid consists of the columns listed on the following table.

Column Name Description

Name The name of the report.

Description The description of the report.

Report Type The report type is mentioned in this column.

Created Date Time The date and time when the report was created.

Created By The creator of the report.
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8.3   Save a Report
To saving a Report (regardless of you are in the Scheduled Reports tab or Ad Hoc Reports tab 
in the Reports window) follow the steps below.

1. Click on the Add button.

2. Add Report window appears. By default, the General tab will be selected as shown below. 

8.3.1   General Tab
1. Under the General tab, type a unique name for the report in the Name field.

2. Add description (if required) of the report in the Description field.

Last Run Date The date and time when the report run last time.

Last Run By The name who runs the report last time.

Schedule If the report is scheduled for daily, weekly, monthly.

Note: This column is applicable only for the Scheduled Reports.

Start Date The date when the scheduled report was started.

Note: This column is applicable only for the Scheduled Reports.

End Date The date when the scheduled report will be ended.

Note: This column is applicable only for the Scheduled Reports.

Next Scheduled Date The next date of the scheduled report.

Note: This column is applicable only for the Scheduled Reports.

Status The status such as Success or Failed.

Active If the report is active then check mark will be shown on the column.

Column Name Description
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3. Click on the drop-down list of the Report Type field. The listed Report Types are Audit 
Activity Detail Report, Evaluation Details Report, Quality Detail Report and Quality Score 
Trend Report.

Note: All fields marked with a red asterisk (*) are required.
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8.3.1.1   Audit Activity Detail Report
Select the Audit Activity Detail Report to review activities logged for users/system over a 
specific date range.

1. Select the Date Options from the drop-down list. To choose any date range based on your 
requirement or click on Custom Date Range. If you select Custom Date Range, the From 
and To fields are enabled. 

2. Choose the date and time range on From and To field. To select date, click on  icon, and 
to select time, click on  icon.
Note: If you have selected Custom Date Range, then the date range must be within the 

last four years.

3. By default, the Time zone is selected based on your location. To change the Time zone, 
click on the drop-down and choose your required time zone.

4. Click on the System Audit or User Audit or both as per your requirement.
Note: If you select System Audit, the remaining fields such as Teams, User From Selected 

Teams will be disabled.

5. After selecting the User Audit, the Teams button will be enabled. 

6. Under Teams, click Select. The Select Teams window opens.
Note: The user can click on Include All check box to include all the teams or else click on 

Select button to add specific teams.
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7. Click on the  icon in the Search Items field, and select Yes. A window opens with a list 
of available teams.

8. Search for a team in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available teams. Active teams display in the list box, and the 
table is, by default, sorted in ascending alphabetical order.

Note:
• To include all of the teams, click on Include All check box. 
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• If you are logged in as an Administrator, you can search for and select any of the 
teams.

• If you are logged in as a Mentor, you can only search for and select teams for which 
have either Score/Review permission in your user profile.

• By default, only Active teams will be displayed. Refer to Edit My Preferences on 
page 4-239, if you would like to see the Inactive teams along with the Active teams in 
the reports.

9. After selecting the teams, the Users From Selected Teams field will be enabled. 

10.Click on the  icon in the Search User(s) field, and select Yes. A window opens with a list 
of available users.

11.Select the user as per your requirement and click OK.

8.3.1.2   Evaluation Details Report
Select the Evaluation Details Report to review the details of the evaluation template. This 
report provides the details of an evaluation template in section, Questions and dependent 
hierarchy such as Question Type, Point Earn, Points Possible and Success Rate. Under 
Report Type, when you select Evaluation Details Report, the below screen appears.
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1. Click on the Report View drop-down and select Interaction or Evaluation.
Note: For more information, click on the Info button for Interaction as shown below.  

For more information, click on the Info button for Evaluation as shown below.

2. Select the Report By drop-down list and select Agent or Reviewer. Select the Agent option 
to display the scores grouped on the basis of agents, where as Reviewer option will display 
the scores grouped on the basis of reviewer. By default the system selects the Reviewer as 
an option. User can change the default option, based on the requirement.

3. Select the Date Options from the drop-down list. To choose any date range based on your 
requirement or click on Custom Date Range. If you select Custom Date Range, the From 
and To fields are enabled. 

4. Choose the date and time range on From and To field. To select date, click on  icon and 
for time,  icon.
Note: If you have selected Custom Date Range, then the date range must be within the 

last four years.

5. By default, the Time zone is selected based on your location. To change the Time zone, 
click on the drop-down and choose your required time zone.

6. Under the Evaluation Template field, click on the  icon in the Search Items field, and 
select Yes. A window opens with a list of available templates.

Active templates display in the list; see the Status column. Select the template as required. 
Note:

• Select only one template at a time.
• If you are logged in as an Administrator, you have access to all templates.
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• If you are logged in as a Mentor, you have access to templates based on how the 
evaluations assigned to you:

• By default, only Active evaluation templates will be displayed. Refer to Edit My 
Preferences on page 4-239, if you would like to see the Inactive users along with the 
Active evaluation templates in the reports.

7. Once you have selected the template, click OK. The templates window closes and the 
Select Evaluation Template window is active.

8. Under Teams, click Select. The Select Teams window opens.

9. Search for a team in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available teams. Active teams display in the list box, and the 
table is, by default, sorted in ascending alphabetical order.

Note:
• If you are logged in as an Administrator, you can search for and select any of the 

teams.
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• If you are logged in as a Mentor, you can only search for and select teams for which 
have either Score/Review permission in your user profile.

• By default, only Active Teams will be displayed. Refer to Edit My Preferences on 
page 4-239, if you would like to see the Inactive teams along with the Active teams in 
the reports.

10.Click OK to return to the General tab. Under the Teams section, number of Team is 
mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

11.The Select button, under the Agents From Selected Teams, is enabled. Click on the 
Select button, the Select Agent(s) window opens.

12.Search for an Agent in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available agents for the selected team.

Note: By default, only Active users will be displayed. Refer to Edit My Preferences on 
page 4-239, if you would like to see the Inactive users along with the Active users in 
the reports.

13.Select the Agent and click OK. 
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14.Click OK to return to the General tab. Under the Agent From Selected Teams section, 
number of Agent is mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

8.3.1.3   Quality Detail Report
Select the Quality Detail Report to review the details of the quality score of agents in a team 
for interactions evaluated against the specified evaluation templates. This report provides the 
ability to display you the High Score/ Average Score/ Low Score and number of evaluations 
scores for each Evaluation Template and provides you with the ability to drill down from 
Templates to Teams. Also, it allows to view the High Score/ Average Score/ Low Score and 
number of evaluations scored for the agents in each selected team, provides you with the 
ability to drill down to agent level, and you further drill down the details of the evaluations at 
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each agent level. Under Report Type, when you select Quality Detail Report, the below screen 
appears.

1. Click on the Report View drop-down and select Interaction or Evaluation.
Note: For more information, click on the Info button for Interaction as shown below.  

For more information, click on the Info button for Evaluation as shown below.

2. Select the Date Options from the drop-down list. To choose any date range based on your 
requirement or click on Custom Date Range. If you select Custom Date Range, the From 
and To fields are enabled. 

3. Choose the date and time range on From and To field. To select date, click on  icon and 
for time,  icon.

Note: If you have selected Custom Date Range, then the date range must be within the 
last four years.
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4. By default, the Time zone is selected based on your location. To change the Time zone, 
click on the drop-down and choose your required time zone.

5. Under the Evaluation Template field, to select a template specific to the evaluations that 
you want to see by clicking Select button (if you want to include all of the available 
evaluation templates, then click on the Include All check box). The Select Evaluation 
Template window appears. 

6. Click on the  icon in the Search Items field, and select Yes. A window opens with a list 
of available templates.

Active templates display in the list; see the Status column. Select one template or multiple 
templates as required. To select multiple templates, CTRL+ Left-click on the templates.

Note:
• If you are logged in as an Administrator, you have access to all templates. 

 
If you are logged in as a Mentor, you have access to templates based on how the 
evaluations assigned to you.

• By default, only Active evaluation templates will be displayed. Refer to Edit My 
Preferences on page 4-239, if you would like to see the Inactive evaluation 
templates along with the Active evaluation templates in the reports.

7. Once you have selected the template, click OK. The templates window closes and the 
Select Evaluation Template window is active.
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8. Click OK to return to the General tab. Under the Evaluation Templates section, number of 
template is mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

9. Under Team, click Select. The Select Teams window opens.
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10.Search for a team in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available teams. Active teams display in the list box, and the 
table is, by default, sorted in ascending alphabetical order.

Note:
• If you are logged in as an Administrator, you can search for and select any of the 

teams.
• If you are logged in as a Mentor, you can only search for and select teams for which 

have either Score/Review permission in your user profile.
• By default, only Active Teams will be displayed. Refer to Edit My Preferences on 

page 4-239, if you would like to see the Inactive teams along with the Active teams in 
the reports.

11.Click OK to return to the General tab. Under the Teams section, number of Team is 
mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

12.Under the Default Chart Type section field’s drop-down, select the chart type as your 
default chart type. It means whenever you will access this report, and the chart type will be 
shown based on the selection from the drop-down list.
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8.3.1.4   Quality Score Trend Report
Select the Quality Score Trend Report to review the average quality score of agents in a 
team for interactions evaluated against the specified evaluation template. The report 
generates at a team level. Under Report Type, when you select Quality Score Trend Report, 
the below screen appears.

1. Click on the drop-down of Trend By field and select the option based on the requirement.
Note: Refer the Save a Report Based on Trend By Field on page 8-360.

2. Click on the Report View drop-down and select Interaction or Evaluation.

Note: For more information, click on the Info button for Interaction as shown below.  

For more information, click on the Info button for Evaluation as shown below.

3. From the View By field, choose the option under the drop-down list to view the report Year 
or Quarter or Month or Week or Day wise.
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4. Select the Date Options from the drop-down list. To choose any date range based on your 
requirement or click on Custom Date Range. If you select Custom Date Range, the From 
and To fields are enabled. 

5. Choose the date and time range on From and To field. To select date, click on  icon and 
for time,  icon.

Note: If you have selected Custom Date Range, then the date range must be within the 
last four years.

6. By default, the Time zone is selected based on your location. To change the Time zone, 
click on the drop-down and choose your required time zone.

7. Under the Evaluation Template field, to select a template specific to the evaluations that 
you want to see by clicking Select button (if you want to include all of the available 
evaluation templates, then click on the Include All check box). The Select Evaluation 
Template window appears. 

Note: By default, only Active Evaluation Templates will be displayed. Refer to Edit My 
Preferences on page 4-239, if you would like to see the Inactive Evaluation 
Templates along with the Active Evaluation Templates in the reports.

8. Click on the  icon in the Search Items field, and select Yes. A window opens with a list 
of available templates.

Active templates display in the list; see the Status column.
Note: If you are logged in as an Administrator, you have access to all templates. 

 
If you are logged in as a Mentor, you have access to templates based on how the 
evaluations assigned to you:

• Peer review
• Agent review
• Team review
• Evaluation Assigned
• Permission in User Profile

9. Once you have selected the template, click OK. The templates window closes and the 
Select Evaluation Template window is active.
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10.Click OK to return to the General tab. Under the Evaluation Templates section, number of 
template is mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

11.Under Team, click Select. The Select Teams window opens.
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12.Search for a team in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available teams. Active teams display in the list box, and the 
table is, by default, sorted in ascending alphabetical order.

Note:
• If you are logged in as an Administrator, you can search for and select any of the 

teams.
• If you are logged in as a Mentor, you can only search for and select teams of which 

you are a member. If you are not a member of any team, then No Team displays in 
the list box.

• By default, only Active teams will be displayed. Refer to Edit My Preferences on 
page 4-239, if you would like to see the Inactive teams along with the Active teams in 
the reports.

13.Click OK to return to the General tab. Under the Teams section, number of Team is 
mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled and “All” 
will be mentioned as shown below.

14.Under the Default Chart Type section field’s drop-down, select the chart type as your 
default chart type. It means whenever you will access this report, and the chart type will be 
shown based on the selection from the drop-down list.
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8.3.2   Schedule Tab
The Schedule tab is used to run a report at a later point of time and recursively. For example, if 
you want to run the report every Friday at 11 PM, you can do that by scheduling the report 
using the Schedule tab.

Note: All fields marked with a red asterisk (*) are mandatory.

1. To schedule a report, toggle-on the Enable button. 

Note:
• When the Enable button is toggled on and saved, the report will be available under 

the Scheduled Reports tab in the Reports window.
• When the Enable button is not toggled on and saved, the report will be available 

under the Ad Hoc Reports tab in the Reports window

2. Click on the Date Type field and schedule a report using any of the date types 

• One Time

• Daily

• Weekly

• Monthly. 

a. One Time: When you need to generate a report for a single time, then select this option. 
Go to Start Date and Time field, select the date and time based on your requirement, as 
shown below.  
Example: If you want to run the report for once, on 21st September’20 at 7 AM, then 
select the date and time by scheduling the report using the Schedule tab.

b. Daily: When you need to generate a report daily, then select this option.
a. Go to Start Date and Time field, select the date and time based on your requirement. 

Example: If you want to run the report daily, on 21st September’20 at 7 AM, then 
select the date and time by scheduling the report using the Schedule tab.

b. If you are turned on the toggle for End Date, then the Aspect Quality system will 
generate everyday.  
Or, 
If you want to generate a report daily till a period of time, then toggle-on the End 
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Date button. The End Date field will be enabled and select the date as shown below. 

Example: Based on the above screenshot, the system will start to generate the daily 
report from 21st September’20 at 7:00 AM till 211st September’20.

c. On the Recurs Every field, “1” must be mentioned. If you want to run a report on 
every alternate day, then type “2” on this field.  
Example: The system will start to run the first daily report on 21st September’20, 
then second daily report on 23rd September’20, third daily report on 25th 
September’20 and so on till 6th October’20.

d. Weekly: When you need to generate a report for every week, then select this option.
a. Go to Start Date and Time field, select the date and time based on your requirement.
b. If you are not toggle-on the End Date, then the Aspect Quality system will generate 

for every week.  
Or, 
If you want to generate a weekly report for some weeks, then toggle-on the End Date 
button. The End Date field will be enabled and select the date as shown below. 

Example: Based on the above screenshot, the system will start to generate the 
weekly report from 21st September’20 at 7:00 AM till 29th November’20.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 352



Administrator Guide
c. On the Recurs Every field, number of weeks will be mentioned. If you want to run a 
report on every alternate week, then type “2” on this field.  
Example: The system will start to run the first weekly report on 21st September’20, 
then second daily report on 5th October’20, third daily report on 19th October’20 and 
so on till 28th November’20.

d. Click on the Days of Week field and select the day when you want to generate the 
weekly report, as shown below. 

Example: On every Monday (from 21st September’20 at 7:00 AM till 28th 
November’20), the system will generate the weekly report for you. 
Note: If you want to run the report for multiple days in a week, then select multiple 

days from the list.

e. Monthly: When you need to generate a report for every month, then select this option.
a. Go to Start Date and Time field, select the date and time based on your requirement.
b. If you are not toggle-on the End Date, then the Aspect Quality system will generate 

for every month.  
Or, 
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If you want to generate a monthly report for some months, then toggle-on the End 
Date button. The End Date field will be enabled and select the date as shown below.

c. Click on the Days of Month field and select the day or days of a month when you want to 
run the monthly report, as shown below. 

Example: On every 12th day of the month (from 21st September’20 at 7:00 AM till 30th 
April’21), the system will generate the monthly report for you.

Note: If you want to run the report last day of the month, then it is recommended to 
select Last from the list. The monthly report will run on the last day of every 
month.

3. Click on the Retain My Last field and type the number of previous reports which you want to 
retain.  
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Example: If you type number 5, then the Aspect Quality system will retain the last five 
reports.

Note: The number must be 1 - 365. The Aspect Quality will not retain the reports if the 
number exceeds. 

8.3.3   Permissions Tab
The Permissions tab helps you to share this report with all the users in the selected user 
profile(s).

1. To provide the permission, select one or more user profiles under the Available Items 
section.

2. Click on the Add items button as shown below, the selected user profiles will be moved 
from Available Items to Selected items section. 

The usage of these buttons are given below.

Button Name Description

Add all items Adds all user profiles from Available Items to Selected Items 
section.

Add items Adds the selected user profiles from Available Items to Selected 
Items section.
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3. To provide the edit permission for the report, select the user profile under the Selected 
Items section.

4. Click on the Permission drop-down and select Edit as shown below.

Note:
• To provide Edit permission for more than one user profiles, select the user profiles 

and click on the change selected user profiles permission button as shown below.

• After providing the Edit permission to the user profile, if you remove the user profile 
from the Selected Items section as shown below, the report will not shown to the 
users associated with the user profile. 

Remove items Removes the selected user profiles from Selected Items section 
to Available Items.

Remove all items Removes all user profiles from Selected Items section to 
Available Items.

Button Name Description
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5. Before saving if you want to preview how the report will appear, click on the Preview button 
to preview the report on the right side of the window, based on the parameters what you 
have defined.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 357



Administrator Guide
6. (Optional) Click on the Legend button to preview the legends as shown below and search 
for the legends or scroll-down to find. 

Once you click on the any listed legend, the selected legend will be hidden on the chart.
Note: The Legend button will be disabled when data is not available. 

7. Click on Save button to complete the process. The Reports window appears as shown 
below.

Note: As the Report is scheduled in the Schedule Tab, the report is saved under the 
Scheduled tab. If the Enable button is not turned on in the Schedule Tab, then the 
Report would be saved under the Ad Hoc Reports tab.
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8.3.4   Save an Ad Hoc Report
The Ad Hoc Report helps you to run a report manually based on the requirement. To save an 
Ad Hoc Report, follow the steps below:

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Navigation bar, click Employee Experience and click Reports.

3. Click on Ad Hoc Reports. 

4. The Reports window appears and the Ad Hoc Reports tab is selected as shown below.

5. Refer from step 1 to step 6 of the Save a Report on page 8-334 section. 
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6. Click on Preview button to preview the report on right side of the window, as shown below.

7. Click on Save button to save the Ad Hoc Report and redirects to the REPORTS window, as 
shown below.

Note: If the Report Storage Path is not defined then an info icon will be displayed on the 
top-right side above the grid and Add button will be disabled as shown below.

8.3.4.1   Save a Report Based on Trend By Field
This feature allows you to save the Quality Score Trend Report based on the selected 
parameter in the Trend By field such as 

• Trend By Evaluation Template on page 8-361

• Trend By Team on page 8-363

• Trend By Agent on page 8-365

• Trend By Agent Group on page 8-367
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• Trend By Application on page 8-371

8.3.4.1.1   Trend By Evaluation Template
Select Evaluation Template from the drop-down list of Trend By field and click on the Preview 
button, the report will show on the right side of the grid. 
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To drill down the report from Year to Quarter for the Evaluation Template, click on the Year as 
shown above and the following window appears.

Note: Click on Quarter, as shown above, to drill down the report to Month, Week and Date 
respectively.

After drilling down the grid (Year column) from Year > Quarter > Month > Week, the folders 
will be shown below the buttons as shown below. 

Note: If the Evaluation Template is drilled down from the Evaluation Template Name > Team 
Name > Agent Name, the folders will be shown below the buttons as shown below.
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8.3.4.1.2   Trend By Team
Select Team from the drop-down list of Trend By field and click on the Preview button, the 
report will show on the right side of the grid. 

To drill down the report from Team to Agent for the Teams, click on the Team as shown above 
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and the following window appears. It also provides the option to drill down the year, as shown 
below.

Note: Click on Year, as shown above, to drill down the report to Quarter, Month, Week and 
Date respectively.

After drilling down the grid (Year column) from Quarter, the folders will be shown below the 
buttons as shown below. 
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8.3.4.1.3   Trend By Agent
Select Agent from the drop-down list of Trend By field and click on the Preview button, the 
report will show on the right side of the grid. 

To drill down the report from Year to Quarter for the Team, click on the Year as shown above 
and the following window appears.

Note:
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• Click on Quarter, as shown above, to drill down the report to Month, Week and Date 
respectively.

• After drilling down the grid (Year column) from Year > Quarter > Month > Week, the 
hierarchy will be shown below the buttons as shown below. 

• When Day is selected on the View By field, then select Previous 3 months or less 
than 90 days as shown below, to preview the report.  

By default, the legends are shown on the preview section. To hide the Legends, click on 
the Chart options > Hide embedded legend as shown below. 
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8.3.4.1.4   Trend By Agent Group
Select Agent Group from the drop-down list of Trend By field and the Agent Groups section is 
added on the left pane as shown below. 
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1. Under Agent Groups, click Select button. The Select Agent Group(s) window opens.

2. Search for an Agent Group in the Search Items text box by clicking Search and select Yes. 
A window opens with the list of available agent groups. Active Agent Group display in the 
list box, and the table is, by default, sorted in ascending alphabetical order.

Note: By default, only Active Agent Groups will be displayed. Refer to Edit My Preferences 
on page 4-239, if you would like to see the Inactive Agent Groups along with the 
Active Agent Groups in the reports.
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3. Select the Agent Group and click OK to return to the General tab. Under the Agent 
Group(s) section, number of Agent Group is mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled 
and “All” will be mentioned as shown below.

4. Click on the Preview button, the report will show on the right side of the grid.
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5. To drill down the report from Agent Groups to Team, click on the Agent Group as shown 
above and the following window appears.

Note:

• Click on the Team, as shown above, to drill down the report to associated Agents as 
shown below.

• Also, click on the Year as shown above, to drill down the report to Quarter, Month, Week 
and Date respectively.
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After drilling down the grid (Year column) from Year > Quarter > Month > Week, the folders 
will be shown below the buttons as shown below. 

8.3.4.1.5   Trend By Application
Select Application from the drop-down list of Trend By field and the Application section is 
added on the left pane as shown below. 
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1. Under Application, click on Select button. The Select Application(s) window opens.

2. Search for an Application in the Search Items text box by clicking Search and select Yes. A 
window opens with the list of available applications. Active Applications display in the list 
box, and the table is, by default, sorted in ascending alphabetical order.

Note: By default, only Active Applications will be displayed. Refer to Edit My Preferences 
on page 4-239, if you would like to see the Inactive Applications along with the 
Active Applications in the reports.
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3. Select the Application and click OK to return to the General tab. Under the Agent Group(s) 
section, number of Agent Group is mentioned, as shown below.

Note: If you have checked the Include All, then the Select button will be disabled 
and “All” will be mentioned as shown below.

Note: Only active templates, teams, applications, agent groups results will be 
displayed when the Preview button is clicked. If you want to see inactive entities 
details along with active in report result then refer to Edit My Preferences on 
page 4-239.

4. Click on the Preview button, the report will show on the right side of the grid.
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5. To drill down the report from Application to Team, click on the Application as shown above 
and the following window appears.

Note:

• Click on the Team, as shown above, to drill down the report to associated Agents as 
shown below.

• Also, click on the Year as shown above, to drill down the report to Quarter, Month, Week 
and Date respectively.
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After drilling down the grid (Year column) from Year > Quarter > Month > Week, the folders 
will be shown below the buttons as shown below. 

8.3.5   Edit a Report
This feature allows you to edit a report which is already saved under the Scheduled Reports or 
Ad Hoc Reports tab. Follow the steps below to edit a report.

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Navigation bar, click Employee Experience and click Reports.

3. To complete the filter criteria for the report which you want to access, click on Scheduled 
Reports or Ad Hoc Reports. 

4. The Reports window appears which consists the Scheduled Reports and Ad Hoc Reports 
tabs. The tab is highlighted based on the selected reports type such as Scheduled Reports 
or Ad Hoc Reports.
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5. Select the report which you want to edit and click on the Edit button as shown below.

Note: The Edit button is always enabled for the administrator.

6. The Edit Report window appears. 
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a. Quality Score Trend Report: If you select a Quality Score Trend Report to edit, the 
following window appears.
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b. Quality Detail Report: If you select a Quality Detail Report to edit, the following window 
appears. 

This report displays the High Score/ Average Score/ Low Score and number of 
evaluations scores for each Evaluation Template and provides you with the ability to drill 
down from Templates to Teams. Also, it allows to view the High Score/ Average Score/ 
Low Score and number of evaluations scored for the agents in each selected team, 
provides you with the ability to drill down to agent level, and you further drill down the 
details of the evaluations at each agent level.

c. Evaluation Details Report: If you select an Evaluation Details Report to edit, the 
following window appears. This report provides the details of a question such as 
Dependent Questions, Question Type, Points Earned, Points Possible and Success 
Rate.
Total Response column displays value for every question type, regardless of parent or 
a dependent question. It displays all the possible answer choices and number of 
responses received for each option in the parenthesis. 

Note: The Total Response column displays N/A as the answer to free form question 
type.
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Click on the Preview button to view the report as shown below.

In the below screenshot, the comment section is displayed for each question. The Comment 
appears below the reviewer’s name. Reviewer is the one who has commented on the question 
during evaluation.

7. Edit the fields under the General Tab, Schedule Tab and Permissions Tab based on the 
requirement.

8. Before saving the report, click on the Preview button to preview the report.

9. Click on Save button to complete the edit process. 
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8.3.6   View a Report
The View Report button helps you to view a Scheduled Report or Ad Hoc Report. To view a 
Scheduled Reports or Ad Hoc Report, follow the steps below:

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Navigation bar and click Quality.

3. Click on Scheduled Reports or Ad Hoc Reports. 

Example: The Ad Hoc Reports option is selected on the below screenshot.

4. The Reports window appears and the Ad Hoc Reports tab is selected as shown below.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 380



Administrator Guide
5. Select the report and click on the expand button as highlighted below, the reports grid will 
expand as shown below.

6. Select the report from the expanded grid (Child grid) and click on the View Report 
button. 

Note: Select a row in the child grid for which you want to view the result.

7. The View Report window appears as shown below.
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a. Quality Score Trend Report: If you select a Quality Score Trend Report to view, the 
following window appears.

b. Quality Detail Report: If you select a Quality Detail Report to view, the following 
window appears. 
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 382



Administrator Guide
This report displays the High Score/ Average Score/ Low Score and number of 
evaluations scores for each Evaluation Template and provides you with the ability to drill 
down from Templates to Teams. Also, it allows to view the High Score/ Average Score/ 
Low Score and number of evaluations scored for the agents in each selected team, 
provides you with the ability to drill down to agent level, and you further drill down the 
details of the evaluations at each agent level.

c. Evaluation Details Report: If you select a Evaluation Details Report to view, the 
following window appears. This report provides the details of a question such as 
dependent questions, Question Type, Point Earn, Points Possible and Success Rate. 

8.3.6.1   Export the Report to PDF
This section describes how to export the report to PDF.

1. Refer View a Report section.
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2. Under the View Report, click on the Export to PDF  button to export the report in .pdf 
format. Refer the below screenshot.

Note:
• The Export to PDF button will be disable if the data is not available for the report or 

the report is not saved.
• When you select the Export to PDF button, the Report Parameter, Chart and Grid 

data will be exported to the .pdf file. The first page of the exported .pdf file contains 
the Report Parameters, the second page contains the Chart data, and the third page 
contains the Grid data as shown below. 
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Report Parameter: 

Chart Data: 

Grid Data:
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8.3.6.2   Export the Report to Excel
This section describes how to export the report to excel file.

1. Refer View a Report section.

2. Under the View Report, click on the Export to excel  button to export the report in 
excel format. Refer the below screenshot.

Note:
• The Export to excel button will be disable if the data is not available for the report or 

the report is not saved.
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• When you select the Export to excel button, only the Grid data (highlighted on the 
above screenshot) will be exported to the excel file. The Report Parameters and the 
Chart will not be shown in the exported excel file. Refer the below screenshot.

8.3.6.3   Export the Evaluation Detail Report to Excel
This section describes how to export the Evaluation Detail Report to Excel file. This can be 
done in the following two ways:

1. Report By: Reviewer – Reports result will be exported and will be displayed by grouping 
reviewer for each question.

2. Report By: Agent – Reports result will be exported and will be displayed by grouping by 
agent.

Report by Reviewer

Report Header data:

• Name: Name of the report.
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• Type: The report type, which will be “Evaluation Detail Report”.

• Report View: The report view is based on either Interaction or Evaluation.

• Report By: The report is based on either Reviewer or Agent’s data.

• Date Range: The From and To date of the report.

• Time Zone: The time zone selected for the report.

• Evaluation Template: The evaluation template name.

• Teams: The teams selected to filter the report data.

• Agents: The agents selected to filter the report data.

Report results will be displayed in the tabular format as shown in the above screenshot. The 
column description is as given below:

Name: 

• The name of the Reviewer or Agent will be displayed in last name, first name format.

• This displays the reviewer’s name if the “Report By” is selected as “Reviewer” – The 
User who has created the evaluation.

• It displays the Agent name if the “Report By” is selected as “Agent” – The User for 
whose interaction, the evaluation was created.

Team:

• The team name of the Reviewer or Agent. If the user is associated with more than one 
team, then it shows the names of all the teams with “,” (comma) separated.

Section Data: 

This includes four columns; Section, Points Earned, Points Possible and Success Rate.

• Section: Name of the section. Each section’s name that is defined in the evaluation 
template. For each reviewer, the section and question details will be displayed.

• Points Earned: This displays the total points the user has earned for that particular 
section.
Formula: Sum of Points earned for each question and dependent 
question (if exists)/Number of Reviewers

• Points Possible: The total number of points that is possible to earn for the section. This 
will be the maximum possible max weighted score.
Formula: Sum of weights of the question scored with valid option. 
If the N/A option is selected for the question that question 
weight will not be considered.

• Success Rate: The percentage rate that the section has earned.
Formula: Points Earned/Points Possible

Question Data: 

This includes the column Question, Options, Question Points Earned, Question Points 
Possible and Question Success Rate.

• Question: Name of the question. For each reviewer each question data will be 
displayed.
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• Options: The options available for the question along with the number of times the 
reviewer have selected the option. For example, Yes (1), which indicates the reviewer 
have selected option ‘Yes’ one time for the question.

• Question Points Earned: The points that is earned for the question by the specific 
reviewer.
For example, If a template has a question with Yes/No type and the weight of the option 
Yes is 10 and Weight of the option No is 0. Now, the option is selected by the reviewer 
as “Yes” then the Points Earned for the question by the reviewer will be 10.
Note: If the same reviewer has evaluated more than once using same template, then 

the Question Points Earned will be calculated as below:
Formula: Sum of the weights of the question option selected/Total 
number of times the evaluation is evaluated
Note: For Free Form Text, the text entered by the reviewer will be displayed. If more 

than one response exists for these question it shows the responses in each line. 
It will be blank when the option is selected as N/A.

• Question Points Possible: This will be the weight of the question.

• Question Success Rate: This displays the percentage rate that the question has 
earned.
Formula: Question Points Earned/Question Points Possible

Report by Agent

The data for the Report by Agent will be the same as explained above for the header and 
columns in the Report by Reviewer, except the grouping of the sections and questions will be 
based on each Agent.

8.3.7   Activate the Report
This feature allows to activate a saved report based on the selected parameters (Refer Save a 
Report). To activate a report follow the steps below.

Note:
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• The user is able to activate or deactivate a report, if the user is either owner of the report 
or has an edit permission right for the report. 

• If report is deactivated then neither the user is able to run the Ad Hoc Reports nor 
scheduler will run the Schedule Reports.

• Report result will not be generated when the Deactivated report is edited.

• These operations will be audited.

1. Select the report for which the Active column is blank, as shown below.
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2. Click on the Activate  button and the check mark will be shown on the Active column 
for the selected report as shown below.

8.3.8   Deactivate the Report
This feature allows to deactivate an activated report. To deactivate the activated report follow 
the steps below.
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1. Select the report for which the Active column is checked as shown below.

2. Click on the Deactivate  button and the Active column will be blank for the selected 
report as shown below. 

Example: In this scenario, the Daily report was created on 16th July, 2021 and as the 
report is deactivated, the daily report will not run.
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8.3.9   Delete a Report
This feature allows to delete a Quality Detail Report or Quality Score Trend Report. To delete 
the Quality Detail Report or Quality Score Trend Report report follow the steps below.

1. Select the report which you want to delete and click on the Delete button.

2. Click on Yes to delete the report from the grid.

8.4   Create Reports in WEM similar to Classic UI
The Classic UI Reports are now available in WEM.

The table lists the name of the Classic UI Reports and corresponding name of the reports that 
are available in WEM:

Classic UI Report Name WEM Report Name

1. Agent Detail Filter by Scorecard Template Quality Detail Report (Classic UI 
Report Name - Agent Detail Filter by 
Scorecard Template)
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2. Agent Percentage Score Comparison to Peers - 
Agent Group

Quality Score Trend Report by Agent 
Group

3. Agent Scores on Questions of a Scorecard by 
Team

Option 1: To know question level 
details use Evaluation Detail Report

Option 2: To know the High Score/
Low Score, Average Score Details 
use Quality Detail Report

Question level details and High or 
Low Score

4. Quality Monitor Detail by Agent Quality Detail Report (Classic UI 
Report Name – Quality Monitor 
Detail by Agent)

5. Quality Monitor Summary by Agent Quality Detail Report (Classic UI 
Report name is Quality Monitor 
Summary by Agent)

6. Scored Call Summary by Agent Quality Detail Report (Classic UI 
Report name is Scored Call 
Summary by Agent)

7. Supervisor Review Performance by Date Quality Score Trend Report by Agent

8. Team Comparison – Specific Scorecard Quality Detail Report (Classic UI 
Report Name is Team Comparison – 
Specific Scorecard)

9. Team Detail with Bar Graph Quality Detail Report (Classic UI 
Report Name – Team Detail with Bar 
Graph)

10. Team Scores on Questions of a Scorecard Option 1: To know question level 
details use Evaluation Detail Report 

Option 2: To know the High Score/
Low Score, Average Score Details 
use Quality Detail Report 

Evaluation Detail Report, High or 
Low Score and Average Score 
(Classic UI Report Name - Team 
Scores on Questions of a Scorecard)

11. Trend Report Average Quality Score by Agent – 
Month View

Quality Score Trend Report by Agent 
with View by as Month

12. Trend Report Average Quality Score by Agent – 
Week View

Quality Score Trend Report by Agent 
with View by as Week

13. Trend Report Average Quality Score by Agent Quality Score Trend Report by Agent 
with View by as Day

14. Trend Report Average Quality Score by 
Application

Quality Score Trend Report by 
Application with View by as Day

Classic UI Report Name WEM Report Name
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8.4.1   Accessing Reports
Follow the steps to access Reports:

1. Login to WEM.

2. Click the main menu icon.

3. Expand Employee Experience.

15. Trend Report Average Quality Score by 
Scorecard Template

Quality Score Trend Report by 
Evaluation Template with View by as 
Day

16. Trend Report Average Quality Score by Teams – 
All Scorecards

Quality Score Trend Report by Team 
with all templates selected and view 
by as Day

17. Trend Report Average Quality Score by Teams – 
Specific Scorecard

Quality Detail Report (Classic UI 
Report Name – Team Comparison – 
Specific Scorecard )

18. Trend Report Daily Agent Comparison to Peers - 
Agent Group

Quality Score Trend Report by Agent 
Group (Classic UI Report Name – 
Trend Report Daily Agent 
Comparison to Peers - Agent Group)

19. Trend Report Daily Agent Comparison to Peers – 
Bar Graph - Agent Group 

Quality Score Trend Report by Agent 
Group (Trend Report Daily Agent 
Comparison to Peers – Bar Graph - 
Agent Group)

20. Audit Activity Detail Report Audit Activity Detail Report

Classic UI Report Name WEM Report Name
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4. Select Reports.

Note: The above steps are universal to access the different WEM reports starting with 
Section 7.4.2 till Section 7.4.21. The below sections illustrate how to create a report in 
WEM similar to classic UI.

8.4.2   Quality Detail Report (Classic UI Report Name - Agent 
Detail Filter by Scorecard Template)

To create Agent Detail Filter by Scorecard Template Report in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports. This depends on which report you want to create.

2. Select Quality Detail Report in Report Type.

3. Enter the data for other required parameters.

4. Click on the Preview button.

5. Click on Evaluation Template Name link available in the result grid. Teams based data will 
be displayed. (Shown in blue color Classic UI Report).

6. Click on the Teams link available in the grid > Agents based data will be displayed.
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WEM Report

Classic UI Report
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8.4.3   Quality Score Trend Report by Agent Group
Classic UI Report Name - Agent Percentage Score Comparison to Peers - Agent Group 

WEM Report - Quality Score Trend Report by Agent Group

To create Agent Percentage Score Comparison to Peers Report in WEM, follow the below 
steps:

1. Click Ad-Hoc or Scheduled Reports. This selection depends on which report you want to 
create.

2. Select Quality Score Trend Report in Report Type.

3. Select Trend By as Agent Group and View By as Day.

4. Enter the data for other required parameters.

5. Click on the Preview button.

6. If you want to view the report created details based on Evaluation, select View By as 
Evaluation or select Interaction to view the details based on the interactions. 

7. Click on Agent Groups link > Teams link > Agent Details will display.

Note: The All agents Score based on teams can be viewed under Team details result.

WEM Report
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Classic UI Report

8.4.4   Question level details and High or Low Score
Classic UI Report Name - Agent Scores on Questions of a Scorecard by Team 

WEM Report:

Option 1: To know question level details use Evaluation Detail Report 

Option 2: To know the High Score/Low Score, Average Score Details use Quality Detail 
Report 

To create Agent Detail Filter by Scorecard Template Report in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports. This depends on which report you want to create.

2. Select Evaluation Detail Report in Report Type.

3. Enter the data for other required parameters.

4. Click on the Preview button.

5. The Question details will be displayed along with the Scores, Number of Responses, Points 
Earned, Points Possible and Success Rate.

6. To drill down for each question details on which an agent scored, click on the Question link 
in the grid.
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WEM Report: Drill Down by Question

WEM Report: Template and Section Level
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WEM Report: Drill Down by Question

Classic UI Report: Template and Section Level
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8.4.5   Quality Detail Report (Classic UI Report Name – 
Quality Monitor Detail by Agent)

To create Quality Monitor Detail by Agent in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create 

2. Select the Report Type as Quality Detail Report 

3. Provide other needed parameters 

4. Click on the Preview button. 

5. The Evaluation Template details along with Scores will be displayed. 

6. To drill down for each interaction details on which agent scored, click on Evaluation 
Template > Team > Agent links respectively in the grid. 

WEM Report 

Classic UI Report 
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8.4.6   Quality Detail Report (Classic UI Report name is 
Quality Monitor Summary by Agent)

To create Quality Monitor Summary by Agent in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create 

2. Select the Report Type as Quality Detail Report 

3. Provide other needed parameters 

4. Click on the Preview button. 

5. The Evaluation Template details along with Scores will be displayed. 

6. To drill down for each agent summary details on which agent scored, click on Evaluation 
Template > Team links respectively in the grid. 

Classic UI

WEM Report
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8.4.7   Quality Detail Report (Classic UI Report name is 
Scored Call Summary by Agent)

To create Scored Call Summary by Agent in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create 

2. Select the Report Type as Quality Detail Report 

3. Provide all required parameters

4. Click on the Preview button.

5. The Evaluation Template details along with Scores will be displayed. 

6. To drill down for each interaction details on which agent scored, click on Evaluation 
Template > Team > Agent links respectively in the grid. 

WEM Report
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Classic UI

8.4.8   Quality Score Trend Report by Agent 

To create Supervisor Review Performance by Date in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create 

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent and View By as Year/Month and provide other needed 
parameters

4. Click on the Preview button. 

5. If you want to view the report created details based on Evaluation, select View By as 
Evaluation or select Interaction to view the details based on the interactions. 

6. Click the Year header or data link to navigate through Year > Quarter > Month. The total 
number of records will be displayed for each Year. 
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WEM Report

Classic UI
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8.4.9   Quality Detail Report (Classic UI Report Name is Team 
Comparison – Specific Scorecard)

To create Team Comparison – Specific Scorecard in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Detail Report

3. Provide other needed parameters and click the Preview button.

4. To drill down for team details, click Template link in the grid. 

WEM Report
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Classic UI

8.4.10   Quality Detail Report (Classic UI Report Name – Team 
Detail with Bar Graph)

To create Team Detail with Bar Graph in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Detail Report

3. Provide other needed parameters

4. Click on the Preview button. 

5. To drill down for agent details, click on Template > Team link in the grid. 
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WEM Report

Classic UI

8.4.11   Evaluation Detail Report, High or Low Score and 
Average Score (Classic UI Report Name - Team Scores 
on Questions of a Scorecard)

To create Team Scores on Questions of a Scorecard in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create
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2. Select the Report Type as Evaluation Detail Report/Quality Detail Report

3. Provide other needed parameters

4. Click on the Preview button. 

5. To drill down for each team details on which agent scored, click the Template link in the 
grid. 

WEM Report

Classic UI
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8.4.12   Quality Score Trend Report by Agent with View by as 
Month 

To create Trend Report Average Quality Score by Agent – Month View in WEM, follow the 
below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent and View By as Month and provide other needed parameters

4. Click on the Preview button. 

5. The trend report by agent on month basis will be displayed in the grid 
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WEM Report

Classic UI
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8.4.13   Quality Score Trend Report by Agent with View by as 
Week 

To create Trend Report Average Quality Score by Agent – Week View in WEM, follow the 
below steps:

1. Click on Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent and View By as Week and provide other needed parameters 

4. Click on the Preview button. 

5. The trend report by agent on week basis will be displayed in the grid 

WEM Report
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Classic UI

8.4.14   Quality Score Trend Report by Agent with View by as 
Day 

To create Trend Report Average Quality Score by Agent in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent and View By as Day and provide other needed parameters

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions

5. Click on the Preview button. 

6. The trend report by agent on day basis will be displayed in the grid. 
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WEM Report

Classic UI
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8.4.15   Quality Score Trend Report by Application with View 
by as Day 

To create Trend Report Average Quality Score by Application in WEM, follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report 

3. Select Trend By as Application and View By as Day and provide other needed parameters

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions

5. Click on the Preview button.

6. The trend report by application on day basis will be displayed in the grid. 

WEM Report

Classic UI
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8.4.16   Quality Score Trend Report by Evaluation Template 
with View by as Day 

To create Trend Report Average Quality Score by Scorecard Template in WEM, follow the 
below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Evaluation Template and View By as Day and provide other needed 
parameters 

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions.

5. Click on the Preview button. 

6. The trend report by evaluation template on day basis will be displayed in the grid. 
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WEM Report

Classic UI
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8.4.17   Quality Score Trend Report by Team with all templates 
selected and view by as Day 

To create Trend Report Average Quality Score by Teams – All Scorecards in WEM, follow the 
below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Team, Select All for Evaluation Templates and View By as Day and 
provide other needed parameters 

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions.

5. Click on the Preview button. 

6. The trend report by teams on a day basis for all evaluation templates will be displayed in 
the grid. 

WEM Report

Classic UI
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8.4.18   Quality Detail Report (Classic UI Report Name – Team 
Comparison – Specific Scorecard )

To create Trend Report Average Quality Score by Teams – Specific Scorecard in WEM, follow 
the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Detail Report

3. Provide other needed parameters and click on Preview button. 

4. To drill down for team details, click on Template link in the grid. 
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WEM Report

Classic UI
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8.4.19   Quality Score Trend Report by Agent Group (Classic 
UI Report Name – Trend Report Daily Agent 
Comparison to Peers - Agent Group)

To create Trend Report Daily Agent Comparison to Peers - Agent Group in WEM, follow the 
below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent Group and View By as Day and provide other needed 
parameters

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions.

5. Click on Preview button. 

6. Click on Agent Groups link > Teams link and the Agent Details will display. 

Note: The All agents Score based on teams can be viewed under Team details result. 

WEM Report

Classic UI
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8.4.20   Quality Score Trend Report by Agent Group (Trend 
Report Daily Agent Comparison to Peers – Bar Graph - 
Agent Group)

To create Trend Report Daily Agent Comparison to Peers – Bar Graph - Agent Group in WEM, 
follow the below steps:

1. Click Ad-Hoc or Scheduled Reports depends on what you want to create 

2. Select the Report Type as Quality Score Trend Report

3. Select Trend By as Agent Group, Default Chart Type as Bar Graph and View By as Day 
and provide other needed parameters

4. If you want to view the report based on Evaluation then select View By as Evaluation or 
select Interaction to view the details based on the interactions.

5. Click on Preview button. 

6. The agent group details with bar graph will be displayed as results. 
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WEM Report

Classic UI

8.4.21   Audit Activity Detail Report 
1. Click Ad-Hoc or Scheduled Reports depends on what you want to create

2. Select the Report Type as Audit Activity Detail Report
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3. Select Option User Audit to see the report for user actions OR choose System Audit to 
view the report for the actions automatically done by system and provide other needed 
parameters

4. Click on Preview button. 

5. All the actions will be audited, and the report will be displayed similar to Classic UI. 

WEM Report

Classic UI
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Tips: 

1. User can perform sorting and filtering the data based on any column in all the reports 
grid. 

2. The reports can be exported to Excel or PDF as is viewed in the UI. 

3. The Chart Type can be viewed in different ways, based on the options available using the 
Default Chat Type option. 

4. Graph Data can be filtered based on the report type data displayed using the Legend 
option. 

5. Chart Type can be viewed in Stacked mode. 
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9.  Import

This chapter will explain about Import metadata and recording files to Aspect Quality feature in 
Workforce Engagement Management. The chapter consists of the below features.

• Create Import Process in Workforce Engagement Management UI

• Import Jobs

• Creating Jobs

• Listing Import Jobs

• Processing the Import Jobs

• Editing Jobs

• Deleting Jobs

• Activating and Deactivating Jobs

• Global Custom Field Definition

9.1   Import Overview
Import feature allows to import third party recording files and metadata files which were 
recorded in an external system into the Aspect Quality to playback and evaluate. 

As a pre-requisite, third parties must provide the metadata and recording files in below format.

• Metadata File - .xml
Note:

• Aspect Quality does not expect the XML in a particular format and Aspect Quality 
accepts any XML format.

• An xml file with attribute/element having data alias will not accept.

• Media Files 
• Audio - .mp3,.mp4, .wav and .wma 
• Chat and Email - .json

An Import Job must be created with a schedule and mentioning a UNC path where you place 
the exported recording and xml file from an external system which Aspect Quality wants to 
import. When the schedule of the import job is reached, the Importer process will process the 
metadata and media files available in the Import location and create interactions by mapping 
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the values from xml file to the Aspect Quality fields. Once the job has runs successfully, the 
interactions will be available to view, playback and evaluate in Aspect Quality.

9.2   Create Importer Process
1. To import the third party media and metadata files to Aspect Quality, user must create an 

Importer Process. Refer to System Administration Guide to know how to create a process.

2. You can either have a separate server where Import process can run or can club this in an 
existing server where you are already running a Aspect Quality process.

Note:

• After Importer process is created, system will also create a “Default Import Switch” for 
which all the Import Jobs and the imported interactions will be associated.

To view the saved recordings in disk space, then go to the switch to turn on the 
encryption.

• System will also create “Default Import Storage Group” to associate with the import 
switch.

Storage group is created by default but if you think while creating a job you want to 
choose a different storage group other that what system has created you can do so.

9.3   Import Jobs
Import Jobs navigation menu is displayed under “Administration” section of WEM. Follow the 
steps below to import a job.
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1. Click on main menu and go to Administration > Import > Import jobs. 

2. Import Jobs window appears as shown below. The grid/table is empty for the first time. 

3. Refresh, Add, Edit, Delete, Activate, Deactivate, and Global Custom Metadata 
Definition buttons will be enabled when “Importer” process is created in Workforce 
Engagement Management UI. (Information message will display the information)
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4. After creating the importer process the Import Job page will be displayed as shown in 
below screenshot. 

Note: Edit, Delete, Activate, Deactivate buttons will be disabled when import jobs not 
exist in the grid.

5. First row contains the buttons as mentioned in the below table.

9.3.1   Create Import Job
It allows to configure new import job, which include defining the schedule, Channel Type to 
import (though for first phase we support only Voice channel), Storage Group, Import Location, 
and Metadata Mapping. Follow the steps below to create import job.

Note: Ensure the Importer Process is created in Workforce Engagement Management UI before 
creating the Import Job.

1. Click on Add button  to add a new import Job.

Table 9-1  Import Job Menu Options

Button Name Description

Refresh Refreshes the import job grid with latest import job changes. Instead of user 
clicking on the browser refresh button user can click on this which will refresh 
only the grid data and not the entire page.

Add Creates a new import job.

Edit Updates the details of existing import job.

Delete Deletes the import job.

Activate Allows to activate an import job which is in inactive state.

Deactivate Allows to deactivate an import job which is in active state.

Global Custom Field 
Definition

Allows to define/update/delete custom field names for import job.
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2. Add Job window appears as shown below. 
 

The description of the fields in Add Job window is given below.

Table 9-2  Import Job Field Definition

Field Name Description

Job Name (Mandatory and 
Unique)

• Provide Job Name which will help you identify this job 
• Allows 100 characters and restricted with special characters 

mentioned below 
\ / : * ? " < > |

Note: System does not allow the above special characters 
because system will create the results file with the job 
name and windows does not allow to create files with 
the above special characters 

• Job Name is mandatory to create an import Job and it 
should be unique.

Description •  Allows to enter 256 character
• Enter a detailed description for this job
• This field is optional
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9.3.2   Import Job Schedule
Set up the Start Date, End Date, Start Time and Run on Days to schedule an import job daily, 
weekly, and so on based on the requirement.

Schedule • Allows to schedule the import Job to run
• Allows to set the Start Date, End Date, Job Start Time and 

Run on Days
• Refer to Import Job Schedule section for more details.

Start Date (Mandatory) • Start Date must set to create import Job and its mandatory
• Start Date shouldn’t be past Date.

End Date • End Date is Optional – by default End Date will be OFF.
• When End Date is specified, job will run until the end date is 

reached.
• End Date cannot be in lesser than Start Date

Job Start Time (Mandatory) • Job Start Time must set to create the import job and its 
mandatory

• Specify the time when the job should run.

Run on Days (mandatory) • Run on Days must set to create the import job and its 
mandatory 

• Specify on which days the job should run.

Define Mapping • Allows to configure the Channel Type, Storage Group, 
Import Location, and Metadata Mapping

Channel Type (Mandatory) • Supports Audio, Chat and Email channel types. Select an 
appropriate channel for the import job from the drop-down 
list.

Storage Group (Mandatory) • Its recommended to use a separate storage group for 
Imported Jobs compare to the storage group what you use 
to store Aspect Quality recorded recordings or have a 
storage group defined for each job what you create which 
will help you to search for recordings manually through 
windows file explorer 

Import Location (Mandatory) • Enter the location from where to import the media files and 
metadata xml file. Please ensure this folder has read access 
from the server where the Import process is running 

• Valid server path required. Please do not use mapped drives 
from your client. For example type \\server\FolderLocation

Add Metadata Mapping • Opens the Add Metadata Mapping dialog page and 
mandatory to fill the required field.  
Refer to Add Metadata Mapping section for more details.

Table 9-2  Import Job Field Definition

Field Name Description
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9.3.2.1   Schedule a Job to Run Daily
Select the specific options to run an import job every day. Refer the below screen shot.

The job will run every day at 4:38 PM till the End date.

9.3.2.2   Schedule a Job to Run Weekly
Select the specific options to run on specific day in a week. Refer the below screen shot.

The job will run every week on Monday at 4:38 PM.
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9.3.2.2.1   Add Metadata Mapping
Pick up a sample XML file from the list of xml files that you want to import and use that sample 
xml file to define the mapping. In the Add Metadata Mapping screen you should upload the 
sample xml file and map what xml field value should be parsed and update to Aspect Quality 
fields. If you find no relevant Aspect Quality field for your field in XML then you can map that to 
custom fields.

The Metadata Mapping can be done based on the Channel Type. These are:

• Channel Type: Audio

• Channel Type: Chat

• Channel Type: Email

Channel Type: Audio

1. Select the Channel Type as Audio from the drop-down list.

2. Click on Add Metadata Mapping on Add Job dialog page.
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3. Mapping tab will be enabled and few fields under the Mapping tab will be disabled. Custom 
Fields tab will be disabled as shown in the Add Metadata Mapping screen below. 

4. Click on Select File button to select a XML file.

5. Select the xml file from the import location.

6. Select a sample XML file from the list of xml files which needs to import. Upload the xml file 
then all the elements and attributes which has a value or self-closing elements and 
attributes in the xml file will be displayed in each combo box.

7. Enter a field name and the combo box will show the matched results and if you don’t know 
the exact name click on the combo box and choose a field name which you want to map. 
Refer the below Table 9-3 for the details on what Aspect Quality fields mean.

Sample Audio XML file:
<?xml version="1.0" encoding="UTF-8"?>
<CAudioFile xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <CRI>
<StartTime>2018-10-15T19:43:41.9000000+0000</StartTime>
    <Filename>SampleAudio.mp3</Filename>
    <Duration>390</Duration> <ANI>2082326773</ANI>
    <DNIS>35394011</DNIS>
    <Direction>1</Direction>
    <AgentPBXID>31432</AgentPBXID>
    <AgentID>0</AgentID>
</CRI>
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</CAudioFile>
8. After Selecting the xml file, Mapping and Custom Fields will enable to map fields. Xml 

attributes/elements will be available in the combo box as shown in the below screenshot. 

Table 9-3  Audio Mapping Definition

Field Name Aspect Quality Field Description

Interaction Type • Type of the interaction.
• Aspect Quality Support four 

types of interaction
• Namely ACD Call, Inbound 

Direct Call, Outbound Direct 
Call, Outbound Queued call are 
the types.

Map the xml attribute that contains the value for 
Interaction type.

ACD Call Used for calls made to a Service 
and routed through ACD (Automatic 
Call Distributor) to an agent.

• Provides the value for the Type available in 
xml file to map for ACD Call type for interaction 
in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value(s) matches with the value in 
the xml file interaction type will be updated 
with ACD.

Inbound Direct Call Used for calls made directly to an 
agent's extension

• Provides the value for the Type available in 
xml file to map for Inbound Direct Call type for 
interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Inbound Direct Call.
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Outbound Queued 
Call

Used for calls that are dialed by the 
system and connected with agent.

• Provides the value for the Type available in 
xml file to map for Outbound Queued Call type 
for interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Outbound Queued Call.

Outbound Direct Call Used for calls manually dialed by 
the agent.

• Provides the value for the Type available in 
xml file to map for Outbound Direct Call type 
for interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Outbound Direct Call.

Media Source File 
(Mandatory)

Filename of the media which will be 
associated to an interaction.

• Map the xml attribute that contains the media 
file name.

• Aspect Quality supports the files with “.wav, 
.wma, .mp3 and .mp4” formats only.

Start Time 
(Mandatory)

Interaction Start date time. • Map the xml attribute that contains the Start 
Time.

• Refer to Date Time Format for Import Job 
section.

End Time (Mandatory) Interaction End date time. Map the xml attribute that contains the End Time.

Refer to Date Time Format for Import Job section.

ACD Login 
(Mandatory)

Username or the login id of the 
agent for the ACD associated who 
handled the interaction.

Map the xml attribute that contains the ACD Login.

First Name First Name of the agent, who 
handled the interaction.

Map the xml attribute that contains the first name.

Last Name 
(Mandatory)

Last Name of the agent who 
handled the interaction

Map the xml attribute that contains the last name.

Queue Name Agent group/Queue associated with 
the interaction.

Map the xml attribute that contains the agent 
group name.

Hold Count • Number of time agent put the 
conversation on Hold

• It is a numeric value

Map the xml attribute that contains the Hold 
Count.

Table 9-3  Audio Mapping Definition

Field Name Aspect Quality Field Description
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 437



Administrator Guide
Maximum Hold Time • Maximum duration, agent kept 
conversation on Hold.

• Will be in format HH:MM:SS
• Eg. Agent kept Conversation on 

Hold twice. First hold for 30 sec 
and Second hold for 1:30 
second, then Maximum Hold 
Time will display as 00:01:30

Map the xml attribute that contains the Maximum 
Hold Time.

Total Hold Time • Total hold Time is the sum of all 
the hold duration.

• Will be in format HH:MM:SS
• Eg. Agent kept Conversation on 

Hold twice. First hold for 30 sec 
and Second hold for 1:30 
second, then Total Hold Time 
will display as 00:02:00

Map the xml attribute that contains the Total Hold 
Time.

ANI • ANI (Automatic number 
identification)

• When agent receive the call 
through Service or Direct, ANI 
will update with the customer 
number

Map the xml attribute that contains the ANI.

DNIS • Dialed Number Identification 
Service

• Dialed number identification 
service (DNIS) is a service 
number given by corporations 
that allows customer to dial to 
reach the agents.

Map the xml attribute that contains the DNIS.

UCID Universal Call ID of the interaction. Map the xml attribute that contains the UCID.

Host ID • Host Id is a unique identifier for 
each interaction.

• It will be same for complete call 
scenario. (If we have a 
conference call all the 
interactions as part of the 
scenario will have same Host 
ID).

Map the xml attribute that contains the Host ID.

Extension Station ID of the agent where the 
agent is logged in

Map the xml attribute that contains the Extension.

Table 9-3  Audio Mapping Definition

Field Name Aspect Quality Field Description
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 438



Administrator Guide
9. Map the metadata for the Mapping fields as shown in the below screenshot. 

Note: Now go to step 10 to complete the Metadata Mapping.

Channel Type: Chat

1. Select the Channel Type as Chat from the drop-down list.

2. Click on Add Metadata Mapping on Add Job dialog page.
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3. Mapping tab will be enabled and few fields under the Mapping tab will be disabled. Custom 
Fields tab will be disabled as shown in the Add Metadata Mapping screen below. 

4. Click on Select File button to select a XML file.

5. Select the xml file from the import location.

6. Select a sample XML file from the list of xml files which needs to import. Upload the xml file 
then all the elements and attributes which has a value or self-closing elements and 
attributes in the xml file will be displayed in each combo box.

7. Enter a field name and the combo box will show the matched results and if you don’t know 
the exact name click on the combo box and choose a field name which you want to map. 
Refer the below Table 9-4 for the details on what Aspect Quality fields mean.

Sample Chat XML file:
<?xml version="1.0" encoding="utf-8"?>
<recording>
  <metadata>
    <Filename>0687d1c6-dc78-4e5a-adbc-07d5849f3eb0.json</
Filename>
    <CallStartUTC>04/12/2023 16:11:45.000 +0530</CallStartUTC>
    <CallEndUTC> 04/12/2023 16:30:40.000 +0530</CallEndUTC>
    <ACDLogin>ktandon</ACDLogin>
    <AgentGroup> ATEAM_IBChatWT2_KT2</AgentGroup>
    <AgentFirstName>cloud_kushalmgr</AgentFirstName>
    <AgentLastName>tandon</AgentLastName>
    <MessageCount>0</MessageCount>
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    <Attachments>0</Attachments>
    <Customer>cust6_chateagles</Customer>
    <Email>cust6_chateagles@gmail.com</Email>
    <Subject>100007</Subject>
  </metadata>
</recording>

8. After Selecting the xml file, Mapping and Custom Fields will enable to map fields. Xml 
attributes/elements will be available in the combo box as shown in the below screenshot. 

Table 9-4  Chat Mapping Definition

Field Name Aspect Quality Field Description

Interaction Type Aspect Quality Support chat type of 
interaction.

For Chat type of interaction, mapping is not 
required.

Media Source File 
(Mandatory)

Filename of the media which will be 
associated to an interaction.

• Map the xml attribute that contains the media 
file name.

• Aspect Quality supports the files with “.json” 
formats only.

Start Time 
(Mandatory)

Interaction Start date time. • Map the xml attribute that contains the Start 
Time.

• Refer to Date Time Format for Import Job 
section.

End Time (Mandatory) Interaction End date time. • Map the xml attribute that contains the End 
Time.

• Refer to Date Time Format for Import Job 
section.

ACD Login 
(Mandatory)

Username or the login id of the 
agent for the ACD associated who 
handled the interaction.

Map the xml attribute that contains the ACD Login.

First Name First Name of the agent, who 
handled the interaction.

Map the xml attribute that contains the first name.

Last Name 
(Mandatory)

Last Name of the agent who 
handled the interaction

Map the xml attribute that contains the last name.
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9. Map the metadata for the Mapping fields as shown in the below screenshot. 

Note: Now go to step 10 to complete the Metadata Mapping.

Channel Type: Email

1. Select the Channel Type as Email from the drop-down list.

2. Click the Add Metadata Mapping in the Add Job window.

Queue Name Agent group/Queue associated with 
the interaction.

Map the xml attribute that contains the agent 
group name.

Customer Name Name of the customer. Map the xml attribute that contains the name of 
the customer.

Email Address Email address of the customer. Map the xml attribute that contains the Email 
address of the customer.

Message Count Number of message threads 
between the customer and an 
agent, during a chat.

Map the xml attribute that contains the Number of 
message threads.

Attachment Count Number of attachments, during a 
chat.

Map the xml attribute that contains the Number of 
attachments.

Case ID Case ID of the interaction. Map the xml attribute that contains the Case ID.

UCID Universal Call ID of the interaction. Map the xml attribute that contains the UCID.

Table 9-4  Chat Mapping Definition

Field Name Aspect Quality Field Description
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3. Mapping tab is enabled and few fields under the Mapping tab will be disabled. Custom 
Fields tab will be disabled as shown in the Add Metadata Mapping screen below. 

4. Click on Select File button to select a XML file.

5. Select the xml file from the import location.

6. Select a sample XML file from the list of xml files which needs to import. Upload the xml file 
then all the elements and attributes which has a value or self-closing elements and 
attributes in the xml file will be displayed in each combo box.

7. Enter a field name and the combo box will show the matched results and if you don’t know 
the exact name click on the combo box and choose a field name which you want to map. 
Refer the below Table 9-5 for the details on what Aspect Quality fields mean.

Sample XML file for Agent:
<?xml version="1.0" encoding="utf-8"?>
<recording>
  <metadata>
    <Filename>email-Agent.json</Filename>
    <CallStartUTC>2023-04-10 14:58:23:000 +0530</CallStartUTC>
    <CallEndUTC>2023-04-10 14:59:07:000 +0530</CallEndUTC>
    <ACDLogin>BManager</ACDLogin>
    <AgentGroup>SWAT_Email</AgentGroup>
    <AgentFirstName>Reba</AgentFirstName>
    <AgentLastName>Manager</AgentLastName>
    <EmailType>InboundEmail</EmailType>
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    <ThreadId>579960963</ThreadId>
    <MessageId>297282</MessageId>
    <Customer>Anthony</Customer>
    <Email>anthony@Alvaria.com</Email>
    <CaseId>1</CaseId>
    <Subject>RE: [Ref#: 579960963] TEST with Attached</Subject>
    <DisplayRecord>true</DisplayRecord>
    <Attachments>SampleAttach1.txt,level1\OpenSSL.txt</
Attachments>
  </metadata>
</recording>

Sample XML file for Customer:
<?xml version="1.0" encoding="utf-8"?>
<recording>
  <metadata>
    <Filename>email-Customer.json</Filename>
    <CallStartUTC>2023-04-10 14:58:23:000 +0530</CallStartUTC>
    <CallEndUTC>2023-04-10 14:58:23:000 +0530</CallEndUTC>
    <ACDLogin>BManager</ACDLogin>
    <AgentGroup>SWAT_Email</AgentGroup>
    <AgentFirstName>Reba</AgentFirstName>
    <AgentLastName>Manager</AgentLastName>
    <EmailType>InboundEmail</EmailType>
    <ThreadId>579960963</ThreadId>
    <MessageId>297282</MessageId>
    <Customer>Anthony</Customer>
    <Email>anthony@Alvaria.com</Email>
    <CaseId>1</CaseId>
    <Subject>TEST with Attached</Subject>
    <DisplayRecord>false</DisplayRecord>
    <Attachments>customer\AspectSampleText.txt</Attachments>
  </metadata>
</recording>
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8. After Selecting the xml file, Mapping and Custom Fields will enable to map fields. Xml 
attributes/elements will be available in the combo box as shown in the below screenshot. 

Table 9-5  Email Mapping Definition

Field Name Aspect Quality Field Description

Interaction Type • Type of the interaction.
• Aspect Quality Support three 

types of interaction
• Namely Inbound Email, 

Campaign Outbound Email, 
Manual Outbound Email are the 
types.

Map the xml attribute that contains the value for 
Interaction type.

Inbound Email Used for emails sent directly to an 
agent.

• Provides the value for the Type available in 
xml file to map for Inbound Email type for 
interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Inbound Email.

Campaign Outbound 
Email

Used for emails that are sent by the 
system and were connected to an 
agent.

• Provides the value for the Type available in 
xml file to map for Campaign Outbound Email 
type for interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Campaign Outbound Email.

Manual Outbound 
Email

Used for emails manually sent by 
the agent.

• Provides the value for the Type available in 
xml file to map for Manual Outbound Email 
type for interaction in Aspect Quality.

• Allows to provide multiple values by comma 
separated.

• If the input value (s) matches with the value in 
the xml file interaction type will be updated 
with Manual Outbound Email.
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Media Source File 
(Mandatory)

Filename of the media which will be 
associated to an interaction.

• Map the xml attribute which contains the 
media file name.

• Aspect Quality supports the files with “.json” 
formats only.

Start Time 
(Mandatory)

Interaction Start date time. • Map the xml attribute which contains the Start 
Time.

• Refer to Date Time Format for Import Job 
section.

End Time (Mandatory) Interaction End date time. Map the xml attribute which contains the End 
Time.

Refer to Date Time Format for Import Job section.

ACD Login 
(Mandatory)

Username or the login id of the 
agent for the ACD associated who 
handled the interaction.

Map the xml attribute that contains the ACD Login.

First Name First Name of the agent, who 
handled the interaction.

Map the xml attribute that contains the first name.

Last Name 
(Mandatory)

Last Name of the agent who 
handled the interaction

Map the xml attribute that contains the last name.

Queue Name Agent group/Queue associated with 
the interaction.

Map the xml attribute that contains the agent 
group name.

Customer Name Name of the customer. Map the xml attribute that contains the name of 
the customer.

Email Address Email address of the customer. Map the xml attribute that contains the Email 
address of the customer.

Message ID The identification number for the 
email message.

For a reply email, the agent and 
customer must have the same 
message ID value.

Map the xml attribute that contains the Message 
ID.

Thread ID The identification number for the 
email thread.

For a reply email, the agent and 
customer must have the same 
thread ID value.

Map the xml attribute that contains the Thread ID.

Case ID The Case ID for the interaction. Map the xml attribute that contains the Case ID.

UCID Universal Call ID of the interaction. Map the xml attribute that contains the UCID.

Subject The subject of the email interaction. Map the xml attribute that contains the subject of 
the email.

Attachments Name of the attachment file in the 
email.

• Map the xml attribute that contains the 
attachments filename of the email.

• Allows to provide multiple values by comma 
separated.

Table 9-5  Email Mapping Definition

Field Name Aspect Quality Field Description
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9. Map the metadata for the Email Mapping fields as shown in the below screenshot. 

10.Once the mapping is done in the Mapping tab for either of the Channel Type; Audio, Chat 
or Email, next is Custom Fields tab.

11.Click on Custom Fields tab to map the custom defined fields, as shown in the below 
screenshot.

Note:
• The user must map data for fields other than those provided in Mapping field, they 

can define their own Custom Fields and map the data.
• Custom Field Name defines when mapping the metadata or using “Global Custom 

Field Name Definition” (Refer to Global Custom Field Definition section) and use 
them while mapping.

Customer Transcripts Indicates whether the imported 
email record should be displayed 
individually as an agent transcript or 
customer transcript. If the email is a 
customer transcript, it will not be 
displayed as separate recording, 
instead it will be associated with the 
corresponding agent reply. 

• Map the xml attribute that contains the 
customer transcripts.

• For example, when the xml is not mapped or 
when mapping xml has value of Yes, True or 
greater than 0, then it is considered as an 
agent record. Any other value will be 
considered as customer record.

Table 9-5  Email Mapping Definition

Field Name Aspect Quality Field Description
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12.Click OK Button, will close the Add Metadata Mapping and opens the Add Job page.
Note: When the metadata is mapped for an import job, the button will be displayed as Edit 

Metadata Mapping. It allows to edit the metadata mapping details and the user can 
not completely remove the metadata mapping.

Table 9-6  Custom Fields Definition

Field Name Description

Add Button • Allows user to add the custom filed names.
• Maximum of 30 custom fields can be added for an import job.

Delete Button • Allows to delete the selected custom field row.
• When one custom field row exists, user will not be allowed to delete.

Custom Fields Name • This is a text box as well as a drop-down list.
• All the custom fields available for Import switch will be displayed in the 

drop-down list.
• User also defines a new custom field name for the import job.

Mapping Allows user to map the xml attributes to the custom field.
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13.Click OK Button on Add Job dialog page. The import Job is saved and populated on the 
Import Job Grid, as shown in the below screen. 

14.First Run and Last Run will be empty when import job is created and the status is in 
Pending status.

9.3.2.2.2   Date Time Format for Import Job
The date-time format is specified in the Importer configuration file. The importer configuration 
file, Importer.exe.config, is located where the product was installed to. The default location is 
C:\Program Files (x86)\Aspect Software\AQM\Server\.

The default formats in the configuration file are:

<add key="ImportJobDateFormats" value="yyyy-MM-dd HH:mm:ss:fff zzz, yyyy-MM-
ddTHH:mm:ss.fffffffzzz" />

which would import dates such as:

2024-12-13 12:54:51:308 -06:00

2024-12-13T12:54:51.3080842-06:00

2024-12-13T20:03:06.1635209Z

The ImportJobDateFormats value is a comma separated list of format strings. Each format 
string must follow the Microsoft .net date-time format string specification. A search for '.net 
custom datetime format strings' should locate the Microsoft documentation and many 
examples. The current Microsoft documentation at the time of writing is available at: https://
learn.microsoft.com/en-us/dotnet/standard/base-types/custom-date-and-time-format-strings

Letters in the format string represent parts of a date.

Common format specification parts are:

yyyy four digit year

MM 01 to 12 month number

dd 01 to 31 day of month

The Importer process will adjust the times to Universal Coordinated time based on the 
provided format. If no timezone information is provided, the times are assumed to be in 
Universal Coordinated Time.

The Importer process must be restarted to apply any changes made to Importer.exe.config file

For example, the start and end times required metadata fields. In the metadata XML files, 
these times could be represented as:

<StartTime>5/30/2019 11:53:07 PM</StartTime>
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<EndTime>5/30/2019 11:53:07 PM</EndTime>

which would require an ImportJobDateFormats value containing: "M/d/yyy h:m:ss tt". 

Note: This example is not the best way to represent and parse dates because there is no 
timezone information. The format of the metadata depends on the external system 
which supplies the metadata XML. 

The ImportJobDateFormats option allows the Importer process to work with different external 
systems. The RFC-3339 (ISO-8601) defines a standard for exchanging dates between 
systems as shown in this example:

<callBeginTime>2024-12-13T19:50:25.3701610Z</callBeginTime>

<callEndTime>2024-12-13T19:55:55.3171714Z</callEndTime>

which would require an ImportJobDateFormats value containing:yyyy-MM-
ddTHH:mm:ss.fffffffK

Note: The XML element names are not part of any standard. You just need to map the names 
provided by the external system to AQM fields. This is described in the "Add Metadata 
Mapping" section.

9.3.2.2.3   Parse Single XML field for First Name and Last Name
XML file can have single xml field containing First Name and Last Name with Separator. 
Examples: 

<AgentName>john,doe</AgentName>
<AgentName>,doe</AgentName>
<AgentName>john,</AgentName>
<AgentName>john.doe,smith</AgentName>
<AgentName>john doe</AgentName>
<Entity AgentName = “john,doe” />

Separator:

Below are list samples

• , (comma)

• . (Dot)

• (Blank-space)

• _ (Underscore)

To Parse the XML which has FirstName and LastName in single xml field, A Default Key 
"ImportJobUserNameSeparators" with value "," will be deployed in the Importer.exe.config file. 
As show in the below.

       <add key="ImportJobUserNameSeparators" value=","/>
Multiple separators can also be specified. As show in the below.

       <add key="ImportJobUserNameSeparators" value=",. _"/>
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While Parsing xml whichever separator occur first based on that Users FirstName and 
LastName will be processed.

Note: If any changes are done in the Importer Configuration file, recommend to restart the 
importer process is required to update the changes.

For example, with comma separator specified, when the same AgentName element is mapped 
against Aspect Quality Field First Name & Last Name, it will be parsed as

Note: *** - When the Last Name is blank in the XML field, then the First Name is mentioned 
as the Last Name by default.

If the key "ImportJobUserNameSeparators" is not specified, then whatever value is present in 
the mapping field will be used directly.

9.4   Import Job Grid
Import Job grid displays all the import jobs available in the system. Users grid contains 
information as mentioned in the below table.

XML Field First Name Last Name

<AgentName>john,doe</AgentName> john doe

<AgentName>,doe</AgentName> doe

<AgentName>john,</AgentName>*** john john

<AgentName>john,doe,smith</AgentName> john doe, smith

Table 9-7  Import Job Grid Attribute Details

Column Name Description Default 
Column

Optional 
Column

Channel to Import • Channel type selected for the import job. 
• We are supporting interactions with “Audio”, 

“Chat” and “Email” channels.

Job Name Displays name of the import job

Description Displays description of the import job

Created Date Time Displays date time when the import job is created.

Note: Date time will be displayed based the locale 
and client machine time zone.

Last Modified Date 
Time

Displays date time when the import job recently 
updated.

Note: Date time will be displayed based the locale 
and client machine time zone.

Import Location Displays the location from where the metadata and 
media files to import can be picked.
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Schedule Displays when the import job will run.
• For e.g. If an import job is scheduled to run on 

every Monday and Tuesday at 12:00 PM then the 
schedule will display as below. 
Every Mon, Tue at 12:00 PM

• If the import job is scheduled to run only one day 
at 2:30 PM then the schedule will be display as 
below. 
Once at 24 July 2019 02:30 PM

Storage Group Displays the storage group assigned for import job 
where the media files will be moved after the 
interactions are imported.

Active Indicates the import job is active or inactive

• Checked ( ) – import job is active

• Unchecked ( ) – import job is inactive

Start Date Displays the start date of the import job. i.e. when the 
job should start to run / have ran.

End Date Displays the end date of the import job. If No End date 
is specified, then this column will have a blank value. 
i.e. until when the job should run.

First Run Date Time when the import job ran for the first time.

Note: Date time will be displayed based the locale 
and client machine time zone.

Last Run The recent date time when the import job ran. Date 
time gets changed every time when the import job is 
run.

Note: Date time will be displayed based the locale 
and client machine time zone.

Table 9-7  Import Job Grid Attribute Details

Column Name Description Default 
Column

Optional 
Column
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Note:

• Grid will be sorted on Created Date Time by default.

• User is able to sort on column in the grid and the customizations will be persisted till the 
user signs out from the WEM or Resets the grid layout.

• Per page 100 import jobs will be displayed.

• Use the Filter option available in the  menu to filter any column based on the 
requirement.

Status Displays the recent run status of the import job.

Status can be any one from the below mentioned list.
• PENDING – displays when the import job is 

created and not run at least once.
• SUCCESS – displays when all the metadata and 

media files available in the import location is 
imported to Aspect Quality successfully.

• PARTIAL SUCCESS – displays when some of the 
metadata and media files available in the import 
location is imported to Aspect Quality and some of 
the metadata and media files failed to import to 
Aspect Quality.

• FAILED – displays when no metadata and media 
files from the import location is imported to Aspect 
Quality.

• PROCESSING – displays when the import job is 
running and processing the metadata and media 
files from import location to Aspect Quality.

Table 9-7  Import Job Grid Attribute Details

Column Name Description Default 
Column

Optional 
Column
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9.5   Importer Process
After the import job is created and When the schedule reaches for the job the import job will 
run.

Note: Import job will not run if any one of the below statements is true.

• Importer Process is not started.

• Import Job is in inactive state.

• Import Location in the import job mentioned is not accessible.

• Storage Group assigned to an import job is inactive.

9.5.1   What does the importer process do?
1. Check for the schedule of the job and once the schedule is reached, starts to process the 

job.

2. Gets the metadata file (xml) and media file from the importer location.

• For each xml file there should be a media file available. (one to one mapping) 
Example: Ideally If 10 xml files is available then 10 media files should be available.

3. Each XML file in the Import location will be processed.

• 1 interaction will be created for every successfully parsed XML file.
• Based on the Metadata mapping (Refer to Add Metadata Mapping section) system 

will parse the XML file and find the XML Attribute/element which is mapped to a 
Aspect Quality field and update the Aspect Quality field with the corresponding value 
of the XML element or attribute mapped.

4. Creates an interaction in Aspect Quality by associating the values parsed from xml for the 
fields mapped.

Example: If xml contains attribute as below
<ACD Login> Agent1 </ACD Login>
If ACD Login attribute is mapped to “ACD Login” field in Aspect Quality, then value for agent in 
the interaction will be assigned a value as “Agent1”.

5. Once interactions are imported to Aspect Quality, metadata file will be deleted from the 
import location and media file will be moved to the storage group specified in the import job.

6. Creates the Result file for job for each schedule. Import Job run details can be viewed. 
(Refer to Import Job Results File section)

Note:

• ACD Login and Last name is mandatory fields in Aspect Quality, if the user specified in 
the xml file is not available in Aspect Quality for import then Importer process will create 
a new user with ACD Login and Last name provided and associate the user to the 
interaction.

• If Agent Group is mapped and if the agent group specified in xml does not exists for the 
import, then the importer process will create the agent group and associate to the 
interaction.
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7. Once import Job ran then it will fall into one of the below status.

• Processing

• Success

• Partial Success

• Failed
Note: Import Job will be in Pending status when the job is created and not run at least 

once.

9.5.2   Import Job Success
1. Import location should be accessible.

2. Import job should be in active state.

3. Storage Group selected in Import Job should be active.

4. Once the schedule is reached, importer process will run the import Job.

5. All the metadata and media files exist in the import location processed without any failures 
then the job will succeed. Run status will get updated in Import Job grid. 

• Status will update to Success.

• If Job runs for the first time, then First Run and Last Run will be the same date time 
when the job is run. Next time when the job will run only Last Run gets updated and the 
First run remains same. 
Example: Out of 100 metadata and media files, all 100 metadata and media file 
processed success –Success

6. Metadata file will be deleted from the import location and Media files will be moved to the 
storage group

7. For each xml file and corresponding media file one interaction will be created in Aspect 
Quality. (Refer to Imported Interactions section)

8. Results File will be generated which will contain the details of the job run. (Refer to Import 
Job Results File section)

9.5.2.1   Nothing to Import
If metadata and media files does not exist in Import Location and if the schedule is reached, 
the job will not process anything, and the job status will be Success.

• No interactions will get imported to Aspect Quality.

• Status of the job will be displayed as Nothing to Import in Results file.

• Last Run Status in UI will be displayed as Success 
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9.5.3   Import Job Partial Success
1. Import location should be accessible.

2. Import job should be in active state.

3. Storage Group selected in Import Job should be active.

4. Once the schedule is reached, importer process will run the import Job.

5. All the metadata and media files exist in the import location processed with few failures 
then the job will succeed partially. Run status will get updated in Import Job grid. 

• Status will update to Partial Success.

• f Job runs for the first time, then First Run and Last Run will be the same date time when 
the job is run. Next time when the job will run only Last Run gets updated and the First 
run remains same. 
Example: 
• Out of 100 metadata and media files, only 1 metadata and media file processed 

success – partial Success.
• Out of 100, only 99 process success -Partial Success.

6. Successfully processed Metadata file will be deleted from the import location and Media 
files will be moved to the storage group. 

7. Media and metadata files failed to parse will be moved to the Failed folder (Refer to Import 
Job Failed section)

8. For each xml file and corresponding media file processed successfully, one interaction will 
be created in Aspect Quality.

9. Results File will get generated which will contain the details of the job run. (Refer to Import 
Job Results File section)

9.5.4   Import Job Failed
1. Import location should be accessible.

2. Import job should be in active state.

3. Storage Group selected in Import Job should be active.

4. Once the schedule is reached, importer process will run the import Job.

5. All the metadata and media files exist in the import location processed with failures (Refer 
to Possible reasons for the Import Job Failure section) then the job will fail. Run status will 
get updated in Import Job grid. 

• Status will be updated as Failed.

• If Job runs for the first time, then First Run and Last Run will be the same date time 
when the job is run. Next time when the job will run only Last Run gets updated and the 
First run remains same. 
Example: Out of 100 metadata and media files, all 100 metadata and media file 
processed with failures – Failed

6. Metadata and Media files will be moved to the Failed folder inside the import location.
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7. No interactions will get imported to Aspect Quality.

8. Results File will get generated which will contain the details of the job run. (Refer to Import 
Job Results File section)

9.5.4.1   Possible reasons for the Import Job Failure
1. Media file does not exist for a metadata file in the Import Location.

2. Media Files with invalid file types.

Note: Files supported formats in Aspect Quality - .WAV, .WMA, .MP3 .MP4, and .JSON

3. Data for the Aspect Quality mandatory fields mapped is missing/Blank. 
Example: ACD Login is a mandatory field in Aspect Quality and if xml file contains no value 
for the attribute/element mapped for ACD Login, then the job will fail.

4. Date Time format is incorrect (format which does not supported by Aspect Quality. Refer to 
Date Time Format for Import Job )

9.5.5   Imported Interactions
Users can search, playback and evaluate the imported interactions in Aspect Quality.

9.5.5.1   Search Imported Interactions
User can add an Imported search criterion as shown in below screenshot and search for the 
Imported Interactions.
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All the imported interactions will be displayed in the search results grid. Imported column is 
added in the search results grid (hidden column) which will indicate interactions imported to 
Aspect Quality.

Imported column displays “Yes” for the imported interactions as shown in the below 
screenshot.

9.5.5.2   Playback imported interactions
User can “Create Playlist” to playback the interactions. (Refer to Create a Playlist on page 4-
163 section).

9.5.6   Import Job Results File
1. Import Job result file contains the details about each iteration of a schedule of the import 

job. User can view the complete details of each schedule of an import job in the results file.

2. Result file will be created by the importer process for each schedule of an import job within 
a storage group specified for the import job. Result file will be in “.txt” format.

3. Structure of the Result file is as mentioned below
       “\\<StorageGroup>\Import Results\ImportJobName-JobID\Result-
YYYYMMDD-HHMM.txt”

Note:
• Job Name will be displayed with first 10 characters specified in the import job.
• Date time will be the start date time of the import job.

4. Result file contains the information mentioned below.

• Import Job Name

• Import Job Id

• Import Job Results
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• Execution Start Time - Date time when the schedule of the import job started. Date 
time will be displayed in both local and UTC time zone.

• Execution End Time - Date time when the schedule of the import job ended. Date time 
will be displayed in both local and UTC time zone.

• Next Execution Time - Date time when the next schedule for the import job. Date time 
will be displayed in both local and UTC time zone. 
If the import job end date is reached and no schedules are available, then N/A will be 
displayed which indicates there is no further schedules.

• Parsed Interactions - Total number of interactions parsed. This includes xml and 
media file as one interaction which includes passed and failed interactions.

• Imported Interactions - Total Number of interactions imported successfully. This 
includes xml and media file as one interaction.

• Failed Interactions - Total Number of interactions failed to import. This includes xml 
and media file as one interaction.

• Status - Status of the job. (Success, Partial Success, Failed and Nothing to import) 
If the status is Failed or Partially success, failure reasons will be displayed.

9.5.7   Import Job Failed Folder
1. When an import job failed to parse the media and metadata files, then all the media and 

metadata files will be moved to Failed folder.

2. Failed folder will be created by the importer process if the parsing of the files is failed.

3. Failed folder gets created within the import location specified for an import job.

4. Failed folder structure will be as mentioned below.
“\\<ImportLocation>\Failed\Jobname-
JobID\YYYYMMDD\<media_metadata_files>”

Note:
• Job Name will be displayed with first 10 characters specified in the import job.
• Date will be the interaction date (start date) specified in the xml file

5. When the import job is failed for the reasons mentioned in section, Possible reasons for the 
Import Job Failure user can get the files failed to parse from the Failed folder and correct the 
errors and add those media and metadata files to the import location so that the job will parse 
those files for the next schedule.

9.5.8   Importer Process and Import Job Log File
1. Log file can be used to know what went wrong in the importer process and the details of the 

import job.

2. Aspect Quality will provide 2 log files for Import.

• Importer Process Log file
• Log file for Importer process will get created when the importer process is started.
• Details of the importer process and Import Job will be logged. Actions performed on 

each import job like Create/Edit/Delete/Activate/Deactivate will be logged in importer 
log file.
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• If the import job not ran after the schedule is reached (Example: Reason like Import 
Job is inactive) the reason will be logged.

• Importer Process log file will be generated in below mentioned location.
“C:\ProgramData\Aspect Software\Quality 
Management\Log\Importer”.

• Import Job Log file
• Log file for each import job gets created by the importer process when the import job 

run.
• Details of the import job schedule and job results will be logged.
• Importer Process log file will be generated in below mentioned location.
“C:\ProgramData\Aspect Software\Quality 
Management\Log\Importer\Import-JobName-JobID\Import-JobName-
JobID_HHMMSSmmm”.

9.5.9   Edit Import Job
Edit button will be enabled when one import job is selected in the import jobs grid.

1. Click on Edit button  to update the import job detail.

9.5.9.1   Edit basic details
1. Select an import job from the import jobs grid and Click on Edit button.
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2. Edit Job dialog displays as shown in the below Edit Job screen.

3. All the fields will be enabled, and the user is able to update data for any field and save the 
import job.

Note: For more information, refer to Table 9-2. When editing the data for each field all the 
information mentioned in the table will be applicable.

9.5.9.2   Edit Metadata Mapping
Follow the steps below to edit a metadata mapping.

1. Click on Edit Metadata Mapping button to edit the metadata mapped for the import job. 
The Edit Metadata Mapping dialog appears as shown below. The Mapping tab is selected 
by default.
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2. The mapped metadata filename will be displayed at the top right corner of the dialog.

3. Click on the drop-down list to update the mapped data based on the requirements.

Note:
• Mandatory Mapping fields are marked with asterisk (*).
• Non-mandatory Mapping fields are editable based on the requirements.

4. Go to Custom Fields tab to add/update/remove for the Import Job.
Note: Functionality of all the fields will remain same as in Add Metadata Mapping dialog. 

(Refer Add Metadata Mapping section)

5. Click on Remap File button to remap different metadata.

6. Click on Remap File button and select a different metadata file. It remaps the metadata 
fields from the latest metadata file selected.
Note: When mapped values do not exist in the new metadata file, then those will get 

obsolete and will display with a red triangle as shown on the below screenshot.
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Note: All the metadata fields which are showing in Red does not exist in the latest 
metadata file selected. User must select the correct mapping value and save the 
metadata for the import job.

7. Click on Import Location field and edit the import job details as shown below.
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8. Click on OK button to save with the updated details and displays in the import jobs grid as 
shown below.

Note:
• After updating the import job basic data and metadata mapping fields, the changes 

will be applicable for the next available run of the import job.
• Import Jobs can be updated regardless of the status of the import job. Even when 

the import job is in Processing state the details can be updated. The updated details 
will get considered for the next run of the import job. The Updates will not be 
considered for the current run.

9.5.10   Delete Import Job
Follow the steps below to delete an Import Job.

1. Select the import job which needs to be deleted and click on Delete  button.

2. Selecting an import job which is in other than Processing state and clicking on the Delete 
button will display a confirmation message as shown in the below screenshot.

3. Clicking on No button will cancel the delete action and will not delete the import job.

4. Clicking on Yes button will delete the import job successfully.
Note: Deleting the import job will not remove the interactions imported as part of the 

deleted import job.

5. Selecting an import job with Processing status will display an alter message as shown in 
the below screenshot.

6. Clicking on OK button will not delete the import job. Once the job is completed then user 
can delete the job.
Note: Import Jobs Created, Updated, and Deleted will be audited in Audit Activity Detail 

Report.
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9.5.11   Activate and Deactivate Import Jobs
Activate  and Deactivate  buttons allow to activate and deactivate one import job from 
the import jobs list page.

1. Activate button will be enabled when one deactivated import job is selected in the Import 
Jobs grid 

• Clicking on Activate button will update the selected import job status to active. 

• Check mark  will be displayed under Active column for the corresponding import 
job as shown in the below screen.

2. Deactivate button will be enabled when one active import job is selected in the Import Jobs 
grid. 

• Clicking on Deactivate button will update the selected import job status to inactive. 

• Check mark  will not be displayed and the column will appear blank under Active 
column for corresponding import job as shown in below screen.

Note:

• When an import job is running and if it is in Processing state, deactivating the job will not 
stop the job processing. The process will complete the run for the job. 

• Only one import job can be activated/deactivated/deleted at a time.

9.5.12   Global Custom Field Definition
User is able to add/edit/delete the Global Custom Metadata Mapping fields for Importer.
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9.5.12.1   Add Custom Field Name
1. Click on Global Custom Field Definition  button will open dialogue as shown below. 

Note: When custom fields are not defined for an import job then all 30 custom filed names 
will be displayed as blank.

2. Maximum of 30 custom fields will be defined for Importer.

3. Enter the custom field name in one or more text box and click the OK button.

4. Entered custom fields will get saved for the Import switch. The defined custom fields are 
used to map the data when creating/editing import job.
Note:

• Custom File Name must be unique.
• Maximum 50 characters are allowed for Custom field name.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 466



Administrator Guide
9.5.12.2   Edit Custom Field Name 
1. After saving the custom fields, click on Global Custom Metadata Mapping button will 

display all the saved custom field names.

2. Custom Field with asterisk indicates that the field is mapped for one or more imported 
4interactions.

3. Defined custom fields are displayed in alphabetical order on the Global Custom Metadata 
Mapping dialog.

4. Update the existing custom field name and click on OK button will save the custom field 
name.

5. Also user is able to define new custom field names. (Refer to Add Custom Field Name 
section)
Note: When a custom field is defined from Add/Edit Metadata Mapping when creating/

editing an import job those custom field names will also be displayed.

9.5.12.3   Delete Custom Field Name
1. Custom Field which is not mapped for any import job or not associated with any imported 

interaction can be deleted/removed.

2. Custom Field which is mapped to minimum one import job displays with asterisk indicating 
that the custom field name cannot be deleted. It can be only updated.
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3. To delete the custom field, clear the data in the corresponding custom field text box and 
click on OK button as shown below. 

The Custom Field 2 (Local IP Host) is removed from the import switch. 
 

Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 468



Administrator Guide
9.5.12.3.1   Import Job Flow Diagram
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10.  Aspect Quality Evaluation

This chapter describes about how Aspect Quality uses Evaluation Templates to evaluate the 
scores and Workforce Configuration to upload the scores. 

The features of Quality Evaluation are listed below:

• Evaluation Templates

• Workforce Configuration
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10.1  Evaluation Templates
In Quality, scorecard templates are templates. Before a Team Lead can evaluate any calls, the 
Team Lead (with rights to create a template) or an Administrator must create a template. To 
use the template for scoring, the Team Lead performing the review must have the View 
permission to that template. When a Team Lead creates a template, the Team Lead has 
permission to see that template, unless the Administrator grants permission to other Team 
Leads to view it.

You can create templates with questions, multiple sections, and user-defined weights to each 
question, to customize the grading according to what is important to the call center. 

You can use Workforce Engagement Management to create, edit, and duplicate templates. 
Then, you can save the template as Draft or as Final. Once you have saved a template as 
Final, you can use the template to evaluate a call.

You can create multiple templates in the system, and can activate or deactivate the templates 
as needed.

10.1.1   Navigating the Evaluation Template Window
This section describes the Evaluation Templates list window, where templates that you save as 
Draft and Complete are displayed. On the Evaluation Templates window, you can create a new 
template; duplicate, edit, or delete a template; or make a template active or inactive.

1. Launch Workforce Engagement Management.

2. Log in as an Administrator.

3. From the menu, select Administration.

The Administration dashboard opens.
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4. Under QM Evaluation, click Evaluation Templates.

The Evaluation Templates window opens, and a list of templates whose Status is either 
Draft or Complete displays in the table.
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The following table contains descriptions of each column in the Evaluation Template table.

The following table describes the menu options.

Column Name Description

Name The name of the template.

Note: By default, the list of templates are sorted based on the Names in the 
ascending order.

Description The description of the template.

Created By The name of the user who created the evaluation template.

Note:
• Administrators can see the list of all templates in the system.
• Team Leads can see the templates for which the Team Lead is the owner, 

and also the templates created by other users for which permission is 
available.

• Evaluation Templates that you did not create in Workforce Engagement 
Management do not display any value in the Created By column.

Created Date The date that the user created the template.

Note:
• Evaluation Templates that you did not create in Workforce Engagement 

Management do not display any value in the Created Date column.
• To get the recently saved evaluation template at the top of the list, user 

can sort the grid based on the Created Date in the descending order.

Status Draft: Templates that the user saves as Draft are not available yet for 
scoring. Only the Created By user or an Administrator can edit a Draft 
template.

Complete: Templates that the user saves as Complete are available for 
scoring.

Active/Inactive If template is available for use in scoring, then a check mark displays in the 
Active column. If no check mark displays, the template is Inactive, and 
therefore unavailable for use in scoring.

Menu Option Description

Refresh Refreshes the Evaluation Template grid with latest evaluation template 
changes. Instead of the browser refresh button user can click on this menu 
button which will refresh only the grid data and not the page.

Add Creates the new Evaluation Template and lists to the grid.

Edit Opens the Draft template for you to edit. Once a template is Complete, this 
option no longer displays in the cog wheel menu.

Duplicate Copies the template for you to use as a basis for a new template.

Delete Removes the template from the Evaluation Templates list.

Note: If an evaluation is created using this template, the Delete option is 
inactive.

Activate Activates the template if the status is inactive.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 473



Administrator Guide
On the Evaluation Templates window, a scroll bar appears when number of templates exceeds 
the display area. Each page contains no more than 100 templates. If there are more than 100 
templates, then pagination appears at the bottom of the window.

10.1.1.1   Definition and Administration
A Team Lead uses a template to review an Agent’s interaction and evaluate it based on 
specific criteria. You create the criteria as a part of the template. The following table describes 
the sections of a template.

Deactivate Deactivates the template if the status is active.

Template Section Description

Sections Templates may have multiple sections. Add sections to similar questions to 
group them together. For example, when creating a template to grade 
customer satisfaction, you might add sections such as:

• Section 1: Greeting behavior

• Section 2: Hold time

Section Weight The section weight defines the importance of the section. Based on the 
response of the questions that you select in this section, the score is 
converted to the section score. In Workforce Engagement Management, 
section weight is always equal to the sum of all the question weighs under 
that section. For example, if Section 1 has 2 questions with the weight of 
each question as 10, then Section Weight = (10 + 10) = 20. The system 
calculates this automatically, so there is no option for the user to enter the 
section weight manually.

If the system calculates a section weight of 20, and 2 questions with each 
having a weight of 10, and when a reviewer evaluates the interaction, if 
each question gets a score of 10, then the section score is calculated as 
[(10 + 10)/20]*100 = 100%.  
(Sum of point accumulated for each question/Sum of all scored question’s 
weight)*100.

Note: The numbers for Section weight are non-negative integers.

Menu Option Description
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10.1.2   Create an Evaluation Template
This section describes how to create an evaluation template. This includes how to add section 
details, question details, dependent question details, and how to save the evaluation template.

1. On the Evaluation Templates window, click Add new evaluation template.

Question Type Each section can have multiple questions, and you can assign a question 
type to questions within a section. The type of question assigned should 
reflect the nature of the question. For example, you would typically assign a 
True/False or Yes/No question type to a question to verify if an agent 
greeted the customer.

Following are the question types that can have a question weight:
• Yes/No
• Bonus: Yes/No
• True/False
• Bonus: True/False
• Pass/Fail
• Bonus: Pass/Fail
• Scored Scale
• Bonus: Scored Scale
• List (if the Enable Weights check box is selected)

Following are the question types that cannot have question weight:
• Free Form Text
• List (if the Enable Weights check box is deselected)

Question Weight The Question Weight defines the importance of the question and allows 
you to tailor the grading to contact center needs. You can specify weight for 
each question within a section. 

Note: The numbers for Question weight are non-negative integers.

Question Description An option to enter the explanation for each question in the template and the 
explanation displays in the evaluation when the user moves the mouse 
over the question. For each question that has a description, the user can 
click the Information icon to display that description.

Template Section Description
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The Create Evaluation Template window opens.

2. In the Name text box, type the name of the evaluation template. The maximum number of 
characters allowed is 100. The template name must be unique and is required.

3. (Optional) In the Description text box, type description for the evaluation template. The 
maximum number of characters allowed is 1024.

4. When you evaluate an interaction, scores can appear in three (3) places on the evaluation 
window. From the Display Scoring drop down list box, select one or more of the following 
options.

5. From the Scoring Type drop-down list box, select one of the following options.

Option Description

Section Displays scores for each section.

Question Displays scores for each question.

Overall Displays score for the entire evaluation.

Score Display Type Description

Success Rate / Quality 
Score (%)

Displays the score converted into a percentage.

Success Rate / Quality 
Score (%) & Pass/Fail

If the defined Auto Fail condition is not satisfied, the system displays Pass 
with Success Rate. 
If the defined Auto Fail condition is satisfied, the system displays Fail with 
Success Rate. 
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6. Define the Default Question Response for all of the questions. Click the drop-down list 
and select one of the following options.

7. When you create a new evaluation template, by default, the Display Question Numbers 
check box is selected. You can deselect the check box if you do not want question numbers 
to display in the evaluation, and if you want to define your own question numbers.

For example, if the question text is This is the question title,

8. Weight for N/A Answer Choice:

• Some evaluation questions may not be relevant to a specific call. In these cases, you 
might want to use the Not Applicable (N/A) answer option to denote that the question 
was not appropriate for this situation. However, using an N/A selection can make it 
difficult to compare its scorecard with other scorecards where the N/A question was 
scored.

• Aspect Quality has a Not Applicable (N/A) option for all questions, but for some 
questions, you may not want N/A to appear as an option. (Refer Add a New Question)

• Depending on how you configure a scorecard template with Weight for N/A Answer 
Choice, if a user selects that scorecard template to score an interaction and selects the 
N/A option for any of the questions, then the system considers N/A in the question 

Total Points (Number) Displays the absolute/raw score.

Total Points (Number) & 
Pass/Fail 

If the defined Auto Fail condition is not satisfied, the system displays Pass 
with Total Points. 
If the defined Auto Fail condition is satisfied, the system displays Fail with 
Total Points.

Pass/Fail If the defined Auto Fail condition is not satisfied, the system displays Pass. 
If the defined Auto Fail condition is satisfied, the system displays Fail.

Option Type Description

None N/A is the default for all the questions in this template.

First answer choice First answer option defined in the question is the default for all the questions 
in this template.

Last answer choice Last answer option defined in the question is the default for all the questions 
in this template.

With the check box Questions display like below

selected 1. This is the question title.

deselected This is the question title.

Score Display Type Description
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score, section score, and overall score. See the following table for more information.  
 
The Weight for N/A Answer Choice drop-down list box contains the following options.

Note: When the interaction has already been scored by the user, then the Weight for N/A 
Answer Choice drop-down list box on the scorecard template is disabled.

9. When the Team Lead evaluates a call using a template, and if the overall score is 0 or less, 
then the configured value overrides the overall score.  
 
If you want the configured value to override the overall score, then from the drop-down list 
box, select Override Minimum Possible Score.

Note: If you select the Scoring Type Quality Score, then the value that you enter displays 
as the Overall score. If you select the Scoring Type Total Points, then the overridden 
value converts to the absolute score. 
 
The calculation to convert the configured value into the absolute score is  
Sum of all Section weights * (value of Override Minimum Possible Score / 100)

10.When the Team Lead uses a template to evaluate a call, and if the evaluation has a 
maximum score, then the configured value overrides the overall score.  
 
If you want the configured value to override the overall score, then from the drop-down list 
box, select Override Maximum Possible Score.
Note: If you select the Scoring Type Quality Score, then the value that you enter displays 

as the Overall score. If you select the Scoring Type Total Points, then the overridden 
value converts to the absolute score.6 
The calculation to convert the configured value into the absolute score is  
Sum of all Section weights * (value of Override Maximum Possible Score / 100)

Option Type Description

Not included in score • When the user selects N/A in the interaction, the system does not 
consider the N/A answer in the scorecard calculation. 

• By default, when the user opens a new scorecard template, the system 
selects the Not included in score option.

Note: By default, the option for Weight for N/A Answer Choice is Not 
included in the score.

Highest weight of the 
question

• When the user selects N/A in the interaction, the system permits the 
highest weight of the question. For example, if  
1. The Question Type is Yes/No  
2. The Yes option has a weight of 10  
3. The No option has a weight of 0

• The user selects N/A for the question, then the question score is 10, and 
the system considers the section score and the overhaul score as 10.

Lowest weight of the 
question

• When the user selects N/A in the interaction, the system permits the 
lowest weight of the question. For example, if  
1. The Question Type is Yes/No  
2. The Yes option has a weight of 10  
3. The No option has a weight of 0

• The user selects N/A for the question, then the question score is 0, and 
the system considers the section score and the overhaul score as 0.
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11.Click the Select button in the Allow Access To section, to select one or more user profiles. 
It allows the user/s to score for the scorecard template. The Select User Profiles window 
appears as shown below. 

Note: To provide the access for a new user, select the user profile for which the user is 
associated with.

12.Go to the Search Items field, either search by name or click on the magnifying glass to 
search and select the profile/s.  
Or, click on the  button to select all of the profiles available in the database.
Note: In Via, every user has their user profile, and the user must be select the 

corresponding user profile.

13.Click OK. The Create Evaluation Templates window is active.
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14.To save the basic template details, click OK. The Create Evaluation Template window 
opens.

OR

You can cancel the template creation by clicking Cancel.

15.In the next procedure, you can Add a New Section.

10.1.2.1   Add a New Section
When you create a new evaluation template, by default, an empty Section with an empty 
Question displays.
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To complete the Section, perform the following steps.

1. The following table describes the fields in the Section. 

Note: The fields marked (*) are mandatory fields.

2. On the Section title bar, click the cog wheel icon. The menu contains the following options 
that you can select regarding this section.

Option Description

Name Type or retype the section name. The maximum number of characters 
allowed is 50. The name is mandatory, but need not be unique.

Description Type or retype a description of the section. The maximum number of 
characters allowed is 256. This field is optional.

Weight Displays the sum of question weights, or displays N/A when there are no 
possible question weights. The System calculates the section weight by the 
sum of all the (Scorable) question weight within the section or user can 
override the sum of question weight by entering the section weight manually.

Note:
• Dependent questions and Bonus questions are not included in the 

Section weight.
• If user updates the existing question weight or adds a new question 

(which is scorable) will override the section weight entered with the sum 
of the question weights.

• After adding questions and adjusting the question weights, change the 
section weight if you want to. 

• When Section Weight is blank and if user saves the template as Draft/
Final, a validation message as “Please supply section weight” will be 
displayed.

Enable Comments To allow feedback at the Section level while evaluating an interaction, select 
the check box.
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The following table describes the functions of the Section cog wheel menu.

Note: You can also add a Section at the bottom of the Create Evaluation Template by 
clicking Add Section.

3. See Add a New Question.

10.1.2.1.1   Expand or Collapse a Section
To manually collapse the contents of a section, click the down arrow at the left of section title.

The down arrow changes into a right arrow.

The section details and the questions within that section collapse, and only the section title 
displays.

Menu Description

Add Section Before Adds an empty section with a question above the current section.

Add Section After Adds an empty section with a question below the current section.

Remove This Section Removes the current section along with the questions in it.

Note: If this is the only section in the template, then this menu option is 
inactive.

Remove All Questions Removes all the questions within the current section and adds an empty 
question.

Expand All Questions Displays all the questions within the current section.

Collapse All Questions Hides all questions within the current section and displays only the question 
title.

Move Up Moves the current section above the preceding section.

For example, if the current section number is 2, then this section moves up 
and displays as section number 1.

Note: If there are no sections above the current section, then this menu 
option is inactive.

Move Down Moves the current section below the following section.

For example, if the current section number is 2, then this section moves 
down and displays as section number 3. 

Note: If there are no sections below the current section, then this menu 
option is inactive.
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To expand and view the contents of a section, click the right arrow at the left of section title. 
The right arrow changes into a down arrow. The section detail displays below the section title 
and the questions within the section display.

10.1.2.2   Add a New Question
When you create a new evaluation template, by default, an empty Section with a Question 
displays. To complete the Question information, perform the following steps.

Note: The fields marked (*) are mandatory fields.
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1. From the Type drop-down list box, select one of the following types of questions.
Note: Questions have two categories: questions with weight, and questions without weight 

(weights are used to calculate the score of the evaluation). Question Types to which 
you can assign weights are described in the following table.

Note: Once you have completed the fields described in the preceding table, continue to 
step 2.

10.1.2.2.1   Scored Scale and Bonus: Scored Scale
To add or modify the Scored Scale or Bonus: Scored Scale options, perform the following 
steps.

Type Option Description

Yes/No

Bonus: Yes/No

If the reviewer selects Yes, then the question gets the highest score (the 
weight is defined in the question). 

If the reviewer selects No, then the question gets the score 0. 

You cannot assign custom weights for options, because the weight of the 
question is assigned to Yes, and 0 is assigned to No.

Note: The fields for Bonus: Yes/No appear the same as the Yes/No type, 
except that the Auto Fail and Dependent questions are not applicable.

True/False

Bonus: True/False

If the reviewer selects True, then the question gets the highest score (the 
weight is defined in the question). 

If the reviewer selects False, then the question gets the score 0. 

You cannot assign weights for options, because the weight of the question is 
assigned to True, and 0 is assigned to False.

Note: The fields for Bonus: True/False appear the same as the True/False 
type, except that the Auto Fail and Dependent questions are not 
applicable.

Pass/Fail

Bonus: Pass/Fail

If the reviewer selects Pass while evaluating, then the question gets the 
highest score (the weight is defined in the question). 

If the reviewer selects Fail while evaluating, then the question gets the score 0. 

You cannot assign custom weights for options, because the weight of the 
question is assigned for Pass, and 0 is assigned for Fail.

Note: The fields for Bonus: Pass/Fail appear same as the Pass/Fail type, 
except that the Auto Fail and Dependent questions are not applicable.

Scored Scale 
Bonus: Scored Scale

This question Type can have multiple options. For specific directions, see 
Scored Scale and Bonus: Scored Scale.

List This question Type can have multiple options. For specific directions, see List.

Free Form Text A question Type to which you cannot assign weights (these questions are not 
considered for evaluation calculation). This question Type has no Options. 
Since the weight is not allowed, the question title bar does not display the 
weight. You can define a question so that the reviewer can answer this 
question by typing a response in free-form.
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a. Once you select the Scored Scale or Bonus: Scored Scale from the Type drop-down list 
box, the Options text box is active. Click Edit.

The Edit Question Options - Scored Scale window opens.

b. In the Question Text text box, you can add or modify the question text.

c. To generate the weight for all the options, type or select the value in High Weight and 
Low Weight text boxes.
Note: The maximum value that is allowed in the High Weight field is 255, and the 

minimum value allowed in the Low Weight field is 0.

d. Click Auto-calculate Weights. The system automatically assigns the weight for all the 
options.
Note: Formula for Auto-calculate weights:

High - (((High - Low)/ (Total Options - 1)) * (Option number - 1))
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e. By default, two (2) rows of Text and Weight fields display. The following table describes 
the text and weight options.

Note: The option that appears on top should have a weight which is high in value 
compared to the option that appears below that. For example, if the question 
contains 4 options and you enter a weight of 20 for option 1, 10 for option 2, 5 for 
option 3, and 0 for option 4, then the weight range is valid. If the weight that you 
entered does not match the high-to-low order, a warning message opens.

f. To add or remove options, click the cog wheel icon at the end of the row of the option.

The following table describes the options in the cog wheel menu.

g. Click OK. The Edit Question Options window closes and the Create Evaluation 
Template window is active. The Options text box for the Scored Scale question displays 
the option text that you typed in the Edit Question Options window, and is separated by 
a comma.
Note: The highest weight is the question weight and the same weight displays in the 

Question title bar.

10.1.2.2.2   List
To add or modify the List option, perform the following steps.

a. Once you select List from the Type drop-down list box, the Options text box is active. 
Click Edit.

Options Description

Text Type the name of the option. 

Note: The option text is unique and mandatory. The maximum characters 
allowed is 200.

Weight Type or select the weight of the option. 

Note: The option weight is mandatory. The maximum value allowed is 255 
for the highest weight. The minimum value allowed is 0 for the lowest 
weight.

Menu Description

Add Option Adds an empty option text and empty weight below the last option. 

Remove Option Removes the current option text and weight. If there are only two options left, 
then this menu is inactive.
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The Edit Question Options - List window opens.

b. If you want this question to have option to select only one select the Choose One 
toggle-button.
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c. In the Question Text text box, you can add or modify the question text.

d. If you want this question to have weight so that during evaluation, this question’s score 
gets contributed to the evaluations score, enable the Enable Weights button.
Note: The Enable Weights button will be disabled if the Choose One button is 

selected. 

e. By default, five rows of Text and Weight display. The following table describes the text 
and weight options.

Note: When you select the Enable Weights button, the Max Possible Weight displays the 
sum of all the option weights, since the reviewer can select more than one option as 
an answer choice during evaluation. The max possible weight is assigned to the 
question weight, and the same weight displays in the question title bar. 
 
When you do not select the Enable Weights check box, the Max Possible Weight 
displays N/A.

f. To add more rows, click the cog wheel icon at the end of the last row. The following 
menu opens.

The following table describes the cog wheel menu options.

Option Description

Text Type the name of the option. 

Note: The option text is unique and mandatory. The maximum characters 
allowed is 200.

Weight Type the weight of the option.

Note:
• Weight will be disabled if the Choose One toggle-button is turned on. 
• The option weight is mandatory. The weights can be provided in any 

order. The maximum value allowed is 255, and the minimum value 
allowed is 0. The values for weight can be duplicated. A warning 
message opens when the sum of all the option weights exceeds 255.

Menu Description

Add Option Before Adds an empty row above the current row. 

Add Option After Adds an empty row below the current row.

Move Up Moves the current row one row above. 

Note: If this is the first row, then this menu is inactive.
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g. Click OK. The Edit Question Options window closes and the Create Evaluation 
Template window is active. The Options text box for the List question type displays the 
option text that you entered in the Edit Question Options window, and is separated by 
comma.

Note: The Maximum Possible Weight is the question weight, and displays in the 
Question title bar.

2. Based on the question Type that you selected, you may or may not need to enter text in the 
text box. If you have not yet completed the Text field, type the question text in the text box.
Note: The maximum number of characters allowed is 1024. The Text field is mandatory 

but does not need to be unique.

3. Type or retype a description for the question by typing or editing the value in the 
Description text box. 
Note: The maximum number of characters allowed is 1024. This is optional.

This question has no options. Since the weight is not allowed, the question title does not 
display the weight. 

4. To set the orientation for how a question displays in the user interface, from the Display 
Mode drop-down list, select one of the following options.

Note: When the question Type is Free Form Text, the Display Mode drop-down list box is 
inactive.

5. From the Auto Fail Interaction drop-down list box, select the entity that you want to fail: 
either Interaction (Evaluation), Section, or Question.

6. From the If drop-down list box, select the answer choice that you want to configure the auto 
fail: No or Yes. When the reviewer selects the answer options as configured in the second 

Move Down Moves the current row one row below. 

Note: If this is the last row, then this menu is inactive.

Remove Option Removes the current row. 

Note: If there are only two rows left, then this menu is inactive.

Menu Description

Dropdown All the question options in the template display in a drop-down list box.

Horizontal All the question options in the template display in an options (radio button) list 
in a horizontal orientation.

Note: Since the List type is a multiple choice, List type options display in 
check box format.

Vertical All the question options in the template display in an options (radio button) list 
in a vertical orientation.

Note: Since the List type question is a multiple choice, List type options 
display in check box format.

Menu Description
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drop-down list box, the selected option in the first drop-down list box auto-fails. For more 
details about auto-fail, see Auto Fail on page 10-496.
Note: When the question Type is Free Form Text, List (with the Enable Weight check box 

selected or deselected), or any Bonus types, the Auto Fail field is inactive.

7. If you want to require a reviewer, while evaluating an interaction, to select an option for a 
question, then select the Response Required check box.

8. If you want a the reviewer to be able to enter comments about a question while evaluating 
an interaction, select the Enable Question Comments check box.

9. If you want to add the question to the question library, select the Add to Library check box. 
The Text, Description, and Options fields of the question are stored in the library. Adding 
the question to the library allows you to select the question from the library at a later time, 
when you are creating another template and want to use the same question options as the 
one you saved.

Note: The system saves the question to the library only when you save the evaluation 
template, not when you select the Add to Library check box.

A dependent question is a question that displays based on a specific answer option that the 
reviewer selects during evaluation. For example, if the question, “Did the agent greet the 
customer,” has answer choices Yes and No, and during evaluation the reviewer selects No, 
you can configure the template to display a dependent question such as: “Did this agent 
complete Contact Center Training?”

10.Select the Dependent Questions check box, which enables the drop-down list box below 
it.

The dependent question drop-down list box contains options defined for the question. For 
example, if the question is a Yes/No question, the dependent question drop-down list box 
contains Yes and No options. If the question is a True/False question, the dependent 
question drop-down list box contains True and False options.
Note:

• The Dependent Question will be disabled, if the Choose One button is enabled.
• If you want to add a dependent question, before you continue with this section, see 

Dependent Questions on page 10-509. Then, return to this step and continue 
creating an evaluation template.
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11.From the dependent question drop-down list box, select an answer choice. An additional 
question table displays below the original question.

12.You can add multiple dependent questions for the same or different options in the question 
by selecting Add Question below the question.

Note: The description for the fields available in dependent question are same as parent 
question. Dependent questions cannot have dependent questions.

OR

On the dependent question title bar, click the cog wheel icon. The menu displays various 
actions that can be performed with the dependent question.
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The following table describes the functions of the Dependent Question cog wheel icon 
menu.

13.If you want to add another Question to the template, at the bottom of the window, click Add 
Question.

OR

Menu Description

Add Question Before Adds an empty dependent question for the same option above the current 
dependent question.

Add Question After Adds an empty dependent question for the same option below the current 
dependent question.

Fill Question From 
Library

Imports a question and its options into the current dependent question.

To import a question, once you select the Fill Question From Library option, 
perform the following steps.
• From the Select Library Question drop-down list box, select the 

question that you want to import into the evaluation template.
• Click OK. The Fill Question From Library window closes, and the Create 

Evaluation Template window is active. The library question text, 
description, and the option text overwrites the current question or 
dependent question.

Note: Once the library question overwrites the current question or 
dependent question, you can not undo the action.

Remove This Question Removes the current dependent question and its options.

Note: If this is the only dependent question for a question option, then this 
clears the check box that corresponds to the question option in the 
dependent drop-down list box.

Move Up Moves the current dependent question one question above. 

For example, if the current dependent question number is 2, then this 
dependent question moves up and displays as dependent question 1. 

Note: If there are no dependent questions above the current dependent 
question, then the Move Up option is inactive.

Move Down Moves the current dependent question one question below.

For example, if the current dependent question number is 2, then this 
dependent question moves down and displays as dependent question 3. 

Note: If there are no dependent questions below the current dependent 
question, then the Move Down option is inactive.
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At the end of the Question title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Question level.

The following table describes the functions of the Question cog wheel icon menu.

Menu Description

Add Question Before Adds an empty question above the current question.

Add Section After Adds an empty question below the current question.

Fill Question From 
Library

Imports a question along with the Text, Description, and Options fields from 
the question library.

Remove This Question Removes the current question along with its options.

Note: If this is the only question in the current section, then Remove This 
Question option is inactive.

Expand Dependent 
Questions

Expands all the dependent questions within the current question. 

Note: If there are no dependent questions defined for the current question, 
then the Expand Dependent Questions option is inactive.

Collapse Dependent 
Questions

Collapses all the dependent questions within the current question. 

Note: If there are no dependent questions defined for the current question, 
then the Collapse Dependent Questions option is inactive.

Move Up Moves the current question one question above. 

For example, if the current question number is 2, then this question moves up 
and displays as question number 1. 

Note: If there are no questions above the current question, then the Move 
Up option is inactive.

Move Down Moves the current question one question below.

For example, if the current question number is 2, then this question moves 
down and displays as question number 3. 

Note: If there are no questions below the current question, then the Move 
Down option is inactive.
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Note: To manually collapse the contents of a Question, click the down arrow at the left of 
section title. 

The down arrow changes to a right arrow. 
 
The Question details and the questions within that Question collapse, and only the 
Question title displays. 
 
To expand and view the contents of a Question, click the right arrow at the left of 
Question title. The right arrow changes into a down arrow. The Question detail 
displays below the Question title.

10.1.2.2.3   Bonus Question Types
You can add a Bonus question to a Question section to give the reviewer an opportunity to 
increase the Section score or Overall score. You add a Bonus question to a template using 
Workforce Engagement Management. The types of bonus questions are:

• Bonus: Yes/No

• Bonus: True/False

• Bonus: Pass/Fail

• Bonus: Scored Scale

Formula for Section Score

• Section Score in Percentage = (Sum of Question options weight selected/Section Weight) * 
100

• Section Score in Point = Sum of selected Question score / Maximum Possible Question 
Weight * Section Weight

Example

If you create a template with a Section with the following two questions,

• Question 1 – Scored Scale (type = range from 1 to 5, weight = 20) with the following 
options.

Excellent – 20, Very Good – 15, Good – 10, Average – 5, Poor - 0

• Bonus Question 2 – Bonus: Scored Scale (type = range from 1 to 5, weight = 10) with the 
following options.

Excellent – 10, Best – 7.5, Good – 5, Average – 2.5, Poor - 0
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then the following screen shot is an example of what the reviewer sees when completing the 
evaluation template.

If the reviewer selects Excellent as an answer choice for both questions, then the score of the 
section is:

• Score in Percentage = (20+10)/20*100 = 150%

• Score in Points = 20+10 = 30

If the reviewer selects Excellent for Question 1, and selects Best for Question 2, then the 
score of the section is:

• Score in Percentage = (20+7.5)/20*100 = 138%

• Score in Points = 20+7.5 = 27.5
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Note: If a template has a Section with only Bonus question types, then the entire Section is 
cannot be scored, which means that the Score displays N/A for the Section.

10.1.2.2.4   Auto Fail
When creating an evaluation template, you can set an Interaction, Section, or Question to fail 
when a reviewer selects a respective question option while scoring. The reviewer must select 
the Template scoring type as Pass/Fail to know whether it is pass or fail. The user can also 
select success Rate / Quality Score(%) and Total Points(Numbers), when user selects the 
failure condition, results for the corresponding Interaction, Question, or Section is 0.

While creating a template, you can set up auto fail. You can set the following question types to 
qualify for auto fail.

• Scored Scale

• True/False

• Yes/No

• Pass/Fail
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At the end of the Question title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Question level.
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The following table describes the functions of the Question cog wheel icon menu.

Note: Refer to Failure Conditions at Question Level on page 10-513 section, under the 
Advanced Failure Condition on page 10-512.

Menu Description

Add Question Before Adds an empty question above the current question.

Add Section After Adds an empty question below the current question.

Add Advanced Failure 
Condition

Failure condition based on Percentage Score or Point Score.

Score Adjustments To award or deduct points the user can use the option of Score Adjustments.

Fill Question From 
Library

Imports a question along with the Text, Description, and Options fields from 
the question library.

Remove This Question Removes the current question along with its options.

Note: If this is the only question in the current section, then Remove This 
Question option is inactive.

Expand Dependent 
Questions

Expands all the dependent questions within the current question. 

Note: If there are no dependent questions defined for the current question, 
then the Expand Dependent Questions option is inactive.

Collapse Dependent 
Questions

Collapses all the dependent questions within the current question. 

Note: If there are no dependent questions defined for the current question, 
then the Collapse Dependent Questions option is inactive.

Move Up Moves the current question one question above. 

For example, if the current question number is 2, then this question moves up 
and displays as question number 1. 

Note: If there are no questions above the current question, then the Move 
Up option is inactive.

Move Down Moves the current question one question below.

For example, if the current question number is 2, then this question moves 
down and displays as question number 3. 

Note: If there are no questions below the current question, then the Move 
Down option is inactive.
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1. In the Create Evaluation Template window, with the Question added, from the Auto Fail 
drop-down list box, select Interaction, Section, Question or any one/two from the list.

2. From the If drop-down list box, select the option that corresponds to the Question type. For 
example, if the question type is Pass/Fail, from the If drop-down list box you select Pass.

Note: When the user wants to auto fail the entire interaction or the entire section then 
select Interaction or Section, and to auto fail only the question select Question. 
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Note: To set up auto fail for a Scored Scale question type, from the If drop-down list box, 
select an option that your company has created for Scored Scale.

Once an interaction is evaluated by using the Evaluation Template, the result will be 
mentioned under the Evaluation tab, as shown below.

10.1.2.2.5   List Type
When you create a List type answer option in an evaluation temple, the reviewer can select 
more than one answer for a List type question. Based on the answer that a reviewer selects, 
you can have different weights for each answer. You also have the option to Enable or Disable 
the List type answer weight.

1. In the Create Evaluation Template window, with the Question added, click on the Enable 
Comments check-box. It enables the comment field for the section. 
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2. From the Type drop-down list box, select List.

3. Click on the Enable Question Comments check-box as shown below. It enables the 
comment field for the question.

4. Next to the Options text box, click Edit.

The Edit Question Options window opens with the Question Text field populated from the 
Create Evaluation Template window.
Note: If you want, you can modify the Question Text field. 

 
By default, the Edit Question Options window has five list options with blank text.
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5. If you want this question to have option to select only one answer, so that during 
evaluation, this question’s score gets contributed to the evaluations score, enable the 
Choose One button.
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• In the Text column, in the text box field, type the text for each option that you want in the 
List type Answer option section of the evaluation template.

Note: By default, the Weight column text fields are disabled. If you do not enable the 
question weight, then the question weight is N/A.

Question weight is calculated based on the sum of the selected option weights. For 
example, if the reviewer selects options 1, 2, and 4, and the weight is 1, 2, and 4 
respectively, then the question weight is 7.

Scoring is based on the following formula:

Percent Score = (Sum of selected options weight/question weight)*100

Point Score = Sum of selected option’s weight

6. If you want to add weights to the List answer options, select the Enable Weights button.
Note:

• The Enable Weights button will be disabled if the Choose One button is enabled.
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• You can type the text and weights in any order that you want. During the interaction 
evaluation, the reviewer sees the check boxes in the List in the same order as you 
create them on the Edit Question Options window.
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At the bottom of the window, the Max Possible Weight displays the total of all the option 
weights. A question can have the maximum possible weight if the reviewer selects all the 
Answer check boxes in the list.
Note: You can move the list options up or down in the list, or you can add an option before 

or after a row in the list. To do this, click the cog wheel icon next to the option that 
you want to modify.

The following table describes the options in the cog wheel menu.

7. When you are finished editing the question options, click OK. The Edit Question Options 
window closes and the Create Evaluation Template window is active.

8. From the Display Mode drop-down list box, select either Vertical or Horizontal.

Option Description

Add Option Before To add a blank row before any option.

Add Option After To add a blank row after any option.

Move Up To move an option one row up.

Note: When an option reaches the top row, the Move Up menu item is 
inactive.

Move Down To move an option to one row down.

Note: When an option reaches the last row, the Move Down menu item is 
inactive.

Remove Option To delete any row until the only two options remain in the list. The List type 
must have minimum of two (2) options.
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If you select Vertical, the reviewer sees the List options displayed as in the following 
screen shot.
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If you select Horizontal, the reviewer sees the List options displayed as in the following 
screen shot.

Note: The Section Question Comment fields are added to the Evaluation with the Note 
field. You can also type any text or <html> text on the fields. Refer the below 
screenshot.
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• If <html> text is used on the Note field, as shown above, the texts inside the 
<script> will not be visible after Submit the evaluation. The other <html> texts 
will be shown as shown below.

9. If you select the Response Required check box for this List type question, the reviewer is 
required to select a minimum of one check box on the evaluation template.

10.When you have finished adding questions and sections, you want to either save the 
template as a Draft template or as a Final template. Select the triple-bar icon to view the 
following menu.

The following table describes the functions of the triple bar icon menu.

Menu Description

Clear 
Template

Removes all the sections and questions in the template and adds an empty section with 
an empty question.

Expand All Expands all the sections, questions, and dependent questions (if any) in the template.

Collapse All Collapses all the sections, questions, and dependent questions; displays only the 
section titles.

Cancel Cancels the changes in the template, closes the Create Evaluation Template window, 
and the Evaluation Templates window is active.

Note: If you click Cancel before saving the changes, the system displays a Warning 
window. To delete the changes, click Yes.
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Note: When you save an evaluation template as Draft, it is successfully saved to the 
database, when the following Success window opens.

Note: When you click Save as Final, the success window does not display. 
 
Whether you click Save as Final or Save as Draft, the template displays in the 
Evaluation Templates list.

10.1.2.3   Dependent Questions
A dependent question is a question that displays based on a specific answer option that the 
reviewer selects during evaluation. For example, if the question, “Did the agent greet the 
customer,” has answer choices Yes and No, and during evaluation the reviewer selects No, 
you can configure the template to display a dependent question such as: “Did this agent 
complete Contact Center Training?”

Note: The weight of a dependent question is not included in the Section weight.

Save As 
Draft

Saves the template changes to the database. The evaluation template remains open so 
that you can continue to make changes.

Note: This template is not available for a user to select when evaluating an interaction 
because the template is a Draft.

Save As 
Final

Saves the template changes to the database. The Create Evaluation template window 
closes and the Evaluation Templates window is active. 

Note: Selecting this option marks the template as complete and allows a user to select 
it when evaluating an interaction.

Menu Description
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When a reviewer selects a template, the template details display in the Evaluation tab. The 
following screen shot displays Question 1 (Did agent greet the customers?), which when the 
reviewer selected the Answer as Yes, displayed two dependent questions.

If you configure a Dependent Question number in the template, then the question number 
appears for the dependent question as XA, where X is the question number. For example: 1A 
or 1B, as in the preceding screen shot.

An Information icon displays next to the dependent questions, and when the reviewer clicks on 
the Information icon, the following message displays. In the following screen shot, Yes is the 
answer choice that the reviewer selected for question which has the dependent question.

In the Description column, if a dependent question’s description exceeds the maximum 
allowed space in the field, then a More hyperlink displays. The reviewer can click More to 
display the complete question description; the hyperlink changes to Less. When the 
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reviewer is finished reading the description, they can click Less to display fewer words in 
the field.

10.1.2.3.1   Score Calculation Formula - With Dependent Questions
The following table describes the system formulas behind the Percentage Score and Point 
Score options.

Question Score 
Display

Dependent 
Question Score 
Display

Section Score 
Display

Overall Score 
Display

Percentage Score (Sum of selected 
question options 
weight/Question 
Weight) * 100

(Sum of selected 
dependent 
question options 
weight/
Dependent 
Question Weight) 
* 100

((Sum of selected 
question options 
weight + Sum of 
selected 
dependent 
question options 
weight) /Section 
weight) * 100

(Sum of all 
section score/
Sum of weights of 
all sections) * 100

Example:

Section Weight as 10

Question weight as 10

Option 1 = 2

Dependent question weight = 
10

Option 1 = 10

Option 2 = 0

Option 2 = 3

Option 3 = 5

If Option 1 (Option 1 selected 
in dependent question), Option 
2 selected

(2+3/10)*100 = 
50%

(10/10)*100 = 
100%

((2+10+3)/
10)*100 = 150%

((2+10+3)/
10)*100 = 150%
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10.1.2.4   Advanced Failure Condition
All the existing automatic failure conditions in earlier versions of Aspect EX Quality have 
replaced with a new set of failure conditions. The Add Advanced Failure Condition feature 
which allows you to fail a question based on Percentage Score or Point Score.  
Example: You have a question as "Rate Agent Performance", and available options are 1) 
Excellent 2) Very good 3) Good 4) Intermediate 5) Needs improvement. You want to fail the 
question for Intermediate or Needs improvement then, you can use the Advanced failure 
condition and add a condition to fail based on the Percentage or Point Score. The failure 
conditions have the following properties.

• You can define failure condition for question types such as 

• Yes/No

Point Score Sum of selected 
question options 
weight

Sum of selected 
dependent 
question options 
weight

Sum of 
Question Score 
(includes 
Dependent 
Questions 
Score) / 
Maximum 
Possible 
Question 
Weight 
(excludes 
Dependent 
Question 
Weight) * 
Section Weight

Sum of all 
Section Scores

Example:

Section Weight as 10

Question weight as 10

Option 1 = 2

Dependent question weight = 
10

Option 1 = 10

Option 2 = 0

Option 2 = 3

Option 3 = 5

If Option 1 (Option 1 selected 
in dependent question), Option 
2 selected

2+3 = 5 10 2+10+3 = 15 2+10+3 = 15

Question Score 
Display

Dependent 
Question Score 
Display

Section Score 
Display

Overall Score 
Display
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• Pass/Fail

• True/False

• Score Scale

• List (Applies only when weight is chosen) 

Note: Advanced Failure Condition cannot be defined for Bonus Question types or Dependant 
question types.

10.1.2.5   Failure Conditions at Question Level
There are two parameters to define the failure conditions at question level such as Percentage 
Score and Point Score.

10.1.2.5.1   Percentage Score
To define the failure conditions based on the percentage score, follow the steps below.

1. When you are creating a template, you have to select a question type such as Pass/Fail, 
Scored Scale, True/False, and Yes/No, as shown below.
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2. At the end of the Question title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Question level.

Note: After selecting any of the above mentioned question type, the Add Advanced Failure 
Condition option will be enabled.

3. Click on the Add Advanced Failure Condition option and the Add Advanced Failure 
Condition window appears. 

4. Click on the Auto Fail Question By drop-down and select Percentage Score.

5. After selecting the Percentage Score, click on  button.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 514



Administrator Guide
6. Choose the failure condition and set the percentage as per your requirement.  

Example: If you create a failure condition called Percentage Score < 50 and while scoring 
a call using this template, if the question score is lesser than 50%, then the question fails. 
Even though the failure condition is satisfied and the question fails, the score of the 
question is set to 0. You must have the Question Scores Display option set to Percentage 
Score & Pass/Fail, Point Score & Pass/Fail, or Pass/Fail to determine if this question has 
failed or not.

7. Click on OK button to complete the process.

10.1.2.5.2   Point Score
To define the failure conditions based on the point score, follow the steps below.
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1. When you are creating a template, you have to select a question type such as Pass/Fail, 
Scored Scale, True/False, and Yes/No, as shown below.

2. At the end of the Question title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Question level.

Note: After selecting any of the above mentioned question type, the Add Advanced Failure 
Condition option will be enabled.

3. Click on the Add Advanced Failure Condition option and the Add Advanced Failure 
Condition window appears. 
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4. Click on the Auto Fail Question By drop-down and select Point Score.

5. After selecting the Point Score, click on  button.

6. Choose the failure condition and set the point as per your requirement.  

Example: If you create a failure condition called Point Score = 10, and while scoring the 
call with this template, if the question option you select has an option weight of 10, then the 
question fails. Even though the failure condition is satisfied and the question fails, the score 
of the question is set to 0. You must set the Question Scores display option to Percentage 
Score & Pass/Fail, Point Score & Pass/Fail, or Pass/Fail to know whether or not this 
question failed.

7. Click on OK button to complete the process.
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10.1.2.6   Failure Conditions at Section Level
There are two parameters to define the failure conditions at section level such as Percentage 
Score and Point Score.

10.1.2.6.1   Percentage Score
To define the failure conditions based on the percentage score, follow the steps below.

1. At the end of the Section title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Section level.

2. Click on Add Advanced Level Failure Condition as shown below.
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3. Click on the Auto Fail Section By drop-down and select Percentage Score.

4. After selecting the Percentage Score, click on  button.

5. Choose the failure condition and set the percentage as per your requirement.  

Example: If you create a failure condition called Percentage Score < 50 and while scoring 
a call using this template, if the section score is lesser than 50%, then the section fails. You 
must have the Section Scores Display option set to Percentage Score & Pass/Fail, Point 
Score & Pass/Fail, or Pass/Fail to determine if this section has failed or not.
Note: If you toggled on the Force Section Score to 0 toggle button, the section score is 

set to 0 when the answer meets the failure condition and criteria.
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6. Click on OK button to complete the process. The Advanced Failure Condition is enabled as 
shown below.

10.1.2.6.2   Point Score
To define the failure conditions based on the point score, follow the steps below.

1. At the end of the Section title bar, click the cog wheel icon to view a menu that displays 
various actions that you can perform on the Section level.

2. Click on Add Advanced Level Failure Condition as shown below.
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3. Click on the Auto Fail Section By drop-down and select Point Score.

4. Choose the failure condition and set the point as per your requirement.  

Example: If you create a failure condition called Point Score = 10, and while scoring the 
call with this template, if the section gets a point score of 10, then the section fails. You 
must set the Section Scores display option to Percentage Score & Pass/Fail, Point Score & 
Pass/Fail, or Pass/Fail to know whether or not this question failed.
Note: If you toggled on the Force Section Score to 0 toggle button, the section score is 

set to 0 when the answer meets the failure condition and criteria.
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5. Click on OK button to complete the process. The Advanced Failure Condition is enabled as 
shown below.

If you want to clear the section level failure condition, follow the steps below.

1. Click on the cog wheel and select Edit Advanced Failure Condition. 

2. Toggle off the Enable toggle button to disable the Advanced Failure Condition and click on 
OK button.

10.1.2.7   Failure Conditions at Template Level
To define the failure condition at the template level (for Overall Score of the template) user can 
use this failure condition. There are two parameters to define the failure conditions at template 
level such as Percentage Score and Point Score.
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To define the failure conditions at the template level, follow the steps below.

1. Click on Action menu in the tool bar of Create Evaluation Template page and Select “Add 
Failure Condition” option. 

2. Add Failure Condition dialog will be displayed with Auto Fail By drop down list. Select 
Percentage Score or Point Score as per the requirement as shown in the screenshot 
below.

3. Click on the ‘+’ button. You will see different options drop down list to set the failure 
condition. Set the failure condition as per the requirement.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 523



Administrator Guide
Example: If you create a failure condition called Percentage Score < 50 while scoring a call 
using this template, and if the overall score is lesser than 50%, then the overall score fails. OR

If you create a failure condition called Point Score = 10, and while scoring the call with this 
template, if the overall score gets a point score of 10, then the overall score fails.

You must have the Overall Score Display option set to Percentage Score & Pass/Fail, Point 
Score & Pass/Fail, to determine if this overall score has failed or not. 

Note:

a. A maximum of 4 different failure conditions can be added by clicking on “+” button.

b. To remove the condition added click on the “- “(remove) button of the corresponding 
condition row.

c. If you toggled on the Force Overall Score to 0 toggle button, the Overall score will be set 
to 0 when failure condition meets the criteria else evaluation will be termed as Failed but 
the score will not reset to 0

4. Click the OK button to save the failure condition. The Failure Condition for Template is 
enabled as shown below.
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5. If you want to update the failure condition defined, click on the Action menu in the tool bar 
in the Create Evaluation Template page and Select Edit Failure Condition option.

6. Update the failure condition as required and Click on OK button.
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7. To clear or remove the Failure condition added, turn off the Enable toggle button and Click 
the OK button.

10.1.3   Score Adjustments
To award or deduct points the user can use the option of Score Adjustments. Although the 
points are awarded or deducted based on the certain conditions that are specified, while 
syncing the Score Adjustments to a Question Type.

Initially the option Score Adjustment will be disabled, as shown below.
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Once the user selects the question type from the Type* drop down list box, the Score 
Adjustments option will be enabled.

Now, enter the weight in the Weight* text box, either by clicking the up down arrow keys, or 
manually.

Click Score Adjustments, the dialog appears as shown below:

The Weight text box shows the same value, as entered on the Evaluation Template, Question 
Weight.

The Score Adjustments drop down list box, by default shows the option as None. It lists the 
following options, other than None:

• Award Points

• Deduct Points

These options are given below:

1. Award Points

The user can award the points based on the certain conditions that are specified in the Score 
Adjustments dialog box to assign the Award points.

Once the Award Points is selected, based on the Question Type selected either all the three 
text boxes, next to Award Points will be enabled or only two text boxes will be enabled.
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In the below example, based on the type of question, only the first text box and the second list 
box for the Award Points option is enabled.

Enter the value in the text box  that user should be awarded with. This is a 
mandatory field, if left blank, a validation message appears to enter a weight in the box.

The next list box has two options, based on the Question Type* selected. Select either of the 
conditions to be assigned to the Question to Award the user.

Click the OK button to assign the Award Points.

2. Deduct Points

The user can deduct the points based on the ceratin score attained by the user.

Once the Deduct Points is selected, based on the Question Type selected either all the three 
text boxes, next to Deduct Points will be enabled or only two text boxes will be enabled.

In the below example, based on the type of question, all the three text boxes for the Deduct 
Points option are enabled.
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Enter the value in the text box  that user should be deducted with. This is a 
mandatory field, if left blank, a validation message appears to enter a weight in the box.

The next list box has four options, based on the Question Type* selected. Select either of the 
conditions to be assigned to the Question to Deduct the user.

In the above example, If Score > option is selected, the immediate next text box is enabled. 
Enter the value in the next text box. Say, if score is greater than 5, the points to be awarded or 
deducted. So, enter the value 5 in the next text box.

Click the OK button to assign the Deduct Points.

Note:
a. For the Questions which has static options, for example: Yes or No, True or False, 

Pass or Fail; the third text box remains disabled for both Award Points as well as 
Deduct Points.

b. Weight has to be entered mandatorily on the Evaluation Template page for the 
Question, otherwise the Score Adjustments dialog will throw an error after clicking 
OK button and will not allow to save the Score Adjustments.

• You will return to either the Create or Edit Evaluation Template page (where you were 
already). Click the Save As Draft option from the main menu, as shown below:
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• After saving the draft, when you click the Cog Wheel button, and select the Score 
Adjustments option. The Score Adjustments dialog appears again. Whatever values you 
have entered, will be saved for the Evaluation Template. Here, you can edit the values of 
Score Adjustments, if required and click the OK button to save.

• Once you enter the Score Adjustments for a question, the header of that particular question 
shows the value as Score Adjustments: Enabled, as shown below:

• If you have not selected the Score Adjustments, the header will show as Score 
Adjustments: Disabled.
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• When the user try to edit the question type, after syncing the Score Adjustments, a 
Warning dialog box appears to remove the Score Adjustments. Select Yes or No, to save 
or revert the changes, as shown below:

Note: Score Adjustments is not applicable for the Dependant Questions type. In the Cog 
Wheel button, the Score Adjustments option will not appear at all for the dependant 
questions.

10.1.4   Edit an Evaluation Template
Use the edit feature to change the basic template details, section details, question details, and 
dependent question details. The Evaluation Templates are editable when the evaluation 
templates are saved as Draft and saved as Final.

To edit an evaluation template that you created as Draft, perform the following steps.

1. Launch Workforce Engagement Management.

2. Log in as an Administrator.

3. From the Main menu, select Administration. The Administration panel appears.

4. Under QM Evaluation, click Evaluation Templates.
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The Evaluation Templates window opens, and a list of templates whose Status is either 
Draft or Complete displays in the grid.

The Edit button  will be displayed beside the Add button as shown on the above 
screen.

10.1.4.1   Editing an Evaluation Template as Draft
1. Select the row of the Evaluation Template that you want to edit and click on the Edit button. 

The Edit Evaluation Template window opens.
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2. To edit the template Name and other details, click Edit.

The Edit Evaluation Template details window opens.

3. Select the required fields based on requirement.
Note: For detailed information about each Evaluation Template (question or section) field, 

see Create an Evaluation Template on page 10-475.

4. To close the template details without editing, click Cancel.

OR

To save the template changes, click OK.
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The Edit Evaluation Template details window closes and the Edit Evaluation Template 
window with the sections and questions displays.

5. When you have finished adding questions and sections, you want to either save the 
template as a Draft or as Final. Click the triple-bar icon and from the menu select either 
Save As Draft or Save as Final.

10.1.4.2   Editing an Evaluation Template as Complete
The Edit button is introduced to edit Evaluation Template which is in a complete state and 
helps to add/remove permissions for users. As an example, if a new employee joins the 
organization and the user wants to give permission for the newly joined employee to use the 
existing evaluation template till version 19, the user has to duplicate the template and add the 
new user. In version 19, the Edit button is added. Hence, the user is able to add/remove 
permission even for an evaluation template with the status as Complete.
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1. Click Edit button , the Edit Evaluation Template details window opens. 

2. All the fields in above screen will be enabled and editable other than "Override Minimum 
Possible Score" and "Override Maximum Possible Score" fields.

3. Click the Select button in the Allow Access To section, to select one or more user profiles. 
It allows the user/s to score for the scorecard template. The Select User Profiles window 
appears as shown below. 

Note: To provide the access for a new user, select the user profile for which the user is 
associated with.
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4. Go to the Search Items field, either search by name or click on the magnifying glass to 
search and select the profile/s.  
Or, click on the  button to select all of the profiles available in the database.

5. In Via, every user has their user profile, and the user must be select the corresponding user 
profile.

6. Click on the OK button in the Edit Evaluation Template dialog. System will save the 
evaluation template and display in the grid.

Note:

• For any typo in the evaluation template name, the system will allow you to change that 
without impacting the existing evaluations or existing report data.

• A user is able to edit the Scoring Type as well. If you think you need to change the 
scoring type and for example you change from Quality Score to Point Score then all the 
existing evaluations and the evaluations that you are going to create all will be displayed 
with point score. This does not mean system will recalculate the scores again and the 
scores are already calculated and stored in all the possible formats of Scoring types and 
system will just display those.

For the Premise user who is not the owner of the evaluation template and have edit permission 
on the evaluation template in user profiles can edit the evaluation template.

10.1.5   Duplicate an Evaluation Template
In Workforce Engagement Management, you may want to duplicate a template if you want to 
use already-created sections or questions in a template, but you want to name the template 
with a different name, thereby creating a new template. 

1. On the Evaluation Template window, highlight the row of the Evaluation Template that you 
want to duplicate.
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2. Click on Duplicate button from the menu options as shown below.

The Duplicate Evaluation Template dialog window opens. All the values from the duplicated 
template are copied to the Duplicate Evaluation Template window, except the Name.
Note: The fields marked with a red asterisk (*) are required fields.

3. In the Name text box, type a name for the template. The maximum number of characters 
allowed is 100. The template name must be unique across the system and is mandatory.

4. To return without duplicating the evaluation template, click Cancel.

OR
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To save the duplicated template details, click OK. The Close Evaluation Template details 
window closes and the Duplicate Evaluation Template window with existing sections, 
questions and dependent questions is active.

You can make changes to existing sections, question and dependent questions or you can 
add new sections, questions and dependent questions.
Note: To enable questions and comments, click on the check-boxes as shown below.

5. If you want to add a new section(s) to the duplicated template, see Add a New Section on 
page 10-480.

6. If you want to add a new question(s) to the duplicated template, see Add a New Question 
on page 10-483.
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7. When you have finished adding questions and sections, you want to either save the 
duplicated template as a Draft template or as a Final template. Select the triple-bar icon to 
view the following menu.

Note: When you save an evaluation template as Draft, it is successfully saved to the 
database, when the following Success window opens.

Note: When you click Save as Final, the success window does not display.

Whether you click Save as Final or Save as Draft, the template displays in the Evaluation 
Templates list.

8. Save the duplicated template. The Duplicated Evaluation Template window closes and the 
Evaluation Templates window is active, with the new template displayed in the table.
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10.1.5.1   Duplicate a Template Created in Quality
You can duplicate a template in Workforce Engagement Management that was originally 
created in Aspect Quality (not in Workforce Engagement Management); however, some of the 
question Types appear different in the duplicated template. These differences are described in 
the following table.

Note: If you created a template in Aspect Quality (not in Workforce Engagement 
Management) that contains the Scored Scale (Low to High), Choose One, Choose One 
or More, Single Line Answer, or Multi Line Answer question types, and then a reviewer 
uses that template in Workforce Engagement Management to evaluate an interaction, 
then those question types display in Workforce Engagement Management as you 
created them in Aspect Quality.

10.1.6   Delete an Evaluation Template
This section describes how to delete an evaluation template. Follow the steps below to delete 
an Evaluation Template.

1. Launch Workforce Engagement Management.

2. Log in as an Administrator.

3. From the Main menu triple-bar, select Administration. The Administration panel appears.

4. Under QM Evaluation, click on Evaluation Templates.

Question Type in Aspect Quality Displays as this in WEM

• Choose one
• Choose one or more

• List, with Enable Options Weight deselected

• Scored Scale (Low to High) • Scored Scale

Note: The options order of this question Type 
displays as High to Low.

• Single Line Answer
• Multi Line Answer

• Free Form Text
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The Evaluation Templates window opens. A list of templates whose status is either Draft or 
Complete and the templates which are used to score display in the grid.

5. Select the evaluation template and click on Delete button as shown below. 

Note:

• If an evaluation template is already in use for scoring, then the Delete button is 
disabled. Check the Used for Scoring column on the grid for the templates which are 
already in use for scoring.

• The admin or the evaluation template owner can delete those Evaluation Templates 
which are not used for scoring.

6. Click on Yes to delete the Evaluation Template.

10.1.7   Activate and Deactivate Evaluation Template/s
This section describes how to activate and deactivate one or multiple Evaluation Templates.
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10.1.7.1   One Evaluation Template
Follow the steps below to activate and deactivate one Evaluation Template.

1. From the Main menu, select Administration. The Administration panel appears.

2. Under QM Evaluation, click on Evaluation Templates. The Evaluation Templates window 
appears. 

3. Select the Evaluation Template on the grid, and click on Activate button from the menu 
buttons as shown below.

Note:
• When the Evaluation template is active, then the Activate button is disabled, and the 

Deactivate button is enabled. Click the Deactivate button to deactivate the 
Evaluation template.

• While activating an evaluation template, if an evaluation template with the same 
name exists then only that evaluation template status will not be updated and an 
error message will pop-up as shown below.

10.1.7.2   Multiple Evaluation Templates
Follow the steps below to activate and deactivate multiple Evaluation Templates.

1. From the Main menu, select Administration. The Administration panel appears.

2. Under QM Evaluation, click on Evaluation Templates. The Evaluation Templates window 
appears. 
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3. Press Ctrl + Left-click to select multiple Evaluation Templates at a time, and click on 
Activate or Deactivate button from the menu buttons as shown below.

• When the selected evaluation templates are active then, the Deactivate button will 
deactivate all of the selected templates.

• When some of the evaluation templates are activated and some are not activated 
(as shown below), then the Activate button will activate all of the deactivated 
evaluation templates which are selected.

• When some of the evaluation templates are activated and some are not activated 
(as shown below), then the Deactivate button will deactivate all of the activated 
evaluation templates which are selected.

Note: Edit, Duplicate and Delete buttons are disabled when multiple evaluation templates 
are selected.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 543



Administrator Guide
10.2  Workforce Configuration
This section discusses about the Workforce Configuration Navigation, Add, Edit and Upload 
Scores options.

10.2.1   Navigation to Workforce Configuration
Follow the steps given below to navigate to the Workforce Configuration page:

1. Go to the main menu.

2. Click Administration > QM Evaluation> Workforce Configuration.
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3. The Workforce Configuration page appears as given below

Note: The menu options varies based on the existing Workforce Configuration. If there is not 
at all any Workforce Configuration listed the grid, then the Add button will appear, as 
shown below. The Upload Scores button will be disabled. 
If there is an existing Workforce Configuration listed in the grid, the Add button will not 
appear at all, instead of that the Edit button is replaced, the Upload Scores button will 
be enabled, as shown above. As there is no option to delete the Workforce 
Configuration, so once it is created, there isn’t any option to add another configuration, 
you can only edit the same.
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4. The Menu buttons or  on the Workforce Configuration page are 
described below:

5. The grid columns on the Workforce Configuration page are described below:

10.2.2   Create Workforce Configuration
To create a Workforce Configuration, perform the following steps.

1. Go to the main menu.

2. Click Administration > QM Evaluation > Workforce Configuration.

3. The Workforce Configuration page appears.

Icons Description

Refresh Refreshes the Workforce Configuration grid with latest 
configuration changes. Instead of the browser refresh button 
user can click on this menu button which will refresh only the 
grid data and not the page.

Add Adds the new workforce configuration to the grid.

Edit Edits the selected workforce configuration existing in the grid.

Upload Scores Allows to upload the scores details.

Note: The Upload Scores button will be enabled only when 
there is at least one Workforce Configuration listed in 
the Workforce Configuration grid.

Column Description

Server Name The name of the server.

Uploaded On The date and time, when the scores are uploaded to Aspect 
Workforce from Aspect Quality.

Uploaded By The logged in user, who uploads the score to the Aspect 
Quality.
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4. Click on the Add  button. The Add Workforce Configuration window appears as shown 
below.

The fields marked (*) are mandatory fields.

5. In the Server Name text box, enter the server name.

6. In the Web Server Name text box, enter the web server name.

7. In the Database Name text box, enter the database name.

8. In the Admin User Name text box, enter the admin user name.

9. In the Admin Password text box, enter the admin password. The Edit button is available 
next to Admin Password text box, when clicked Change Password, a dialog appears, as 
shown below.

The dialog allows to change the Admin password, which was entered on the Add 
Workforce Configuration definition window.
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10.In the Employee Extra Field Name text box, enter the employee extra field name.

Note: When the value is not entered in the mandatory text boxes, a validation message 
appears for the blank fields, when clicked OK, as shown below.

11.Click OK to create a Workforce Configuration. 

The created Workforce Configuration appears in the Workforce Configuration grid.

10.2.3   Edit Workforce Configuration
To edit a Workforce Configuration, perform the following steps.

1. Go to the  main menu icon.

2. Click Administration > QM Evaluation > Workforce Configuration.

3. The Workforce Configuration page appears.

4. Select the available Workforce Configuration from the grid that needs to be edited and click 
the Edit icon.
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5. The Edit Workforce Configuration window appears as shown below.

6. Edit the fields as per your requirement.

Note: Refer to Create Workforce Configuration on page 10-546 section, step 4 to 10.

7. Click the OK button to complete the process.

10.2.4   Upload Scores
To upload scores in the Workforce Configuration, perform the following steps.

1. Go to the  main menu icon.

2. Click Administration > QM Evaluation > Workforce Configuration.

3. The Workforce Configuration page appears.

4. Select the available Workforce Configuration from the grid for which the scores needs to be 
uploaded and click the Upload Scores icon .

5. A Warning message dialog appears to confirm the scores upload as shown below.

6. Click Yes to complete the process.

The Uploaded On and Uploaded By column on the Workforce Configuration page will be 
updated and will display the date, time and name of the logged in user in the respective 
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columns. 
If the Configuration details which are entered, are not validated either during creating or editing 
the Workforce Configuration, the error message is displayed on the Upload Scores page, as 
shown below. 

This prohibits the user to upload scores, so enter the same passwords in the Change 
Password text boxes.
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11.  Recording

This chapter describes about how Aspect Quality uses different configuration to record a 
particular interaction.

Different features are covered within Recording. Recording features are listed below:

• Agent Groups

• Audio Ports

• Locations

• Receiver Groups

• Recording Boards

• Recording Groups

• Recording Rules

• Skill Groups

• Switches

• Trunk Channels

• VOIP Tap Points

11.1  Agent Groups
Agent Groups are the groups of agents defined with the common skill set.

This section discusses about the Agent Groups information.

11.1.1   Navigation to Agent Groups
Follow the steps given below to navigate to the Agent Groups page:

1. Go to main menu icon.
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2. Click Administration > Recording > Agent Groups.

3. The Agent Groups page appears as given below:
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4. The Menu buttons on the Agent Groups page are described below:

5. The grid columns on the Agent Groups page are described below:

11.1.2   Edit Agent Group
This section only applies if you are connecting to a Unified IP switch supporting the Enhanced 
CTIPS functionality. The configuration options are only available for ACD and Outbound 
Queued Call types; they are optional and override the settings defined for the switch to which 
the Agent Group is associated. You can define the Enhanced CTIPS options on a per-agent 
group level. You must start the Aspect Quality service on the Primary server in order to 
perform an initial data synchronization operation to load the agent groups into Aspect Quality.

To configure the enhanced CTIPS options for individual agent groups, perform the following 
steps.

Note: The edit button will be enabled only for those Agent Groups that is associated with UIP 
Enhanced CTIPS switches and call type other than chat. Also, the edit button remains 
disabled for UIP Enhanced CTIPS related switches, which are inactive.

1. Go to the  main menu icon.

2. Click Administration > Recording > Agent Group.

3. The Agent Group page appears.

4. Select the available Agent Group from the grid that needs to be edited and click the Edit 
icon .

Icons Description

Refresh Refreshes the agent groups grid with latest agent group 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Edit Edits the selected Agent Group existing in the grid.

Information Provides the information about the skill groups associated with 
the selected agent group from the grid.

Column Description

Name The name of the Agent Group.

Call Type The type of call to which the agent is connected and recorded.

Number The unique number to identify the Agent Group.

Switch The name of switch to which agent is connected.

Active The agent group status is displayed by the icon, whether active 
or not.
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5. The Edit Agent Group window appears as shown below:

Note: The Name, Switch, Call Type and Agent Group Number cannot be updated for 
any Agent Group that is once created and it will remain disabled for Edit Agent 
Group option.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 554



Administrator Guide
6. The Override Switch Setting toggle button is unflagged by default, flag it to enable other 
options in the window.

The information button pop-up is available adjacent to the Override Switch Setting, 
stating, “Please make sure the selected recording tone settings are in compliance with 
local laws.”

7. If you want Unified IP to record calls for the selected agent group when Aspect Quality is 
unable to communicate with the Unified IP system, flag the Enable Full-Time Recording 
toggle button.

8. Once the Override Switch Setting toggle button is flagged, the Record Tariff Tone Type 
drop-down is enabled and is a mandatory field. Select from the following options listed in 
the drop-down:

Note: If you select the Tariff Tone Type No Tone, then the Tariff Tone Duplex Type drop-
down list is inactive. 
If you select Initiated Tone or Periodic Tone, the agent and caller will hear the tones 
in the Unified IP call, as well as in the recordings.

Options Description

No Tone No tone or beep sounds.

Initiated Tone A tone or beep sounds when recording begins.

Periodic Tone A tone sounds repeatedly at intervals specified in seconds.
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9. After providing the value in the Record Tariff Tone Type field, the Record Tariff Tone 
Duplex Type drop-down is enabled and is a mandatory field. Select from the following 
options listed in the drop-down:

Or

If you select the Record Tariff Tone Type Periodic Tone, then from the Record Tariff Tone 
Duplex Type drop-down list, select the following option.

Note: When Record Tariff Tone Type No Tone option is selected, the Record Tariff Tone 
Duplex Type field remains disabled.

10.The Record Tariff Tone Interval field remains disabled for Initiated Tone and No Tone 
options. The field is enabled and is a mandatory, when Periodic Tone option is selected. 
Enter the value manually in seconds, after which you want the tone to repeat. The value 
should be a positive integer, less than 10 characters in length.
Note: Any modifications that you make in the Enhanced CTIPS configuration or the 

Record Tariff Tone configuration do not require that you restart the Aspect Quality 
Service in the Primary server.

11.Edit the field values as per your requirement.

12.Click the OK button to complete the process.

11.1.3   Information about Agent Group
This Information icon briefly gives the skills group information associated with the Agent Group 
that is selected from the grid.

1. Go to the  main menu icon.

2. Click Administration > Recording > Agent Groups.

3. The Agent Groups page appears.

4. From the Agent Groups page select the agent from the grid for whom you need to view the 
skill groups information. Then click the Information  icon.

Options Description

Agent Half Duplex Only the agent hears the tone or beep sounds.

Contact Half Duplex Only the contact hears the tone or beep sounds.

Full Duplex Both the agent and the contact hear the beep or tone.

Options Description

Full Duplex Both the agent and the contact hear the beep or tone.
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5. The Agent Information appears as below:

6. The Information pop-up appears with following details:

Selected Agent Group: Name of the Agent Group to which the agent belongs.

Skill Groups: The name of the Skill Group assigned to the agent.

11.2  Audio Ports
This section discusses about the Audio Ports. To navigate, create, edit, filter, and changing 
status of an audio port is given below.

11.2.1   Navigation to Audio Ports
Follow the steps given below to navigate to the Audio Ports page:

1. Go to main menu icon.
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2. Click Administration > Recording > Audio Ports.

3. The Audio Ports page appears as given below:
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4. The Menu buttons on the Audio Ports page are described 
below:

5. The grid columns on the Audio Ports page are described below:

Note: Audio Ports offers the grid that can be filtered and sorted based on selecting any of 
the columns. Select the Column Settings icon from the column that needs to be 
filtered.

11.2.2   Create Audio Ports
To create a new Audio Port, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Audio Ports.

Icons Description

Refresh Refreshes the Audio Ports grid with latest audio ports changes. 
Instead of the browser refresh button user can click on this 
menu button which will refresh only the grid data and not the 
page.

Filter Filters the grid based on the switches.

Add Adds the new Audio Port to the grid.

Edit Edits the selected Audio Port existing in the grid.

Information Provides the information about the switch associated with the 
selected audio port from the grid.

Change Status Changes the status of the Audio Port listed in the grid.

Column Description

Name The name of the port.

Description The description of the port.

Type The type of the port, which is configured.

Server Name The name of the server.

Terminal Number The terminal number of the port.

Mode The mode of the port.

Channel The channel of the port.

Enabled Indicates whether port is enabled or disabled by means of a 
check mark icon.

Status Indicates whether port is active or inactive by means of a 
check mark icon.

Extension The extension of the port, if provided.
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3. The Audio Ports page appears.

4. Click on the Add button.The Add Audio Ports window appears with General tab active.

The fields marked (*) are mandatory fields.
Note:

a. By default the Switch Associations, VOIP Forwarding, and Associated Recording 
Groups tabs are disabled. 

b. The VOIP Forwarding tab will be enabled only for HPXM Port Type. 

c. Associated Recording Groups tab will be enabled only when there is minimum one 
Switch Associations listed and Recording option should be flagged on the Usage 
section, in the General tab.

5. In the General Tab: In the General tab of the window, various controls are disabled, once 
Port Type is selected the corresponding controls are enabled. General tab broadly includes 
five sections; Basic, Configuration, Usage, Audio Streaming, and Communication Manager.

6. The Create Multiple Ports toggle key is unflagged by default. Flag the key to create a 
group of audio ports. Leave it unflagged, if single port is to be created. 

7. The Number of Ports option text box will be enabled, once the Create Multiple Ports 
option is flagged. Enter the number of ports to be created in the Number of Ports text box.

The information button pop-up is available adjacent to the Number of Ports, stating, 
“Sum of 'Number of Ports' and 'Port Number' cannot exceed maximum port size 
100,000.”
An error message displays, if the port number exceeds 100,000.
Either select the value by clicking the up-down arrow keys or manually enter it in the 
Number of Ports text box.
Number of Ports field cannot be blank, when enabled.
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8. In the Port Number text box, the information button pop-up is available adjacent to the 
Port Number, stating, “Enter the 'Port Number' between 1 and 100,000.”

Enter the unique value manually in the Port Number text box.
Port numbers appear in the Port Name Column after you configure the ports.
This field cannot be blank.

9. In the Description text box, enter the descriptive name for the ports. 

10.The Enable toggle key is flagged by default. If user wants the audio ports to be able to 
record, leave it as is. User can unflag it, so that the port does not record.

11.The Multi Registration toggle key is unflagged and disabled by default. Flag the key as 
required.
Note: The Multi Registration key will be disabled for all the Port Types other than DMCC. 

12.In the Port Type drop-down, the options that are available by default are given below. Also 
the General tab options pertaining to that Port Type are given in the below table:

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section

AC_HPXM Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Codec: Select 
from the available 
Codec options 
listed in the drop-
down. The options 
are:
• Linear PCM 

8KHz 8-bit 
mono

• G.711 ulaw
• G.711 alaw

NA
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AL_LDPM Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board: Select 
the recording board on 
which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: Select 
from the options listed 
under drop-down.

Alternate Recording 
Mode: Select from the 
options listed under drop-
down.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box.The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

Terminal Number: This 
option is enabled only 
when single port is 
created.

Note: If Create Multiple 
Ports option is flagged, 
the Terminal Number will 
be disabled.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Note: Live 
Monitoring can 
be flagged only 
with the 
Recording 
Mode: On 
demand option.

Codec: Select 
from the available 
three Codec 
options listed in the 
drop-down.The 
options are:
• Linear PCM 

8KHz 8-bit 
mono

• G.711 ulaw
• G.711 alaw

Note: When Live 
Monitoring option 
is flagged, Linear 
PCM 8KHz 8-bit 
mono option is not 
available.

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 562



Administrator Guide
AL_DP Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board: Select 
the recording board on 
which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: Select 
from the options listed 
under drop-down.

Alternate Recording 
Mode: Select from the 
options listed under drop-
down.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Note: Live 
Monitoring can 
be flagged only 
with the 
Recording 
Mode: On 
demand option.

Codec: Select 
from the available 
three Codec 
options listed in the 
drop-down.The 
options are:
• Linear PCM 

8KHz 8-bit 
mono

• G.711 ulaw
• G.711 alaw

Note: When Live 
Monitoring option 
is flagged, Linear 
PCM 8KHz 8-bit 
mono option is not 
available.

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section
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AL_DT_AM
C

Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board: Select 
the recording board on 
which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

COM Port:* Select a 
COM Port listed under the 
drop-down.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Note: Live 
Monitoring can 
be flagged only 
with the 
Recording 
Mode: On 
demand option.

Codec: Select 
from the available 
three Codec 
options listed in the 
drop-down.The 
options are:
• Linear PCM 

8KHz 8-bit 
mono

• G.711 ulaw
• G.711 alaw

Note: When Live 
Monitoring option 
is flagged, Linear 
PCM 8KHz 8-bit 
mono option is not 
available.

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section
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AL_DT_CB
K

Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

NA

Note: The 
Usage section 
is uneditable, 
but by default 
Live Monitoring 
is flagged in 
this section.

UDP Port:* Enter 
the value for the 
UDP Port text box 
for the Port Type, 
either using the up 
down arrow keys 
or manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port'.”

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section
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AL_DT_ 
GSM

Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board: Select 
the recording board on 
which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Codec: Select from 
the available three 
Codec options listed 
in the drop-down.The 
options are:
• Linear PCM 

8KHz 8-bit mono
• G.711 ulaw
• G.711 alaw

Note: When Live 
Monitoring option 
is flagged, Linear 
PCM 8KHz 8-bit 
mono option is not 
available.

Streaming 
Reception: The 
Streaming Reception 
toggle key is enabled 
only when Live 
Monitoring option is 
flagged. By default 
Streaming Reception 
is unflagged. Flag it 
as required.

UDP Port:* This 
option is enabled 
only when Streaming 
Reception option is 
flagged. Enter the 
value for the UDP 
Port text box for the 
Port Type, either 
using the up down 
arrow keys or 
manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port'.”

NA

Port Type Configuration Section Usage Section Audio Streaming 
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AL_NGX Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board: Select 
the recording board on 
which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: Select 
from the options listed 
under drop-down.

Alternate Recording 
Mode: Select from the 
options listed under drop-
down.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.”

Terminal Number: This 
option is enabled only 
when single port is 
created.

Note: If Create Multiple 
Ports option is flagged, 
the Terminal Number will 
be disabled.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Note: Live 
Monitoring can 
be flagged only 
with the 
Recording 
Mode: On 
demand option.

Codec: Select 
from the available 
three Codec 
options listed in the 
drop-down.The 
options are:
• Linear PCM 

8KHz 8-bit 
mono

• G.711 ulaw
• G.711 alaw

Note: When Live 
Monitoring option 
is flagged, Linear 
PCM 8KHz 8-bit 
mono option is not 
available.

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section
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DMCC Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Channel:* Either select 
the value by clicking the 
up-down arrow keys or 
manually enter it in the 
Channel text box. The 
channel number of the 
physical port used to 
record.

Note: The information 
button pop-up is 

available adjacent to the 
Channel, stating, “Enter 
the 'Channel' between 1 
and 9999.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Codec: Select 
from the available 
Codec options 
listed in the drop-
down.The options 
are:
• G.711 ulaw
• G.711 alaw

UDP Port:* Enter 
the value for the 
UDP Port text box 
for the Port Type, 
either using the up 
down arrow keys 
or manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port' between 
10000 and 65534.”

Jitter Buffer 
Size:* Enter the 
value for the Jitter 
Buffer Size text 
box, either using 
the up down arrow 
keys or manually. 
The minimum 
value is 10.

Address:* Enter 
the IP Address in 
the Address text 
box.

Extension:* 
Enter the 
extension 
number in the 
Extension text 
box.

Manager 
Name:* Enter 
the name of the 
Manager in the 
Manager Name 
text box.

Password:* 
Enter the 
password in the 
Password text 
box.

Note: When the 
Create Multiple 
Ports key is 
flagged, the 
Manager Name 
and Password 
fields are not 
mandatory.

Port Type Configuration Section Usage Section Audio Streaming 
Section

Communication 
Manager 
Section
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SIP Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Codec: Select 
from the available 
Codec options 
listed in the drop-
down.The options 
are:
• G.711 ulaw
• G.711 alaw

UDP Port:* Enter 
the value for the 
UDP Port text box 
for the Port Type, 
either using the up 
down arrow keys 
or manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port' between 
10000 and 65534.”

NA

UCM_SIP Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

Recording Mode: By 
default only the On 
Demand option to be 
selected.

Recording: 
The Recording 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port.

Live 
Monitoring: 
The Live 
Monitoring 
toggle key is 
unflagged by 
default. Flag it 
if you want to 
allow recording 
on this port 
using Live 
Monitor.

Codec: Select 
from the available 
Codec options 
listed in the drop-
down.The options 
are:
• G.711 ulaw
• G.711 alaw
• G.729

UDP Port:* Enter 
the value for the 
UDP Port text box 
for the Port Type, 
either using the up 
down arrow keys 
or manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port' between 
10000 and 65534.”

NA

Port Type Configuration Section Usage Section Audio Streaming 
Section
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The fields marked (*) are mandatory fields.

See Whenever once a Port Type is selected and an attempt is made to change the Port Type, 
irrespective of whether all the fields are populated or not being saved, a dialog box appears, 
stating to select Yes or No for whether to accept or revert the changes. As given below: for 
details.

See Alternate Recording Mode for details.

See Codec for details.

Note: Whenever once a Port Type is selected and an attempt is made to change the Port 
Type, irrespective of whether all the fields are populated or not being saved, a dialog 
box appears, stating to select Yes or No for whether to accept or revert the changes. As 
given below:

d. Recording Mode

In the Configuration section of the window, select one of the following Recording Mode 
from the drop-down list box.

SIP_CBK Server:* Select from the 
available server options in 
the drop-down list box, the 
name of the server on 
which the audio port runs.

Recording Board:* 
Select the recording board 
on which the audio port 
resides from the available 
options listed in the drop-
down list box.

NA

Note: The 
Usage section 
is uneditable, 
but by default 
Live Monitoring 
is flagged in 
this section.

UDP Port:* Enter 
the value for the 
UDP Port text box 
for the Port Type, 
either using the up 
down arrow keys 
or manually.

Note: The 
information 

button pop-up 
is available 
adjacent to the 
UDP Port, stating, 
“Enter the 'UDP 
Port' between 
10000 and 65534.”

NA

Selection Description

On Demand This is the most common setting. Recording is controlled by the 
monitoring mode and the rules that are configured by the user.

Port Type Configuration Section Usage Section Audio Streaming 
Section
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Manager 
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e. Alternate Recording Mode

In the Configuration section of the window, select one of the following Alternate Recording 
Mode from the drop-down list box.

Note: The Call Events mode is recommended if the integration supports it. Call Events 
provides much better call recordings. To use Call Events, the integration tap point 
must be between the outside caller and the call center. Call Events does not work 
for always-connected agent side taps (sometimes called “nailed-up” connections). 
Activity Detection breaks a single call into multiple recordings because periods of 
silence are interpreted as the end of a call, and then the recording stops. However, 
Activity Detection is the only alternate way to record for always-connected, nailed-
up agent side taps.

f. Codec

In the Audio Streaming section of the window, select the Codec from the drop-down list 
box. Codec options specify the audio format which the audio port uses when writing a 
recording file to disk or when streaming across the network for live monitoring.
Note: In general, for sites in North America and Japan, select ulaw. For sites in Europe, 

select alaw.

Call Events This option is not available for every port type. From the 
Recording Mode drop-down list box, if you want to start or stop 
recordings using telephony hardware signals, select Call Events.

Activity Detection This option is not available for every port type. In this mode, Audio 
Codes hardware attempts to detect voice activity and record when 
present.

Selection Description

Call Events From the Alternate Recording Mode drop-down list box, if you 
want to start or stop recordings using telephony hardware signals, 
select Call Events.

Activity Detection If you want to start or stop recordings when the system sense 
audio activity on the line, select Activity Detection.

Selection Description

Linear PCM 8KHz 8-bit mono An uncompressed version of the audio. Aspect Software does not 
recommend this format. If you select Live Monitoring for use on 
the audio port, this option is not available in the drop-down list.

G.711 ulaw A compressed audio format. Aspect Software recommends that if 
the source from which the audio port is retrieving the audio is 
using this audio format, that you also set up the audio port to use 
the same audio codec.

G.711 alaw A compressed audio format. Aspect Software recommends that if 
the source from which the audio port is retrieving the audio is 
using this audio format, that you also set up the audio port to use 
the same audio codec.

Selection Description
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13.In the Switch Associations tab: By default only Add button is enabled to add switch 
associations.

The welcome screen for the first time shows, ‘Use “Add” button to add switch associations’.

Click on the Add  button. The Add Switch Associations window appears as given below:

Note: The fields marked (*) are mandatory fields.

Select the Association Type from the drop-down. The options listed in the drop-down 
varies as per the Port Type in the General tab. These are given in the below table:

Port Type Association Type

AC_HPXM Switch only

AL_LDPM • Position on switch: By default this option is selected. Enter 
the value in the Position:* combo text box.

Note: If Create Multiple Ports key is flagged in the general tab: 
Multiple Port Creation for Position on switch will increment by 
one for every new port position value in Switch Association tab 
for the selected switch type.
• Agent on switch: When this option is selected, enter the 

value in the Agent:* combo text box from the drop-down.

Note: The Position selection should be unique to a Switch. For 
example: When you select Switch 1 as Position 1, you can still 
add Switch 2 as Position 1 or Switch 1 as Position 2. But, you 
cannot again associate Switch 1 with Position 1.

AL_DP Trunk Channel: By default this option is selected. Select the 
value from the drop-down in the Trunk Channel:* combo text 
box.

AL_DT_AMC Switch only
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AL_DT_CBK Switch only

AL_DT_ GSM Switch only

AL_NGX • Position on switch: By default this option is selected. Enter 
the unique value in the Position:* combo text box.

Note: If Create Multiple Ports key is flagged in the general tab: 
Multiple Port Creation for Position on switch will increment by 
one for every new port position value in Switch Association tab 
for the selected switch type.
• Agent on switch: When this option is selected, select the 

unique value in the Agent:* combo text box from the drop-
down.

DMCC • Switch only: By default this option is selected.
• Position on switch: If this option is selected, enter the value 

in the Position:* combo text box.

Note: If Multi Registration key if flagged:
1.) When you have only one Avaya switch in the system 
and Multi Registration option is flagged from the General 
tab, the Switch Association Position field will be 
automatically populated with the Extension number that is 
given by the user and the Switch Association is created 
itself.
The Delete option will be disabled for the single Avaya 
Switch Associations for which the Multi registration key is 
flagged. Also Edit option is enabled, but will not allow to 
make any changes to these fields in the Switch 
Associations tab.
2.) When you have more than one Avaya switch in the 
system and the Multi Registration key is flagged, the Switch 
Association will not be automatically added by the system. 
The user has to select the Switch from the drop-down list 
box and then the Position field will be populated itself as in 
the Extension number. Select OK to create a Switch 
Association. This process needs to be repeated for as 
many switches listed.
3.) When more than one Port or multiple ports are created, 
the Switch Associations needs to be created only for one 
switch, and for next n number of switches, the Switch 
Associations will be created itself with the Port Number and 
the Extension number (Position field) will be automatically 
populated. The Port Number will be with existing Port 
Number + 1 and Extension number or Position also as 
existing Extension number + 1.

Note: If Create Multiple Ports key is flagged in the general tab: 
Multiple Port Creation for Position on switch will increment by 
one for every new port position value in Switch Assocation tab 
for the selected switch type.

SIP Switch only

Port Type Association Type
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Select the Switch with which you associated the audio ports from the drop-down that lists 
all the active switches for the system.

Click OK to save.

The Switch Association created appears in the grid.

User can add more than one Switch Associations.
Note: Whenever once a Switch is selected and an attempt is made to change the Switch, 

irrespective of whether all the fields are populated or not being saved, a dialog box 
appears, stating to select Yes or No for whether to accept or revert the changes. As 
given below:

Once the Switch Association is created, all the other menu options are enabled.These are:

Note: By default the first line switch item will be marked as default, with a check mark  
icon in the default column.

UCM_SIP Switch only 

Note: You should not define UCM_SIP audio ports dedicated 
for more than one switch in the same Recording server. A 
separate recording server needs to be configured for each 
additional switch.

Example of non-supported configuration: (See table below)

SIP_CBK Switch only

Ports Switch Server

1000 to 1100 Cisco SwitchA RecordingServer1

2000 to 2100 Cisco SwitchB RecordingServer1

Icons Description

Add Adds the new switch to the grid.

Edit Edits the selected switch existing in the grid.

Delete Deletes the selected switch from the grid.

Set As Default Sets the selected switch from the grid as default.

Port Type Association Type
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Any switch item from the grid can be made as default, by selecting the required switch and 
click the Set as Default icon . The check mark  appears in the Default column for the 
respective switch.

14.In the VOIP Forwarding tab: By default only Edit  button is enabled to change source 
tap points.

The welcome screen for the first time shows, ‘Use “Edit” button to change source tap 
points’.

Click on the Edit  button. The Edit Source Tap Points window appears as given below:

Note: The VOIP Forwarding tab will be enabled only for HPXM Port Type. 

In the Edit Source Tap Points window, shows all the VOIP Forwarding items in the 
Available Items column. 

User can select the items from Available Items section and move it to Selected Items by 

using the Add items  arrow key.

To select more than one item from the Available Items section, long press the Ctrl key.

To remove the items from the Selected Items section, use the Remove items arrow 
key.

Once the required VOIP Forwarding items are in the Selected Items section, click the OK 
button.

Now, the VOIP Forwarding grid is updated and all the Selected Items will be listed.

The VOIP Forwarding grid comprises of one column, that is Name. Name includes all the 
VOIP Forwarding details.

15.In the Associated Recording Groups tab: By default only Edit  button is enabled to 
change associated recording groups.
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The welcome screen for the first time shows, ‘Use “Edit” button to change associated 
recording groups’.

Click on the Edit  button. The Edit Associated Recording Groups window appears as 
given below:

Note: Associated Recording Groups tab will be enabled only when there is minimum one 
Switch Associations listed and Recording option should be flagged on the Usage 
section, in the General tab.

The Switch drop-down will list all the switches that were created in the Switch Associations 
tab.

Select any of the Switch from the drop-down and all the Recording Groups from the 
selected Switch will be displayed under the Available Items section. 

If user wants to select any or all of the Available Items select them with the help of Ctrl key 

and click the Add items  arrow key.

Now, the selected items will be displayed in the Selected Items section.

To remove the items from the Selected Items section, use the Remove items arrow 
key.

If user wants to select the different recording group from a different switch, first select the 
switch from the Switch drop-down, and then select the respective recording groups as 
required.

Although, when you select the different Switch, the previously selected recording groups 
will not be listed under the Selected Items section. But, when the previous Switch is 
reselected, same recording groups will be populated itself under the Selected Items 
section.

Once the required recording groups are in the Selected Items section, click the OK button.
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Now, the Associated Recording Groups grid is updated and all the Selected Items will be 
listed. This list includes all the recording groups added by means of all the different 
selected switches.

The Associated Recording Groups grid comprises of two columns, these are Name and 
Switch. 

Name includes all the Recording Group names.

Switch includes the name of the switch to which the Recording Group belongs.

16.After updating the recording groups in the Associated Recording Groups tab, click the 
Switch Associations tab for editing a switch. Select the name of the Switch that needs to 
be edited. Click on the Edit  button. The edit Warning dialog box appears, as shown 
below:

Click Yes, if you want to remove the recording groups added in the associated recording 
groups tab. Click No, if you don’t want any changes.

17.After updating the recording groups in the Associated Recording Groups tab, click the 
Switch Associations tab for deleting a switch. Select the name of the Switch that needs to 
be deleted. Click on the Delete button. The delete Warning dialog box appears, as shown 
below:

Click Yes, if you want to delete the recording groups added in the associated recording 
groups tab. Click No, if you don’t want any changes.

18.After updating the recording groups in the Associated Recording Groups tab, click the 
General tab. The Recording toggle key was flagged to enable the Associated Recording 
Groups tab. Again unflag the Recording toggle key in the Usage section. The Warning 
dialog box appears, as shown below:
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Click Yes, if you want to change the recording groups added in the associated recording 
groups tab. Click No, if you don’t want any changes.

19.Once all the required fields are populated, select the OK button on the General tab to 
complete the process.

The created audio port appears in the Audio Ports grid.

11.2.3   Edit Audio Ports
To edit an Audio Port, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Audio Ports.

3. The Audio Ports page appears.

4. Select the available Audio Port from the grid that needs to be edited and click the Edit icon 
.

5. The Edit Audio Ports window appears with General tab active as shown below:

Note: The Port Type cannot be updated for any Audio Port that is already created and it 
will remain disabled for Edit Audio Ports option.

6. Edit the fields as per your requirement.

Note: Refer to Create Audio Ports on page 11-559 section, step 4 to 18.

7. Click the OK button to complete the process.
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11.2.4   Filter Audio Ports
The Filter icon filters the audio ports listed in the grid on the basis of switches.

1. Go to the main menu.

2. Click Administration > Recording > Audio Ports.

3. The Audio Ports page appears.

4. From the Audio Ports page click the Filter  icon.

5. The Filter window appears as below:

6. Switches:* From the Switches drop-down list box, select the type of switch associated to 
the port, that should be listed on the Audio Ports page. Multiple switches can be selected at 
once.

7. Click OK to complete the process.

11.2.5   Information about Audio Ports
The Information icon briefly gives the audio ports information associated with the switches that 
is selected from the grid.

1. Go to the  main menu icon.

2. Click Administration > Recording > Audio Ports.

3. The Audio Ports page appears.
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4. From the Audio Ports page select the Name from the grid for which you need to view the 
switches information. Then click the Information  icon.

5. The Audio Port Information appears as below:

6. The Information pop-up appears with following details:

Selected Audio Port: Name of the Audio Port.

Switches: The name of the Switches associated to the port.

11.2.6   Change Status of an Audio Port
The Change Status icon allows to edit only the audio ports status that is selected from the grid.

1. Go to the main menu.

2. Click Administration > Recording > Audio Ports.

3. The Audio Ports page appears.

4. From the Audio Ports page select the Name from the grid for which you need to edit the 
status information. Then click the Change Status  icon.

Note: Status can be updated for multiple audio ports selected at once.
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5. The Change Status window appears as below:

6. By default the Change Status dialog box for the selected audio port, shows the Status and 
Enabled toggle keys unflagged, irrespective of whether they are active in the grid. The 
radio buttons beneath both the options are disabled as well.

7. Notice the selected Audio Port highlighted in the grid for Change Status. Enabled column is 
active and Status column shows inactive.

8. Edit the Change Status dialog as required.

Here, Status is flagged to Active and Enabled is flagged to No.

9. Click the OK button to save the changes.
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10.The changes will be updated in the Audio Ports grid as shown below:

11.3  Locations
You only need to define locations if one or more of the following conditions apply:

• You are configuring Aspect Quality with Unified IP.

• You are using Location Aware Recording servers in the system. For example, on Unified IP, 
the Aspect Quality Recording server is aware of the physical location of the DCP/TMS and 
knows which agents are configured to which DCP/TMS based on the configuration location 
settings.

• You are using distributed recording storages across three or more distinct geographic 
locations where the locations share the storage groups as alternate storages.

This section describes about Navigation, Add, Edit and Delete a Location.

11.3.1   Navigation to Locations
Follow the steps given below to navigate to the Locations page:

1. Go to main menu icon.
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2. Click Administration > Recording > Locations.

3. The Locations page appears as given below:

4. The Menu buttons on the Locations page are described below:

Icons Description

Refresh Refreshes the locations grid with latest locations changes. 
Instead of the browser refresh button user can click on this 
menu button which will refresh only the grid data and not the 
page.
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5. The grid columns on the Locations page are described below:

11.3.2   Create Locations
To create a new Location, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Locations.

3. The Locations page appears.

4. Click on the button. The Add Location definition window appears with the General tab 
active.

The fields marked (*) are mandatory fields.

5. On the General tab:

• In the Name text box, type a name for the location.

Add Adds the new location to the grid.

Edit Edits the selected location existing in the grid.

Delete Deletes the selected location existing in the grid.

Column Description

Name The name of the locations.

Description The details about the Location, if entered while creating a new 
location.

Icons Description
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• In the Description text box, type a short description of the location.

If the system does not use location aware recording servers, then go to step 7.

6. On the Telephony Servers tab:

Under the Switch drop-down, only the UIP switches are listed, because the Telephony 
Server is based on the UIP.

After you select a UIP Switch from the drop-down list, in the Available Items window all the 
servers that are associated with that UIP switch are listed.

The naming configuration of Server is:

Server Name (Switch Name): For example, 100159 (UIP735)

You can Add or Remove a server associated with the switch to the Selected Items window, 
by using the arrow keys.

You cannot modify the Telephony Servers tab until the telephony server is available for 
selection, which occurs when the system is up and running.

Note: For more information, see Location Aware Recording Server on page 11-588.

7. If the system does not use distributed recording storages across three or more distinct 
geographic locations where the locations share the storage groups as alternate storages, 
then go to step 10.

8. On the Servers tab:
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 585



Administrator Guide
In the Available Items window all the servers that are available in the system are 
displayed. You can Add or Remove the required servers that you want to associate with 
this particular location to the Selected Items window, by using arrow keys.

9. On the Storage Groups tab:

All the storage groups are linked and listed under the Available Items window. You can 
Add or Remove the required storage groups that you want to associate with this particular 
location to the Selected Items window, by using the arrow keys.

10.Click OK. The Add Location window closes, and the Location that you created displays in 
the grid on the Locations page.
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11.Repeat the procedure for all locations that are required in the system.

Note: Only Name of location on the General tab is the mandatory field to create a new 
location.

11.3.3   Edit Location
To edit a Location, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Locations.

3. The Locations page appears.

4. Select the available Location from the grid that needs to be edited and click the Edit icon 
.

5. The Edit Location window appears, as shown below.

6. Edit the field values as per your requirement.
Note: Refer to Create Locations on page 11-584, step 4 to 10.

7. Click the OK button to complete the process.

Note: Multiple switches can be selected from the drop-down list box on the Telephony 
Servers tab, and can be edited.

11.3.4   Delete Location
To delete a Location, perform the following steps.

1. Go to the main menu.
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2. Click Administration > Recording > Locations.

3. The Locations page appears.

4. Select the available Location from the grid that needs to be deleted and click the Delete 
icon.

5. A warning message appears, if you want to delete or not, as shown below.

6. Select the Yes option to delete the location.

11.3.5   Location Aware Recording Server
In Aspect Quality, for example, when there are two recording servers at different locations, and 
when an agent answers the call from one location, Aspect Quality might select the port 
connected to a switch (Telephony Server ID) that resides at a different location. Another 
example is that you might be using a Unified IP system that has telephony in two different 
locations.

You can select a recording port on which to record calls, as explained below (see also the 
following diagram).

• In the first level, recording ports that are tied to the same Telephony Server as the agent 
audio path (where the agent is signed on) are preferred first. In the diagram example below, 
the location is named Bangalore.

• If for some reason all recording ports at the first level of preference are busy, and there is 
another telephony server tied to the Bangalore location, then the second telephony server 
ports are selected to record calls.
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• If all ports of all telephony servers associated with the Bangalore location are busy, then 
recording ports are selected from the remaining pool of recording ports.

11.3.5.1   Prerequisites
• Aspect Quality version 24 and above

• Aspect Unified IP version 7.4 SP2 and above

• SIP Recording Ports

• Agent Trunk Tapping configuration only when telephony servers are in multiple locations 
when used with Aspect Quality.

11.4  Receiver Groups
Use Receiver Groups to create an association between File Receiver process(es) and Unified 
IP telephony servers for a switch. Receiver Groups only apply to Unified IP switch definitions 
configured to use Enhanced CTIPS.

You can use Receiver Groups to record on the Telephony Server and transmit the recording 
files for storage and retrieval in Aspect Quality.

You must define at least one Receiver Group for each Unified IP switch with an Enhanced 
CTIPS integration.

This section describes about Navigation, Add, Edit, Delete a Receiver Groups.
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11.4.1   Navigation to Receiver Groups
Follow the steps given below to navigate to the Receiver Groups page:

1. Go to main menu.

2. Click Administration > Recording > Receiver Groups.
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3. The Receiver Groups page appears as given below:

4. The Menu buttons on the Receiver Groups page are described below:

5. The grid columns on the Receiver Groups page are described below:

11.4.2   Create Receiver Groups
To create a new Receiver Group, perform the following steps.

1. Go to the main menu.

Icons Description

Refresh Refreshes the receiver groups grid with latest receiver group 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new receiver group to the grid.

Edit Edits the selected receiver group existing in the grid.

Delete Deletes the selected receiver group existing in the grid.

Column Description

Name The name of the Receiver Group.

Switch The name of the switch to which the receiver group is 
associated.
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2. Click Administration > Recording > Receiver Groups.

3. The Receiver Groups page appears.

4. Click on the  button. The Add Receiver Group definition window appears with the 
General tab active.

Note: The fields marked (*) are mandatory fields.

• In the Name text box, enter the name for the receiver group to be created.

• From the Switch drop-down list box that displays the active UIP Enhanced CTIPS 
switches, select the switch to which you want to associate the Receiver Group. The 
switch that you select determines the items that you can select on the Senders tab.

Note: When you select a Switch once, on the general tab, and you revisit to change the 
same, a warning dialog appears, if you want to change and lose the changes, as shown 
below.

Once you enter the value in the General tab fields, other two tabs; Receivers tab and 
Senders tab, will be enabled.

5. On the Receivers tab, the Available Items window lists all the File Receiver Processes 
server names. You can Add or Remove a File Receiver process associated with the 
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Receiver Group to the Selected Items lists, by using the arrow keys. You must assign at 
least one File Receiver process to the Receiver Group.
Note: A File Receiver process cannot be associated with more than one Receiver Group 

with the same switch.

6. On the Senders tab, the Available Items window lists all the Unified IP servers available 
for the selected switch. You can Add or Remove a selected Unified IP server(s) that you 
want to associate with the Receiver Group to the Selected Items window, using the arrow 
keys.

Add the Unified IP servers that use this Receiver Group. This maps or associates specific 
Unified IP servers with specific Aspect Quality File Receivers. Proper mapping allows sites 
to control how to move recordings.

Note: The Senders tab displays the list of valid Unified IP servers only after:
• You create a proper switch definition with Enhanced CTIPS switch type,
• You start Interaction Monitor, and
• The switch definition connects to Unified IP and data syncs.

There are two Type of Senders list:

• Quality Metadata Sender: These type of servers are all listed in one row only, separated 
by spaces and Hyphen (-).

• Quality Media Sender: These are listed individually in different rows.
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The combination of Receiver Group options defines the File Receiver process(es) that 
handle the media and metadata files for the specified Unified IP servers.

The list of valid Unified IP servers must include all the Unified IP telephony servers and the 
Unified IP Centercord servers. The Chat server uses File Receiver to send chat transcript 
files as a reply to the user. Centercord servers use File Receivers to send recording 
metadata only when you enable Full Time recording, and there is an error condition 
preventing normal recording processing.

Unified IP servers consist of Telephony servers for media (vox files) and core machines for 
full time recording metadata (for example, Agent, Agent Group). If you enable Full Time 
Recording, you must add these Quality Metadata Sender machines to a Receiver Group. 
For chat integration, you must add the Quality Media Sender machines to a Receiver 
Group.
Note: The Unified IP Sender Type column is a read-only field that contains either Quality 

Media Sender or Quality Metadata Sender.

7. Click OK. The Add Receiver Group window closes, and the Receiver Group that you 
created displays in the grid on the Receiver Groups page.

Note: It is mandatory to enter and select values in all the tabs, otherwise an error message 
appears with the exclamation tag on the tabs, as shown below.

Unified IP Sender Type Description

Quality Media Sender The Unified IP system sends VOX files.

Quality Metadata 
Sender

The Unified IP system sends fields with information about the 
VOX files.
The Unified IP chat server sends .json files with interaction 
content and metadata.
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11.4.3   Edit Receiver Groups
To edit a Receiver Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Receiver Groups.

3. The Receiver Groups page appears.

4. Select the existing Receiver Group from the grid that needs to be edited and click the Edit 
icon .
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5. The Edit Receiver Group window appears as shown below.

6. Edit the field values as per your requirement.
Note: Refer to Create Receiver Groups on page 11-591 section, step 4 to 7.

7. Click the OK button to complete the process.

Note: The Switch option will be disabled for editing, whether it is Active or Inactive. The 
inactive switch will be displayed in the window as (Inactive).

11.4.4   Delete Receiver Group
To delete a Receiver Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Receiver Groups.

3. The Receiver Groups page appears.

4. Select the existing Receiver Group from the grid that needs to be deleted and click the 
Delete icon.

5. A warning message appears, if you want to delete or not, as shown below.

6. Select the Yes option to delete the receiver group.
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11.5  Recording Boards
Recording Board lists all the available recording boards in the system.

This section describes about Navigation, Add, Edit, Activate and Deactivate a Recording 
Board.

11.5.1   Navigation to Recording Boards
Follow the steps given below to navigate to the Recording Boards page:

1. Go to the main menu.

2. Click Administration > Recording > Recording Boards.
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3. The Recording Boards page appears as given below:

4. The Menu buttons on the Recording Boards page are described 
below:

5. The grid columns on the Recording Boards page are described below:

Icons Description

Refresh Refreshes the recording boards grid with latest recording board 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new recording board to the grid.

Edit Edits the selected recording board existing in the grid.

Activate Activates the existing recording board.

Deactivate Deactivates the existing recording board.

Column Description

Name The name of the Recording Board.

Description Gives the description of the board, if any.

Serial Number Gives the serial number of the particular recording board.

Type Gives the recording board configuration.

Server The name of server to which recording board is associated.
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11.5.2   Create Recording Boards
To create a new Recording Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Boards.

3. The Recording Boards page appears.

Active The recording board status is displayed by the icon, whether 
active or not.

Column Description
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4. Click on the  button. The Add Recording Boards definition window appears.

Note: The fields marked (*) are mandatory fields.

5. In the Name text box, type a board name that uniquely identifies a recording board. This 
field cannot be blank.

6. In the Description text box, type a short description of the board.

7. Select the Server from the drop-down list box, in which you installed the board.

8. In the Board Configuration section of the window, from the Type drop-down list box, 
select the type of board. There are total nine recording board types listed in the drop-down. 
In the example, the card is an AudioCodes HPXMedia.

By default the first type of recording board is selected, here it is AudioCodes HPXMedia.
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Based on the Type of recording board selected, further section needs to be updated.

Type Section (s)

AudioCodes HPXMedia In the Network Adapter section of the window, enter the IP 
Address*.

AudioCodes 
SmartWORKS DP

In the Serial Number* text box enter a value.

AudioCodes 
SmartWORKS DT

In the Serial Number* text box enter a value.

AudioCodes 
SmartWORKS HPX

In the Serial Number* text box enter a value.

Note: In the AudioCodes SmartWORKS HPX, the Serial 
Number need not be unique.

AudioCodes 
SmartWORKS LD

In the Serial Number* text box enter a value.

AudioCodes 
SmartWORKS NGX

In the Serial Number* text box enter a value.
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Avaya DMCC In the Primary AES Server section of the window, enter the 
following values in the text boxes:
• Address*
• Port*
• User Name*
• Password*
• Certificate*
• Protocol Version*
• TSAPI Link Name

In the Backup AES Server section of the window, enter the 
following values in the text boxes:
• Address
• Port
• User Name
• Password
• Certificate
• Protocol Version
• TSAPI Link Name

Note:
• In the Primary AES Server section window the fields 

marked with * are mandatory, but they aren’t mandatory in 
the Backup AES Server section until and unless all these 
similar * fields are left blank. If any one of the similar to * 
marked fields are entered with any value in the Backup 
AES Server, all the similar * fields becomes mandatory in 
Backup AES Server.

• Any modification made to an Avaya DMCC recording board 
requires restarting the Aspect Quality service on affected 
Recording port server. The DMCC Recording ports are 
made aware of the DMCC interface when the Aspect 
Quality service is restarted; otherwise, the DMCC 
Recording ports associated with the recording board are 
not functional.

Type Section (s)
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SIP In the SIP Configuration section of the window:
• Secure RTP: The Secure Real-Time Transport Protocol 

(RTP) toggle key is unflagged by default.
• Certificate*
• Transport Protocol: Select the protocol for SIP signaling 

(TCP, UDP or TLS) from the drop-down list box. By default, 
the first listed item, i.e. TCP is selected.
Note: Even though you can add multiple recording boards 
against a single Aspect Quality Recording server, the 
boards must have the same Local Signaling Port and 
Transport Protocol. The UI populates the two fields by 
using the information from the first board when you create 
more boards. Aspect Quality warning messages open if 
you attempt to change the information.

• Local Signaling Port*

Note: An Aspect Quality Recording server can have two 
Unified IP switches up and running only when the 
Transport Protocol and the Local Signaling port for 
both Unified IP versions are the same. Therefore, a 
single Aspect Quality Recording server cannot 
accommodate two versions of Unified IP if one of the 
versions is secure (with Secure Socket Layer [SSL]) 
and the other is unsecure (non-SSL).

• Primary Proxy Server Port*
• Primary Proxy Server Address*
• Backup Proxy Server Address 
• Backup Proxy Server Port

Note: Backup Proxy Server Address and Backup Proxy 
Server Port, both are optional fields. But, if any value is 
entered should be entered either in both the fields or 
both the fields should be blank.

• RFC 2833 DTMF Payload Type*: Enter the Type to carry 
RFC 2833 DTMF digits. 
Note: This type must match the value used in the Unified 
IP Gateway configuration.

9. Dial String: In the Dial String text box, type a number used 
by the Unified IP Numbering Plan for the M3 Service that is 
running the Aspect Quality Monitor Script. The number 
overwrites the Dial String value in the Switch Definition 
window for this particular recording board. If you leave the 
text box empty, the system uses the switch Dial String 
instead.
Note: For Unified IP, a typical Dial String is 9999.

Note: When you have already created any SIP board from 
any particular server listed in the drop-down list box, 
the Transport Protocol will automatically be selected as 
the same, when you again create another SIP board 
with the same server.

Type Section (s)
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Note: The fields marked (*) are mandatory fields.

Serial Number*
In the Serial Number text box, type the full master serial number, which is unique for 
every type of recording board in the system.

Note: To determine the serial number, you can examine the documentation included 
with the card, or you can access the built-in Web server configured on this card. 
You can also open SmartWorks on the Recording server and locate the serial 
number on the Board tab.

Certificate
Enter any value for Certificate.

Note: When a Recording Board is created with a particular Server with either the SIP or 
Cisco BIB Type, the Certificate field value should remain the same for as many 
Recording Boards created. If the Certificate value is changed for either SIP or 
Cisco BIB, a warning message appears that whether the value to be updated 
across all the Recording Boards with that particular Type, as given below for SIP 
Type.

Cisco BIB (Cisco Built-in 
Bridge)

The Built-in Bridge (BIB) recording feature requires the 
creation of a new Cisco BIB recording board on each recording 
server. This board is based on the SIP Protocol and provides 
an interface between the Cisco Unified Contact Center 
Enterprise (UCCE) and the Unified Communications Manager 
(UCM) switch and the recording servers.

The number of audio ports on this board is limited by the CPU 
and memory capacity of the recording server. The results of 
the load testing provide the specific capacity numbers and limit 
on provisioning. For the specific capacity numbers and limits 
on provisioning, see the Alvaria Quality Planning Guide.

In the SIP Configuration section of the window, enter the 
following values in the text boxes:
• Transport Protocol: Select the protocol for SIP signaling 

(TCP, UDP or TLS) from the drop-down list box. By default, 
the first listed item, i.e. TCP is selected.
Note: Even though you can add multiple recording boards 
against a single Aspect Quality Recording server, the 
boards must have the same Local Signaling Port and 
Transport Protocol. The UI populates the two fields by 
using the information from the first board when you create 
more boards. Aspect Quality warning messages open if 
you attempt to change the information.

• Local Signaling Port*
• Certificate

Note: When you have already created any Cisco BIB board 
from a particular server listed in the drop-down list box, 
the Transport Protocol and Local Signaling Port will 
automatically be updated with the existing same value, 
when you again create another Cisco BIB board with 
the same server.

Type Section (s)
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Note: You can configure multiple recording boards against a single Aspect Quality server. You 
can also configure multiple ports against a single board and against an already-created 
board.

10.Click the OK button to create the Recording Board.

Note: By default, the new Recording Board which is created will be listed in the grid and will 
be Active.

11.5.3   Edit Recording Boards
To edit a Recording Board, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Boards.

3. The Recording Boards page appears.
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4. Select the available Recording Board from the grid that needs to be edited and click the 
Edit icon.

5. The Edit Recording Board window appears as shown below:

6. Edit the field values as per your requirement.

Note: Refer to Create Recording Boards on page 11-599 section, step 5 to 9.

7. Click the OK button to complete the process.

Note: When you edit the Transport Protocol type for SIP or Cisco BIB Type of Board 
Configuration, a warning message appears to confirm the changes. If Yes, then this 
change will be updated in all the existing SIP and Cisco BIB recording boards.

11.5.4   Activate a Recording Board
This feature allows to activate a Recording Board based on the selected parameters. To 
activate a Recording Board follow the steps given below.
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1. Select the Recording Board for which the Active column is blank, as shown below:

2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected Recording Board as shown below:
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11.5.5   Deactivate a Recording Board
This feature allows to deactivate a Recording Board. To deactivate a Recording Board follow 
the steps given below.

1. Select the Recording Board for which the Active column is checked as shown below:
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2. Click on the Deactivate  button and the Active column will be blank for the selected 
Recording Board as shown below:

Note: When in the Recording Boards grid, there is more than one Recording Board with the 
same Name, either of the Recording Boards can be set to Active. But both the 
Recording Boards with the similar name can be inactive. If you try to Activate both the 
similar named Recording Boards, an Error message appears to deactivate the existing 
recording board or change the name of the recording board.

Note: When similar Serial Number for different Types of Recording boards, all the Recording 
Boards can neither be activated nor deactivated. The Serial Number should be unique 
for different recording boards types for all to be active. This is not applicable for 
AudioCodes SmartWORKS HPX, as it doesn’t need to have unique serial number.
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11.6  Recording Groups
Recording Groups are a collection of one or more Audio ports based on similar criteria (for 
example, the same switch or the same telephony card). An Administrator can create a 
Recording Group and give only certain Mentors permission rights to review the calls recorded 
on the ports in the group(s).

This section discusses about Navigation, Add, Edit, Activate and Deactivate a Recording 
Group.

11.6.1   Navigation to Recording Groups
Follow the steps given below to navigate to the Recording Groups page:

1. Go to the main menu.

2. Click Administration > Recording > Recording Groups.
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3. The Recording Groups page appears as given below:

4. The Menu buttons on the Recording Groups page are described 
below:

5. The grid columns on the Recording Groups page are described below:

Icons Description

Refresh Refreshes the recording groups grid with latest recording group 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new recording group to the grid.

Edit Edits the selected recording group existing in the grid.

Activate Activates the existing recording group.

Deactivate Deactivates the existing recording group.

Column Description

Name The name of the Recording Group.

Switch The name of switch to which recording group is associated.

Active The recording group status is displayed by the icon, whether 
active or not.
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11.6.2   Create Recording Groups
To create a new Recording Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Groups.

3. The Recording Groups page appears.

4. Click on the  button. The Add Recording Groups window appears with General tab 
active.

Note: The fields marked (*) are mandatory fields.

5. In the General tab of the window, in the Name text box, type a group name that uniquely 
identifies a recording group. This field cannot be blank.

6. Select the Switch from the drop-down list box.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 612



Administrator Guide
7. Once the Switch is selected the Recording Group Members option is enabled. Click the 
Select tab, the Add Audio Port(s) window appears as below:

• Click the Add button on the Audio Port(s) window to add the active audio ports 
which are associated with the switch that is selected. Click the Shift key to select the 
multiple audio ports from the list.

Note: Only the active audio ports will be listed by default.

• Click the Add All button to select all the existing audio ports associated with the 
selected switch.

• Click the Clear button to clear the selected audio ports from the Audio Port(s) grid 
window.

• Click the Delete button to clear all the existing audio ports at once from the Audio 
Port(s) grid window.

• Select OK to confirm the selected Audio Ports.
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8. Now, select the Profile Permissions tab, as shown below:

Note: Here all the user profiles which are active will be displayed, except the Administrator 
profile.

• When you want to provide permissions to the Recording Groups that you are creating, 
then the user profiles can be added from the Profile Permissions tab.

• To select one or multiple user profiles under the Available Items section, click on the 
 button.
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• Once the user profiles are selected, they are added to the Selected Items grid, as 
shown below:

• The user profiles permission can be edited by two ways. 
By either selecting the adjacent Permission drop-down button for changing individually 
the user profiles, or by selecting the Change selected user profiles 

permission button for changing all the user profiles Permission in the Selected 

Items grid at once.
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• The Change Permission window appears. Select the desired permission for the user 
profiles and click OK, as shown below:

9. Click the OK button to create the Recording Group.

Note: By default, the new Recording Group which is created will be listed in the grid and will 
be Active.

11.6.3   Edit Recording Groups
To edit a Recording Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Groups.

3. The Recording Groups page appears.

4. Select the available Recording Group from the grid that needs to be edited and click the 
Edit icon.
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5. The Edit Recording Group window appears with General tab active as shown below:

6. Edit the General and Profile Permissions tab as per your requirement.
Note: Refer to Create Recording Groups on page 11-612 section, step 5 to 8.

7. Click the OK button to complete the process.

11.6.4   Activate a Recording Group
This feature allows to activate a Recording Group based on the selected parameters. To 
activate a Recording Group follow the steps given below.
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1. Select the Recording Group for which the Active column is blank, as shown below:

2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected Recording Group as shown below:
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11.6.5   Deactivate a Recording Group
This feature allows to deactivate a Recording Group. To deactivate a Recording Group follow 
the steps given below.

1. Select the Recording Group for which the Active column is checked as shown below:
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2. Click on the Deactivate  button and the Active column will be blank for the selected 
Recording Group as shown below:

Note: Multiple Recording Groups can be Activated / Deactivated together.

11.7  Recording Rules
You can base the rules on a wide variety of criteria, so that you can create general rules that 
apply to the entire contact center or specific rules that apply only to a particular agent or 
customer.

11.7.1   Recording Permission for Rules
Permissions allow an Administrator to create, edit or view rules. To view the Recording Rules 
window, perform the following steps.

1. Go to the main menu.
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2. Click Administration > Recording > Recording Rules.

3. The Recording Rules window appears.

The fields that display in the Recording Rules window include:

• Name - an arbitrary name that you create to identify the rule.
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• Call Type - the type of call to record; ACD Calls, Direct Calls, Outbound Calls.

• Switch - the specific switch.

• Schedule - schedule period for rule.

The schedule date and time will be displayed based on the server (where QWS is running) 
time zone. The information icon on the rules page will specify the same. The recording will 
also take place based on the server time zone, irrespective of the machine time.

For example: Let’s say the server is in (UTC-06:00) Central Time (US & Canada) time 
zone, and the WEM is launched from a machine which has (UTC-05:30) Chennai, Kolkata, 
Mumbai, New Delhi time zone.

The user selects the Start Time as “4:45 PM” which is current time of machine, where you 
have opened your browser, but the server’s current time is “5:15 AM”. The calls will get 
recording only when the server reaches the start time specified in the rule, despite of the 
machine where you have opened your browser have already reached.

• Recording Percentage - the rate at which the system records interactions that satisfy the 
rule (for example, 50% means one out of every two interactions are recorded that meet the 
criteria of this rule, 25% means one out of every four interactions are recorded).

• Screen – a checkmark under the column indicates whether the system records window 
activity and voice on the call.

• Evaluation – indicates whether the system evaluates the specific rule before or after the 
call takes place.

• Status – use the option to turn rules on and off from the Rules List window. When a rule is 
Enabled, it triggers recordings appropriately. When a rule is Inactive or Deleted, it does not 
trigger recordings. You can reset Rules that are Disabled to Active status at any time.

11.7.2   Create a New Rule
To create a new rule, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Rules.

3. The Recording Rules window appears.
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4. Click on the  button. The Add Recording Rule window appears with General tab active.

Note:
• The fields marked (*) are mandatory fields.
• Click on the Info  icon for more details.

5. In the General Details section of the window, in the Name text box, type a rule name that 
uniquely identifies a rule. This field cannot be blank.

6. In the Description text box, type a description that uniquely identifies a rule in the Defined 
Rules List window.

7. Select the Switch from the drop-down list box.

8. In the Recording Details section of the window, in the Recording Percentage field, specify 
the percentage of the interactions that the system should meet the rule’s criteria. 
Note: Click on the Info  icon for more details.

9. From the Interaction Type drop-down list box, select the type of interaction to which the 
rule applies. This field cannot be blank.

Note: Click on the Info  icon for more details.

Monitor Interaction 
Type

Description

ACD Call Calls that the system routes to an agent by an automatic call distributor. A 
call that comes into an ACD is queued/announced to some application 
and taken or delivered to an agent.

Inbound Direct Call Inbound calls that the system places directly to a specific agent. Here, 
ACD does not queue or announce the call.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 623



Administrator Guide
10.In the Daily Records field, type the maximum number of interactions that meet the rule’s 
criteria that the system should record each day. This field cannot be blank.

Business rules are applicable for all Aspect Quality connectors. In the Aspect Quality 
system, you can define business rules for Quality Monitoring. During Quality Monitoring, 
the system records every interaction only if it satisfies a predefined business rule.

Note: Click on the Info  icon for more details.

11.Select the Disqualify Recording toggle button for a particular business rule defined within 
Aspect Quality. If you toggled on the button, the flag acts as if no rules apply, even if other 
rules qualify a particular interaction to record. For example, if the system records an 
interaction for a reason other than recording rules, such as agent request via the Desktop 
Client, selecting Disqualify Recording does not alter that, and the system records the 
interaction.

12.In the Screen Capture section of the window, select the Enable Screen Capture toggle 
button if you want to allow screen captures. Screen capture only occurs if a rule matches 
when the agent receives a call.

If you toggled on the Enable Screen Capture button, the After Call work field becomes 
active. The Quality uses this option when an agent is in Wrap up mode. If the timeout 
duration ends before the Wrap mode, the interaction monitor stops the screen capture 
activity. If the Wrap mode ends before the timeout duration, then the screen capture 
timeout is not applicable, and the interaction stops.
Note: Click on the Info  icon for more details.

13.In the Override Historical and Archiving section of the window, click on the Move to 
Historical toggle-button if you want to set up different historical results than what the 
system already creates.

Note: Click on the Info  icon for more details.

a. In the After text box, type the number of days after which you want the system to store 
the recordings. This field cannot be blank.

b. Under the Delete Instead of moving to Historical section, toggled-on the Audio toggle 
button if you want the system to delete recordings before moving the recordings to 
Historical.

c. Under the Delete Instead of moving to Historical section, toggled-on the Screen 
Capture toggle button if you want the system to delete recordings before moving the 
recordings to Historical.

Outbound Direct Call Calls placed by an agent to another agent or to a customer.

Outbound Queued 
Call

This is the outbound call that the dialer initiates if the system eventually 
connects the call to an agent. This is applicable only for dialer integration.

IVR Call Any interaction type recorded over the IVR port or IVR trunk channel.

Chat An interaction that the system routed to an agent through the chat 
window.

All Types Apply one rule to all interaction types.

Monitor Interaction 
Type

Description
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d. Under the Delete Instead of moving to Historical section, toggled-on the Chat toggle 
button if you want the system to delete chats before moving the chats to Historical.

In the Override Historical and Archiving section of the window, click on the Move to 
Archiving toggle-button if you want to set up different archiving results than what the 
system already creates.
Note: Click on the Info  icon for more details.

a. In the After text box, type the number of days after which you want the recordings to be 
archived.

b. Under the Delete Instead of moving to Archive section, toggled-on the Audio toggle 
button if you want the recordings to delete before moving the recordings to Archive.

c. Under the Delete Instead of moving to Archive section, toggled-on the Screen Capture 
toggle button if you want the recordings to delete before moving the recordings to 
Archive.

d. Under the Delete Instead of moving to Archive section, toggled-on the Chat toggle 
button if you want the chats to delete chats before moving the chats to Archive.

14.Select the Criteria tab and click on the Criteria drop-down list.

Note:
• If the switch is not selected in the General tab, the Criteria tab will be disabled.
• Criteria search will show the result specific for the selected switch.
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• When the user selects a switch and adds some criteria then, go back to the General 
tab and changes the Switch, the below warning message pops up. 

Note: Clicking on the Yes button will remove only the switch specific criteria. 

15.In the Criteria drop-down list, select one of the following criteria for the rule.

Criteria Evaluation 
Type

Definition

ANI Pre-Call Specifies a rule that applies to a specific Automatic Number Identification 
(ANI). 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Equals None
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Agent Pre-Call Specify an agent name whose interactions should be considered for this 
recording rule. 

On the Search field, type the name of the agent or click on the magnify 
glass to search and select Yes. Select the Agent and click on OK. It 
displays the result related to the selected switch in the General tab.

Agent Group Pre-Call Specify an agent name whose interactions should be considered for this 
recording rule. 

On the Search field, type the name of the agent group or click on the 
magnify glass to search. It displays the result related to the selected 
switch in the General tab.

Application Pre-Call Specify an agent name whose interactions should be considered for this 
recording rule.

On the Search field, type the name of the application or click on the 
magnify glass to search. It displays the result related to the selected 
switch in the General tab.
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Custom 
Information

Post-Call Specifies a (usually) post-call rule that applies to a custom information 
value associated with the call. 

From the Key drop-down list, select the Custom Information Name and the 
Show items with value that appears, select
• Contains
• Ends with
• Equals
• Starts with

Then, in the Entry text box, type the number by which you want to search. 
It displays the result related to the selected switch in the General tab.

DNIS Pre-Call Specifies a rule that applies to a specific Dialed Number Identification 
Service (DNIS).

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Duration Post-Call Specifies a post-call rule that applies to call duration. 

From the Show items with value that is drop-down list box, select
• Greater than
• Less than

Then, in the Entry text box, type the number by which you want to search. 
The Entry text format is HH:MM:SS.

Hold Count Post-Call Specifies a post-call rule that applies to the number of times the agent 
placed the call on hold. 

From the Show items with value that is drop-down list box, select
• Greater than
• Less than

Then, in the Entry text box, type the number by which you want to search.

Initial Agent 
Group

Pre-Call On the Search field, type the name of the agent group or click on the 
magnify glass to search. It displays the result related to the selected 
switch in the General tab.

Initial Skill 
Group

Pre-Call On the Search field, type the name of the skill group or click on the 
magnify glass to search. It displays the result related to the selected 
switch in the General tab.

Criteria Evaluation 
Type

Definition
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16.After selecting any of the above criteria, click on the  button to add the criteria under 
the Criteria List section. 

Note:
• After adding a criteria into the Criteria List section that criteria will be removed from 

the Criteria drop-down list. 
• If you want to remove the selected criteria from the Criteria List section, click on the 

Remove button. 

Max Hold 
Duration

Post-Call Specifies a post-call rule that applies to the longest single time the agent 
placed the call on hold. 

From the Show items with value that is drop-down list box, select
• Greater than
• Less than

Then, in the Entry text box, type the number by which you want to search. 
The Entry text format is HH:MM:SS.

Position Pre-Call Specifies a rule that applies to a specific position or a position that Equals, 
Begins With, Ends With, or Contains a particular string. 

From the Show items with value that is drop-down list box, select
• Contains
• Ends with
• Equals
• Starts with

Then, in the Entry text box, type the number by which you want to search.

Recording 
Group

Post-Call On the Search field, type the name of the recording group or click on the 
magnify glass to search.

Recording 
Port

Post-Call Specifies a rule that applies to a Specific recording port or group of ports. 

On the Equals drop-down, select the Port.

Skill Group Pre-Call A group of Agents called Skill Group. On the Search field, type the name 
of the skill group or click on the magnify glass to search.

Team Pre-Call On the Search field, type the name of the team or click on the magnify 
glass to search.

Total Hold 
Duration

Post-Call Specifies a post-call rule that applies to the total time the agent placed the 
call on hold. 

From the Show items with value that is drop-down list box, select
• Greater than
• Less than

Then, in the Entry text box, type the number by which you want to search. 
The time must be hh:mm:ss format.

Criteria Evaluation 
Type

Definition
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17.Select the Schedule tab.

The day and time parameters define the period recording takes place with the other criteria 
that you select.

18.In the Date Options section drop-down list, the Immediately option is selected by default.

OR

Select the Begin On option, and select the specific date on which you want the schedule to 
begin.

19.Toggle on the End Date field if you want to end the schedule. To select the specific date on 
which you want the schedule to end, click the calendar icon and select the date.

20.In the Days of Week drop-down list, select the check boxes of the day(s) of the week on 
which you want to apply this rule.

21.In the Start Time of Day field and End Time of Day field, select the time as per your 
requirement. 
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22.Click the Permissions tab.

23.To provide permission to view or edit a rule, select one or multiple user profiles under the 
Available Items section and click on the  button. 
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24.To add more users who can view and modify the rule, click Edit under the Permission drop-
down field as shown below.

25.If you give a user permission to view a rule, then the rule is available as a search parameter 
on the Mentor’s Search window.

Permission to edit rule allows a user to enable, disable, and change the rule.

26.Click OK to save the rule.

11.7.3   Edit a Rule
To edit a rule, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Recording Rules.

3. The Recording Rules window appears.
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4. Select the rule and click on  button. 
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5. The Edit Recording Rule window appears. 

6. Edit the General, Criteria, Schedule and Permissions tab as per your requirement. 
Note: Refer to the Create a New Rule on page 11-622 section (for General - step 4 to 12, 

Criteria - step 13 to 15, Schedule - step 16 to 20 and Permissions - step 21 to 25). 

11.7.4   Activate a Recording Rule
This feature allows to activate a Recording Rule based on the selected parameters (Refer 
Create a New Rule). To activate a Recording Rule follow the steps below.
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1. Select the Recording Rule for which the Status column is blank, as shown below.

2. Click on the Activate  button and the checkmark will be shown on the Status column 
for the selected Recording Rule as shown below.
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11.7.5   Deactivate a Recording Rule
This feature allows to deactivate a Recording Rule. To deactivate the Recording Rule follow 
the steps below.

1. Select the Recording Rule for which the Status column is checked as shown below.
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2. Click on the Deactivate  button and the Status column will be blank for the selected 
Recording Rule as shown below.

11.7.6   View a Recording Rule
This feature allows to view a recording rule. To view a recording rule, follow the steps below.

1. Select the recording rule which you want to view. 
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2. Click on the View button and the below window appears. 

3. Go through the General, Criteria, Schedule and Permissions tab.
Note: When an user has only view permission on the recording but not the Edit then this 

will help the user to view the recording rule in read only mode

11.8  Skill Groups
This section describes about the Navigation, Add, Edit, View, Activate and Deactivate Skill 
Groups.

11.8.1   Navigation to Skill Groups
Follow the steps given below to navigate to the Skill Groups page:

1. Go to the main menu.
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2. Click Administration > Recording > Skill Groups.

3. The Skill Groups page appears as given below:
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4. The Menu buttons on the Skill Groups page are described 
below:

5. The grid columns on the Skill Groups page are described below:

11.8.2   Create Skill Groups
To create a new Skill Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Skill Groups.

3. The Skill Groups page appears.

Icons Description

Refresh Refreshes the skill groups grid with latest skill group changes. 
Instead of the browser refresh button user can click on this 
menu button which will refresh only the grid data and not the 
page.

Add Adds the new skill group to the grid.

Edit Edits the selected skill group existing in the grid.

View Provides the information to view about the selected skill groups 
from the grid.

Activate Activates the existing skill group.

Deactivate Deactivates the existing skill group.

Note: If the existing Skill Group is synced, the Deactivate 
button will be disabled, which means the synced skill 
group will be active by default.

Column Description

Name The name of the Skill Groups.

Switch The name of the switch to which the skill group agent is 
connected.

Active The skill group status is displayed by the icon, whether active 
or not.

Synced The icon to identify whether the Skill Group agent is synced, as 
created from WEM.
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4. Click on the  button. The Add Skill Groups window appears with General tab active.

Note: The fields marked (*) are mandatory fields.

5. In the General tab of the window, in the Name text box, type a group name that uniquely 
identifies a skill group. This field cannot be blank.

6. Select the Switch from the drop-down list box.
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7. Once the Switch is selected the Skill Group Members option is enabled. Click the Select 
tab, the Add Agent Group window appears as below:

• Click the Add button on the Agent Group window to add the active agent groups 
who are associated with the switch that is selected. Click the Shift key to select the 
multiple agent groups from the list.

• Click the Add All button to select all the existing agent groups associated with the 
selected switch.

• Click the Clear button to clear the selected Agent Groups from the Agent Groups 
grid window.

• Click the Delete button to clear all the existing Agent Groups at once from the 
Agent Groups grid window.

• Select OK to confirm the selected Agent Groups.
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8. Now, select the Profile Permissions tab, as shown below:

Note: Here all the user profiles which are active will be displayed, except the Administrator 
profile.

• When you want to provide permissions to the Skill Groups that you are creating, then 
the user profiles can be added from the profile Permissions tab.

• To select one or multiple user profiles under the Available Items section, click on the 
 button.
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• Once the user profiles are selected, they are added to the Selected Items grid, as 
shown below:

• The user profiles permission can be edited by two ways. 
By either selecting the adjacent Permission drop-down button for changing individually 
the user profiles, or by selecting the Change selected user profiles 

permission button for changing all the user profiles Permission in the Selected 

Items grid at once.
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• The Change Permission window appears. Select the desired permission for the user 
profiles and click OK, as shown below:

9. Click the OK button to create the Skill Group.

Note: By default, the new Skill Group which is created will be listed in the grid and will be 
Active. As it’s created from the WEM and not from the Switch, the Synced column will 
be blank by default.

11.8.3   Edit Skill Groups
To edit a Skill Group, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Skill Groups.

3. The Skill Groups page appears.

4. Select the available Skill Group from the grid that needs to be edited and click the Edit icon 
.
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5. The Edit Skill Group window appears with General tab active as shown below:

6. Edit the General and Profile Permissions tab as per your requirement.
Note: Refer to Create Skill Groups on page 11-639 section, step 5 to 8.

7. Click the OK button to complete the process.

11.8.4   View a Skill Group
This feature allows to view a Skill Group. To view a Skill Group, follow the steps below.
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1. Select the existing skill group from the grid, which you want to view.

2. Click on the View button and the below window appears. 

The user can view the Skill Group details.

3. Click OK to close the View window.
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11.8.5   Activate a Skill Group
This feature allows to activate a Skill Group based on the selected parameters. To activate a 
Skill Group follow the steps given below.

1. Select the Skill Group for which the Active column is blank, as shown below:
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2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected Skill Group as shown below:

11.8.6   Deactivate a Skill Group
This feature allows to deactivate a Skill Group. To deactivate a Skill Group follow the steps 
given below.
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1. Select the Skill Group for which the Active column is checked as shown below:

2. Click on the Deactivate  button and the Active column will be blank for the selected 
Skill Group as shown below:

Note: Multiple Skill Groups can be Activated / Deactivated together. Synced Skill Groups can 
neither be Activated, nor Deactivated. The Skill Groups that are created from WEM only 
can be Activated / Deactivated.
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11.9  Switches
Each Aspect Quality system integrates with one or more switches, which is used for the 
environmental definitions (for example: agents, agent groups and teams) within that 
integration.

For each of these switches the configuration procedures need to be performed.

This section discusses about the Switches.

11.9.1   Navigation to Switches
Follow the steps given below to navigate to the Switches page:

1. Go to the main menu.

2. Click Administration > Recording > Switches.
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3. The Switches page appears as given below:

4. The Menu buttons on the Switches page are described below:

5. The grid columns on the Switches page are described below:

Icons Description

Refresh Refreshes the switches grid with latest skill group changes. 
Instead of the browser refresh button user can click on this 
menu button which will refresh only the grid data and not the 
page.

Add Adds the new switches to the grid.

Edit Edits the selected switches existing in the grid.

LDAP/AD Sync Allows to sync the LDAP/AD details.

Activate Activates the existing switches.

Deactivate Deactivates the existing switches.

Column Description

Name The name of the Switches.

Type The type of the switch, which is configured. The Type column 
can be filtered by the user based on the Type of switch.

Monitoring Mode The option selected for Monitoring Mode is displayed.
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6. The hidden columns are also available in the Switches, which can be explored with the help 
of column settings menu of grid column. These are given below:

11.9.2   Create Switches
To create a new Switch, perform the following steps.

Primary Replica The replica associated with the switch is displayed.

Sync With Quality The switch is configured to Sync with Quality is displayed in 
this column with a tick mark icon.

Screen The switch is configured to enable the screen capture is 
displayed in this column with a tick mark icon

Active The switch status is displayed by the icon, whether active or 
inactive.

Column Description

Default Storage Group The storage group which is associated with the switch is 
displayed.

LDAP/AD Enabled The LDAP server is configured for the switch is displayed in 
this column with a tick mark icon.

Encryption The switch is configured with Encryption is displayed in this 
column with a tick mark icon.

Column Description
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1. Go to the  main menu icon.

2. Click Administration > Recording > Switches.

3. The Switches page appears.

4. Click on the Add  button. The Add Switch window appears with General tab active.

Note:

a. (*) - These are the Mandatory Fields.

b. By default the Database tab is disabled. It will be enabled, when the Type of switch is 
selected from the General tab.

c. When the Type of switch is selected as Custom, the Database tab will be disabled.

5. In the General Tab: In the General tab of the window, in the Name text box, type a 
descriptive name that uniquely identifies a switch. This field cannot be blank.

6. By default Sync with Aspect EX Quality and Send quality scores of agents to WEM 
toggle keys are available. The toggle keys selection options varies as per the Type of 
switch selected, any or all of the below keys are available:

a. Select the Sync with Aspect EX Quality toggle key, if you want Aspect Quality to read 
the entity data from the switch and store it in the Aspect Quality database.

b. Select the Send quality scores of agents to WFM toggle key, if you want to upload 
scorecards to Aspect Workforce Management for viewing.

c. Select the Communication Over SSL toggle key, if the Secure Data Transmission is 
enabled at Unified IP for the Primary or Secondary CTI Portal server, or with the Primary 
or Secondary Admin Web Service.
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d. Select the Record within same location only toggle key, when you define a switch for 
the location. Flag this option when you want Aspect Quality to search for recording ports 
only at the location associated with the switch (and not at other locations).This option is 
available only when the switch type is Aspect Unified IP. When no location is defined 
and the option is flagged, the DCP’s are implicitly treated as separate locations.

7. By default LDAP Servers and Primary Database Replica fields are available in the LDAP 
Servers section of the window. The fields varies as per the Type of switch selected, any or 
all of the below fields are available:

a. From the LDAP Servers drop-down list box, select the LDAP or Active Directory server 
ID or IP address.

b. From the Primary Database Replica drop-down list box, select the available database 
replica.

c. In the Dial String field, type the DN that the audio port dials when attempting to perform 
agent monitoring. The information is needed only when Silent Monitoring audio ports is 
used.

d. In the Unique Aspect Quality ID field, type the unique number to identify this switch 
definition to the Unified IP system. This number must be a two-digit, positive integer in 
the range of 10 through 99.

8. Select the Type of switch from the drop-down list box.There are several switches in the 
drop-down list, as shown below: 
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When you select a Type, based on it the Version field appears. And upon selecting the Version 
from the drop-down menu the Communication section and the LDAP Servers section field 
varies.

The Type of switches along with the Version, and the Communication section fields are given 
in the below table.

Type Version Description (Communication Section)

Avaya CMI Primary Address:* Type the name or IP Address of the 
Avaya Contact server.

Primary Port:* Type the port number that you use to 
connect to the Avaya Contact server. The default is 9011.

Backup Address: Type the name or IP Address of the 
failover Avaya Contact server, if used.

Backup Port: Type the port number of the failover Avaya 
Contact server, if used. The default is 9011.

Avaya TSAPI TLINK:* Type the TLINK service name.

Note: This name can be obtained from the AES 
Management Console by clicking Status > Status 
and Control > TSAPI Service Summary.

User Name:* Type the Avaya Application Enablement 
Service (AES) user name.

Note: The user must be a CTI user with the CTI User field 
set to Yes in the AES Edit User window.

Password:* Type the Avaya Application Enablement 
Service (AES) password.

Note: The list of AES users can be obtained from the AES 
Management Console by clicking User 
Management > User Admin > List All Users.
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Cisco UCCE

(Cisco Unified 
Contact 
Center 
Enterprise)

CTI Server Primary Address:* Type the name or IP Address of the 
SideA CTI server.

Primary Port:* Type the port number that you use to 
connect to the SideA CTI server.

Backup Address: Type the name or IP Address of the 
failover SideB CTI server, if used.

Backup Port: Type the port number of the failover SideB 
CTI server, if used.

User Name:* Type the Cisco UCCE Agent login ID.

Password:* Type the Cisco UCCE Agent login password.

CTIOS Primary Address:* Type the name or IP Address of the 
Primary CTIOS server.

Primary Port:* Type the port number that you use to 
connect to the Primary CTIOS server.

Backup Address: Type the name or IP Address of the 
Backup CTIOS server, if used.

Backup Port: Type the port number of the Backup CTIOS 
server, if used.

Cisco UCCX

(Cisco Unified 
Contact 
Center 
Express)

NA Primary Address:* Type the name or IP Address of the 
SideA CTI server.

Primary Port:* Type the port number that you use to 
connect to the SideA CTI server.

Backup Address: Type the name or IP Address of the 
failover SideB CTI server, if used.

Backup Port: Type the port number of the failover SideB 
CTI server, if used.

Cisco UCM

(Cisco Unified 
Communicatio
ns Manager)

NA Initial Service Provider:* Type the name of the Cisco TSP 
driver that you got, when configured the Cisco TSP (Phone 
and Modem settings).

Note: If there is only one instance of the Cisco TSP driver 
installed, the Initial Service Provider and Final 
Service Provider contain the same name.

Final Service Provider:* Type the name of the service 
provider.

Note: If there is more than one instance of the Cisco TSP 
driver installed, the Final Service Provider is the 
name of the last service provider. If there is only one 
instance of the Cisco TSP driver installed, set the 
Final Service Provider to the same value as the 
Initial Service Provider.

Custom NA NA

Type Version Description (Communication Section)
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(*) - These are the Mandatory Fields.

Unified IP ECL (External Call 
Logger)

Primary Address:* Type the name or IP Address of the 
Primary CenterCord server.

Primary Port:* Type the port number that you use to 
connect to the Primary Call Logger.

Backup Address: Type the name or IP Address of the 
failover backup CenterCord, if used.

Backup Port: Type the port number of the failover backup 
CenterCord, if used.

Tenant Name:* Type the short name of the tenant.

CTIPS (CTI Portal 
Server) / Enhanced 
CTIPS

Primary Address:* Type the name or IP Address of the 
primary CTI portal server machine name.

Primary Port:* In the Primary CTI Portal Server Port text 
box, type 8170, which is the port number for the primary 
CTI portal server with the Secure Data Transmission (SDT) 
disabled in Unified IP. 
ORType 8171, which is the port number for the primary CTI 
portal server with the Secure Data Transmission (SDT) 
enabled in Unified IP.

Note: Refer to the Unified IP Server Configurator 
application to identify the exact port number 
required.

Backup Address: In the Secondary CTI Portal Server 
Address text box, type the machine name of the backup CTI 
portal server.

Note: You must use the Secondary CTI Portal Server 
machine name, not the IP address, for the IMON 
Unified IP connector to work with CTIPS over the 
SSL.

For integrations with Unified IP 7.3 SP1 or later, use a Fully 
Qualified Domain Name (FQDN). For example:  
lom-rec73.cor.ord.labs.aspect.com 
Where lom-rec73-cor is the machine name, and 
ord.labs.aspect.com is the FQDN.

Backup Port: Type the port number of the failover CTI portal 
server.

Tenant Name:* Type the short name of the tenant.

CallBack Server Port:* Type the port number that the CTI 
Portal Server should use for publishing the events. The 
value is unique across all Aspect Unified IP switch defined 
on a particular site.

User Name:* Type the CTI portal server user name.The 
user is defined in the Active Directory and in the Server 
Configurator application of Unified IP.

Password:* Type the password for the corresponding user.

Type Version Description (Communication Section)
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9. In the Database Tab: Based on the selection of the Type of switch, the Database tab will be 
enabled. The Database tab will be enabled with the field variables that vary with the Type 
and Version of the switch.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 658



Administrator Guide
Below table specifies the various section and fields in the Database tab that are available 
based on the Type and Version of switches selected in the General tab: 

Section Field Description

LDAP 
Configuration

Server Address:* Type the name or IP address of the server running 
Microsoft ADAM.

Port:* • Type 389. This port number is the port to connect to 
Microsoft ADAM.

• Type 443. This port number is for the System Manager 
User Management Web Services with the SSL flagged.

• Type 80 for unsecure and 8443 for secure connection. 
This port number is for the TCP port used when 
connecting to the Cisco Call Manager.

• Type 1433. This port number is to connect to the Cisco 
UCCE CTI Server.

• Obtain the port number from the Unified IP Server 
Configurator entry for the PrimaryDataServer.

User Name:* Type the fully qualified name to connect to Microsoft ADAM 
/ Avaya System Manager / Avaya AES / Cisco Call 
Manager / ODBC data source. 

For example:
• Microsoft ADAM: 

CN=aqm,O=dem,DC=lombard,DC=com
• Avaya AES: CMUser@CMServerIPAddress
• Cisco Call Manager: This is the Cisco Call Manager 

user that was created for data-sync.
• ODBC data source: The default is dta.

Password:* Type the password associated with the User Name.
• The default password for the ODBC data source is tjm.

SSL By default Secure Socket Layer (SSL) toggle key is 
unflagged. Select SSL to securely connect to Microsoft 
ADAM / Avaya System Manager / Avaya AES / Cisco Call 
Manager.

Note: The SSL connection is mandatory to connect to the 
Cisco Unified Communications Manager and LDAP/
AD,.

Base DN:* The LDAP Base Distinguished Name (DN) for the switch to 
which you are integrating.

Sync Database 
using

To Sync Database, select the options available of either 
System Manager or DEM from the drop-down menu.

System 
Manager User 
Management 
Web Service

SM Server 
Address:*

Type the name or IP address of the server running the 
Avaya System Manager.

System 
Management 
Service

AES Server 
Address:*

Type the name or IP address of the server running the 
Avaya Application Enablement Service (AES).
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(*) - These are the Mandatory Fields.

Primary/ 
Backup 
Database

Data Source Name:* Type the name of the ODBC DSN you created to connect to 
the Switch database. If you used the default name when 
you set up the ODBC configuration, then enter ACC_DSN.

Database Name:* Either Primary or Backup.

Primary database name is the name of the database to be 
connected.

Backup database name is the name of the backup 
database to be connected

Call Manager 
Database

Call Manager IP/
Host:*

Type the IP address of the Cisco Call Manager.
Warning: Do not type the name; type only the IP 

address.

Notification 
Service

Endpoint Port:* Type the port number.

Note: The Endpoint port is the port that the Unified IP 
Notification Services uses to alert Aspect Quality 
about changes made to entities against which 
Aspect Quality syncs; for example, if a user logs 
into UCC Administrator and adds or updates a 
service, Aspect Quality receives notification of that 
change through this port.

Note: Aspect requires that the port for Aspect Quality is in 
the range of 5180 and 5189.

Section Field Description
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10.In the Monitoring Tab: Based on the configuration in the General tab and the Database 
tab, the options are enabled in the Monitoring tab.
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11.Below table specifies the various section and fields in the Database tab that are available 
based on the Type and Version of switches selected in the General tab: 

Section Field Description

Configuration Monitor Mode:* From the Monitoring Mode drop-down list box, select one of 
the following options:
• Logging
• Quality Monitoring
• Quality Monitoring with Caching

Invalid Call 
Duration:*

• Type the minimum time (in milliseconds) of a recorded 
file. If a recording is shorter than the set time, the file is 
deleted.

• By default it is set to 5000 Milliseconds.

Screen Capture

(Toggle key)

In the Screen Capture section, select the flagged option to 
allow screen captures when recording calls.

OR

Select the unflagged option to disallow screen captures 
when recording calls.

Note: Regardless of the recording option that you select, 
you must define a rule before any screen captures 
can occur.

Record Inbound 
Direct Calls 

(Toggle key)

If you want to record inbound direct calls to an agent, select 
the Record Inbound Direct Calls toggle key.

Note: If the Monitoring Mode is Quality Monitoring, you 
must create a rule and enable it before Aspect 
Quality records any inbound direct calls.

Record Outbound 
Direct Calls

(Toggle key)

If you want to record outbound direct calls to an agent, 
select the Record Outbound Direct Calls toggle key.

Note: If the Monitoring Mode is Quality Monitoring, you 
must create a rule and enable it before Aspect 
Quality records any outbound direct calls.

Record calls if no 
agent present

(Toggle key)

Select the Record calls if no agent present toggle key, if you 
want any call (or segment of a call) recorded when there is 
no agent involved in the call. When deselected, any call (or 
segment of a call) on which there is no agent involved, is 
not recorded.

Note: This setting does not refer to IVR calls.

Stereo Recording

(Toggle key)

Select the Stereo Recording to record a call as stereo 
instead of mono.

Note: Stereo recordings roughly is double the size of 
mono recordings of the same duration. So the 
storage space needs to be planned accordingly.
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Media Storage 
and Security

Default Storage 
Group:*

From the Default Storage Group drop-down list, select the 
storage group default that the system should use to store all 
files associated with interactions recorded for this switch.

Note: When the system uses distributed recording 
storages, the system can override the default 
storage group for the switch in all of the recording-
producing processes (for example, Port Manager, 
IVR Import, Agent Desktop Client, and Mentor 
Desktop Client).

Enable Media 
Security 
(Toggle key)

a.) Encryption Key

b.)Show Key History

c.)Auto-Generate 
new key every 
(Toggle key)

If you want to secure the media files, select the Enable 
Media Security toggle key.

Note: If you want to secure the media files, and you select 
the Enable Media Security toggle key, you must set 
the encryption key to encrypt the media files on 
network transmission.

• a.) When the Enable Media Security toggle key is 
flagged, the Generate tab is enabled. Click Generate 
tab to generate the Encryption Key. 

• b.) Show Key History button shows the history of last 
ten keys that were generated for encryption.

• c.) If you want the system to change the encryption key 
every N hours, select the Auto-Generate new key every 
toggle button.

In the every hours field, type the interval number of hours 
after which you want the system to change the encryption 
key. The Interaction Monitor process changes the key for 
every N hour automatically, and the system starts 
encrypting the media files using the newly-changed key. 
The Interaction Monitor process calculates the key change 
time based on the key creation time.

As an example, if you back up the database every 24 hours, 
and automatically set the encryption key to change every 
48 hours, then the potential key loss is the period between 
the last backup and the database failure.

Cisco BIB 
Configuration / 
Enhanced 
CTIPS 
Configuration

Enable Full-Time 
Recording

(Toggle key)

Select the Enable Full-Time Recording toggle key, if you 
want to continue to record calls when the Recording server 
is not able to communicate with the Interaction Monitor.

Section Field Description
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(*) - These are the Mandatory Fields.

12.In the Monitoring Configuration section of the window, from the Monitoring Mode drop-
down list box, select one of the following options:

Record Tariff 
Tone 
Configuration

Record Tariff Tone 
Type:*

From the Record Tariff Tone Type drop-down list box, select 
one of the following options:
• Initiated Tone
• Periodic Tone
• No Tone

If you select Initiated Tone or Periodic Tone, the agent and 
caller will hear the tones in the Unified IP call, as well as in 
the recordings.

The info button pop-up disclaimer is available adjacent 
to the Record Tariff Tone Type, stating “Please make sure 
the selected recording tone settings are in compliance with 
local laws.”

Record Tariff Tone 
Interval

If you selected the Record Tariff Tone Type as Periodic 
Tone, then in the Record Tariff Tone Interval text box will be 
enabled. Type the number (in seconds) in the text box after 
which you want the tone to repeat.

Note: If you select either Initiated Tone or No Tone from 
the Record Tariff Tone Type, the Record Tariff Tone 
Interval will be disabled.

Record Tariff Tone 
Duplex Type:*

If you selected the Record Tariff Tone Type Initiated Tone, 
then from the Record Tariff Tone Duplex Type drop-down 
list box, select one of the following options.
• Agent Half Duplex
• Contact Half Duplex
• Full Duplex

OR

If you selected the Record Tariff Tone Type Periodic Tone, 
then from the Record Tariff Tone Duplex drop-down list box, 
select the following option
• Full Duplex

Note: If you select No Tone from the Record Tariff Tone 
Type, the Record Tariff Tone Duplex Type drop-
down list box will be inactive.

Option Description

Logging All calls are recorded (displayed as Active).

Quality Monitoring Calls are recorded based on Aspect Quality rules that are 
defined.

Quality Monitoring with Caching All calls are recorded (displayed as Pending). Primarily used 
when on-demand recording is required.

Section Field Description
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13.In the Record Tariff Tone Configuration section of the window, from the Record Tariff Tone 
Type drop-down list box, select one of the following options.

Note: If necessary, you can set tone characteristics in the Unified Resource Manager in 
Unified IP. For more information, see the Unified IP Resource Manager System 
Administrator Guide.

14.If you selected the Record Tariff Tone Type Initiated Tone, then from the Record Tariff 
Tone Duplex Type drop-down list box, select one of the following options:

15.If you selected the Record Tariff Tone Type Periodic Tone, then from the Record Tariff 
Tone Duplex drop-down list box, select the following option:

16.Click Ok. The Switches window appears and the created switch displays in the Active list.

11.9.3   Edit Switches
To edit a Switch, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Switches.

3. The Switches page appears.

4. Select the available Switch from the grid that needs to be edited and click the Edit icon .

Option Description

No Tone No tone or beep is heard.

Initiated Tone A tone or beep sounds when the recording starts.

Periodic Tone A tone is heard repeatedly at the interval specified in seconds.

Option Description

Agent Half Duplex Only the agent hears the beep or tone.

Contact Half Duplex Only the contact hears the beep or tone.

Full Duplex Both the agent and the contact hear the beep or tone.

Option Description

Full Duplex The agent and the contact hear the beep or tone at regular intervals.
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5. The Edit Switch window appears with General tab active as shown below:

Note: For the UIP switches, the Version drop-down list will be disabled for “ECL” and 
“Enhanced CTIPS”. Only for the “CTIPS” the Version drop-down list is enabled and it 
can be updated to only “Enhanced CTIPS”. This means the Version of the UIP switches 
once created, can only be edited from “CTIPS” to “Enhanced CTIPS”.

6. Edit the General, Database and Monitoring tab as per your requirement.
Note: Refer to Create Switches on page 11-652, step 4 to 16.

7. Click the OK button to complete the process.

11.9.4   LDAP\AD Sync
To Sync a Switch with LDAP, perform the following steps:

1. Go to the  main menu icon.

2. Click Administration > Recording > Switches.

3. The Switches page appears.
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4. Select the Switch from the Name column that needs to be synced and click on LDAP/AD 
Sync  button. 

Note: If LDAP/AD is configured for the switch, the LDAP/ AD Sync button will be enabled. 
If LDAP/AD is not configured for the switch, then the LDAP/AD Sync button will be 
disabled.

5. The LDAP/AD Sync Success message window appears, as shown below:

Note: Once the LDAP/ AD sync is successful, the users part of that switch will be updated 
with the domain and logon details.

6. Click the OK button to save the changes.
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11.9.5   Activate a Switch
This feature allows to activate a Switch based on the selected parameters. To activate a 
Switch follow the steps given below.

1. Select the Switch for which the Active column is Unchecked, as shown below:
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2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected Switch as shown below:

11.9.6   Deactivate a Switch
This feature allows to deactivate a Switch. To deactivate a Switch follow the steps given below.
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1. Select the Switch for which the Active column is checked as shown below:

2. Click on the Deactivate  button and the Active column will be blank for the selected 
Switch as shown below:
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11.10  Trunk Channels
When using IVR Recording, you may need to modify existing trunk entities within the Aspect 
Quality system.

The following procedure describes where existing trunk channel information resides, and how 
the information displays. You can follow this procedure to examine existing trunk channel 
definitions and to create new trunk channel definitions.

This section describes about Navigation, Add, Edit, Activate and Deactivate a Trunk Channel.

11.10.1  Navigation to Trunk Channels
Follow the steps given below to navigate to the Trunk Channels page:

1. Go to the main menu.

2. Click Administration > Recording > Trunk Channels.
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3. The Trunk Channels page appears as given below:

4. The Menu buttons on the Trunk Channels page are described 
below:

5. The grid columns on the Trunk Channels page are described below:

Icons Description

Refresh Refreshes the Trunk Channels grid with latest trunk channels 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new trunk channel to the grid.

Edit Edits the selected trunk channel existing in the grid.

Activate Activates the existing trunk channel.

Deactivate Deactivates the existing trunk channel.

Column Description

Card Number The name of the trunk channel. Can be alpha-numeric.

Note: By default, the trunk channels are sorted based on 
Card Number in ascending order.

Channel Number The channel number of the trunk channel. Should range 
between 0 to 999999999.

Host ID The ID associated with the trunk channel. Should range 
between 1 to 999999999.
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11.10.2  Create Trunk Channels
To create a new Trunk Channel, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Trunk Channels.

3. The Trunk Channels page appears.

4. Click on the Add button. The Add Trunk Channel definition window appears.

Note: The fields marked (*) are mandatory fields.

5. The Create Multiple Trunk Channels toggle key is unflagged by default. Flag the toggle 
key to create multiple Trunk Channels.

6. Once the Create Multiple Trunk Channels toggle key is flagged, the Number of Trunk 
Channels text box is enabled. Either set the value for number of trunk channels to be 
created with the help of arrow keys adjacent to the text box, or manually enter the value.

Switch Name The name of the Switch to which the trunk channel is 
associated.

Source The UI from where the respective Trunk Channel is created. 
For example, Aspect EX Quality, Aspect Unified IP, etc.

IVR The IVR Channel is displayed by the icon, whether enabled or 
not.

Active The trunk channel status is displayed by the icon, whether 
active or not.

Column Description
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7. From the Switch drop-down text box, select the type of switch required for association to 
the trunk channel.

8. Enter the value in the Card Number text box. This is the name of the trunk channel and 
can be, alphabets, numbers, or alpha-numeric.

9. Enter the value in the Host ID text box. 

The information button pop-up is available adjacent to the Host ID, stating, “Host ID 
should be in the range between 1 to 999999999.”
An error message displays, if the port number exceeds 999999999.
Manually enter the value in the Host ID text box.
Host ID field cannot be blank.

10.Enter the value in the Channel Number text box.

The information button pop-up is available adjacent to the Channel Number, stating, 
“Channel Number should be in the range between 0 to 999999999.”
An error message displays, if the port number exceeds 999999999.
Either select the value by clicking the up-down arrow keys or manually enter it in the 
Channel Number text box.
Channel Number field cannot be blank.

11.The IVR Channel toggle key is unflagged by default. Flag the toggle key to enable IVR 
Channel. The IVR column will be marked with a check mark icon, to show IVR Channel 
enabled for the trunk channel.

12.Click OK to create the Trunk Channel.

By default, the new Trunk Channel which is created will be listed in the grid and will be 
Active.

11.10.3  Edit Trunk Channel
To edit a Trunk Channel, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > Trunk Channels.

3. The Trunk Channels page appears.

4. Select the available Trunk Channel from the grid that needs to be edited and click the Edit 
icon.
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5. The Edit Trunk Channel window appears, as shown below:

Note: For Synced Trunk Channels, only IVR Channel toggle key will be enabled to edit.

6. Edit the field values as per your requirement.

Note: Refer to Create Trunk Channels on page 11-673 section, step 4 to 12.

7. Click the OK button to complete the process.
Note: Unflag the IVR Channel toggle key for an existing enabled IVR trunk channel turns 

the IVR trunk channel to a regular trunk channel.

11.10.4  Activate a Trunk Channel
This feature allows to activate a Trunk Channel based on the selected parameters. To activate 
a Trunk Channel follow the steps given below.
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1. Select the Trunk Channel for which the Active column is blank, as shown below:

2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected Trunk Channel as shown below:

11.10.5  Deactivate a Trunk Channel
This feature allows to deactivate a Trunk Channel. To deactivate a Trunk Channel follow the 
steps given below.
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1. Select the Trunk Channel for which the Active column is checked as shown below:

2. Click on the Deactivate  button and the Active column will be blank for the selected 
Trunk Channel as shown below:

Note: When in the Trunk Channels grid, there is more than one Trunk Channel with the same 
Card Number(name), either of the Trunk Channels can be set to Active. But both the 
Trunk Channels with the same Card Number(name) can be inactive. If you try to 
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Activate both the similar named Trunk Channel, an Error message appears to 
deactivate the existing Trunk Channel or change the name of the Trunk Channel.

Note: Multiple Trunk Channels can be Activated / Deactivated together.

11.11  VOIP Tap Points
In Recording Boards, you configured one or more recording boards. Now, create the VOIP tap 
points that utilize these recording boards.

This section applies to Avaya, Aspect Unified IP, and Cisco integrations.

This section describes about Navigation, Add, Edit, Activate and Deactivate a VOIP Tap Point.

11.11.1  Navigation to VOIP Tap Points
Follow the steps given below to navigate to the VOIP Tap Points page:

1. Go to the main menu.
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2. Click Administration > Recording > VOIP Tap Points.

3. The VOIP Tap Points page appears as given below:
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 679



Administrator Guide
4. The Menu buttons on the VOIP Tap Point page are described 
below:

5. The grid columns on the VOIP Tap Points page are described below:

11.11.2  Create VOIP Tap Points
To create a new VOIP Tap Point, perform the following steps.

Note: Use this section only if you are using an AudioCodes HPXMedia board.

1. Go to the main menu.

2. Click Administration > Recording > VOIP Tap Points.

3. The VOIP Tap Points page appears.

Icons Description

Refresh Refreshes the VOIP tap points grid with latest VOIP tap point 
changes. Instead of the browser refresh button user can click 
on this menu button which will refresh only the grid data and not 
the page.

Add Adds the new VOIP tap point to the grid.

Edit Edits the selected VOIP tap point existing in the grid.

Activate Activates the existing VOIP tap point.

Deactivate Deactivates the existing VOIP tap point.

Column Description

Name The name of the VOIP Tap Point.

Server The name of the server to which VOIP tap point is associated.

Recording Board Displays the name of the recording board associated with the 
VOIP tap point.

Active The VOIP tap point status is displayed by the check mark icon, 
whether active or not.
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4. Click on the Add  button. The Add VOIP Tap Point definition window appears, with the 
General tab active, by default.

Note: The fields marked (*) are mandatory fields..

5. On the General tab:

a. In the Name text box, type a VOIP Tap Point name that identifies a VOIP tap point. This 
field cannot be blank.

b. In the Description text box, type a short description for the VOIP Tap Point.

c. Select the Server from the drop-down list box that hosts the VOIP Tap Point.

d. In the Tap Board drop-down list box, select the type of board that the Tap Point uses.

e. In the Maximum Forwarding Sessions text box, type the number of media sessions 
that are available for use on the selected HPX Board.

6. On the Tapped Protocols tab:

Flag any or more of the below VOIP protocols toggle key to enable them and use them to 
monitor on the tapped local area network, based on the ACD/PBX with which Aspect 
Quality is integrated:

a. Cisco Skinny Call Control Protocol: Cisco (HPX)

b. Session Initiation Protocol: Aspect Unified IP (HPX), and Cisco (HPX)
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c. Avaya H.323: Avaya (HPX only)
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The above protocols options are explained below in the table:

Note: The fields marked (*) are mandatory fields.

7. On the Forwarding tab:

Select the Edit button to change the associated audio ports.

Protocols Description

Cisco Skinny Call 
Control Protocol

Port*: In the Port text box, type the port number over which 
Cisco Skinny Call Control Protocol communication will occur. 
By default, this is port 2000.

Port Protocol: From the Port Protocol drop-down list box, 
select the transport protocol that delivers Cisco Skinny Call 
Control Protocol messaging. The typical transport protocol is 
TCP.

Switch*: From the Switch drop-down list box, select the 
Aspect Quality switch with which to associate monitored Cisco 
Skinny Call Control Protocol VoIP traffic.

Session Initiation 
Protocol

Port*: In the Port text box, type the port number over which 
session initiation protocol communication occurs.

Port Protocol: From the Port Protocol drop-down list box, 
select the transport protocol that delivers session initiation 
protocol messaging. The typical selection is UDP.

Session Initiation Protocol*: In the Session Initiation Protocol 
text box, type the value over which session initiation protocol 
communication occurs.

Switch*: From the Switch drop-down list box, select the 
Aspect Quality switch with which to associate monitored 
session initiation protocol VoIP traffic.

Avaya H.323 C S Port*: In the CS Port text box, type the H.323 Call 
Signaling (CS) port number. By default, the CS port number is 
1720.

Port Protocol: From the Port Protocol drop-down list box, 
select the transport protocol that delivers H.323 Call Signaling 
(CS) messaging. The typical transport protocol is TCP.

RAS Port*: In the RAS Port text box, type H323 registration, 
Admission, and Status (RAS) port number. By default, the RAS 
port number is 1719.

RAS Port Protocol*: From the RAS Port Protocol drop-down 
list box, select the transport protocol that delivers H.323 
Registration, Admission, and Status (RAS) messaging. The 
typical RAS transport protocol is UDP.

Switch*: From the Switch drop-down list box, select the 
Aspect Quality switch with which to associate monitored Avaya 
H.323 VoIP traffic.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 683



Administrator Guide
The Edit Forwarding window appears.

Note: The fields marked (*) are mandatory fields.

Select a Switch from the drop-down list box. The VoIP audio ports associated with the 
selected switch will appear in the Available Items list.
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Select one or more of the VoIP audio ports that you want to associate with this VoIP tap 
point, with the help of Add button, and move the audio ports to the Selected Items list.
Note: You can select any VoIP audio port and assign it to this VoIP tap point. Aspect 

Software recommends that you select a group of ports that are sequentially 
numbered. Then, it is easier to track which group of audio ports that you assigned to 
which tap point.

If you want the VoIP audio port to be able to receive audio that needs to be recorded 
from multiple tapped locations on the local area network, you can also assign the 
same VoIP audio ports to multiple VoIP tap points.

Click OK to complete the process and close the Edit Forwarding window.

8. Click OK to create the VOIP Tap Point.

Note: By default, the new VOIP Tap Point which is created will be listed in the grid and will be 
Active.

11.11.3  Edit VOIP Tap Point
To edit a VOIP Tap Point, perform the following steps.

1. Go to the main menu.

2. Click Administration > Recording > VOIP Tap Points.

3. The VOIP Tap Point page appears.

4. Select the available VOIP Tap Point from the grid that needs to be edited and click the Edit 
icon.

5. The Edit VOIP Tap Point window appears, with General tab active, by default, as shown 
below:
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6. Edit the field values as per your requirement.
Note: Refer to Create VOIP Tap Points on page 11-680 section, step 4 to 8.

7. Click the OK button to complete the process.

11.11.4  Activate a VOIP Tap Point
This feature allows to activate a VOIP Tap Point based on the selected parameters. To activate 
a VOIP Tap Point follow the steps given below.

1. Select the VOIP Tap Point for which the Active column is blank, as shown below:
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2. Click on the Activate  button and the checkmark will be shown on the Active column 
for the selected VOIP Tap Point as shown below:

11.11.5  Deactivate a VOIP Tap Point
This feature allows to deactivate a VOIP Tap Point. To deactivate a VOIP Tap Point follow the 
steps given below.
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1. Select the VOIP Tap Point for which the Active column is checked as shown below:

2. Click on the Deactivate  button and the Active column will be blank for the selected 
VOIP Tap Point as shown below:

Note: When in the VOIP Tap Point grid, there is more than one VOIP Tap Point with the same 
Name, either of the VOIP Tap Point can be set to Active. But both the VOIP Tap Point 
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with the same name can be inactive. If you try to Activate both the similar named VOIP 
Tap Points, an Error message appears to change the name of the VOIP tap point.

Note: When similar Recording Board for different VOIP Tap Points, all the VOIP Tap Point 
cannot be activated. The Recording Board should be unique for different VOIP Tap 
Points for all to be active.
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12.  Security

The chapter introduces the major Security components that are the part of the Aspect Quality. 
As an Administrator, knowing the components helps you to be more productive while using the 
Aspect Quality.

The Security features are listed below:

• API Users

• Teams

• User Profiles

• Users
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12.1  API Users
This section describes how to view the existing API Users and how to Add, Edit and Delete the 
API Users in the system.

12.1.1   Navigation to API Users
Follow the steps given below to navigate to the API Users page:

1. Go to the main menu icon.

2. Click Administration > Security > API Users.
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3. The API Users page appears, as given below:

4. The Menu buttons on the API Users page are described below:

5. The grid column on the API Users page is described below:

12.1.2   Create API User
To create a new API User, perform the following steps.

1. Go to the main menu icon.

Icons Description

Refresh Refreshes the API Users grid with latest API users changes. 
Instead of the browser refresh button user can click on this 
menu button which will refresh only the grid data and not the 
page.

Add Adds the new API user to the grid.

Edit Edits the existing API user listed in the grid.

Delete Deletes the existing API user listed in the grid.

Column Description

Authorized Account The name of the API User account.
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2. Click Administration > Security > API Users.

3. The API Users page appears.

4. Click on the Add button.The Add API User definition window appears.

Note: The fields marked (*) are mandatory fields.

5. Enter the user name in the Authorized Account text box.

6. In the API List, select the Media File Security from the Available Items window. With the 
help of Add button, move it to the Selected Items window. To move the items from Selected 
Items to Available Items window, use the Remove button.

7. Click OK to create the API User.

By default, the new API User which is created will be listed in the grid.

12.1.3   Edit API User
To edit an API User, perform the following steps.

1. Go to the main menu icon.

2. Click Administration > Security > API Users.

3. The API Users page appears.

4. Select the available API User from the grid that needs to be edited and click the Edit icon.
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5. The Edit API User window appears, as shown below.

6. Edit the field values as per your requirement.
Note: Refer to Create API User on page 12-692 section, step 4 to 7.

7. Click the OK button to complete the process.

12.1.4   Delete API User
To delete an API User, perform the following steps.

1. Go to the main menu icon.

2. Click Administration > Security > API Users.

3. The API Users page appears.

4. Select the available API User from the grid that needs to be deleted and click the Delete 
icon.

5. A warning message appears, if you want to delete or not, as shown below.

6. Select the Yes option to delete the listed API User.
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12.2  Teams
A team is a collection of one or more agents, based on equivalent skills or a specific contact 
center need (predominantly for reporting). Through the data-sync process, Aspect Quality 
imports any teams (or equivalent entity) from the switch. You can also define Teams on the 
Aspect Quality system, but you cannot edit teams that the data-sync process has imported.

Use Teams on the Aspect Quality system for the following purposes:

• Reviewing and Scoring interactions

• Live Monitoring

• Reporting

In this section, you can

• View Available Teams

• Create a New Team

• Add Members to a Team

• Edit a Team

• View Team Details

• Activate a Team

• Deactivate a Team

12.2.1   View Available Teams
This section describes how to see the available teams in the system.

1. Login to Workforce Engagement Management.
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 695



Administrator Guide
2. Go to Main Menu and click on Administration and under Security, click Teams as shown 
below.

The Teams window opens with the list of teams displayed in the table.

Note:
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• A maximum of 100 teams display on each page. Pagination options display at the 
bottom of the table.

• An information icon displays above the table, stating Synced teams cannot be 
activated/deactivated.

The following table describes the buttons available on the Teams window.

The following table contains descriptions of the columns in the Teams table.

12.2.2   Create a New Team
Through the data-sync process, Quality imports any teams (or equivalent entity) from the 
switch. However, you cannot edit teams that the data-sync process has imported.

Button Name Description

Refresh When you click Refresh, the system refreshes the Teams 
table.

Add When you click Add, you can create a new team.

Edit When you click Edit, you can modify a team.

View When you click View, you can see existing team details.

Activate When you click Activate, you make a team active.

Deactivate When you click Deactivate, you make a team inactive.

Column Name Description

Name The name of the team.

Switch The switch that is associated with the Team.

Active If the team is active, then a check mark displays. 

If the team is inactive, no icon displays.

Synced If the team is synced from the ACD, a check mark displays.
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You can also create a team in Workforce Engagement Management. To create a team, 
perform the following steps.

1. On the Teams window, click Add. The Add Team window opens.

Note: The fields marked (*) are mandatory fields.

2. In the Name text box under the General tab, type a name for the team. 

The maximum number of characters allowed is 128. The Team name must be unique, and 
you can use special characters.
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3. From the Switch drop-down list box, select the switch that you want to associate with the 
team. In the Team Members section of the window, the Select button is enabled, and 
displays Selected (0).

4. Click on the Select button under the Team Members section to Add Members to a Team.

5. Go to Profile Permissions tab to provide the review or score permission for the user 
profile. The main menu, under the Available Items section, contains features such as 
Sorting, Filtering, Reset Layout and Clear All filters. 

The following table describes the available option under the main menu.

Button Name Description

Sort Ascending Refer Sort Columns section

Sort Descending Refer Sort Columns section

Filter Refer Filter Criteria section
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6. Select the Available Items based on your requirement and click on the Add items button as 
shown below.  

The following table describes the arrow buttons on the Profile Permissions tab.

Reset Layout Refer Reset Layout section

Clear All Filters Refer Clear All Filters section

Arrow Button Button Name Description

Add All Items Moves all the Available Items table to the Selected Items 
table.

Note: If no items are available in the Available Items 
table, the Add All Items button is disabled.

Add Items Moves only the selected items from the Available Items 
table to the Selected Items table.

Note: If you select at least one item in the Available 
Items table, the Add Items button is enabled.

Remove Items Moves only the selected items from the Selected Items 
table to the Available Items table.

Note: If you select at least one item in the Selected 
Items table, the Add Items button is enabled.

Button Name Description
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7. Select either Review or Score from the drop-down list as shown below.

Note: To apply the same permission such as Review or Score for the selected user 
profiles under the Selected Items, follow the steps below.

Remove All Items Moves all the selected items from the Selected Items 
table to the Available Items table.

Note: If no items are available in the Selected Items 
table, the Remove All Items button is disabled.

Arrow Button Button Name Description
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a. Select all of the user profiles and click on the Change selected user profiles 
permission button as shown below.
Note: By default, the Change selected user profiles permission button is disabled. 

When you select two or more user profiles, the button will be enabled. 

b. Click on the Permission drop-down list and select Review or Score based on your 
requirement. 

c. Click OK to complete the process.
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8. Click OK button. The Add Team window closes and the Teams window is active as shown 
below. 
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12.2.3   Add Members to a Team
1. On the Add Team window, in the Team Members section, click Select. The Select Users 

window opens.

The buttons on the Select Users window are described in the following table.

Button Name Description

Search Click to search for the matched user and to open the 
User table.

Note: Only active users are displayed.

Add Click to open the Users table, where you can add users 
to the team.

Note: Only active users are displayed.

Add All Add all members associated with the switch to the team.
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2. In the Search Items text box, you can type the name of the member that you want to add to 
the team. 

OR

Click the Search icon. A window opens with a list of users from the selected switch.

3. Select the members that you want to associate with the team.

Note: You can select more than one member at a time by pressing CTRL key and clicking 
the member row with the mouse.

4. Click OK. The member list closes, the Select Users window is active, the users display in 
the lower half of the window.

5. Click OK. The Select Users window closes, the Add Team window is active, and the 
Selected (X) label displays the number [in parentheses ( )] of members that you selected.

Remove Remove the selected member from the team.

Delete All Remove all members from the team.

Button Name Description
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6. Click OK. The Add Team window closes, and the team that you created displays in the 
table on the Teams window.

12.2.4   Edit a Team
This section describes how to edit a team that you created in Workforce Engagement 
Management. Use the Edit feature to modify the Team Name, and add users to, or remove 
associated users from, the team.

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Main Menu and click on Administration and under Security, click Teams as shown 
below.
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3. From the Teams table, select the row of the team that needs to edit, and click Edit. The Edit 
Team window opens.

Note: The Edit button is disabled for teams that are synced in the system.

4. If you want, you can change the team name in the Name text box.

AND

If you want to change the team members, perform the following steps.

a. Click Select. The Select Users window opens.

b. To delete a member, select the member from the list, and click Remove.

c. To add a member, click Add. A window opens with a list of members associated with the 
selected switch.

d. Select the members that you want to associate with the team.

e. Click OK. The window with the list of members closes, and the Select Users window is 
active.

f. Click OK. The Select Users window closes and the Edit Team window is active.
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5. Go to the Profile Permissions tab (refer Arrow Button table) and select the options based 
on your requirement. Refer step 6 and 7 from Create a New Team.
Note: To remove one item from the Selected Items list, select the item and click on 

Remove items button.

6. Click OK. The Edit team window closes and the Teams window is active. The system saves 
the changes that you made.

12.2.5   View Team Details
You can view the details of a team - the switch name, team members and user profiles 
associated with the team.

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Main Menu and click on Administration and under Security, click Teams as shown 
below. 
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3. From the Teams, select the row of the team which needs to view, and click on the View  
button. The View Team window opens. 

The following table describes the available option under the triple-bar menu as shown 
above.

Note: You can group data by column when you drag-and-drop the column from the table 
header to the top of the table where it says Drag a column header and drop it 
here to group by that column. Refer the below screenshot. 

Example: Based on the above scenario, if the Permission column is drag-and-drop 

Button Name Description

Sort Ascending Refer Sort Columns section

Sort Descending Refer Sort Columns section

Filter Refer Filter Criteria section

Columns Click on the Name and Permission check boxes to add or remove the 
columns under the Profile Permission section

Reset Layout Refer Reset Layout section

Clear All Filters Refer Clear All Filters section
Aspect Workforce Engagement Management Quality™ Administrator Guide  Alvaria Confidential | aspect.com | 709



Administrator Guide
on the “Drag a column header and drop it here to group by that column” field. Then 
the Profile Permissions section will be grouped, as shown below. 

4. When you are finished viewing the team details, click OK to close the window.

12.2.6   Activate a Team
To activate a team, perform the following steps.

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Main Menu and click on Administration and under Security, click Teams as shown 
below.

3. From the Teams table, select the row of the team which needs to activate, and click 
Activate.

Note: The Activate button is enabled only for an inactive team.

The system activates the team and refreshes the table on the Teams window.
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12.2.7   Deactivate a Team
To deactivate a team, perform the following steps.

1. Log in to Workforce Engagement Management as an Administrator.

2. Go to Main Menu and click on Administration and under Security, click Teams as shown 
below.

3. From the Teams table, select the row of the team which needs to deactivate and click 
Deactivate.

Note:  The Deactivate button is enabled only for an active team.

The system activates the team and refreshes the table on the Teams window.
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12.3  User Profiles
To grant permissions or rights to a user, you should create a user profile. Using profiles, an 
Administrator can assign permissions and rights for multiple users at the same time. You can 
assign a user permission to perform specific tasks; for example, creating or viewing templates 
and reports.

To launch the User Profiles window, perform the following steps.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration > Security > User Profiles.

The User Profiles window opens with a table listing all the user profiles available in the 
system.

Note: A maximum of 100 user profiles can display on the page.
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The following table describes the buttons on the User Profiles window.

The following table describes the columns in the User Profiles table.

Note: The default for the column sorting is by Name.

Button Name Description

Refresh Refreshes the User Profiles table.

Add Creates a new user profile.

Edit Edits an existing user profile.

Duplicate Copies an existing user profile.

Note: You cannot duplicate the Admin profile.

Delete Deletes an existing user profile.

Activate If a user profile is inactive, click to activate the user 
profile.

Note: If the user profile is inactive, the Active button is 
enabled.

Deactivate Deactivates the user profile.

Note: If the user profile is active, the Deactivate button 
is enabled.

Column Description

Name The name of the user profile.

Description The description of the user profile.

Active If the user profile is active, then a check mark icon displays.
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12.3.1   Rights and Permissions

12.3.1.1   User Rights
User rights are privileges that you give to users to access Aspect Quality entities (for example, 
Interactions, Reports, Rules). If a user has a Right on an entity, then the user can create 
objects of that entity.

Rights Definition

Manage Recordings

Self Review The user can review their own calls.

Download Recordings The user can download a recording to review when the user 
disconnects from the Aspect Quality system. Aspect 
recommends that you give only Mentors and Administrators 
permission to download.

Export Recordings The user can export an audio or video recording for future 
viewing.

Assign Interactions The user can assign the interaction(s) to other users temporarily.

Note: This right exposes all user profiles and the users for each 
profile.

Delete Interactions The user can delete the interaction(s).

Note: This right exposes all user profiles and the users for each 
profile.

Manage Evaluations

Self Evaluate The user can score their own calls.

Create Evaluation Template The user can create evaluation templates.

View Peer Review Agent: All Agents, Mentors, and Administrators can view the 
evaluations marked for Peer review by Agent.

Mentor: All the Mentor and Administrators can view the 
evaluations marked for Peer review by Mentor.

Administrator: All Administrators can view the evaluations 
marked for Peer review by Administrator.

Grant Peer Review The user can flag an evaluation for peer review for the 
accessible interactions. Users who have the View Peer Review 
right can have the Grant Peer Review right.

View All Evaluations The user can view all evaluations for the accessible interactions.

Edit All Evaluations The user can edit an evaluations.

Note: This feature works if the View All Evaluations button is 
enabled. 

Assign Evaluations The user can assign an evaluation (created by the user) to other 
users.
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12.3.1.2   User Permissions
To grant permissions to a user, you should create a user profile. Using profiles, an 
Administrator can assign permissions and rights for multiple users at the same time. You can 
assign a user permission to perform specific tasks; for example, creating or viewing templates 
and reports.

The calls you can see when you search in Aspect Quality are the union of calls between any 
Teams, Agent Groups, and Recording Groups you have permission to review or score. You 
can review a call:

• If any agent in one of the Team handles the call.

• If an Agent Group takes the call.

• If a port in one of the Recording Groups records the call.

Create Task The user can create tasks. A task is a type of interaction, such as 
a non-recording option, which the user uses to evaluate the 
agent in general; the system does not associate a task with a 
recording.

Hide/Show Interactions The user is able to reserve interactions for Hide/Show 
interactions as well as release interactions from Hide/Show 
interactions. The user is able to search and access interactions 
that are currently reserved for Hide/Show interactions given that 
the interaction falls within the scope of the user’s permissions. 
Users who do not have this permission cannot search or access 
any interactions that are currently reserved for Hide/Show 
interactions.

Manage Calibrations

View Calibration Events The user can access all the calibration events.

Assign Calibration Events The user can assign the interaction to other users to calibrate the 
score.

Note: This right exposes all the users for the selected 
templates.

Manage Reports

View Reports The user can review all reports.

Create Reports The user can create new reports.

Other Configurations

Create Recording Rule The user can create business rules that determine how Aspect 
Quality records a call.

Protect Interaction User can request to keep an interaction available for playback 
after the historical or archive processes run.

Rights Definition
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To access calls, you must determine if you should have access to calls based on a set of 
Agents, a set of Agent Groups, a set of Recording Ports, or a combination of these sets. Once 
you determine the access, define the groups you need and grant access.

In addition to which groups a user can access, you can set each group for review-only, edit, or 
score permission. The following are permission options:

12.3.2   Create a User Profile
To create a user profile, perform the following steps.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration > Security > User Profiles.

Permission Definition

Teams Review – Permission allows the Mentor to listen to calls handled 
by Agents in the Teams.

Score – Permission allows the Mentor to score these 
interactions.

Evaluation Templates View – Permission allows the Mentor to use a specific evaluation 
template without modification.

Edit – Permission allows the Mentor to make changes to the 
specific evaluation template.

Rules View – Permission allows the Mentor to use a specific rule in 
searches and to open the rule definition without modifying it.

Edit – Permission allows the Mentor to make changes to the 
specific rule within the bounds of the Mentor’s other assigned 
access.

Recording Groups Review – Permission allows the Mentor to listen to any call 
recorded by a physical port in the assigned recording group.

Score – Permission allows the mentor to score these 
interactions.

Reports View – Permission allows the Mentor to view existing report 
results and the report template without modifying it.

Edit – Permission also allows the Mentor to make changes to the 
specific report within the bounds of the Mentor’s other assigned 
access.

Skill Groups Review – Permission allows the Mentor to listen to calls handled 
by Agent Groups associated with the Skill Group.

Score – Permission allows the Mentor to score these 
interactions.
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The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. Click Add. The Create User Profile window opens with the Rights tab active as shown 
below.
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The following table describes the buttons on the Create User Profile window.

Note: The fields marked (*) are mandatory fields.

4. In the Name text box, type a name for the user profile.

5. In the Description text box, type a description for the user profile.

6. On the Rights tab, using the Rights table (see User Rights on page 12-714), select the 
options that you want to assign to the user profile.

7. Select the Permissions tab.

Note: The Item Type displays below the tabs. For information about each Item Type, see 
User Permissions on page 12-715. 
 
In the preceding screen shot, the Item Type selected is Teams.

Button Name Description

Back Click to redirect to the User Profiles window.

Save Click to save the user profile.
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The following table describes the columns in the Available Items table.

The following table describes the columns in the Selected Items table.

The following table describes the arrow buttons on the Permissions tab.

Column Description

Name The entity name.

Switch The switch name.

Note: The Switch column does not display Entity types 
such as Evaluation Template or Reports.

Column Description

Name The entity name.

Switch The switch name.

Note: The Switch column does not display Entity types such as 
Evaluation Template or Reports.

Permission Depending on the type of Entity, displays a drop-down list box from 
which you can select the following permissions.
• Review or Score - if you select Score, the entity item can both 

Review and Score.
• Edit or View

Note: See User Permissions on page 12-715 for more information on 
which permission to select.

Arrow Button Button Name Description

Add All Items Moves all the Available Items table to the Selected 
Items table.

Note: If no items are available in the Available 
Items table, the Add All Items button is 
disabled. 
 
You need not select any check boxes if you 
intend to click this button.

Add Item Moves only the selected items from the Available 
Items table to the Selected Items table.

Note: If you select at least one item in the Available 
Items table, the Add Items button is enabled.

Remove Item Moves only the selected items from the Selected 
Items table to the Available Items table.

Note: If you select at least one item in the Selected 
Items table, the Add Items button is enabled.
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8. To move an Available Item type, in the left pane, select the check boxes next to the items 
that you want to move, and click the appropriate arrow button. The Available Items that you 
selected move to the Selected Items table in the right pane.
Note: To select all Available Items or all Selected Items, click the first check box in the 

header row, next to Name.

9. In the Selected Items table, from the drop-down list box next to each entity item, select the 
Permission for that entity.

10.Select the Users tab.

The following table describes the buttons on the Users tab.

Remove All 
Items

Moves all the selected items from the Selected Items 
table to the Available Items table.

Note: If no items are available in the Selected Items 
table, the Remove All Items button is 
disabled. 
 
You need not select any check boxes if you 
intend to click this button.

Button Button Name Description

Add Click to add users.

Remove Click to remove users.

Note: By default, the Remove button is disabled. 
When you select at least one item from the 
table, the Remove button is enabled.

Arrow Button Button Name Description
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11.Click Add. The Add User window opens.

Note: The fields marked (*) are mandatory fields.

12.Click Select. The Select Users window opens.
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The buttons on the Select Users window are described in the following table.

Button Name Description

Search Click to search for the matched user and to open the 
Users table.

Note: Only active users are displayed.

Add Click to open the Users table, where you can add 
users to the list.

Note: Only active users are displayed.

Add All Add all active users to the list.

Remove Remove the selected users from the list.

Delete All Remove all users from the list.
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13.Click Add. The Users list opens.
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The following table describes the columns in the User list table.

14.Select the users to which you want to apply the user profile you have just created.

Note: You can select more than one user at a time by pressing the CTRL key and clicking 
the user row with the mouse.

15.Click OK. The User list table closes, the Select Users window is active, and the users you 
selected displays in the lower half of the window.

16.Click OK. The Select Users window closes and the Add User window is active.

17.Click OK. The Add User window closes, the Create User Profile window is active, and the 
new user profile displays in the table.

18.Click Save.

12.3.3   Edit a User Profile
To edit a user profile, perform the following steps.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Security, click User Profiles as 
shown below.

The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. From the User Profiles table, select the user profile which needs to modify.

Column Name Description

User Name The user’s name.

First Name The first name of the user.

Last Name The last name of the user.

Switch Name The switch associated with the user.

Note: If the user is not associated with any switch 
name, then No Switch is displayed.

Role The user’s role or persona.
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4. Click Edit.

The Edit User Profile window opens with the Rights tab active.

5. Make the changes you want, on any of the tabs, to the user profile.
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6. Click on Users tab, the users associate with the User Profile listed in the grid as shown 
below.  

Example: 2112 and 2117 users are associated with the User Profile.

7. Click on the Add button to add more users.

8. Click on Select button and the Select Users window appears as shown below.

9. Type the username on the Search Items field or click on the magnifying glass and click Yes 
as shown below.
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10.Select the user which you want to add and click on OK button.  
Example: 2111 is selected from the grid as shown below.

Note: 2112 and 2117 are not listed under the User Name column as both are already 
added to the Users tab.

11.Click on OK button as shown below.
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12.The user 2111 is added to the grid. Refer the below screenshot.

Note: The grid will be sorted by Not Saved column and always adding a new user to user 
profile will be shown at the top.

13.Click Save.

12.3.4   Remove a New User from a User Profile
To remove a user from a user profile, perform the following steps.

Note: You can only remove an existing user from a user profile if you first add that user to 
another user profile.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Security, click User Profiles as 
shown below.

The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. From the User Profiles table, select the user profile from which needs to remove a user(s).
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4. Click Edit.

The Edit User Profile window opens with the Rights tab active.
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5. Select the Users tab.

Note: The new user is flagged with a check mark icon in the Not Saved column. The 
information message on the right reminds you that Only users marked as ‘Not 
Saved’ can be deleted from the list.

6. Select the row of the new users and click on Delete.

12.3.5   Duplicate a User Profile
You may want to duplicate a user profile if you want to create a profile with similar (but not 
exact) options.

Note: Users cannot be duplicated during this procedure, so you must select the users that 
you want to associate with this user profile.

To duplicate a user profile, perform the following steps.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Security, click User Profiles as 
shown below.
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The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. From the list of user profiles, select the user profile which needs to duplicate.

4. Click Duplicate.

The Duplicate User Profile window opens with the Rights tab active.

5. In the Name text box, type a name for the duplicated user profile.

6. In the Description text box, type a description for the duplicated user profile.
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7. Make the edits to the user profile Rights and Permissions with the options that you want.

8. Select the Users tab. The following table describes the buttons on the Users tab.

9. Click Add. The Add User window opens.

Note: The fields marked (*) are mandatory fields.

Button Button Name Description

Add Click to add users.

Remove Click to remove users.

Note: By default, the Remove button is disabled. 
When you select at least one item from the 
table, the Remove button is enabled.
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10.Click Select. The Select Users window opens.

The buttons on the Select Users window are described in the following table.

Button Name Description

Search Click to search for the matched user and to open the 
Users table.

Note: Only active users are displayed.

Add Click to open the Users table, where you can add 
users to the list.

Note: Only active users are displayed.

Add All Add all active users to the list.
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11.Click Add. The Users list opens.

Remove Remove the selected users from the list.

Delete All Remove all users from the list.

Button Name Description
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The following table describes the columns in the User list table.

12.Select the users to which you want to apply the user profile you have just duplicated.

Note: You can select more than one user at a time by pressing the CTRL key and clicking 
the user row with the mouse.

13.Click OK. The User list table closes, the Select Users window is active, and the users you 
selected displays in the lower half of the window.

14.Click OK. The Select Users window closes and the Add User window is active.

15.Click OK. The Add User window closes, the Duplicate User Profile window is active, and 
the new (duplicated) user profile is listed in the table.

16.Click Save.

12.3.6   Delete a User Profile
To delete a user profile, perform the following steps.

Note: If at least one user exists in the user profile, you cannot delete the user profile.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Security, click User Profiles as 
shown below.

The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. From the list of user profiles, select the user profile which needs to delete.

Column Name Description

User Name The user’s name.

First Name The first name of the user.

Last Name The last name of the user.

Switch Name The switch associated with the user.

Note: If the user is not associated with any switch name, then No 
Switch is displayed.

Role The user’s role or persona.
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4. Click Delete.
Note: If at least one user exists in the user profile, the Delete button is disabled.

12.3.7   Activate a User Profile
To activate a user profile, perform the following steps.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Security, click User Profiles as 
shown below.

The User Profiles window opens with a table listing all the user profiles available in the 
system.

3. From the list of user profiles, select the user profile which needs to activate.

4. Click Activate.

12.3.8   Deactivate a User Profile
To deactivate a user profile, perform the following steps.

Note: If even one user exists in the user profile, you cannot deactivate the user profile.

1. Login to Workforce Engagement Management.

2. Go to Main Menu and click on Administration and under Administration, click User 
Profiles as shown below.

The User Profiles window opens with a table listing all the user profiles available in the 
system.
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3. From the list of user profiles, select the user profile that you want to deactivate.

4. Click Deactivate.

If even one user exists in the user profile, the Deactivate button is disabled.
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12.4  Users
User Management is a feature from the Aspect Quality component of Workforce Engagement 
Management that an Administrator uses to add a user, activate and deactivate a user, and so 
on. 

This chapter describes the below features about Users.

• Listing Users on page 12-738

• Creating Users on page 12-743

• Editing User on page 12-755

• Filtering Users on page 12-758

• Activate and Deactivate Users on page 12-762

• Monitoring Permissions on page 12-763

• Team Information on page 12-765

12.4.1   Listing Users
Users navigation menu is displayed under “Administration” section.

1. Go to main menu and select Administration > Security > Users. 

2. The Users screen which will list all the active users in the system by default as shown 
below.
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The header bar icons function as follows: 

Users grid contains information as mentioned in the below table. 

Icons Description

Refresh Refreshes the users grid with latest user changes. Instead of user click 
on the browser refresh button user can click on this which will refresh 
only the grid data and not the page

Filter Allows to 
• Filter users by team
• User status (active and inactive)

Add Creates a new user

Edit Updates the details of existing user

Information Provides the team information of the selected user

Activate Allows to activate more than one user who are in inactive state

Deactivate Allows to deactivate more than one user who are in active state

Monitoring Permissions Change the monitoring permissions (audio and screen) for more than 
one user

Users Grid Attributes Details:

Column Name Description Default Column Optional Column

First Name Displays first name of the user

Last Name Displays last name of the user

User Name Displays user name of the user

Switch • Switch name to which the 
user is associated.

• If the user is not associated 
with any switch, then “None” 
will be displayed

Switch Type • Type of the switch the user is 
associated.E.g., Unified IP, 
Avaya

• If the user is not associated 
with any switch, then “None” 
will be displayed
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Role Displays Role of the user from 
the below list
• None
• Agent
• Mentor
• Administrator
• Silent Monitor
• IVR

Windows Logon 
Name

• If windows account is 
available for the user, then 
displays the windows logon 
domain and user name in 
below format 
<domain\username>

• If windows account is not 
available, then blank will be 
displayed.

Email Address • Displays Email address of 
the user

• If email address does not 
exist, then blank will be 
displayed

User Profile Name • Displays Profile name for 
which the user is associated.

• For user with Role “Silent 
Monitor” and “IVR” blank will 
be displayed as the users will 
not be assigned to any 
profile.

Agent Position Displays Position ID of the user

Active Indicates the user is active or 
inactive

• Checked ( ) - user is 
active

• Unchecked ( ) - user is 
inactive

Synced Indicates the user is synced from 
Switch OR created from other 
source like (WEM UI, Importer, 
and so on.)

• Checked ( ) – Synced 
User from ACD

• Unchecked ( ) – Non-Synced 
User 

Users Grid Attributes Details:

Column Name Description Default Column Optional Column
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Note:

• Displays all the active users available in the system.

• Users associated with inactive switch will not be displayed.

• Grid will be sorted on Last Name by default.
The grid is customizable till the user signs out from the WEM or reset the grid layout.

• Per page 100 users will be displayed.

• Use the filter option of each column (available top of the column) based on the 
requirements.

Monitoring 
• Audio
• Screen
• Chat
• Login

Indicates what monitoring 
permissions available for the 
user
• If audio monitoring is 

available for the user a tick 
mark will be displayed under 
“Audio” column

• If screen monitoring is 
available for the user a tick 
mark will be displayed under 
“Screen” column

• If chat monitoring is available 
for the user a tick mark will 
be displayed under “Chat” 
column

• If the user is allowed to log in, 
a check mark will be 
displayed under the “Login” 
column

LDAP/AD Synced Indicates the user having LDAP/
AD synced account

• Checked ( ) – LDAP/AD 
account is synced

• Unchecked () – LDAP/AD 
account is not synced

• Info Icon  - Duplicate 
LDAP User account found for 
the same user. If an icon like 
this is found the 
Administrator must Edit the 
user and choose the right 
LDAP User account (Refer 
Editing a user section for 
more details)

Users Grid Attributes Details:

Column Name Description Default Column Optional Column
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12.4.2   Creating Users
Create user will add a new non-synced ACD user into the Users list page and by default it will 
be in active state. To add a new user, follow the steps below.

1. Click on Add button to add a new user.
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2. Add User dialog will be displayed as shown in below Add User screen. 
 

Add Users Attribute Details:

Field Name Description

User Name (Mandatory 
and unique)

• Provide username
• Username is mandatory to create a user and it should be unique 

within the switch (If you are associating this user to a switch else the 
user name should be unique within the list of users who are not 
associated with any switch).

First Name • Provide the user’s first name
• This is an optional field.

Last Name • Provide the user’s last name
• This is a mandatory field.

Switch • Select switch for which the user should be associated
• All the active switches available in the system will be displayed in the 

Switch drop-down list
• By default, None will be selected as switch option. Select None when 

the user is not associated with any switch.
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LDAP/AD Sync • LDAP/AD Sync button will be enabled if the selected switch is 
configured with LDAP/AD server.

• The LDAP/AD Sync will be enabled when None is selected in the 
Switch drop-down list and the LDAP/AD server is configured in the 
system.

• Clicking on this button will sync the LDAP/AD account for the user 
based on the first name and last name entered. e.g., enter user first 
name as “Joe” and last name as “Fernald” and the same user will be 
existing in the LDAP/AD server configured, then the LDAP/AD 
account for the user will be synced.

• Below details will be synced from LDAP/AD based on the 
configuration of the LDAP/AD in Workforce Engagement Management 
UI:

• Windows Logon User Name
• Windows Logon Domain
• Email Address

Windows Logon User 
Name

• This is a drop-down list and textbox.
• User can enter the “Windows Logon User Name” or Select the logon 

name synced from the LDAP/AD.

• If you don’t want to click on the Sync button to connect to the 
LDAP/AD and sync the data and if you are sure what the windows 
logon account and domain then you can enter it and either if you 
are not sure or you want to sync that from LDAP/AD instead of 
typing you can Click on the SYNC LDAP button and pick the value 
from the drop-down list.

• After the LDAP/AD account is synced, the logon name for the user will 
be displayed in “Windows Logon User Name” drop-down list. User can 
select the name as shown in the below screen shot. 

• All the logon accounts will be displayed in the drop-down list when 
more than one logon are available for same user in the LDAP/AD. The 
user will select the account which need to be synced.

• If the user wants to provide an account details without syncing from 
LDAP/AD, then user can enter the user name. 

Note:
• Windows Logon User Name must be configured for a user to log in for 

WEM (If WEM is deployed in Premise or if its hosted in Rackspace)
• When “Windows Logon User Name” is entered/synced for a user, then 

“Windows Logon Domain” must be provided and vice-versa. Both the 
fields are dependent.

Add Users Attribute Details:

Field Name Description
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Windows Logon 
Domain

• Domain synced from the LDAP for the user. After LDAP/AD sync the 
domain name will be displayed as shown in the below screenshot. 

• User can also enter the domain manually.

Note: Windows Logon Domain must be configured for a user to log in for 
WEM (If WEM is deployed in Premise or if its hosted in 
Rackspace).

Email Address • Provide the valid email address for the user.
• Email Address can also be synced from the LDAP.
• Email Address should be in format of <text@a.com>

Note: To sync email address from LDAP “Sync emails” should be 
configured when creating LDAP server from Workforce 
Engagement Management UI.

Note: Some SMTP Servers support case-sensitive email addresses. 
(Example: John.Smith@company.com and 
john.smith@company.com are different email addresses for case-
sensitive SMTP Servers). If entering manually, verify the letter 
case is correct.

Role • Select the role for the user
• Below roles will be displayed in the Role dropdown list

• None
• Agent
• Mentor
• Administrator
• Silent Monitor
• IVR

• By default, “None” will be selected.
• Refer Section C to view the changes for adding a user with different 

roles.

Agent Position ID • Enter the position ID for the user.
• Enabled only for the users with role IVR. For all other user roles, it will 

be read-only field.
• Agent Position ID can also be synced from switch.

User Profile • Select a user profile for which the user should be assigned.
• By default, the user profile will be blank.
• Saving the user without selecting any user profile will assign the user 

to “Default Profile”.
• For users with “Administrator” role the “Admin Profile” will be 

displayed by default.
• To select a user profile, follow the steps provided in Section A

Add Users Attribute Details:

Field Name Description
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Note: Maximum characters allowed for the text fields are as mentioned in the below table.

Legacy Password • Provide the password for the user to log in to Workforce Engagement 
Management UI.

• As the name specifies this password will be helpful only when the user 
wants to log in to Classic UI (Legacy application).

Monitoring Capabilities • Set “Audio Monitoring”, “Screen Monitoring”, “Chat Monitoring”, and 
Login for the user.

• Audio Monitoring, Screen Monitoring and Chat Monitoring – 
ON – audio, screen and chat can be recorded for the user.

• Audio Monitoring, Screen Monitoring and Chat Monitoring – 
OFF – audio, screen and chat can cannot be recorded for the 
user.

• Login ON – login is enabled for the user for a particular site.
• Login OFF -- login is disabled for the user for a particular site

Teams • Select a team for which the user should be member of.
• If a switch is selected Select button will be enabled. 

• Only if a user is associated to switch, team can be assigned.
• User can be assigned to a team or not as its optional.
• If you don’t want the user should not be assigned to any team, then do 

not select any team.
• To assign a user for team, follow the steps provided in Section B.

Note:
• Teams which are not synced from switch will be displayed. 
• The information about which teams will be displayed will be provided 

in the Information popover when the user clicks on the Info ( ) icon.

Character limitation in Add User dialog

Text Field Name Maximum Characters Allowed

User Name 256

First Name 64

Last Name 64

Windows Logon User Name 50

Windows Logon Domain 50

Email Address 256

Agent Position ID 10

Password 64

Add Users Attribute Details:

Field Name Description
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As
3. After entering data in all the fields (refer the below screen shot), click on OK button to save 
the user. 

4. The User is added to the grid as shown in the below screenshots.

12.4.3   Select a User Profile
Follow the steps below to select a user from the directory.
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1. Click on the Users Profile text box then type a Users Profile name or without typing any 
text, click on the Search button. 

Note: The below screen shot pops up when the User Profile text box field is empty or 
without any text. 

2. Click on Yes button to view all the active user profiles except the Admin Profile available in 
the system or No button to cancel the search.

3. Select the User Profile and click on OK button or double click on the User Profile row. Refer 
the below screenshot. 

Note: Select only one profile for a user.

4. Selected user profile will be displayed in the User Profile text box as shown in the below 
screenshot. 

Note:
• All the profiles matching the search text entered will be listed.
• In case only one profile exists with the entered text, then the profile will get added 

directly to the User Profile text box.
• To remove or re-assign the user profile selected, click on x button on the User 

Profile text box.
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12.4.4   Select one or more Teams
To select one or more teams follow the steps below.

1. Select a switch.

2. Click on Select button for Teams. Refer the below screen shot. 

3. Select Teams dialog will be displayed as shown in the below screenshot. 

4. Click on the Search Items text box then type any text or without typing any text, click on 
the Search button.
Note: The below screenshot pops up when the Search Items text box field is empty or 

without any text. 

5. Click on Yes button to view all the active non-synced teams for the selected switch or No 
button to cancel the search.
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6. Select one or more teams and click on OK button.
Note: To select multiple teams, use the CTRL key and left key on the mouse.

7. Selected teams will be displayed in the search list box. Refer the screen shot below. 

Note:
• Teams can be searched by clicking on  button (adds one or more selected teams)
• Click on  button to add all the teams to the search list.
• Click on  button to remove selected teams.
• Click on  to remove all the selected teams.

8. Click on OK button. Selected teams count will be displayed as shown in the below screen 
shot. 
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12.4.5   Saving a User with Different User Roles
Based on the user role selected, the input to be provided for the user will differ. 

Note: Mandatory fields are marked with red asterisk on the screen shots.

1. Role: None/Agent/Mentor

• When None/Agent/Mentor role is selected, below data will not be applicable. Hence, 
those fields will be disabled.
• Agent Position ID

2. Role: Administrator

• When Administrator role is selected, below data will not be applicable. Hence, those 
fields will be disabled.
• Agent Position ID
• Teams
• User Profile

• User with Administrator role will be assigned to Admin Profile by default.
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3. Role: Silent Monitor

• When the Silent Monitor role is selected, the data below will not be applicable and 
these fields will be disabled.
• Agent Position ID
• Teams
• User Profile
• Monitoring Capabilities – Audio Monitoring, Screen Monitoring and Chat Monitoring
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4. Role: IVR

• When the IVR role is selected, the following fields are not applicable and are disabled:
• LDAP/AD Sync – Windows Logon User Name and Windows Logon Domain
• Email Address
• Teams
• User Profile
• Monitoring Capabilities – Screen Monitoring
• Legacy Password

• Switch and Agent Position ID are mandatory fields for an IVR user and are marked with 
a red asterisk.
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12.4.6   Editing User
• Edit button will be enabled when one user is selected in the users grid.

• Click on  button to update the user details. 

12.4.6.1   Edit ACD Synced User
Follow the steps below to edit an ACD synced user.

1. Select a synced user from the users’ grid and click on Edit button.

2. Edit User dialog displays as shown in the below screen shot.
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Note:

• The fields below do not allow updates for a synced user. The fields will be displayed in 
read only mode:
• User Name
• First Name
• Last Name
• Switch

• All other fields can be updated.

• The Selected user count will not be displayed when the user is assigned to a synced 
team.

3. Click OK.

12.4.6.2   Edit ACD Non-Synced User
Follow the steps below to edit an ACD non-synced user.

1. Select a non-synced user from the users’ grid and click on Edit button.
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2. Edit User dialog displays as shown in the below screen shot. 
.

Note:

• All the fields are enabled. Any field can be updated and the updated fields saved for the 
chosen user.

• For information on each field, refer to the Table (Add Users Attribute Details). When 
editing the data for each field, all the information mentioned in the table will be 
applicable.

• If a Password is provided for the user regardless of the characters entered for the 
password, 6 bullets will be displayed to indicate that the user was saved with a 
password.

• Editing the Last Name, First Name or the Switch for the LDAP/AD synced user will reset 
the “Windows Logon User Name” and “Windows Logon Domain”. This allows a sync of 
the data based on the latest modifications.

• Under Monitoring Capabilities, use the Login toggle to indicate whether the user is 
enabled for login (ON) or disabled for login (OFF).

3. When a duplicate icon is found for the LDAP/AD sync, select the correct LDAP/AD account 
for the user and save the LDAP/AD account for the user as shown below.
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Note: When editing a user, both active and inactive teams will be displayed for the user.

4. Click on OK to save the updated details and displays in the users grid.

Note: Users Created and Updated will be audited in Audit Activity Detail Report.

12.4.7   Filtering Users
Follow the steps below to filter users.

1. Click on Filter button to filter users by

• Active or inactive users 

• Teams

2. Filter dialogue will be displayed as shown in below screen shot. 

12.4.7.1   Filtering by Team
1. By default, Include All will be flagged. Select (All) will be displayed which indicates all the 

teams present in the system will be selected. 
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2. Select button will get enabled when Include All is un-flagged as shown in below screen 
shots. 

3. Click on Select button and Select Teams Dialogue appears as shown in the below screen 
shot. 
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4. Click on Add button and displays all active teams present in system. 

5. Select one or more teams and click on OK button. The total number of teams appear as 
shown in the below screen shot. 
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6. Click on OK button and all the active users associated with the selected team(s) will be 
displayed in the Users Grid as shown below. 

Note: Refer Team Information on page 12-765 to view the team information of the users 
displayed in the grid, 

12.4.7.2   Filtering to include Inactive Users
1. Include Inactive Users will be un-flagged which indicates all the active users present in the 

system only will be displayed by default. 

2. Flag Include Inactive Users and click on OK button in below Filter screen shot. 
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3. All the active and inactive users based on the selected Teams will be displayed in Users 
Grid as shown in below screen shot. 

Note: Include Inactive Users label appears top right corner on the Users page.

• When Include Inactive Users is flagged in Filter dialogue, then “Yes” will appear in 
Users page which indicates inactive users included

• When Include Inactive Users is Un-flagged in Filter dialogue, then “No” will appear 
in Users page which indicates inactive users excluded.

12.4.8   Activate and Deactivate Users
The user is allowed to activate or deactivate one or more users from the users list page by 
clicking Activate  and Deactivate  button.

1. Activate and Deactivate button will disable when only one synced user is selected in the 
Users Grid because system does not allow a ACD Synced user to be deactivated.

2. Activate button will be enabled when one deactivated non-ACD synced user is selected in 
the Users Grid.

Note:
• Click on Activate button to activate the selected non-ACD synced user’s status to 

active.
• Check mark  will be displayed under Active column for corresponding user as 

shown in the below screen shot.

3. Deactivate button will be enabled when one active non-ACD synced user is selected in the 
Users grid. 
Note:
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• Click on Deactivate button to deactivate the selected non-ACD synced user status 
to inactive. 

• Check mark  will not be displayed a under Active column for corresponding user 
as shown in below screen shot.

4. Activate and Deactivate button will be enabled when more than one ACD synced or non-
ACD synced user is selected in the Users grid regardless of the user is in active or inactive 
state.

Note:
• Click on Activate button will update the user’s status to active for only inactive non-

synced user.
• Click on Deactivate button will update the user’s status to Inactive for only active 

non-synced user.
• Click on Activate or Deactivate button for selected Synced users, the status will not 

update to active or inactive.

5. Activate and Deactivate both the buttons will be enabled when combination of synced and 
non-synced users are selected. 

Note: Only non-synced users status will be get updated based on users active or inactive 
status.

6. Selecting two or more users with the same user name with different active status and 
clicking on Activate button will display error message as shown in below screen.

Note: Updated user status will be audited in Audit Activity.

12.4.9   Monitoring Permissions
You can click on the Monitoring Permissions  button to update Audio, Screen, Chat 
Monitoring, and Login status.

1. Monitoring permissions allows to update Audio, Screen, and Chat monitoring for multiple 
users as well as enabling and disabling logins for those selected users.
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2. Click on the Monitoring Permissions  button and the Monitoring Permissions 
dialogue appears as shown below.

Note:
• By default, Audio Monitoring, Screen Monitoring, Chat Monitoring and Login 

toggle buttons are in the OFF state.
• Clicking on the OK button in Monitoring Permissions dialogue, will not update any 

changes to selected users.

3. Toggling to ON for Audio Monitoring, Screen Monitoring, Chat Monitoring, and Login 
enables these settings and sets the choice to Allowed by default.

4. Clicking the OK button in the Monitoring Permissions dialogue displays a check mark  
under the Audio. Screen, Chat and/or Login columns as shown below.

5. If any Monitoring Permissions are set to Not Allowed, check marks  for the selected 
users in the Users grid under the Audio, Screen, Chat, and/or Login columns will not be 
displayed as shown below.

6. The Monitoring Permissions button will be disabled when the Silent Monitoring role user 
is selected in the user’s grid.
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7. When selecting a user defined with the IVR user role, the Monitoring Permissions option is 
disabled. The Audio Monitoring, Chat Monitoring, and Login options are available for 
modification.

Note: After updating monitoring permissions, only permissions changed for the user will be 
updated in Audit Activity.

12.4.10  Team Information
Information button will be enabled when only one user is selected in users’ grid.

1. Select a user and click on Information  button. A pop-up appears as shown in the below 
screen shot.

Note:
• All the teams will be displayed when the user is assigned to multiple teams as shown 

in the below screen shot.
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• No Team will be displayed as team name when the user is not assigned to any team. 

Note:

• If a user is assigned to an inactive team, then team name with (Inactive) suffix will be 
displayed.

• If a user is selected as Administrator, IVR and Silent Monitor then N/A will be displayed 
for Teams as they cannot be member of any team.
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About Aspect®
Aspect is dedicated to transforming the service economy by humanizing the workforce experi-
ence. Their WorkforceOS platform offers a robust workforce management solution that aligns 
employee preferences with business needs enhancing scheduling, predictive insights, and col-
laboration tools. Supported by its parent company, Alvaria Inc., which boasts over 50 years of 
leadership in workforce management technology, Aspect is a trusted partner for large global en-
terprises across key sectors, including financial services, airlines, automotive, insurance, retail, 
telecommunications, and utilities. The Aspect WorkforceOS stands out as the only culture-driven 
WEM software designed to foster work-life balance while maximizing ROI for businesses. For 
more details, visit www.aspect.com
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